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Disclaimer

This document and its contents, including the viewpoints, dates and functional content expressed herein are the
proprietary copyrighted property of Epicor Software Corporation, are intended for informational purposes only and
are believed to be accurate as of its date of publication. However, Epicor Software Corporation makes no guarantee,
representations or warranties with regard to the enclosed information and specifically disclaims any applicable implied
warranties, such as fitness for a particular purpose, merchantability, satisfactory quality or reasonable skill and care.
As each user of Epicor software is likely to be unique in their requirements in the use of such software and their business
processes, users of this document are always advised to discuss the content of this document with their Epicor support
representative, account manager and/or consulting personnel. All information contained herein is subject to change
without notice and changes to this document since printing and other important information about the software
product are made or published in release notes, and you are urged to obtain the current release notes for the software
product. The usage of any Epicor software shall be pursuant to an Epicor end user license agreement and the performance
of any consulting services by Epicor personnel shall be pursuant to Epicor's services terms and conditions. Usage of the
solution(s) described in this document with other Epicor software or third party products may require the purchase of
licenses for such other products. Where any software is expressed to be compliant with applicable laws or other statutory
or regulatory requirements in this document, such compliance is not a warranty and is based solely on Epicor's current
understanding of such laws and requirements. All laws and requirements are subject to varying interpretations as well
as to change and accordingly, Epicor cannot guarantee that the software will be compliant and up to date with such
changes. All statements of platform and product compatibility in this document shall be considered individually in
relation to the products referred to in the relevant statement, i.e., where any Epicor software is stated to be compatible
with one product and also stated to be compatible with another product, it should not be interpreted that such Epicor
software is compatible with both of the products running at the same time on the same platform or environment.
Additionally platform or product compatibility may require the application of Epicor or third-party updates, patches
and/or service packs and Epicor has no responsibility for compatibility issues which may be caused by updates, patches
and/or service packs released by third parties after the date of publication of this document. Epicor, Business Inspired
and the Epicor logo are trademarks of Epicor Software Corporation, registered in the United States, certain other
countries and/or the EU. All other trademarks mentioned are the property of their respective owners. Copyright ©
Epicor Software Corporation 2014. All rights reserved. No part of this publication may be reproduced in any form
without the prior written consent of Epicor Software Corporation.
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Introduction

The Epicor ERP Application User Guide contains a complete overview of the major ERP modules. This guide begins
with a chapter that describes the primary navigational features of the interface. It then explores the major setup
programs within the application you can leverage to fine-tune ERP to match the business needs of your
organization. You examine how to define features like multiple books, multiple currencies, Site configuration,
Restrictions on Hazardous Substances (RoHS), and many other setup features. Together, these chapters round
out the primary information you need to know about the Epicor application.

The majority of the guide explores the main data flow of the entire suite of modules – taking a quote and then
eventually posting its cash results to books. The first block of chapters describe the sales order flow, from customer
relationships to managing incoming demand to building sales orders. You then review how to engineer parts
that are then used on jobs for production within a manufacturing center. Related chapters detail managing
materials through purchasing and inventory, as well as scheduling material releases to your jobs for on-time
completion. Another series of chapters describes how you create complex projects for a variety of uses, like
manufacturing a related line of products or evaluating product quality. Time and Expense functionality provides
you with the functionality for tracking both time and expense costs against all your projects. The guide concludes
with the financial functionality – Accounts Receivable, Accounts Payable, Advanced Allocations, and General
Ledger.

The guide is intended for a wide audience. Managers and administrators can use it to explore and better understand
the overall architecture of the manufacturing, distribution, service, and financial functionality, and new users can
leverage the guide as a teaching tool for specific modules. For more experienced users, it can also serve as a
reference guide for key descriptions of the primary programs and fields. The Epicor ERP Application User Guide
provides an excellent way to learn the basic, standard workflow of ERP by describing how regular tasks are carried
out from start to finish.

When delivered in PDF format, the guide is split into two parts to make the PDF files a more manageable size.
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Chapter 1: The Epicor Environment

The Epicor application is a feature-rich Enterprise Resource Planning (ERP) software package. In order to gain a thorough
understanding of its features, you first need to know how to navigate the application.

The Epicor application is designed for versatility and integration. To enrich user experience, two types of User Interfaces
(UI) are available for selection:

• Modern Shell - A new, modern interface, represents a fundamental shift in the way Epicor ERP navigation works.
The new UI is more touchscreen-orientated for use on tablets as well as traditional PCs. The touch-centric Home
Page serves as your starting point and can be customized through mosaic tiles. Tiles are the new way to access
applications or documents; you can use them by clicking or tapping on them.

• Classic Style - A traditional way of navigation around the Epicor application. The Classic Style interface is primarily
made up of three parts: Main Menu, Module, and Program. The Main Menu is your home base within the Epicor
application. Every module is consistently organized through the directory tree on the Main Menu, so you can quickly
find the program you need to run.

Each program contains the functionality you need to enter and manipulate data such as toolbars and sheets. A sheet
is a layer of a program interface that contains related data input and functionality. Programs such as Carrier Maintenance
contain two sheets – a detail sheet and a list sheet. More complex programs like Sales Order Entry contain multiple
sheets that accommodate the different ways in which organizations process orders. In this chapter, you will explore
sheets and the data entry elements found on sheets – like check boxes, grids, context menus, and radio buttons.

Trackers are query programs you use to drill into the details of your database. Trackers are also a secure way for users
to view system data without updating information. Whether you are looking for related job information, quote
information, or the status of shipments, receipts, or financial transactions, trackers are the programs you use to access
this information. The application supports three types of trackers – display only, status dashboards, and executive
dashboards.

This chapter also describes the Epicor Everywhere Framework™ – a unique technology that stores all client business
logic as tagged XML metadata. This permits the Epicor application to run as a smart client, Web client, or mobile device
application, all from the same source code. At the end of this chapter, the educational resources available from Epicor
University are described - such as feature summaries, application help, technical reference guides, embedded courses,
and release documentation. You should frequently leverage the documentation and education content to improve
your use of the Epicor application.

Once you understand the interface and the educational resources available, you are better able to reduce the technology,
integration, and accessibility barriers that reduce productivity.

Interface Navigation

This section explains how to use the main controls of Epicor ERP interfaces and how to navigate within active
programs.

Log On

Before you can log into the Epicor application, your System Administrator must set up your personal account
record through User Account Security Maintenance. The user name defined on this record gives you access to
the application. When you first log in, you create a unique password for your user account; only you know this
password.

To access the application running in the Modern Shell style:
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1. Click the Epicor icon on your desktop.

2. The Log in window displays.

3. Enter your User name.

4. Either create a new Password or enter an existing password for this user account.

5. Click the right button to access the Epicor ERP 10 application.

Modern Shell Style

The enhanced menu introduced in Epicor 10 is the new way of navigating around the ERP application.

Similar to Windows 8 menu style, utilizing the kinetic scrolling, the Modern Shell is more touchscreen-orientated
for use on mobile devices such as tablets, but can you also use the keyboard and mouse and make use of the
environment on a traditional PCs. You can customize the Home Page so it best meets your needs. You can, for
example, create shortcuts to commonly used Epicor forms, popular websites, working documents or to display
real-time data using the dashboards. For more information, review the Interface Basics sections found in the
Application Help.

The Modern Shell Menu has the following features:
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1. Tiles are the main building blocks of the home page to quickly access Epicor Forms, URL Links, documents
or programs you use the most.

2. You can organize tiles within Tile Groups such as Favorites List, or maintain your custom groups, for example,
most frequently used Purchase Management forms.

You can rearrange Tiles within the Home Page by using
the drag and drop process.

3. The sliding Open Forms Bar found at the top of the screen displays all opened forms.

4. You can click a form icon to maximize it or click the x button to close it.

5. Use the Navigator buttons found in the top right corner to scroll through the opened forms and return to
the Home Page. You can also launch the Search application that offers several ways to look for and retrieve
a particular information you need.
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6. The embedded search capability includes:

• Searching for a specific Epicor ERP Menu Item using the Menu Search.

• Using a Web Search Engine of your choice to search for a particular information on the internet.

• Using the Enterprise Search to retrieve indexed content from within the Epicor ERP application and then
quickly launch specific programs to display the data returned from the search.

7. To change the company for which you are entering data, in the top right corner, click the link on the current
company and select a company you want.

8. To access the Help application from which you can for example, access Application Help or launch the
Embedded Courses, click the Help tile.

9. The Settings tile provides access to application Settings such as current environment options, changing a
color scheme or configuring your Epicor Social Enterprise access.

19Epicor ERP | 10.0.700

The Epicor Environment | Chapter 1Epicor ERP Application User Guide - Part One



10. To access to the Menu application where you have access to all licensed modules and programs in the Epicor
application, click the Menu tile.

Help, Settings and Menu tiles are standard tiles delivered
by Epicor.

11. The Application Bar at the bottom provides access to context specific options and session-specific options
such changing a user, adding a new tile or accessing the developer mode.

12. You can use zoom in and out of the Home Page using the zooming button located in the low right hand
corner.

Use Menu Application

Use the Menu application launched from the Home Page to access Companies, Modules and Programs found
within the Epicor ERP 10 application. Programs are grouped first by module category, then by module, and last
by function.

The following are the main controls you can use in the new menu:

1. The Menu interface can be viewed in two ways, the Zoom view and the Tree view. You can switch between
the View modes using the icons found in the top right corner of the Menu. The Zoom view is designed for
touch screen devices. It displays the menu for the current Company and Site and it allows the user to focus
on one section of the menu. As the folders are selected on the left, their contents are displayed on the right
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side. The Tree view displays the application tree on the left of the screen. You can navigate through
companies, modules and related programs by clicking on branches and nodes.

2. In this example, the menu interface is displayed using the Zoom view.

3. The Contents pane displays the contents of the folder selected in the left portion of the screen.

4. You can toggle between the List view and the Tile view using the icon found in the top-right corner of the
Contents pane. The Tile view is displays items as rectangular tiles. In this example, the List view is used; it
displays the content of the selected folder as the list of items.
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5. When you open Epicor forms, the status slider at the bottom indicates the form is opening. When the form
has opened, the status slider backs down. If you want to interrupt opening the form, click the X button on
the status slider.

Classic Menu

The Classic Menu style represents a traditional way of navigating around the Epicor application. This interface is
designed for a hands-on environment, general navigation principles and techniques are available at each of the
interface levels in the Epicor application.

The Classic Style interface is primarily made up of three parts: Main Menu, Module, and Program. The Main
Menu is your home base within the Epicor application. Every module is consistently organized through the
directory tree on the Main Menu, so you can quickly find the program you need to run.

The Main Menu

The Main Menu has the following features:

1. Menu bar - Use the Menu bar located at the top of the Main Menu to set your view, change the current
company and plant, select the language for your session, access application help, and so on. The Menu

Epicor ERP | 10.0.70022

Epicor ERP Application User Guide - Part OneChapter 1 | The Epicor Environment



toolbar, located below the Menu bar, holds icons that you use to quickly launch functions also found under
the Options menu of the Menu bar.

2. History toolbar - Click the Down Arrow within this toolbar to view the list of programs you recently
launched. You can select one of these options and click the Go button to activate the program again.

Note: To clear history, from the Options menu, select
Preferences. On the General sheet, click the Clear
History button and click OK.

3. You can launch Enterprise Search directly from the Main Menu application. Use this feature to enter search
text and retrieve results from a wide range of Epicor data.

4. If you right-click a toolbar, a context menu displays. Use this context menu to hide or show the Menu and
History toolbars, to set (lock) the toolbars into their current positions, and to customize the toolbars to match
your needs.

5. Click the Menu Groups tab to display the Main Menu folder list.

6. The Main Menu folder list is an explorer-type tree view of all companies and sites within your organization,
including the module categories and modules.

7. In this example, Epicor Corporation, Epicor Distribution, and Epicor Education are some of the companies
in this organization. You can switch between companies by selecting the company you need on the Main
Menu folder list. (You must have rights to switch between companies.)

8. Notice the Epicor Education company has multiple sites. Some sites in this company are Evanston, Los
Angeles, and Main. You can switch between sites within the current company by selecting the plant you
need on the Main Menu folder list.

9. You access programs within a plant. Programs are grouped first by module category, then by module, and
last by function. Review the next section, Module Navigation, on how to access programs using these
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groupings. The information that displays in a program pertains to the specific company and plant from
which the program was launched.

10. Optionally use the Module Category buttons located below the Main Menu folder list to quickly access
the modules within a specific module category. The Production Management button is selected in this
example.

11. The Menu Groups sheet now displays the module group (in this example, Production Management) in its
title bar. When you select the module you need, the function folders for the module display. You expand
the function folder to view and access a program. In this example, the Engineering module and General
Operations folder are selected.

12. Status Bar – Use the Status Bar to view session information such as current user, current site, time, date,
and so on. The default language for the current user also displays. The interface can appear in a different
language for each user.
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13. Favorites – Use Favorites to access shortcuts to programs you frequently use.

14. To add a favorite option, right-click the program for which you want to create a shortcut. Select Add to
Favorites Bar from the context menu.

You can also add shortcuts that launch external
applications such as Microsoft® Excel® spreadsheet.

Styling and Themes

You have complete control over the look and feel of the entire interface through its styling functionality. Use this
functionality to display user interfaces unique to your company, departments, and users. A theme is a collection
of style modifications that can include unique looks for buttons, check boxes, fields, and colors. For more
information on how to create and manage styles, review the Styling and Themes chapter in the Epicor ICE User
Experience and Customization Guide. Information on styling is also available in application help.

To display the interface using a different style:
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1. To select a theme using the Classic Style, from the Main Menu, select the Options menu.

2. Highlight the Styling submenu and select Load Style Theme.

3. The Load Style Theme (Open) window displays.

4. Select any style available on your client installation.

5. Click Open.
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6. The interface now displays using the selected style.

7. When using the Modern Shell Menu, from the Home Page access the Settings page.

8. From the General Operations, click Preferences and select an available Theme.
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Module Navigation

Programs are grouped first by module category, then by module, and last by function. This section reviews these
different groupings.

1. When using the Classic Style, select the Menu Groups sheet to view the Main Menu folder list.

2. In Modern Shell menu, from the Home Page, access the Menu application.

3. Module Category – Related modules are found within a module category. For example, all the financial
modules such as Accounts Payable, Accounts Receivable, General Ledger, and so on are found within the
Financial Management module category.
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4. Module – Typically, each module has a folder. For example, Accounts Receivable, Order Management, and
so on.

5. Function – Within a module, programs are grouped by their function.

• Setup – Maintenance programs included for the current module. For example, Bank Fee and Terms are
maintenance programs found in the Setup folder for the Accounts Receivable module.

• General Operations – Entry and tracker programs included for the current module. For example, AR
Invoice Entry and Customer Tracker are entry and tracker programs found in the General Operations
folder for the Accounts Receivable module.

• Reports – Reports included for the current module. For example, the Commission and Sales Analysis
reports are found in the Reports folder for the Accounts Receivable module.

6. Program – When you click a function folder, all programs in that folder display in the pane located on the
right side. Programs contain all the functionality you need to enter and manipulate data. Review the next
section, Program Interface, on how to use this functionality.

Program Interface

Programs contain the functionality you need to enter and manipulate data. Each program uses toolbars and
sheets for navigation and data entry.

1.  Program Menu toolbar – This toolbar contains the drop-down menus for the program. Most of these
menus contain features common to all programs; the Actions menu contains functionality unique to the
current program.

2. Standard toolbar – This toolbar contains buttons you use to manipulate data on the current record such
as save, delete, copy, and paste.
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3. Navigation toolbar – Use this toolbar to move through all the records currently selected for display within
the program.

4. Currency toolbar – Use this toolbar to convert transaction amounts displayed within the current record to
a different currency available within the company.

5. Tree View – Another navigation tool, use the Tree View to select specific items contained within each
record. The selected items then display on the program sheets.

6. Sheets – A program is divided into layers, or sheets, of related functionality. Each sheet contains fields that
define a specific item on the current record.

7. Status Bar – The bottom toolbar displays information about the current session; for example, current user,
date, time, current company, and so on. You can choose the information that displays on the Status Bar.
To do this, click the Tools menu and select Options.

Fonts in the Epicor Environment

Using the Control Panel settings in Windows®, you can choose which fonts displays within your programs and
how you install fonts on your computer. The Epicor application is designed to be used with the Normal (100%)
font setting in Windows. If you change your Windows text size to Medium (125%) or Larger (150%), fonts may
not display properly.

Standard Toolbar

The Standard toolbar contains buttons you use to manipulate data on the current record such as save, delete,
copy, and paste. The buttons found on the toolbar change based on the program you are currently using.
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The following table lists the available options:

DescriptionIcon

New - Click this button to create a new record. Some programs require you add additional new
items to the current record. For example, you add sales order lines to a sales order record.

To create these multiple items, some New
buttons also have a drop-down menu. To display
this menu, click the Down Arrow button.

Save - Click this button to save the current record to your database.

Delete - Click this button to remove the current record or record item (for example, a sales order
detail line) from the database.

Change Log - Select this button to display the Change Log. All the changes made to the current
record display within this log.

Memo - Click this button to view any memos written for the current record. If a memo or attachment
is linked to a record, a star appears on the button icon.

Call Log - Click this button to review, add, edit, or delete Call Log records.

Attachments - Click this button to access and view any files attached to the current record.

Refresh - Click this button to reload the data within the current record. Any changes made to the
open records by you or other users display within the fields.

Clear - Click this button to remove all the data from the current program. Any unsaved changes
are discarded and any open records are closed.

Print - Click this button to print the current record.
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DescriptionIcon

Cut - Click this button to cut the current selection (usually text) and move it to the Clipboard to
later paste it elsewhere. This is a standard Windows convention and can also be achieved by pressing
Ctrl + X on your keyboard.

Copy - Click this button to copy the current selection (usually text) and move it to the Clipboard
to later paste it elsewhere. This is a standard Windows convention and can also be achieved by
pressing Ctrl + C on your keyboard.

Paste - Click this button to paste the contents of the Clipboard to where your cursor currently sits.
This is a standard Windows convention and can also be achieved by pressing Ctrl + V on your
keyboard.

Undo - Click this button to remove the last action you performed within the program.
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Navigation Toolbar

Use the Navigation toolbar to find a specific record to display within the program. All the records you created
since entering the program and the records you pulled in from the corresponding Search window are available.

The following table lists the available options:

DescriptionIcon

Search - Click this button to launch the main search window for the current program. Use this
window to find and select all the records you want to review within the active program. In most
search windows, you can select multiple records at the same time. The search functionality is
explored later in this chapter.

First Record - Click this button to display the first record.

Previous Record - Click this button to display the record numerically just ahead of the current
record.

Current Record - This field displays the current record displayed within the program. To see a list
of all the records currently loaded into the program, click the Down Arrow button.

Next Record - Click this button to display the record numerically just after the current record.

Last Record - Click this button to display the final record.

Currency Toolbar

Use the Currency toolbar to quickly convert the transaction amounts displayed within the current record to a
different currency. When you select a different currency, all the amounts within the current record convert to
reflect the current exchange rate and conversion rule assigned the source (original) and target (selected) currency
pair.

Your company can have several currencies available. The currency functionality is explored in more detail within
the Multi-Currency Management chapter in the Epicor ERP Implementation Guide.

To use the Currency toolbar: 

1. Click the Down Arrow on the toolbar.
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2. The list displays the currencies available within the company. Select the currency you need.

The Currency toolbar now displays the selected currency; all the amounts within the current record update to
show the recalculated amounts.

Status Bar

The Status Bar is found at the bottom of each program window. It displays information about the current session
such as current user, date, time, current company, and so on. You can choose the information that displays on
the Status Bar. To do this, click the Tools > Options and select the information you want to display on the Global
Options > Status Bar sheet.

Tree View

The Tree View is a tool you use to navigate through the items that make up a selected, complex record.

The current record automatically displays within the Tree View. When you expand the nodes on the tree by
clicking the + icons, you can quickly locate (or drill down) to a specific item within a record.

In this example, you selected a release from order 5253. When you select this node on the Tree View, the Release
sheet automatically displays with the selected order release information.

Sheets

A sheet is a layer of a program interface that contains related functionality and is the main input and display area
for a program. Sheets may contain grids and other elements. As you create a record, one or more sheets are
used to complete the record.  
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To navigate through all the sheets in a program, you click the tabs for each sheet. You can also display sheets
within the Tree View by clicking on its related node.

Some tabs group together related sheets. In this example, the Lines tab contains all the sheets related to entering
and editing order detail lines.
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Sheets can be torn off and placed anywhere on the desktop.

In the same way that sheets of paper connected with a paper clip can be reorganized, sheets within a program
can be reorganized from their default positions.

To reset the sheets back to their default positions, from the Tools menu, select Reset Layouts to Base.
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Entry Sheets

Each program has one or more Entry sheets that hold data entry elements such as check boxes, combo boxes,
group boxes, radio buttons, and text boxes.

You use these data entry elements to enter the details for a specific aspect of a record. For example, use this
entry sheet to enter the details for an order line.

List Sheets

List sheets display data through a grid format. These sheets are always linked to an Entry sheet – usually a Detail
sheet. If the Detail sheet can be used to enter multiple items, in this example, order detail lines, all of these items
contained within the current record display on the List sheet grid. Some list sheets contain additional information
as well.
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Grids

Grids display information through a series of columns and rows. Each column displays a category of information,
like Part Number, while each row displays data from individual records.

Grids are designed so you can quickly enter data. When you create a new item, like a detail line, you can add
the information directly through the grid. You move through the row’s fields by pressing the Tab key on your
keyboard.

1. In this example, a new row has been added to this grid. You can now use this row to enter a new detail
line on the current order.

2. You can also delete rows on a grid. To do this, highlight the row as shown and then click Delete on the
Standard toolbar.

To learn more about grid functionality, review the Epicor
ICE User Experience and Customization Guide. Information
on modifying grids is also available within application
help.

New Records

You create new records using a consistent set of interface features. Most maintenance and entry programs
contain a New button and a couple New submenus you use to activate fields on sheets and then enter data. You
can also add new records by selecting a sheet and clicking the New button.

The following section explores how you add new records to the Epicor database:
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1. To create a new primary record like a sales order, AR invoice group, chart of accounts, and so on, click New
on the Standard toolbar.

2. For complex records, you create child items like detail lines and invoices. You can add these child items
through different interface features. To create a child item using the Standard toolbar, click the Down
Arrow next to the New button.

3. Select the child item you want from this menu. In this sales order example, you select New Line.
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4. You can also add new records through the File menu. To do this, first click the File menu to display its
options.

5. Highlight the New sub-menu.

6. The list of new options appear on this sub-menu. To create a new record or child item, select its corresponding
option from this menu. In this sales order example, you select New Line.

7. You can also create new child items by selecting specific sheets and clicking the New button. To do this,
navigate to the sheet that contains the child item you need to add. In this sales order example, you navigate
to the Lines > Detail sheet.

8. Now click the New button. The fields on this sheet activate for data entry.

9. Enter the data you need on the record. When you finish, click Save.
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Searches

Search programs are available throughout the application. Use these programs to find and select the specific
records to display within another program. In each search program, you can filter and organize search results
through record specific criteria. You can then select a single record or a group of records.

You launch a search window by clicking a Search button next to a key field. These buttons are found on sheets
throughout the interface. The button label indicates what specific records this search program locates. In this
example, when you click the Sales Order button, the Sales Order Search window displays where you can find
and select specific sales orders.

Here’s how to use the primary features available on each search window:

1. Sort By – Select an option on this drop-down list to organize the search results by a specific field found in
the record. The results display in descending order.

2. Starting At – Enter a character to indicate where in the code master you would like to begin your search.
For example, enter 200 to display all sales orders starting at 200.

3. Additional Filters – Further limit your search results. In this example, you can limit the results by Order
Type (Open or Closed) and Customer record.

4. When you define the filters you want, click the Search button.
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5. The records that match your search criteria display within the Search Results grid.

6. To select specific records from the Search Results grid, highlight its row and click OK.

7. To select all search results, click the Select All button and then click OK.

You can now view the selected record or records within the current program.

You can also set up Named Searches, Quick Searches, BAQ
(Business Activity Query) Searches, Advanced Searches, and
Data Tag searches. To learn more about this search
functionality, review the Epicor ICE Tools User Guide.
Information on customized searches is also available within
application help.

Context Menus

The Open With feature is available on many of the key data fields in the application. A triangle in the upper right
corner of a field indicates this functionality is available. You access this functionality by right-clicking while your
cursor is positioned in one of these key fields. An Open With context menu applicable for that field displays. You
can select any option on the menu such as a search program, entry program, or tracker program.
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1. In this example, the context menu for the Customer field displays.

2. Select Open With from the context menu to launch various programs such as Customer Entry, Create Quote
or Customer Tracker.

3. If BPM Holds is selected, the application looks for a Business Process Management hold against this order.
This functionality places a status on certain records; this status can cause the application to do various
actions, like verify the data within the record or display an informational message.

4. You can also use this program to Cut, Copy, and Paste text within the field.

Business Process Management (BPM) functionality is a
toolset managers and system administrators use to
regulate data entry within the Epicor application. For more
details on BPM functionality, review the Epicor ICE Tools
User Guide. Information on BPM is also available within
application help.

5. Use the Select All command to select all the text within a field.

6. Use the Spelling command to launch the Spelling Checker. Run this tool to verify whether the text in the
current field is spelled correctly.

7. Use the Tag Record command to add personal or public tags to records. The tags are unstructured text
values that provide a way to group otherwise unrelated records so that you or other users can search for
them.

8. If your company utilizes Epicor Social Enterprise (ESE), you can use the Social command to post a message
to the ESE message stream in the context of the program and displayed record.

9. You can launch Quick Searches from within context menus. For more information on this functionality,
review the Searches chapter in the Epicor ICE 3.0 Tools User Guide.
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Trackers

Trackers are query programs you use to drill into the details of your database. Trackers are also a secure way for
users to view system data without updating sensitive information. Whether you are looking for related job
information, quote information, or the status of shipments, receipts, or financial transactions, trackers are the
vehicles you use to access this information in the application.

The application supports three types of trackers - display-only, status dashboards, and executive dashboards. All
types of trackers share similar features, but an individual tracker may not contain all of the features. The ability
to identify each individual tracker as one type versus the other is not important, but you should understand the
basic features and navigation techniques of all the tracker types in order to display information for a specific
business situation.

If you have Dashboard Designer privileges, you can create a
new dashboard that displays specific data you need. To learn
about creating a new dashboard, review the Epicor ICE Tools
User Guide. Information on creating new dashboards is also
available in application help.

Trackers are found in the General Operations folder for each module. Since much of the information available
in these programs also relates to other functional areas within the application, many of the trackers are found
within other modules. All trackers, however, can be found under the Executive Analysis folder in the Trackers,
Status Dashboards, or ShopVision folders.

This section provides you with an overview of the elements and navigation techniques of display-only trackers,
status dashboards, and executive dashboards.

Display-Only Trackers

Display-only trackers primarily show you information found in corresponding maintenance and entry programs.
Examples of display only trackers are Customer Display, Part Display, and the Job Tracker. The main elements of
display-only trackers are detail sheets, grids, and supplemental sheets.

Customer Display

The Customer Display tracker is a display-only version of the Customer Maintenance entry program. You cannot
add or update customer records in this tracker.

Executive Analysis > Trackers > Customer Display
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1. Click the Customer button.

2. The Search Form window displays.

3. Click the Search button to retrieve the customer records.

4. Select a customer from the list.

5. Click OK.

6. Notice the New menu option is not available. You cannot add customer records through this tracker program.
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7. Also notice the sheets and fields are identical to Customer Maintenance, but they display as read-only.

Sales Order Tracker

The Sales Order Tracker contains many elements you also find in Sales Order Entry. The Summary, Header, Lines,
and Releases sheets are identical to their corresponding sheets within the entry program. The only difference is,
like the Customer Display tracker, these sheets, and the fields on the sheets, display as read-only.

This tracker also contains supplemental sheets that provide additional transaction information related to the sales
order currently displayed. For example, you can also review the invoices, miscellaneous shipments, and consolidated
invoices created for the current sales order. These sheets are not available within Sales Order Entry.

Menu Path: Executive Analysis > Trackers > Order Tracker

1. Click the Sales Order button.

2. The Sales Order Search window displays. Define parameters to filter the search results. Notice you can
filter the search results by a Starting At identifier, Order Type, and Customer. You can also sort the results
using different methods.

3. Click the Search button.

4. Select the sales orders that you wish to view. In this example, you click the Select All button. This indicates
you want to pull in all sales orders to the Sales Order Tracker.

5. Click OK.
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6. The first sales order in the list of selected records displays within the tracker. You navigate through the
different sales orders using the Navigation toolbar at the top of the tracker. In this example, you wish to
display sales order 5176.

7. The Summary sheet displays overview information for the selected sales order.

8. Use the Tree View to navigate to a specific sales order release.
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9. When you click the release, the Releases > Detail sheet displays the current information about this specific
release.

10. The Invoices, Miscellaneous Shipments, and Consolidated Invoices sheets are supplemental sheets not
found within Sales Order Entry. These sheets display transactions related to the selected sales order.

Click the Invoices tab to display all the invoices currently created for the selected sales order.

11. When you first display this supplemental sheet, no data displays within the Invoices grid. You need to pull
current invoice data into this sheet. To do this, click the Retrieve button.

12. Invoice data now displays in the Invoices grid. Notice in this example, invoice 10065 was created for sales
order 5176.

Status Dashboards

Status dashboards retrieve records according to a specific status. For example, the Job Status dashboard groups
jobs together by Active, Complete, and Closed status levels. These records display on separate status sheets. The
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Sales Order Status dashboard groups sales orders by Open, Late, and Completed Releases; it also displays related
Shipment statuses.

Opportunity/Quote Status Dashboard

The Opportunity/Quote Status Dashboard shows you selected quotes grouped by different statuses like Open,
Due + 1 Week, Expires, and FollowUp.

Menu Path: Executive Analysis > Status Dashboards > Opportunity / Quote Status

To use this status dashboard:

1. The Advanced Search sheet displays at the top of this tracker. To filter the search results, you can enter
search criteria into any of the specific fields.

2. In this example, you enter a value in the Cust. ID field. You can also add other values to filter the results
even more. For example, you could also enter a Part value to only display quotes for a specific customer and
part.

3. To retrieve records that match the search criteria, click the Refresh button.

4. You can now view the Open quotes retrieved for customer Dalton by navigating to the Open sheet.

5. To review all the quotes which are due, click the Due tab.
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6. The Context Menu options change based on the record and the selected column. In this example, when
you right-click the quote number and select the Open With option from the context menu, you can access
the current quote within different programs, including the Opportunity/Quote Tracker.

7. To change the Advanced Search criteria, enter the filtering values within the available fields on the Advanced
Search sheet.

8. Click the Clear button.

You can now enter new search criteria and refresh the dashboard with new information.

Executive Dashboards

The executive (ShopVision) dashboards display strategic data required for critical short and long term decisions.
The data displays in an enhanced dashboard which contains a dynamic graphing tool you use to sort and group
the data in a grid, pie chart, or bar chart view. If your organization uses the ShopVision module, these powerful
dashboards are available to you.
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In order for these dashboards to display current data, its executive query must be refreshed. This enhanced query
pulls data from two tables and combines, or aggregates, this data for dimensional views. You then review this
data through both grid and chart displays.

During this example, you learn how to display data within the Supplier Performance executive dashboard.

Execute a Process Set

Before you launch the Supplier Performance executive dashboard, you need to populate its executive query with
data. You do this by either scheduling, or immediately executing, a process set. A process set contains one or
more related programs you wish to run in a sequence you define. Each program linked to the process set is
considered a task. When a process set executes, all tasks linked to it are launched in the sequence defined by
the process set; they then generate current data.

When you schedule a process set, the data is updated during a regular schedule you select. You explore how to
assign schedules to process sets in the Automatic Data Processing chapter in the Epicor ERP Implementation
Guide. You can, however, always run, or execute, a process set immediately to gather current data for an executive
dashboard.

Menu Path: System Management > Process Sets > Schedule Process Set

To run a process set:

1. From the Process Set drop-down list, select a process set that populates the executive dashboard. In this
example, zSVSupplierPerf – EPIC06 refreshes the Supplier Performance executive dashboard with current
data.

2. From the Schedule drop-down list, select Now. This indicates you want this process set to run immediately.

3. If you want this process to run on an automatic schedule, you would select a schedule other than Now and
then select the Recurring check box.

4. In the User Description field, enter Supplier Performance Today.

5. Click Submit on the Standard toolbar.

6. Close the Schedule Process Set window.

Populate Supplier Performance

You now launch the Supplier Performance executive dashboard and display the current data.

Menu Path: Executive Analysis > ShopVision > Supplier Performance
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1. To display the data you just gathered through the process set, click the Refresh button.

2. Data displays within the executive dashboard. Each executive dashboard defines its search fields and criteria
as dimensions. Select a different dimension from the available options to display the data you refreshed
through the process set. From the Dimension ID grid, select Buyer.

3. From the Dimension Detail grid, select Brian Howard.

4. The Summary Data grid populates with the current monthly receipts totals for Brian Howard.
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5. Click the Fiscal Year Performance tab; the Summary Data grid displays Brian Howard’s performance year
to year.

6. Notice the chart view also updates to display Brian Howard’s fiscal year performance information.

7. If you need, click the Settings tab to modify the chart used to graphically display this data.

Epicor Everywhere Framework

Epicor Everywhere Framework™ is a unique technology that stores all client business logic as tagged XML metadata.
This permits Epicor applications to run as smart clients, Web clients or mobile device applications, all from the
same source code. This framework also ensures that user customizations and personalizations stay compatible,
whatever the user interface.

Epicor Web Access

Browser-based clients provide a more convenient way to access business information and are easier to deploy.
Epicor Web Access™ displays programs as web forms within a browser window and is a significant part of the
Epicor Everywhere Framework.

These forms are generated from Epicor ERP 10 programs. Because of this, the appearance and functionality of
the Epicor Web Access forms is nearly identical to the Epicor smart client programs, but do not require the
installation of the Epicor client. You can run Epicor Web Access programs on multiple operating systems and on
multiple devices including handheld devices.
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Your system administrator gives users permission to launch the Epicor Everywhere (web-based) interface through
User Account Security Maintenance. The Options sheet contains the Allow Epicor Web Access check box; once
your system administrator selects this check box for your user account, you have rights to log into the web-based
interface. Just like any other web site, you point your web browser to the web address for your Epicor application.
And just like the smart client, you need to enter your user ID and password to view the web forms.

There are two ways of displaying the EWA interface:

• Classic Style

• Enhanced Menu Interface

These are discussed in the following topics.

Classic Menu Interface

The Classic Menu Interface style in Epicor Web Access represents a traditional way of navigating around the
Epicor application.

To navigate within the Classic interface and web forms:

1. The Main Menu tab displays the companies and sites in your organization. Select the company and plant
you need.

2. The Favorites tab displays all shortcuts to programs you want to quickly access. You define these shortcuts.

3. Notice you navigate within the Main Menu folder list the same way as the Classic Style smart client interface.

4. When you launch multiple programs, they appear as separate tabs. In this example, you launch Customer
Maintenance and Sales Order Entry. Select a specific tab to display the program you need. In this example,
you select Order Entry.
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5. If you click the top left button, the pull-down style menu displays. In EWA forms, this button replaces the
toolbar that has all the dropdown menus and all the tool buttons at the top of the smart client form.

While there are two ways of displaying the EWA interface,
navigating through selected forms is identical for both of
them.

6. All of the frequently used buttons display at the top for convenience.

7. All other buttons, including applications-defined buttons are placed at the top of the pull-down menu.

8. The menu items correlate to the menu bar items in the win app. As you click through them, the current
items slide off to the left and new items slide in from the right.

9. Navigating through sheets within a program is performed using the breadcrumb navigation that always
displays the current level of selected program sheets.

10. If a sheet has child sheets, the small arrow at the right of the heading displays as an indicator.

11. If you click the down arrow at the left side of the breadcrumb, a menu drops down that allows you to
navigate through all of the tabs to find the one you want. As you click through the items on the left, the
child items are displayed on the right. If you click a tab that has children on the right, then the left items
slide off, and the new items slide in.

12. When you click an item that is underlined, then the menu closes, and the selected panel is loaded onto the
page.
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13. In this example, you display the Salespersons sheet.

When you use EWA using a touch-screen device, you can
navigate through sheets by dragging your fingers on the
display. This way, you can swipe right or left in the main
body of the panel to move to the next or previous item
in the breadcrumb list. For example, if you are currently
on the Summary panel, swiping from right to left will
open the Header panel. Then if you swipe left to right,
you will be returned to the Summary panel. You can also
swipe up or down to invoke screens based on the context
of the current tab.

For more information on how to navigate within web forms using the available controls and gestures,
review the Web Forms Navigation topics found within the Application Help.

14. To record your information, click the Save button on the Standard toolbar.

15. To exit a program, click the red x on its tab.

Enhanced Menu

The enhanced menu introduced in Epicor 10 smart and web clients is the new way of navigating around the ERP
application. The modern environment is more touchscreen-orientated for use on mobile devices such as tablets,
but can you also use the keyboard and mouse and make use of the environment on a traditional PCs.

To use the primary controls of the new Epicor Web Access environment:
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1. Use the sliding Options Bar at the top to access the Standard menus and the Options Toolbar.

2. Below the Options bar, you can switch between the Main Menu and the Favorites menu.

Use the Main Menu to access all programs available for the current user. The Favorites menu provides access
to the commonly used programs set up in your environment.

3. The Menu interface can be viewed in two ways, the Zoom view and the Tree view. You can switch between
the View modes using the icons on the Options toolbar. The Zoom view is designed for touch screen devices.
It displays the menu for the current Company and Site and it allows the user to focus on one section of the
menu. As the folders are selected on the left, their contents are displayed on the right side. The Tree view
displays the application tree on the left of the screen. You can navigate through companies, modules and
related programs by clicking on branches and nodes.

4. In this example, the menu interface is displayed using the Tree view.

5. The Contents pane displays the contents of the folder selected in the left portion of the screen.

6. You can toggle between the List view and the Tile view using the icon found in the top-right corner of the
Contents pane. The List view displays the contents of the selected folder as the list of small icons. In this
example, the Tile view is used and items display as rectangular tiles.

7. The Context Menu in Epicor Web Access is activated by right-clicking on a menu item. The available options
for the selected item display in the sliding bar at the bottom of the site.

You can use the context menu to perform various actions such as display the selected item in a new window
or add the selected item into the list of Favorite items.

For more information on displaying the Epicor ERP 10 using a web environment, review the Epicor Web
Access topics within the Application Help topics.
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Epicor Mobile Access

The extension of the Epicor Everywhere Framework™ to generate properly sized Web forms for mobile platforms
including Blackberry, iPhone and Android is achieved by leveraging the existing mechanism of Windows form
generation from an Epicor Dashboard.

Since the mobile dashboards that support Epicor Mobile Access (EMA) are built using the dashboard technology
and Updatable BAQ technology, it is simple to create web applications that implement business functionality on
mobile devices. Web browser-based mobile forms can be constructed as a Dashboard and then generated with
form navigational elements for your mobile device of choice.

Epicor Mobile Access makes it much easier to deploy complex functionality to individual users, by delivering
standard business functionality with browser access directly to a mobile device. It provides a framework for easy
navigation and use, so that it's possible to create and deploy very complex entry screens including standard status
queries to any supported mobile browser. EMA is based on the results of BAQs and Dashboards and mobile apps
can feature updatable fields for two way synchronization of information.

The images in this guide depict an iPad simulator. For a
complete list of supported devices, review application help or
contact your Epicor Account Manager.

1. Once you are logged into Epicor’s Mobile menu from your mobile device, you have access to the Mobile
Menu and System menu options. You deploy mobile dashboards to the Mobile Menu directly from the
Dashboard program but you can also define what displays on this menu using the Menu Maintenance
program.

2. The System menu is where you define your configuration and other mobile device settings.
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3. When you select the Mobile Menu, all mobile dashboards display for selection. In this example, you select
the Customer Contact Update dashboard.

4. The primary view in this dashboard displays the list of existing customers.
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5. Once you select a customer from the records presented, you can navigate to another view that presents the
list of customer contacts.

6. Since this dashboard uses the updatable Business Activity Query as its datasource, you can use it to update
database records directly from a mobile device. To update and edit the contacts for this customer, click Edit.

7. To enter a new contact for this customer, click the New button.
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8. You can now enter the new contact information.

9. When finished, click Save to update the changes on the server.

10. Th grid now displays the new contact record you entered.

11. To exit the application, navigate back to the Mobile Menu and select Log Off.
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To learn more about this functionality, review the Epicor ICE Tools User Guide and Epicor Mobiles Access topics
within the application help.

Epicor Smart Client

Epicor takes full advantage of Microsoft’s .NET smart client technology to deliver a rich user experience in a
traditional local client environment. Smart clients deploy easily and offer users a powerful interactive experience
- an experience that takes advantage of local resources to connect intelligently to distributed data sources. The
Epicor smart client delivers the rich functionality that users expect, including tear off sheets, user sizeable screens,
navigation trees, drag and drop attachments, and drill down navigation.

The images in the chapters of this guide depict the Epicor Smart Client.

Epicor University Resources

As with any investment in enterprise software, the documentation and education content is nearly as important
as the application itself. Epicor University offers documentation, education, and other content that delivers
relevant, context driven information directly to stakeholders and end users. This comprehensive set of educational
and documentation resources shorten your return on investment while maximizing your organization’s use of
the Epicor application.

Release Documentation

During your Epicor software installation and implementation, the release documentation is the first set of
documentation you will use. Start Here Cards accompany any physical media, like DVDs, shipped by Epicor. These
cards contain installation instructions and information on how to contact support.

Epicor’s release documentation is located on EPICweb, Epicor’s customer portal. On the Epicor ERP 10
documentation pages in EPICweb, you will find documentation content specific to Epicor ERP 10 such as installation
guides, supplemental install guides, migration guides, and release notes. Installation guides are instructions that
explain how to install a product and can include pre-installation, installation, and post-installation steps.
Supplemental Installations guides provide information on how to install and configure additional programs and
features delivered by Epicor, such as Enterprise Search, Education Module or Epicor Web Access. Migration guides
discuss principles and actions existing customers must follow to upgrade their previous Epicor installations to
Epicor ERP 10. Release notes contain late-breaking information directly related to a specific version and can
include basic installation steps, required configuration, and change lists. The guides are also found on the Epicor
ERP 10 support pages in EPICweb.

Feature Summary

Feature Summaries are high level overviews of all the major, new functionality released with each version of an
application. This deliverable is designed for anyone who needs a review of the enhancements provided with each
version and service pack release.

The Epicor ERP Version 10 Feature Summary is found on the Help menu within the Epicor application. You can
also view the Epicor Feature Summary on EPICweb - Epicor’s customer portal.

To use the Feature Summary:
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1. To access the Feature Summary from the Modern Shell Menu, first click on the Help tile found on the Home
Page.

2. On the Help page, click Feature Summary.

To access the Feature Summary using the Classic Style
interface, from the Help menu, select Feature Summary.

3. The Feature Summary is organized into two parts. The Feature Highlights section contains the features
introduced in Epicor ERP 10. Within the highlights section, features are organized first by module group (for
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example, Sales Management) and then by module (for example, Demand Management). If you are upgrading
the Epicor application, review this section to see the features added with the latest release.

4. The Epicor University Resources section documents the current educational resources available through
Epicor University. Review this section to learn about these resources and where you can locate them.

5. Each feature is concisely described to give you a snapshot of its purpose.

Application Help

You can access the application help in multiple ways. You can launch application help from the Help menu found
on most windows. Likewise, you can launch application help by pressing the F1 key on your keyboard; the topic
linked to the current program or selected sheet displays. Lastly, you can launch application help from within the
Field Help window. The Field Help feature is discussed later.

The main features of Application Help:
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1. The Content pane displays the selected documentation.

2. Notice the Epicor icon next to the program name. This icon indicates you can click the program name to
open the form for this program directly from the content, providing a tight integration between application
help and the application.

3. Click any link within the topic to display more information related to the current topic.
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4. In the Search field, enter the word or phrase you want to search. In this example, an advanced search was
used to search for an exact phrase. For more information on advanced searches, review application help.

5. Click the Search button (magnifying glass) to activate the application help search.

6. Any topics that contain the word or phrase display within the Content pane. Notice that each topic displays
with a brief summary of the content it contains. Topics which contain the most instances of the word or
phrase appear highest in the search results.

7. Click a link within the search results to display that specific topic.
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8. Use the Forward and Backward buttons to move through the help topics you have viewed during the
current session.

9. Click the Print button to print a hard copy of the current help topic.

10. Use the Table of Contents pane to navigate through all the topics within application help.

Annotate Help Topics

You can annotate a help topic so users can review information related to your business workflow. You create
annotations within the Help window. Here’s how:

1. Click Annotations located at the bottom of the Help window.
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2. The Annotations panel displays.

3. Click the Thumbtack button to pin the window in place.

4. Notice you can create two annotations for each topic:

• You can create a User annotation that only displays when you log in with your User ID, so no other users
can view it.

• You can also enter a Company annotation; anyone within your company can view this help topic
annotation. Use this feature to customize a help topic so it contains information specific to your company
or industry.

5. To create an annotation, click the Down Arrow next to the New button. Select either New Annotation
or New Company Annotation. If either annotation already exists, you cannot select its respective option.
In this example, a user annotation already exists for this topic, so this option is not available.

6. Enter the annotation within the field.

7. To record the annotation, click Save.

8. To remove an annotation, highlight it on the grid and click Delete.

9. Click Print to print a hard copy of the current annotation.

Field Help

You can access field help within each program. Both the field description and the data dictionary display for your
information. Field help is designed to display in a dockable sheet.
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All users can view the field level help. These field descriptions are pulled from the application help. If you have
security permissions, you can also view the technical details for a field. You use this level of field help when
customizing windows (forms), writing reports, and creating queries or dashboards.

You activate field help within each program. Here’s how:

1. Navigate and launch the program which contains fields you want to view.

2. From the Help menu, select Field Help.

3. The Field Help window displays.

4. Click the Thumbtack button to pin the window in place. If you do not click this button, the Field Help
window automatically minimizes to the side of the window (form).

5. Select a field on a sheet. In this example, you select the Resource Group field.
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6. The field definition from application help displays in the Field Help window.

7. If you wish to display the Help topic for the current sheet, click the Open Help Browser button.

8. If you have security rights, you can also display the technical details on a specific field. To do this, click the
Technical Details button.

9. The Field Help window now displays the technical details on each selected field such as field name, format,
and data type.

10. Continue to click other fields. When you finish, click Close on the Field Help toolbar.

Technical Reference Guides

Technical reference guides provide users with detailed information on complex functionality in the Epicor
application. The current series of technical reference guides include: EDI and Demand Management, Inventory
Transactions, Job Costing, Material Requirements Planning, Multi-Site, Performance Diagnostic and Troubleshooting,
Performance Tuning, Virtual Environment Tuning, Configurator, Posting Engine, and Scheduling.
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1. The Technical Reference Guides topic contains a complete list of all the guides available within application
help. This topic, found under the Epicor 10 Getting Started > Educational Resources node on the Table
of Contents pane, also has links to each guide.

2. The technical reference guides are found under the Working with section for the applicable module.

3. The guides are fully integrated in the application help, so you can use the Search field to locate specific
topics within these guides.
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4. Each technical reference guide is also available in a separate .pdf file format.

Embedded Courses

Epicor University’s extensive library of educational materials provides you with an excellent platform to develop
an effective training program for your organization. The wide range of resources cover all aspects of the Epicor
application, enabling you to choose the best options to meet your needs and tailor programs to your organization’s
preferences.

Embedded courses use the same interface as application help. You can open the form for a program directly
from the content, and you can use the Search field to locate specific words or phrases.

To use Embedded Courses:
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1. To access the embedded education using Modern Shell Menu, first click on the Help tile found on the
Home Page.

2. On the Help page, click Education Courses.

When using the Classic Style interface, click the
Education Courses button on the Main Menu toolbar.
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3. Within the Education Courses window, use the Tree View to navigate to the course you want to review.

4. The Licensed folder contains all of the courses available to you.

5. The Unlicensed folder contains those courses not currently purchased by your organization. If you wish to
access these courses, contact your Epicor Account Manager.

6. Select the course you need. In this example, you select the Material Requirements Planning course.

7. The Course Name field identifies the course.

8. Review the License Information for details on how long the selected course is available.

9. The Description field displays a description of the course, the target audience, and any prerequisites.

10. If you wish to take the current course, click Launch. The Launch button is only available for licensed courses.
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11. The course displays in the Help Viewer window.

12. Use the Search functionality to locate topics in this course which contain words that match your search
text.

13. Use the Tree View to navigate within the selected course.

14. The course topic you select displays within the Content pane.

15. Each course is also available in a separate .pdf file format. This file is found in the Before You Begin topic.
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16. Notice the Epicor icon next to the program name. This icon indicates you can click the program name to
open the form for this program directly from the content, providing a tight integration between embedded
courses and the application itself.

Epicor may release new or updated courses with service packs or patches. Contact your Epicor Account Manager
for details on education course licensing and the current course catalog.

Annotate Course Topics

You can annotate a course topic so the embedded course contains custom procedures and information related
to your business and industry. Users can also create their own annotations to keep notes on a specific course
topic. You create annotations within the Embedded Course window. Here’s how:
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1. Click Annotations panel located at the bottom of the Embedded Courses window.

2. The Annotations panel displays.

3. Click the Thumbtack button to pin the window in place.

4. Notice you can create two annotations for each topic:

• You can create a User annotation that only displays when you log in with your User ID, so no other users
can view it.

• You can also enter a Company annotation; anyone within your company can view this course topic
annotation. Use this feature to customize a course so it teaches procedures specific to your company or
industry.
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5. To create an annotation, click the Down Arrow next to the New button. Select either New Annotation
or New Company Annotation. If either annotation already exists, you cannot select its respective option.
In this example, a company annotation already exists for this course topic, so this option is not available.

6. Enter the annotation within the field.

7. To record the annotation, click Save.

8. To remove an annotation, highlight it on the grid and click Delete.

9. Click Print to print a hard copy of the current annotation.

User Guides

Epicor University also maintains a series of user guides that provide a complete overview of the major functions
within an application. These user guides contain both screen shots and accompanying text to help you more
easily understand the specific program or function.

Epicor has also developed separate printed user guides on various tools you can use with your application. Contact
your Epicor account manager to order these user guides. These guides are also available as .pdf files from the
EPICWeb site. Some of these .pdf files may also be available within the application help.

• Epicor Application User Guide – This guide illustrates the manufacturing and distribution features available
in your Epicor application. The main features of each module are described along with other unique functions.
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This guide is intended as a starting point; use it to strategize which features you should leverage to match
your business needs.

• Epicor ERP Implementation User Guide – This guide provides you with a thorough description of the
various implementation features you may need – from defining how a company processes records from the
Order Management module to automatically populating reports and trackers with data.

• Epicor ICE User Experience and Customization Guide – This guide provides an in-depth exploration of
the interface tools available within the Epicor ICE framework. This guide begins by exploring startup methods
available within the configuration settings file. It then examines the functionality for styling the look of the
interface and personalizing specific programs. The customization tools are thoroughly documented - basic
customization tools, managing customizations, and modifying user-defined tables. This guide concludes with
chapters on localizing the application and building a customized solution.

• Epicor ICE Tools User Guide – This guide provides a detailed exploration of the data flow tools available
within the Epicor ICE framework. This guide examines business activity queries (BAQs) and how you incorporate
your BAQs for custom use on search programs, BAQ reports, smart client dashboards, executive dashboards,
and mobile device dashboards. The rest of the guide documents the tools you use to regulate, secure, and
distribute data throughout your organization including the Business Activity Manager and Business Process
Management.

• Epicor Service Connect User Guide – This guide provides an in-depth, task-based approach to creating
workflows that can automate processes across one or more enterprise-level applications. The guide begins
by explaining Service Connect concepts and then progresses into detailed descriptions of the various
components such as the Administration Console and Workflow Designer.

• Epicor Advanced Financial Reporting User Guide – This user guide explores the entire Epicor AFR
application. It begins by describing the various environments you need. It then details data replication, a
process that pulls financial data out of your source database and pushes it out to an AFR report server. This
guide concludes by describing how you create the SSRS reports for display through printing or the Report
Viewer.

• Epicor Enterprise Performance Management User Guide – You can use this guide as a starting point to
learn about the complete set of tools and applications that let you plan, execute, and analyze at both strategic
and tactical levels. The content includes Epicor Advanced Financial Reporting, EPM Server (including Cube
Connect), EPM Content Packs, and EPM Performance Canvas.
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Chapter 2: Customer Relationship Management

Customer Relationship Management (CRM) is equipped with the tools you need to find more prospects and quickly
convert them to satisfied customers. As a marketing tool, the CRM module contains functionality to create a marketing
campaign and then track it within the application through events, activities, and ultimately the leads generated from
the event. The responses from a given activity (the piece with which the marketing message is delivered) are entered
into the CRM module as leads. From that point, leads are tracked through the application to the eventual order. The
chapter begins with setup steps to create a marketing campaign - defining the type of marketing activities you wish
to track, identifying the specific advertisements, and including your advertising publications.

Once a lead is found, the CRM functionality helps manage the entire sales process more effectively with features such
as workflow and forecasting. As a sales and management tool, the CRM module assists managers with guiding
employees through the sales quote and order process. When leads are entered into the application, these records are
assigned to the respective sales personnel based on territory and region definition. Tools are provided to define and
adjust the territories, regions, and sales force. Your sales force is guided through a specific sales process through task
lists. The contacts and activities that nurtured the lead into a quoted stage are tracked. The Salesperson Workbench
is a tool your salespeople use to manage the complete prospect-to-customer life cycle. It can also provide an accurate
review of forecasts by tracking the pipeline. A quote can be easily turned into an order using the Push method directly
from within the Salesperson Workbench.

The chapter concludes with an overview of the Case Management module. From initial call to resolution and follow-up,
the Case Management module provides a customer-focused solution for personalized, high-quality service. The Case
Workbench, a comprehensive one-stop solution, enables your service team to manage current case load and respond
quickly to customers for industry leading customer satisfaction.

If your Customer Relationship Management (CRM) license is installed
and functional, the Epicor Application displays an alternate Main
Menu than the one shown without CRM.

With the CRM license, the Sales Management module is referred to as Customer Relationship Management. Additionally,
the functionalities that correspond to the Customer Relationship Management folder are found under the Sales and
Marketing Management folder.

Setup

This section describes the primary records you need to create for the Customer Relationship Management module.
These programs are contained within the Setup folder for this module. Only the primary records are described
here. Some areas within the next Operations section may also document setup records if they are required for a
specific workflow.  

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for this module;
the Configuration topic details the options you define within Company Configuration. You can also review the
Company Configuration chapter in the Epicor ERP Implementation Guide.
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Customers

The Customer Maintenance program is the backbone of CRM. Sales people use this program to track businesses
you hope to sell products and services. Customers are used to create quotes, sales orders, and accounts receivable
invoices.

This section reviews those sheets and fields that pertain to the CRM module. Review the Opportunities and
Quotes chapter for more information about sheets within Customer Maintenance that pertain to quotes and
sales orders.

Menu Path: Sales Management > Customer Relationship Management > Setup > Customer
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Customer

To add a customer:

1. Click the New button on the Standard toolbar.

2. Enter a unique Customer ID.

3. In the Name field, enter the complete name for this customer.

4. Select the customer type from the Type list. The options are:

• Customer – Indicates you have sold products or services to this business.

• Prospect – Indicates your sales team has sent quotes to this business.

• Suspect – Indicates a potential customer that has not yet been contacted by your sales team.
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In this example, you use the default Suspect value. The customer type automatically changes to prospect
once a quote is generated for this customer; likewise, the customer type automatically changes to customer
once a sales order is placed for this customer.

5. In the Customer Address area, add the Address,City,State,Postal Code, and Country.

6. Click the Get Territory button to assign a sales territory to this customer. The application matches the city,
state/province, country, and postal code of the customer address with your defined sales territories. Then
the most applicable territory for this address is assigned and displays in the Territory field. Sales territories
are discussed later in this chapter.

7. Select the Territory Locked check box to indicate this customer always remains in this territory regardless
of any territory restructuring you may do. You can use this feature to ensure the same salesperson remains
assigned to this customer record.

8. The salesperson designated as the primary person for the selected territory defaults in the Salesperson field;
if you need, however, you can change this value.

9. Enter the customer’s Phone,Fax,Email, and Website.

10. Click Save.

Add Ship To Information

Use the Ship To sheets to enter and edit shipping information about the current record.

1. Click the Down Arrow next to the New button; select New Ship To.

2. Enter a unique Ship To ID.
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3. The customer defaults into the ship to Name field; if you need, you can change this value.

4. To indicate this location is the most common shipping address for this customer, select the Primary Ship
To check box. This ship to location becomes the default shipping address for sales orders created for this
customer.

If you generally ship items to the billing address, do not
designate any shipping address as the primary ship to
location.

5. In the Ship To Address area, add the Address,City,State,Postal Code, and Country.

6. Specify the Salesperson who handles this ship to location. The salesperson defined on the Customer >
Detail sheet displays.

7. The Territory Source field indicates how you will select the sales territory for this ship to address. Options
include:

• System Select – If you select this option, the Get Territory button becomes available. When you click
this button, the application matches the city, state/province, country, and postal code of the ship to
address with your defined sales territories.

• Synchronize to Customer – This option assigns the territory defined on the Customer > Detail sheet
to this ship to address.

• Locked – Select this option to manually assign a territory to this ship to location using the
Territory drop-down list.

8. Click Save on the Standard toolbar.

Add Contacts

You can create contacts directly within Customer Maintenance. Contacts play an important role in the application,
as they default into programs (such as Opportunity/Quote Entry and Order Entry) and print on various forms.

To create a contact:
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1. Click the Down Arrow next to the New button; select New Contact.

2. The Contacts > Detail sheet displays. Optionally, select the Person/Contact identifier for this contact
record if one exists. If one does not exist, the application uses the values in the contact information fields
to automatically create a person/contact record.

3. Enter the Name of the contact.

4. From the Role list, select the area of responsibility this contact performs within the customer’s company.

You can create person/contact records within
Person/Contact Maintenance, and then use these
person/contact records on related records as you need.
To learn about this functionality, review the Epicor ERP
Implementation Guide. Role codes are defined in Role
Code Maintenance. For more information about this
program, review the Time Management chapter.
Application help also contains details about both
maintenance programs.

5. Use the Phone/Fax area to add information such as phone numbers for work, cell, and home.

6. When selected, the No Contact check box indicates this contact is not included in marketing lists; marketing
information will not be sent to this customer.

7. If you want name and phone changes made to this contact record to automatically update the linked person
record within Person/Contact Maintenance, select the Sync check boxes that apply.

8. Click Save on the Standard toolbar.

Attach Industry Classes

Industry classification systems are used by government localities to categorize each industry by its type of economic
activity. Classification systems (called types in the Epicor application) are made of industry class codes that further
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divide these types into sectors, such as construction, forestry, and healthcare. Some common industry class types
include The International Standard Industrial Classification of All Economic Activities (ISIC), The North American
Industry Classification System (NAICS), and The Standard Industrial Classification (SIC).

To learn how to create industry class types and industry class
codes, review application help. To learn how to create Business
Activity Queries (BAQs), review the Business Activity Queries
chapter in the Epicor ICE Tools User Guide. To learn how to
create marketing campaigns and marketing lists, review the
next sections within this chapter.

You can attach the industry class types and codes most relevant to each customer record. Then by using a Business
Activity Query (BAQ), you can analyze the data to find out, for example, the industry sectors your new customers
belong or to determine the industry sectors you want your marketing campaigns to target.

To add an industry class type and industry class code to a customer record:

1. Click the Down Arrow next to the New button; select New Industry Class.

2. The Industry Classes > Detail sheet displays. Select the Industry Class Type from the drop-down list.  

3. Click the Industry Class Code button to find and select the industry class code you want to add for the
industry class type you selected.

4. To indicate this industry class code is the primary code for this industry type for this customer, select the
Primary for type check box.

5. Click Save on the Standard toolbar.

Continue to add all the industry class types and industry class codes you need.

Marketing Activity

Use Marketing Activity Type Maintenance to classify the types of marketing events you do.

Menu Path: Sales Management > Customer Relationship Management > Setup > Marketing Activity Type
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Marketing Activity Type

To create a marketing activity:
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1. Click the New button on the Standard toolbar.

2. In the Activity Type field, enter the identifier for the marketing activity.

3. Now enter a Description. This value displays when adding a marketing event.

4. Click Save.

Marketing Advertisement

Use Marketing Advertisement Maintenance to create a list of advertisements, such as slogans, you will associate
with specific marketing events.

Menu Path: Sales Management > Customer Relationship Management > Setup > Marketing Advertisement
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Marketing Advertisement

To create a marketing advertisement:

1. Click the New button on the Standard toolbar.

2. In the Code field, enter the identifier for the marketing advertisement.

3. Now enter a Description. This value displays when adding a marketing event.

4. Click Save.

Marketing Publication

Use Marketing Publication Maintenance to create a list of the publications you leverage in your marketing efforts.
By using these records, you can then track the publications you use within the events of the marketing campaign.

Menu Path: Sales Management > Customer Relationship Management > Setup > Marketing Publication
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The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Marketing Publication

To add a marketing publication:

1. Click the New button on the Standard toolbar.

2. Enter the marketing publication identifier in the Publication field.

3. In the Description field, enter a concise explanation of this marketing publication. This value displays when
adding a marketing event.

4. Click Save.

Marketing Campaign

Use Marketing Campaign Maintenance to track your campaign information such as start and end dates, campaign
budgets and costs, estimated and actual revenue, and related events.

Menu Path: Sales Management > Customer Relationship Management > Setup > Marketing Campaign
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Marketing Campaign

To create a marketing campaign:

1. Click the New button on the Standard toolbar.

2. Enter the marketing campaign identifier in the Campaign field.
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3. In the Description field, enter a concise explanation of this campaign. This value displays on the opportunity
or quote record.

4. Define the Start and End dates for the marketing campaign.

5. Enter the campaign Budget.

6. Enter the Estimated Revenue you expect from the marketing campaign.

7. Once the campaign is complete, update the Total Cost to run the campaign and the Actual Revenue that
resulted from the campaign.

8. Click Save.

Add Marketing Events

A marketing campaign must have at least one or more events.

To add a marketing event:

1. Click the Down Arrow next to the New button; select New Event.

2. The application generates the Event identifier. This value cannot be changed.

3. Optionally, enter the Project ID assigned to this event. Use this feature when the market event is included
in a larger project, and you need to monitor the costs created by the event. To learn more about creating
projects, review the Project Management chapter.

4. Enter the event’s Start and End dates.

5. Select the marketing Activity Type,Advertisement, and Publication assigned to the event. You create
these records in maintenance programs described previously in this chapter.
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6. You can define the Budget and the Estimated Revenue, as well as record the Total Cost and the Actual
Revenue for each event assigned to a campaign.

7. Continue to add events as you need. When you finish, click Save on the Standard toolbar.

Marketing List

Use the Marketing List program to pull together contact information from your customers, prospects, and suspects.
Then, after you have the contacts you need, you can export the list to an external program where you can generate
mailing labels, create direct mailers, and so on.

Menu Path: Sales Management > Customer Relationship Management > Setup > Marketing List
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Marketing List

This program is not available in the Epicor Web Access.

To create a marketing list:

1. Click the New button on the Standard toolbar.  

2. Enter an ID and Description for this marketing list.

3. Click the Campaign/Event button to find and select the marketing event you want to associate with this
list.

4. Now you are ready to add items to your list. On the List Query sheet, click the Query button to find and
select the query from which you want to pull customer records. In this example, you select the Customer
Contact (zCustContacts) query.

5. If you only want suspects and prospects, that is, no customers, brought into the list, select the No
Customers check box.
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6. Click the Pull List button to pull the database contact records into your marketing list.

7. The List Items sheet displays the contacts pulled into the marketing list.

8. Highlight a contact in the Marketing List Items grid.

9. To remove the contact from the list, click Delete.

10. When you finish, click Save.

11. You can export a marketing list you wish to use in an external application, such as Microsoft® Excel®. To
do this, click the Actions menu and select Export.

12. Browse to the location you want to save the file.

13. Use the Options section to create a call or task related to this marketing list.
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14. Click OK to export the file to the specified location.

15. Open the file in Microsoft® Excel® to maintain the information.

Work Force (Sales Team)

The sales team work force is the group of persons involved in the case management or sales management process;
these persons resolve tasks assigned to these processes. You can also associate customers and sales orders with
specific work force people. The work force people you assign to a sales order receive a commission based on the
values you enter in Work Force Maintenance.

Menu Path: Sales Management > Customer Relationship Management > Setup > Work Force
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Work Force

Create a Work Force Person Record

To create a new work force person:
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1. Click the New button on the Standard toolbar.

2. Enter a Work Force ID, a code that uniquely identifies the work force person.

3. Optionally, select the Person/ Contact identifier for this work force record if one exists. If one does not
exist, the application uses the values in the work force information fields to automatically create a
person/contact record.

4. Select an appropriate Role for the person. When tasks are assigned, eligible work force people are determined
by their role code

5. From the Reports To drop-down list, select the person to whom this work force person reports. This list
displays the records in Work Force Maintenance.

If you have an individual who needs to be defined on
multiple records, like a shop employee who is also a work
force member, you can define this person in
Person/Contact Maintenance first and then link this person
record to other records throughout the application. To
learn about this functionality, review the Personnel chapter
within Epicor ERP Implementation Guide.

6. Use the Commissions section to define the default rate the application uses when calculating commissions
for this work force person, and to define when a commission is earned. Options are Invoice and Payment.

7. Use the Sales Manager section to assign the degree of confidence this work force person has to turn a
lead/quote into an order.

8. If you want to allow this work force person to view sales territories or pipeline activity within the Salesperson
Workbench, select the View all Territories or View Company Pipeline check boxes.
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9. Click Save.

Add an Authorized User

You may want to designate another work force person as an authorized user for the current work force person.
Authorized users, such as managers, would then have permission to view, add, and maintain sales-related records,
or to approve phases of the workflow process.

To add an authorized user to a work force record:

1. Click the Down Arrow next to the New button; select New Authorized User.

2. Select an Authorized User from the drop-down list.

3.  Select the Default check box to designate this authorized user as the default value for the work force
record.

4. When finished adding authorized users, click Save on the Standard toolbar.

Sales Region

A sales region is a group of sales territories. Sales regions are used to track and analyze sales statistics for geographic
areas. A region is also a required field when defining sales territories.

Menu Path: Sales Management > Customer Relationship Management > Setup > Sales Region
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Sales Region

To create a new sales region:
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1. Click the New button on the Standard toolbar.

2. Enter a meaningful identifier for the sales region in the Region field. In reports that have limited space, only
the Region ID displays.

3. Enter a concise Description.

4. Select the country where the sales region is located from the Country drop-down list.

5. From the Sales Manager drop-down list, select the sales manager assigned to this region.

6. Click Save.

Task Type

Use Task Type Maintenance to classify tasks by the type of function it serves; for example, call or meeting.

Menu Path: Sales Management > Customer Relationship Management > Setup > Task Type
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Task Type

To set up a task type:

1. Click the New button on the Standard toolbar.
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2. Enter a Code that identifies the task type used during the sales process.

3. In the Description field, enter a concise explanation of the task type. This description displays when
maintaining tasks.

4. Click Save.

Tasks

Tasks are the action items, or milestones, created and assigned to each step in the sales process, from opportunity
or quote to the sales order and follow-up. Tasks are also used to track other activities, such as credit approval or
engineering requirements, not directly related to the sales process.

Menu Path: Sales Management > Customer Relationship Management > Setup > Task
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Task

To create tasks:

1. Click the New button on the Standard toolbar.

2. Enter the task identifier in the Task ID field.

3. The Description displays on opportunities and quotes as well as in Task Set Maintenance. This program is
described in the next section.

4. The Priority code is not required, but can be used to weight the importance of a task. The default is 50;
you can enter a range of 1-99.

5. Select the Task Type that corresponds to this specific task.

6. Select the Role Code associated with this task. Only members assigned this role have access to this task.

7. If users are required to complete this task, select the Mandatory check box.
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8. You can assign multiple persons within a role to a task. If you want the application to mark this task (or
milestone) as complete when any person assigned to the task marks it as complete, select the Any
Approver check box.

9. The application can automatically send a message, or alert, to specific users when this task is created or
finished. To activate this feature, select the Send Alert Complete and Send Alert Create check boxes.

10. When you finish, click Save.

Continue to add all tasks you need.

Task Sets

Defining the sales process workflow you want your work force to follow is a key part of winning business for
your company. You can set up multiple workflow task sets to either guide or control the process within your
sales environment. They can be as simple as a “to do” list of guidelines or as complex as a rigid series of mandatory
tasks that require electronic signatures at key milestones. You decide how to best leverage this powerful workflow
tool.

Once individual tasks are identified, you organize them into a task set. Within the task set, you arrange the
milestones (tasks) into the sequence you want viewed within Opportunity/Quote Entry, assign responsibility,
define the number of days to complete the milestone, and add any related tasks. You can create complex,
branching workflows that can handle the requirements you need.

Menu Path: Sales Management > Customer Relationship Management > Setup > Task Set
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Task Set

Create a Task Set

To create a task set:

1. Click the New button.

2. Enter a Set ID.

3. In the Description field, enter a concise explanation for this task set.

4. Select CRM from the Workflow Type drop-down list. Other types include ECO (Engineering Workflow),
Case Management, and Time & Expense.
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Add Milestones

Now you are ready to add milestones to this task set. A Milestone is a task completed in a specific order (determined
by the task set) and is typically assigned to a specific person.

You can also add related tasks. A Related Task is used to describe details about tasks within tasks. These items
can be used if one task has several distinct steps within it, each of which requires its own details.

To add a milestone:

1. Click the Down Arrow next to the New button; select New Milestone.

2. Accept the default of 10 in the Sequence field. Sequence numbers establish the order in which tasks are
done.

3. From the Task drop-down list, select the first task you want within this task set.

4. The role assigned to this task displays as read-only in the Required Role field.

5. Select the stage in which this task is found within the opportunity/quote process in the Current Stage list.
Options include Lead, Opportunity, and Quote.

6. Optionally enter the number of days this task requires to complete in the Days to Complete field.

7. Select the First Milestone check box to indicate this milestone is the first one in this task set.

8. Use the Win Allowed and Lose Allowed check boxes to indicate whether a win or lose result is available
for this task.

A quote/opportunity can be won or lost when each milestone is marked as complete. As you define
milestones, determine at which steps you could conceivably get the sales order (Win) or lose the sales order
(Lose).

9. Continue adding milestones, and related tasks, to the task set until all the tasks are identified. Click Save
on the Standard toolbar.

Define Next Milestones

Once all milestones are identified, you are ready to establish the order required for milestone completion.
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1. Select a milestone on the Tree View, click the Down Arrow next to the New button, and then select New
Next Milestone.

2. The Milestones > Next Milestones > Detail sheet displays.

3. Select the next milestone that makes up this task set from the Next Milestones list. When the current task
is complete, this task starts. The available options are all the milestones defined in this task set.

4. Click Save on the Standard toolbar. Continue connecting the remaining milestones to each next milestone.

Sales Territories

Use the Sales Territory program to establish territory boundaries and to assign salespeople to a specific territory.
This setup enables your work force to respond quickly to leads and opportunities.

Menu Path: Sales Management > Customer Relationship Management > Setup > Sales Territory
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Sales Territory

To create a new sales territory:

1. Click the New button.
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2. Enter a unique code that identifies the territory in the Territory ID field.

3. Enter a concise Description. This description displays in opportunities, quotes, and orders.

4. Select the sales Region to which this territory belongs. Several territories can belong to one region. For
more information on sales regions, review the Sales Region section earlier in this chapter.

5. Optionally select a Task Set to assign to this sales territory. This field is not required when establishing a
territory; however, the task set defined here defaults into quotes created by salespeople assigned to this
territory.

Define Boundaries

Use the Boundaries sheet to establish or update the boundaries for a territory. Boundary options include country,
state, and province.

To establish territory boundaries:

1. Click the Down Arrow next to the New button; select New Boundary.

2. From the Country drop-downlist, select the country of the boundary.

3. From the State/Province list, select the state or province of the country.

4. Use the Start and End Postal Code fields if your boundaries use these factors.

5. Click Save on the Standard toolbar. Continue adding boundaries to this territory.

Add Salespersons

Use the Salespersons sheet to assign one or more salespersons to a territory.

Here’s how:
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1. Click the Down Arrow next to the New button; select New Salesperson.

2. Select the Salesperson you want to assign to this territory.

3. The role assigned to this salesperson defaults in the Role field; if you need, you can change this value.

4. Click Save on the Standard toolbar. Continue adding salespersons to this territory.

Reassign Salespersons and Realign Sales Territories

You use the salesperson reassignment and sales territory realignment functionality when a salesperson situation
changes. For example, if a salesperson moves to a different territory, you can decide whether the open tasks and
opportunities assigned to this salesperson follows the current salesperson, moves to the new salesperson, or
both.

To reassign a salesperson and to realign sales territories:

1. First, select the salesperson to reassign on the Tree View.

2. On the Salespersons > Detail sheet, click the Reassign button.

3. The Reassign Opportunities/Quotes window displays.

4. Select the New Salesperson to whom you want to reassign the work of the current salesperson. Options
include all salespersons assigned to this territory.
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5. To assign all open opportunities and quotes to the new salesperson, select the Replace Current with
New check box; for example, the current salesperson has left the company.

6. To assign all open opportunities and quotes to the new salesperson and the current salesperson, select the
Add New to Current check box; for example, the current and new salespeople are working together.

7. If you selected the Replace Current with New option, you have the option to assign open tasks to the new
salesperson as well. To do this, select the Reassign Open Tasks check box.

8. Click OK.

9. Now you can update the customer records in the territory with the reassignment changes. To do this, click
the Actions menu and select Adjust Current Territory.

When asked if you are sure, click Yes; click OK when the process is complete.

10. Use the Edit List command to review the changes.

11. Use the Post command to commit the adjusted sales assignments.

Salesperson Quotas

Salesperson quotas may be established by year or fiscal period and can be adjusted as necessary. If quotas are
entered by year, the application divides the total quota amount into 12 equal periods. All entries are visible in
the Salesperson Pipeline.

Menu Path: Sales Management > Customer Relationship Management > Setup > Salesperson Quota
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > Setup >
Salesperson Quota

To define a salesperson quota:

1. Click the New button.

2. The Fiscal Year defaults into the program.
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3. Select the Salesperson for whom you are entering the quota.

4. Enter the quota dollar amount in the Amount field.

5. From the Quota Per list, select either Period or Year.

6. If you select Period, the application calculates each fiscal period’s quota and displays the total amount in
the Total Quota Amount field.

7. Click Save on the Standard toolbar.

8. Use the Fiscal Period Detail sheet to manually adjust the quota for a specific period.

Operations

This section details the operations available through the Customer Relationship Management and Case
Management modules. Each operation is described as a workflow to help guide you through the process from
start to finish. These programs are primarily found within the General Operations folder for these modules. If a
unique setup record is required to run the operation, this record is also described in this section.

Salesperson Workbench

Once the sales process (task set) and the marketing efforts are defined, the salesperson has many tools available
to manage the lead to customer process. The tool that the salespeople use in the sales process is the Salesperson
Workbench.

This tool helps salespeople keep in touch with customers and prospects as well as stay on top of the tasks required
for the opportunities in their territories. The workbench includes all of the information a salesperson needs (for
example, opportunities, orders, and customers) and provides drill down functionality to detailed information for
inquiry and follow-up. This results in quick and thorough response to leads. This feature works regardless of
whether the lead is an existing customer.

The Salesperson Workbench utilizes the dashboard framework.
You can personalize the views on this dashboard to match
your own needs. For example, you can sort columns in
ascending or descending order and switch the order of the
columns in the view. To do this, you must copy the dashboard
for each user who wants to personalize the Salesperson
Workbench. For more information on personalizing and
customizing dashboards, review the Epicor ICE Tools User Guide
and application help.

Menu Path: Sales Management > Customer Relationship Management > General Operations > Salesperson
Workbench

The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > General
Operations > Salesperson Workbench

This program is not available in the Epicor Web Access.

To use this tool:

1. Select the Customer List > Customer List sheet and click the Refresh button to populate the workbench.
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The data that populates depends on the Workforce ID currently logged on and the data the Workforce ID
is Authorized to view.

2. Notice you have access to sheets that hold information on customer contacts, Opportunities/quotes, orders,
jobs, tasks, customer shipments, and so on. You can also filter each sheet of information further. For example,
you can filter the Tasks sheet by open or closed tasks, or by customer.

Create a Quote from the Salesperson Workbench

You can generate an opportunity or quote from within the Salesperson Workbench.

To create an opportunity/quote:

1. Select the Customer List sheet.

2. Click Refresh on the standard toolbar.

3. Select a customer record.

4. Navigate to the By Customer sheet.
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Notice the quotes for the customer you selected on the Customer List sheet display.

5. Click the Add button to create the quote with default information from the customer master file.

6. The Opportunity  /Quote Entry program displays.
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7. Navigate to the Header > Detail sheet to update the marketing definition on the quote.

8. The campaign details that populate the screen default from Company Configuration; however, you can
change these details to reflect a different marketing campaign. Select the marketing Campaign and
Event that generated this quote from the customer.

9. Click Save on the Standard toolbar.

Complete Tasks in Opportunity/Quote Entry 

You can also maintain tasks within Opportunity/Quote Entry. Once you create a quote, the predefined task set
attached to the sales territory populates into the Tasks > Details sheet.

To update a task:

1. In Opportunity/Quote Entry, navigate to the Tasks > Tree sheet.

2. Highlight a task on the Tree View.
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3. On the Tasks > Details sheet, select the Complete check box.

4. The Win/Lose/Next options define the result of the task. If a Win or Lose result is allowed for this task,
you can select either option and then indicate the Reason for the win or loss. If you select Next, you can
define both the Reason and the Next Task.

The application automatically generates a sales order from this task if Win and Create Order are both
selected.

5. Select a Reason code.

6. Optionally, update additional details regarding this task. For example, the person to whom the task was
assigned, the status of the task, and the percent complete.

7. Click the Update button.  
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8. Notice the task icon on the Tasks > Tree sheet now displays a green check mark; this indicates the task is
complete.

Add a Call Log

Use CRM Call Entry to enter information about any calls you have with a customer. You can access this program
either on the Main Menu or within the Salesperson Workbench.

To add a call log:

1. Select a specific customer record on the Salesperson Workbench Customer List sheet.

2. Select the CRM Calls sheet.
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3. Select the By Customer sheet.

4. Click the Add button to add a call log for this customer.

5. The Call Log program displays. Enter a concise Description that identifies this call.

6. Optionally, in the Text field, enter the specific call details.

7. Select the Call Type that applies.

You define call types in the Call Type program. For more
information about this program, review application help.

8. The user currently logged in defaults in the Owner field. If you need, select a different salesperson from
the drop-down list.

9. Notice the Customer selected within the Salesperson Workbench displays; however, you can change this
value.
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10. In the Tree View, notice the call log saves as the date the call is entered.

11. Click Save on the Standard toolbar.

12. Refresh the Salesperson Workbench and notice that the new call is added to the list.

Salesperson Pipeline

Sales managers use the Salesperson Pipeline to review their team’s sales figures, as compared with the quotas,
and to monitor their activities.

Pipeline data, which is calculated based on open, unexpired, quotes with expected close dates, is shown on one
tab. Actual sales numbers, which are based on orders, include to-date totals and are shown on another.

This program is available only to sales team members who have View Company Pipeline privileges. You assign
this privilege to team members in Work Force Maintenance. Pipeline information is filtered by the Work Force
ID. For example, if your sales force is divided into regions, you can allow regional managers to view all salespeople
in their territories, provided the regional managers are authorized users for the salesperson.

Menu Path: Sales Management > Customer Relationship Management > General Operations > Salesperson
Pipeline

The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > General
Operations > Salesperson Pipeline

To use this tool:
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1. The Pipeline sheet displays pipeline information for each salesperson based on a user-defined date range.

2. The Actuals sheet displays quota amounts and actual sales amounts based on user-defined criteria.

3. From the Actual Type drop-down list, select how you want to display the actual values. Options include
by Company, Region, Territory, Sales Manager, or Sales Representative for a given fiscal year and period.

4. After you select the options you want, click the Calculate button.

You can then compare the quotas against actual sales in the bottom section of the window.

The quota values are calculated by prorating the salesperson's quota (or goal) for the month, quarter, and
year based on the current date. The actual values are the salesperson's existing sales for the month, quarter,
and year.
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Contact Tracker

You use the Contact Tracker to review activity for a specific contact. It consolidates transaction information from
multiple programs. Trackers are display-only; you cannot add or edit records in a tracker program.

Menu Path: Sales Management > Customer Relationship Management > General Operations > Contact Tracker
The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > General
Operations > Contact Tracker

To use this tracker:

1. Click Contact to find and select the contact(s) you want to display.

2. In the grid section, use the Contact sheet to review contact details such as the status, contact type, phone
number, ship to mailing address, name details, and attributes.

3. Use the Customer sheet to review customer details such as address, salesperson, quote markup, allocation
priority, territory, and ship to information.

4. On the Transactions sheet, you can review consolidated transaction information related to this contact.
Transaction detail information includes financials, contracts, quotes, orders, RMAs, jobs, shipments, service,
tasks, calls, cases, and warranties.

5. Click the Retrieve button on the Standard toolbar to populate the grid with information from your database.
For example, click the button to display the open invoices for the contact.

6. Click the Refresh button to view the latest information associated with the selected contact.
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Customer Tracker

You use the Customer Tracker to review customer activity within your database. It displays information about
each customer record, including quotes, AR invoices, orders, jobs, and other records linked to this specific
customer. The Customer Tracker can only display one customer at a time. Trackers are display-only; you cannot
add or edit records in a tracker program.

Menu Path: Sales Management > Customer Relationship Management > General Operations > Customer
Tracker

The CRM menu path is: Customer Relationship Management > Sales and Marketing Management > General
Operations > Customer Tracker

To use this tracker:

1. Click Customer to find and select the customer you want to display.

2. Navigate to the Customer > Detail sheet and review the customer information.

3. Use the other available sheets to review the consolidated information for this customer. For example, click
the Financial tab to review financial information, including billing detail, national accounts, invoices,
payments, credit details, and price lists.

4. Click the Refresh button on the Standard toolbar to view the latest information associated with the selected
customer.

Case Management

This section provides an overview of the Case Management module. From the first call to final resolution and
follow-up, the Case Management module provides your organization with personalized, high-quality customer
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service. This comprehensive module enables your service team to manage their current case load and respond
quickly to customer issues.

This module includes a Case Workbench that contains time saving links to customer-focused activities like new
quotes, orders, RMA requests, or service calls. It also contains a workflow you leverage to standardize how you
resolve customer cases. Use this functionality to dispatch field activities and give your field service representatives
access to online knowledge such as existing customer field service calls, warranty information, and service
contracts.

Workflow Stage

Workflow stages define the status of a case at any time within its overall workflow record. You can use that
stage as criteria for searching the case database, as well as display it on various reports. You establish these stages
in Workflow Stage Maintenance for a particular workflow type. Then when you create the case management
task set for your workflow, you assign each milestone task a workflow stage.

Menu Path: Sales Management > Case Management > Setup > Workflow Stage
The CRM menu path is: Customer Relationship Management > Case Management > Setup > Workflow Stage

To create a workflow stage:

1. From the Workflow Type list, select Case Management.

2. Click New on the Standard toolbar.

3. Enter a code that uniquely identifies the workflow stage in the Stage field.

4. Enter a Description that further describes this stage.

5. Click Save.

Now you can define tasks and tasks sets for your case management workflow. For more information, review the
Tasks and Task Sets sections earlier in this chapter.

Workflow Group

You use workflow groups in Case Entry to establish a series of tasks to perform on a specific case, and, if you
want, by specific team members. You both set up workflow groups and assign team members to them in Workflow
Group Maintenance.

Menu Path: Sales Management > Case Management > Setup > Workflow Group
The CRM menu path is: Customer Relationship Management > Case Management > Setup > Workflow Group

To create a new workflow group:
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1. From the Workflow Type list, select Case Management.

2. Click the New button on the Standard toolbar.

3. Enter a code that uniquely identifies the workflow group in the Workflow Group field.

4. Enter a Description that further describes this workflow group.

5. Select the task set that defaults into Case Entry for this workflow group from the Default Task Set list.

6. Click Save.

Add Members

Use the Group Member sheet to add the team members you need to the workflow group and then to reassign
tasks, if necessary.

Here’s how:

1. Click the Down Arrow next to the New button; select New Group Member.

2. Select the work force member to add to the group from the Member list. For information on how to add
a work force member, review the Work Force (Sales Team) section earlier in this chapter.

3. The Role assigned to the work force member defaults; if you need, change the role.

4. If this work force member is the primary person in this group, select the Primary check box.
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5. To reassign a workflow from one workflow group member to another, click the Reassign button. You are
asked to select the member to reassign.

6. When you finish, click Save on the Standard toolbar. Continue to add members to this group.

Topics

You use topics to define the scope of contact with a customer for future analysis. Although not required, topics
are helpful by providing historical information for evaluation purposes as well as assisting the service representatives
in troubleshooting the case. Topic Maintenance supports ten levels of sub-topics for each topic. As a result, you
can further subdivide the scope of contact with a customer.  

Menu Path: Sales Management > Case Management > Setup > Topic
The CRM menu path is: Customer Relationship Management > Case Management > Setup > Topic

Add Parent Topic

To add a top-level topic that can be used as a parent:

1. Click the New button on the Standard toolbar.

2. Enter a code that uniquely identifies the topic in the Topic ID field.

3. Enter a concise Description for this topic.

4. Because this topic is at the top level, with sub-topics beneath it, select the Top Level check box.

5. Select the Case check box.

6. Click Save.

Add Sub-Topic

Add a topic and use the Parent Topics sheet to define parent topics for use in Case Entry.

1. Click the Down Arrow next to the New button and select New Case Topic.
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2. Add a new topic as described in the parent topic example; however, do not select the Top Level check box.

3. When you finish defining the sub-topic, click Save on the Standard toolbar.

4. Now with the sub-topic selected, click the Down Arrow next to the New button and select New Case
Topic Parent.

5. The Parent Topics > Detail sheet displays.

6. From the Parent Topic list, select the top level topic for this sub-topic. Only topics you define as a top level
topic display as options.

7. Enter the sequence number to indicate where this topic should display in the Parent Sequence field.

8. Click Save.

Case Entry

Use Case Entry to create and track customer calls. This program integrates with other related modules, and so
is used to manage and process customer issues. For example, when a customer places a call for a defective part,
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you can create a case to track the issue. Within Case Entry, you can enter a Returned Material Authorization
(RMA) for the returned part, and, at the same time, create a sales order to send out the replacement part. Related
information defaults to other modules as applicable and a reference is listed on the corresponding Links sheet
in Case Entry.

Many fields in the program hold historical information for reports, and this data is only kept for your information.
However, using the system customization tools, you can indicate that additional fields are required based on your
company’s business requirements.

Menu Path: Sales Management > Case Management > General Operations > Case Entry
The CRM menu path is: Customer Relationship Management > Case Management > General Operations >
Case Entry

Enter a Case

You use the Case sheet in Case Entry to enter information about an issue, or case, when a customer contacts
you. Use this sheet to start the process of reconciling the customer issue by leveraging the information you already
have. In this example, you will start a new case and then interface with other modules to resolve the case. If a
case exists, you would use the Selection sheet to select the criteria by which to review a case.

To start a case:

1. Click the New button on the Standard toolbar.

2. On the Case sheet, enter a short description of the case in the field to the right of the case number (this
number is assigned automatically when you save the case in a later step).

3. Select the Case Type from the drop-down list. The options include:

• Case – Use this option to resolve customer issues such as trouble installing hardware or defective parts.
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• CRM – Use a CRM case as an opportunity for a sale. For example, a customer service representative
enters a case for a customer issue involving an outdated part that is no longer supported. The customer
service representative could also enter a CRM case that has the sales team trying to convince the customer
to purchase the latest version.  

• ECO – Typically used as an internal process, the ECO case type can initiate the need for a part review as
it relates to engineering.

In this example, you select Case.

4. To assist the work force members assigned to this case, enter a Full Description of the case.

5. Click the Workflow Group button to find and select the workflow group you want to associate with this
case.

6. The Territory field is available if you select CRM as the case type. You can either select a territory on the
drop-down list, or, once you select the customer on the Contacts sheet, the territory designated for the
customer defaults.

7. The Task Set associated with the workflow group defaults; however, you can change this value. In this
example, the customer will return the defective part, so you select the Material Return task set.

8. The Current Milestone field identifies in which milestone the case is currently, based on the task set defined.

9. On the Contacts sheet, you can view and define the primary people involved in this case.

10. The primary member of the workflow group you selected defaults in the Owner field; if you need, you can
change this value.

11. Click Sold to Customer and then search for and select the customer for which the case is being opened.
Notice the customer’s information defaults are applied. You can define other primary people as needed.

12. When you finish, click Save. The application assigns a case number.

Enter Related Information

Use the Related To sheet to define information related to the case such as the sales order number, part number,
or serial number.

Epicor ERP | 10.0.700118

Epicor ERP Application User Guide - Part OneChapter 2 | Customer Relationship Management



1. Click the Related To tab.

2. In this example, the customer provided the serial number for the defective part. Click Serial Number to
find and retrieve the related sales order based on the serial number.

3. Once you accept the defaults, the information related to this part and serial number display. For example,
the Sales Order and Line/Release information now can be seen.

4. The Part information related to this serial number also displays.

5. When you finish defining the information related to this case, click Save on the Standard toolbar.

Create RMA

Because this customer is returning the part, you need to create a Return Material Authorization (RMA) record.
You can create an RMA directly from Case Entry, and include header and line information as well.

Note: This example illustrates how Case Entry interfaces with
the RMA functionality. For more information on how to create
and process an RMA, review the Customer Returns chapter.

To create an RMA:
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1. On the Actions men, highlight the Create RMA sub-menu and select Create RMA (Header and Line).

2. Because you want to create the RMA line information, you need to select the Reason for the return when
the Create New RMA window displays. In this example, you select Defective Assembly.

3. Click OK.

4. The Return Material Authorization program displays.

5. Information such as customer, sales order, and part numbers default from Case Entry. Also notice this RMA
references the Case Number.

6. If you need, adjust the information. When you finish, click Save on the Standard toolbar and exit Return
Material Authorization.
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7. Notice when you return to Case Entry, the RMA you created displays within the Linked RMA List grid on
the Links > RMAs sheet.

Create Sales Order

This customer wants a replacement part while the original part is in the RMA process. You can send a replacement
part, using Sales Order Entry, directly from Case Entry, and include header and line information as well.

This example illustrates how Case Entry interfaces with the
Order Management module. For more information on how to
create a sales order, review the Sales Order Processing chapter.

To create a sales order:

1. On the Actions menu, highlight the Create Order sub-menu and select Create Order (Header and Line).
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2. The Sales Order Entry program displays.

3. On the Summary sheet, notice customer information defaults from Case Entry.

4. Navigate to the Header > Detail sheet.
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5. Enter the Need By and Ship By dates.

6. Notice this sales order references the Case Number.

7. If you need, adjust the information. When you finish, click Save on the Standard toolbar.

An informational window displays. This message tells you the Need By Date and the Ship By Date fields have
changed and asks if you want to refresh the lines and releases with the changes. Click Yes.

8. Exit Sales Order Entry. Notice when you return to Case Entry, the sales order created displays within the
Linked Order List grid on the Links > Orders sheet.

Create Job

Because this replacement part is a make-to-order (non-stock) part, you next will create a job. You can create a
job directly from Case Entry.

This example illustrates how Case Entry interfaces with the Job
Management module. For more information on how to create
a job, review the Job Management chapter.

To do this:

1. On the Actions menu, select Create Job.
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2. The Job Entry program displays.

3. Notice the Part information defaults from Case Entry.

4. Define the job information. Enter the Required By date.

5. Click the Down Arrow next to the New button, and choose the New Demand Link sub-menu, and then
Make To Order.
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6. Click the Order/Line/Rel button to find and select the order created for this replacement part.

7. Select the Released check box to both engineer and release this job.

8. Now you are ready to schedule this job. From the Actions menu, highlight the Schedule sub-menu, and
then select Job Scheduling.

9. The Schedule Job window displays.

10. Click OK to accept the default scheduling information.
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11. Notice when you return to Case Entry, the job created displays within the Linked Job List grid on the Links
> Jobs sheet.

Update Call Log

Use the Call Log program to keep track of the communication about the case between your support staff and
the customer.

To do this:

1. On the Actions menu, select Call Log.
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2. The Call Log window displays.

3. Click the New button on the Standard toolbar and choose New Call.

4. Enter a concise Description that identifies this call.

5. In the Text field, enter the specific call details.

6. Select the Call Type that applies.

You define call types in the Call Type Maintenance
program. For more information about this program, review
application help.

7. The user currently logged in displays in the Owner field; however, you can change this value.

8. Notice in the Tree View, the call log records the date the call is entered.

9. Click Save.
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10. Notice the Call Log button within Case Entry changes to indicate a call log exists. You can click this button
to access all calls for this case.

Complete Tasks

You use the Task Maintenance sheet within Call Entry to update task details such as the status, the person to
whom the task is assigned, the customer in question, and any applicable vendor information.

To complete a task:

1. Navigate to the Task > Task Tree sheet.

2. On the Task Tree, highlight the task you want to update.
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3. Navigate to the Task > Task Maintenance sheet.

4. Select the Complete check box.

5. From the Reason list, select the reason this call is complete. Only codes that have a Case Management
reason type are available.

You set up reason codes in Reason Code Maintenance.
Review application help for more information on reason
codes and reason types.

6. Use the General, Customer, Supplier, and Comments sheets to enter additional task details.

7. Click the Update button.
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8. Notice the task icon on the Task Tree sheet now displays a green check mark. This indicates the task is
complete.

Add Topics

Next, you want to assign topics to this case for analysis and reporting purposes. Available topics are defined in
the Topic Maintenance program. For more information, review the Topics section earlier in this chapter.

To add topics:

1. Navigate to the Topics sheet.

2. Select the topic you want to assign to this case from the Topic 1 list.

3. To assign a subset of topic 1 to this case, select this topic from the Topic 2 list.

4. Continue to select subset topics for the previous topic. The topic ID, the Topic String populates as you
assign topics of varying depth.

5. When you finish, click Save on the Standard toolbar.
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Add a Resolution

The Resolution sheet holds information about how the case was resolved. You can also decide whether to publish
this information as a selection criterion for searching cases or to make this information available for inquiry in
the Knowledge Base. The Knowledge Base Inquiry is discussed next.

To add a resolution:

1. Navigate to the Resolution sheet.

2. If you want to make this resolution available for inquiry in the Knowledge Base, select the Knowledge
Database Entry check box.

3. The Resolution Text field holds information about how the case was resolved.

4. Select the Published Item check box if the resolution for this case is available to the public and as a selection
criterion when searching for cases.

5. Now enter a brief description about how the case was resolved in the Published Summary field.

6. Use the Published Text field to describe how the case was resolved.

7. Optionally, click the Copy Resolution button to copy the text in the Resolution Text field to the Published
Text field. Be sure to review and update the text in the Published Text field so it only contains text you want
the public to see.

8. When you finish, click Save on the Standard toolbar.
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Close a Case

Use the Case > Close Case option from the Actions menu to close an open case. The Status field indicator on
the Case sheet displays the current status of the case. Once the case is closed, the case details cannot be changed.

You cannot close a case if it has an active milestone task.

To close a case:

1. Navigate to the Case sheet.

2. Verify the Status field indicator is green and displays Open.

3. From the Actions menu, select Case > Close Case.

4. Verify the Status field indicator is red and displays Closed.

5. Click Save.
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Reopen a Case

Use the Case > Reopen Case option from the Actions menu to reopen a closed case. The Status field indicator
on the Case sheet plays the current status of the case. The Reopen Case option allows you to change the details
of the closed case.

To reopen a case:

1. Navigate to the Case sheet.

2. Verify the Status field indicator is red and displays Closed.

3. From the Actions menu, select Case > Reopen Case.

4. Verify the Status field indicator is green and displays Open.

5. Click Save.
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Knowledge Base Inquiry

Use the Knowledge Base Inquiry to search for keywords found in the issue/published/resolution text, to search
for case topics, or both.

Menu Path: Sales Management > Case Management > General Operations > Knowledge Base Inquiry
The CRM menu path is: Customer Relationship Management > Case Management > General Operations >
Knowledge Base Inquiry

To launch a search in the Knowledge Base:

1. On the Selection sheet, use the Text Keywords field to enter the keywords for which you want to search.
The search functionality supports wildcards to pull in a range of results.

2. You can choose to search for these text keywords within the Issue text, Published text, or Resolution text.

3. Use the Case Topics area to define topics to search.

4. Click the Search button.
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5. Search results display on the List sheet.

6. With a case selected, use the Issue sheet to view the case short and full descriptions.

7. Use the Resolution sheet to view the resolution text, and, if any, the published text.
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Chapter 3: Opportunities and Quotes

Use the Quote Management module to enter and maintain leads, opportunities, or quotes in the application. A quote
is a document used to track price quotations for manufactured parts. These documents are sent to the customer or
prospect, and retained for follow-up. Existing quote information can be transferred to a sales order or job in several
ways. The quote can be converted (pushed) into a sales order, or pulled (in its entirety or line by line) through Order
Entry into the sales order. When the Customer Relationship Management (CRM) module is enabled, a quote can be
marked as won, which automatically generates an order.

Quotes can range from a quick simple entry of a make-to-stock item, to a custom make-to-order item with markup
pricing. Each quote consists of heading information, and one or more line items that contain the parts and quantities
to be quoted. Manufacturing details can be entered for each line and used to calculate the estimated material,
subcontract, labor, and burden costs required to make the part. Miscellaneous costs and commission expenses can
also be entered.

Whether you ship from inventory, manufacture to order, or engineer to order, the quoting module can easily provide
accurate pricing and estimating for all your customer’s requests.

If your Customer Relationship Management (CRM) license is installed
and functional, the Epicor application displays an alternate Main
Menu than the one shown without CRM. The Sales Management
module is referred to as Customer Relationship Management.
Additionally, the functionalities that correspond to the Customer
Relationship Management folder are found under the Sales and
Marketing Management folder.

Setup

This section describes one of the primary records you need to create for the Quote Management module. This
program is contained within the Setup folder for this module.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for this module;
the Configuration topic details the options you define within Company Configuration. You can also review the
Company Configuration chapter in the Epicor ERP Implementation Guide.

Customers

Customer records are primarily used to create quotes, sales orders, and AR invoices. Customers are entered and
maintained in the Customer Maintenance program.

Menu Path: Sales Management > Quote Management > Setup > Customer
The CRM menu path is: Customer Relationship Management > Quote Management > Setup > Customer

Many attributes are on a customer record; however, this section only reviews basic customer information as it
pertains to opportunities and quotes.

To add a customer:
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1. Click the New button on the Standard toolbar.  

2. Enter a Customer ID.

3. Enter the Customer Name.

4. Select the customer type from the Type list. Available options:

• Customer - Indicates you have sold products or services to this business.

• Prospect – Indicates your sales team has sent quotes to this business.

• Suspect – Indicates a potential customer that has not yet been contacted by your sales team.

In this example, you select Customer. The customer type automatically changes to prospect once a quote
is generated for this customer; likewise, the customer type automatically changes to customer once a sales
order is placed for this customer.

5. Optionally, select the Exclude from address validation check box to indicate this customer address is not
validated using Epicor Tax Connect functionality.

To learn more about Epicor tax methods, review the
Customers and Accounts Receivable chapter.

6. Enter the Customer Address in the appropriate fields including Address, City, State, Postal Code, and
Country.

7. Verify the Valid Payer, Valid Sold To, and Valid Ship To check boxes are selected by default. If this
customer uses National Account relationships, these fields verify the customer can pay cash receipts, process
invoices, and create shipments with other customers in the national account hierarchy.
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8. Select the Allow One Time Ship To check box if this customer can process invoices on a one-time basis
using the One Time Ship To functionality within Sales Order Entry. Select the Allow Ship To Third Party if
this customer can process shipments to third-party customers.

9. If you want, select a Quote Markup option from the drop-down list. This record defines the material, labor,
burden, and other percentages by which you want to increase the total cost of a quote for this customer.
For more information on quote markups, review the Markup Maintenance topic within application help.

10. Optionally, select the default language that prints on the report documents from the Language drop-down
list. By default, all part descriptions that use this language also print on these reports.

11. Enter the Phone, Fax, Email, and  Website.

12. Click Save.

Add Billing Information

The Billing > Detail sheet contains customers’ payment terms and shipping terms as well as accounting and tax
codes.

To add billing information:

1. Select the Billing > Detail sheet.

2. Select a Terms code.

3. Select a Ship Via.
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4. Click Save on the Standard toolbar.

For more information about the fields on the Billing sheet,
review the Customers and Accounts Receivable chapter.

Add Ship To Information

Customers may have multiple shipping locations associated with a single sold-to address. You enter shipping
locations on the Ship To > Detail sheet.

To define a ship to address:

1. Click the Down Arrow next to the New button; select New Ship To.

2. Enter the Ship To ID and Name.

3. Enter the ship to information, including the Address, City, State, Postal Code, and Country.

4. Optionally, select the Exclude from address validation check box to indicate this ship to address is not
validated using Epicor Tax Connect functionality.

To learn more about Epicor tax methods, review the
Customers and Accounts Receivable chapter.

5. Click Save on the Standard toolbar.
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Add Contacts

You can create contacts directly within Customer Maintenance. Contacts play an important role in the application,
as they default into programs (such as Opportunity/Quote Entry and Order Entry) and print on various forms.

To create a contact:

1. Click the Down Arrow next to the New button; select New Contact.

The Contacts > Detail sheet displays.

2. Optionally, select the Person/Contact identifier for this contact record if one exists. If one does not exist,
the application uses the values in the contact information fields to automatically create a person/contact
record.  

3. Enter the Name of the contact.

You can create person/contact records within
Person/Contact Maintenance, and then use these
person/contact records on related records as you need.
To learn about this functionality, review the Epicor ERP
Implementation User Guide. Role codes are defined in
Role Code Maintenance. For more information about this
program, review the Time Management chapter. The
application help also contains details about both
maintenance programs.

4. From the Role list, select the area of responsibility this contact performs within the customer’s company.

5. Use the Phone / Fax area to add information such as phone numbers for work, cell, and home.
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6. If you want name and phone changes made to this contact record to automatically update the linked person
record within Person/Contact Maintenance, select the Sync check boxes that apply.

7. Click Save on the Standard toolbar.

Operations

This section details the operations available through the Quote Management module. Each operation is described
as a workflow to help guide you through the process from start to finish. These programs are primarily found
within the General Operations folder for this module. If a unique setup record is required to run the operation,
this record is also described in this section.

Opportunity/Quote Entry

A quote is often the starting point for the supply chain cycle. Entering a quote can result in greater efficiency, as
you can define manufacturing details that give job management, scheduling, purchasing, and other production
areas a head start on satisfying upcoming requirements.

Menu Path: Sales Management > Quote Management > General Operations > Opportunity / Quote
The CRM menu path is: Customer Relationship Management > Quote Management > General Operations >
Opportunity / Quote

To add a new quote:

1. Click the New button on the Standard toolbar.
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2. Enter the Customer ID. The Sold To is the customer location purchasing the goods and services. This text
is the main address you enter on the Customer > Detail sheet within Customer Maintenance.

3. If a different customer pays for the goods and/or services, (such as a leasing company or a lend office) select
this customer from the Bill To Customer drop-down list.

4. In the Ship To section, enter or find and select the customer location that receives the goods and services.
Each customer record can have multiple ship to locations.

5. Or, you can select the One Time check box if the customer allows one-time shipping locations to be
identified. Click the One Time Ship To tab to enter the one-time shipping contact and address information.

6. Click Save.

7. The Terms and Ship Via fields default in from the customer’s Ship To record.

8. Click the Down Arrow next to the New button; select New Line.

9. Enter the Part number for the first quote line.

10. Right-click the Part field and select Open With… to display a context menu of options to assist you with
part entry.  
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11. Tab through the line item fields and enter the Expected Quantity.

12. Click Save.

13. When you save the entry, the Gross Value and Potential fields are populated.

You can also add a line to a quote for a make-to-order item. If the part has been manufactured before, the part
number is entered on the line and the Method of Manufacturing is pulled into the quote. The method can be
pulled in from another quote or job, or be built from scratch while you enter a quote.

Method of manufacturing, or method, is the information
required to build a part. It includes all the necessary purchased
and manufactured parts, as well as the steps required to build
the final product. The list of materials is known as the bill of
materials, and the list of operations is known as the routing
or bill of operations. For more information on methods, review
the Engineering chapter.
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Add a Line with Manufacturing Details

1. Select the Line > Detail sheet, and click the New button.

2. Enter the Part number for which you would like to quote. Click the Part/Rev button to search for and select
an existing part number.

3. If the Co-Parts check box is selected, the selected part has at least one co-part associated with it. A co-part
is an additional part manufactured with the selected part. For more information on co-parts, review the
next section in this chapter.

4. In the Concurrency field, select either Concurrent or Sequential. The selected value determines quantity
reporting and costing.

• If sequential, the quantity requirements of the co-parts are factored in the total cost of the revision and
then split according to the labor/material cost split set up in the co-part.

• If concurrent, only the quantity requirement of the main part is considered and then divided by yield
to determine the total cost of the revision. Then, labor and material cost factors are used to split the
costs.

5. If alternate parts have been defined for the quoted part in Part Maintenance on the Parts > Alternates sheet,
a series of buttons become available next to the Part/Rev field. Use these buttons to access the Alternate
Part Search window where you can select an alternate part, if any. Alternate parts can be comparable,
upgrades, downgrades, or complements. For more information on alternate parts, refer to the topic
within application help.

6. Enter the Order Quantity (used as the quantity if the quote is converted to an order). You also want to
enter the Expected Quantity (used as the quantity on pipeline calculations).
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7. From the Actions menu, select Quote Line > Mfg Details > Get Details.

8. The Get Details window displays.

9. Select the Revision of the part from which you wish to pull in the details.

10. Click OK.
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11. You can review and modify the part method on the Line > Mfg Details > Tree sheet. To expand the tree,
right-click the quote and select Tree > Expand Tree.

12. If any lines on the quote contain manufacturing details, the lines must be selected as Engineered on the
Line > Detail sheet.
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Add Co-Parts

Often when you produce one part another part is produced as a by-product, or two parts are produced similarly
except for one minor operation. Use co-parts to define a method of manufacturing that produces multiple parts
(co-parts) on a single job. An example of a co-part is a left and right bracket (with different part numbers) where
the only functional difference in the two parts is the bend operation or the placement of the drilled holes.

Co-parts functionality is available only if you have the Advanced
Production module installed. For more examples of co-parts,
review the Engineering chapter.

Use the Line > Co-Parts sheet to define a method for a co-part on a quote line. The appropriate method is then
created if the quote line is eventually turned into an order and then a job.

To add a co-part for the identified primary part:

1. Click the Down Arrow next to the New button; select New Co-Part.

2. Click the Part/Rev button to search for and select the part number and revision for the co-part you wish
to add.

3. Use the Yield Per field to define how many of the specified co-part will be made when one quantity of the
primary part is manufactured.

4. If you need, you can further define the costs by entering values in the Material Cost Factor and Labor
Cost Factor fields.  For example, increase a part’s Material Cost Factor if the part uses more material than
the primary part.

5. Select the Prevent Suggestions check box to stop Material Requirements Planning (MRP) from creating
job suggestions for the co-part when the quote is turned into an order and then a job. Refer to the Material
Requirements Planning Technical Reference Guide for more information on the Prevent Suggestions modifier;
this guide is located in the Material Requirements Planning > Working with Material Requirements Planning
section in the application help.

147Epicor ERP | 10.0.700

Opportunities and Quotes | Chapter 3Epicor ERP Application User Guide - Part One



6. Use the Line > Co Parts > List sheet to review the co-parts.

Use the Quote Worksheet

Use the Quote Worksheet to review calculated costs for each quote line. Calculated costs are based on the
production details, if you pulled manufacturing details into the quote line, and markup rates. The cost fields
display the rolled up costs for the selected method of manufacture.

To review calculated costs:

1. From the Tree View, select the line for which you want to review costs and then click the Worksheet tab.

2. In the Calculations Based Upon section, select either Markup to base markups on a monetary amount
or Profit to base markups on profit percentages.

3. The Markup/Profits defaults from the customer record; if you need, you can change this.
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4. Review the calculations, including the Quoted Markup, Quoted Profit, and Total Quoted Price.

5. If you modify the Quoted Unit Price, the calculations update.

6. Click Save on the Standard toolbar.

7. When the quote is saved, the quote line updates with the new price, including the Doc Unit Price. This is
the unit price in the customer’s currency.

Print a Quote

To print the quote within Opportunity/Quote Entry:

1. Select the Quoted check box on the Summary sheet.

The Quoted status verifies that all quotes have a Quoted Date before they are printed. Selecting the Quoted
status defaults the Quoted Date to the current day and you can immediately print the quote. This status
also helps you keep track of where your quotes are at within your process.
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2. Click the Actions menu and select Print Form.

The quote form can now be sent to the customer or retained for internal records if necessary.

Create a Sales Order from a Quote

You can generate a sales order from information entered on a quote in several ways. Quote information can be
converted (or pushed) into a sales order in its entirety or by selecting specific lines.

To create a sales order from a quote:
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1. From the Actions menu, select Quote > Create Sales Order.

2. The Quote Order Wizard window displays.

3. Enter the Ship By date.  

4. Enter the PO Number for the sales order.

5. Select the Order Worthy check box for each line to add to the sales order.

Optionally, launch the Order Job Wizard to schedule, and release the job to manufacturing.

For more information on the Order Job Wizard, review
the Sales Order Processing chapter.
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6. Click the Create button to generate the sales order.

7. A message displays with the order number created. Click OK.
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Chapter 4: Demand Management

Use the Demand Management module to more efficiently manage short and long term customer demand contracts,
and then convert demand from these contracts into sales orders and MRP forecasts. Demand Management handles
the creation, analysis, editing, and reconciliation of cumulative records for releases from your trading partners. If you
use Electronic Data Interchange (EDI), the functionality generates electronic information that passes both to and from
your customer trading partners.

Using sheets in Customer Maintenance, you associate a trading partner identification number with each customer,
and also define rules that designate how inbound and outbound EDI demand transactions are processed. When you
enter into a formal demand agreement with your customer trading partner, you then enter the details of the contractual
agreement into Demand Contract Entry.

As you receive specific demand schedules for the demand contract from your customer, you enter the transactional
details in Demand Entry. You can use Demand Entry or Demand Mass Review to manually review the demand lines
and shipping schedule, evaluating their impact. These programs both contain tools you use to manually reject and
select the schedules for transactional processing; you can view the impact of incoming contract changes before you
accept them. You can also accept, revise, or reject these changes as you need. When you are satisfied with the schedule,
you can then process the demand, automatically converting it into firm order releases, unfirm releases, or MRP forecasts.

If you use EDI, you can optionally generate this demand schedule detail automatically when receiving inbound EDI
transactions, after the data is imported using the Import EDI Demand Process. When you receive inbound EDI demand
transactions, the processes run the same tasks you would perform manually using Demand Entry or Demand Mass
Review. You can then efficiently process and manage the large volumes of data that result through use of long term
demand contracts.

Direct EDI import is managed using the Import EDI Demand Process. It imports inbound text-based tilde-delimited EDI
transaction files (received from your customer trading partners) passed by the TIE KINETIX eVision application and
deposited into an import folder. File importation occurs based on a processing schedule you designate in the Import
EDI Demand Process. If erroneous data is identified during direct EDI import processing, you can correct it as required
using the Demand Workbench.

Setup

This section describes the primary records you need for the Demand Management module. These programs are
contained within the Setup folder; only the primary records are described here. Some areas within the next
Operations section may also document setup records if they are required for a specific workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review the application help for this
module; the Configuration topic details the options you define within Company Configuration. You can also
review the Company Configuration chapter in the Epicor ERP Implementation Guide.

Customer Periodicity

Use Customer Periodicity Maintenance to define valid periodicity rules (if any) for a specific customer trading
partner or ship to customer location. Periodicity rules define the regular intervals at which deliveries to the
customer or ship to location take place (daily, specific day of the week, weekly, or monthly). The demand
functionality uses these values to calculate the Ship By or Need By dates for shipping schedules required for each
order release or forecast you generate from manual demand entries or from inbound EDI files. Once you create
periodicity codes, you assign them to specific customer trading partners in the Customer > Demand or Ship To
> Demand sheets in Customer Maintenance.
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For a detailed explanation about the setup and use of the
EDI-Demand Management interface, refer to the EDI/Demand
Management Technical Reference Guide. This guide is found
within application help.

Menu Path: Sales Management > Demand Management > Setup > Customer Periodicity

1. Click New on the Standard toolbar.

2. Use the Daily Rules check box to set up daily periodicity. This designates that all shipments for the customer
occur every weekday (Monday through Friday).

3. If deliveries are also required to this customer on Saturdays and Sundays, select the Include Saturdays and
Sundays Shipments check box.

4. Use the Monthly Forward Rules check box to set up Monthly Forward periodicity. This indicates all
shipments for this (ship to) customer are only sent once per month.

5. You can then use the First Ship Day drop-down list to select the day of the week on which shipments to
this customer must arrive.

6. To further define this shipment interval, you can use the Week Number in the Month field to indicate the
week during the month (1-5) on which shipments to this customer need to be sent.

7. Use the Weekly Forward Rules check box to set up Weekly Forward periodicity. This designates that all
shipments for this (ship to) customer are sent weekly.

8. When you select the Weekly Forward Rules check box, you can then use the Ship Day drop-down list to
optionally specify the day of the week on which shipments must arrive to this customer.

9. Use the Nth Day of the Week Rules check box to indicate all shipments for this (ship to) customer can
only arrive on a specific work day.

10. You can now use the Day of the Week Shipment drop-down list to select the specific day of the week
(Monday-Sunday) on which shipments must arrive to this customer.

11. When you finish, click Save.
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Customers

Use the Customer > Demand, Ship To > Demand, Documents, and Ship To > Documents sheets to assign trading
partner identification numbers and to define parameters that designate how the Demand Management module
should function for specific customers. It defines how demand transactions are processed in the module.

The Ship To > Demand sheet operates in the same way as the
Customer > Demand sheet, but also allows you to override
demand processing parameters for specific customer ship to
locations.

Menu Path: Sales Management > Demand Management > Setup > Customer

Demand Processing Parameters

Use the Customer > Demand and Ship To > Demand sheets to assign a trading partner identification number
and define demand processing parameters for a specific customer or ship to customer location. This includes
specifying the lead times required to evaluate and process certain types of action requests on incoming EDI
shipping schedules. For each request, you specify the actions that will take place in the Epicor application when
incoming EDI transactions are received or when manually entered demand transactions are processed.

1. Click the Customer button on the Customer > Detail sheet to find and select a customer.
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2. Navigate to the Customer > Demand sheet.

3. Enter the Trading Partner identifier for this customer. This value is a universal code required on EDI
transactions; it uniquely identifies the business entity involved in the transaction.

4. Enter the Delivery Days required to ship a part quantity from your manufacturing center to this customer
trading partner. The Epicor application uses this date interval as a buffer when calculating Ship By or Need
By dates. To calculate the Ship By Date on each order release, the Epicor application subtracts the value you
specify in this field from the customer’s required Need By date. Conversely, it calculates Need By dates in
the opposite manner. The Date Type field selection determines which date is calculated by the Epicor
application.

5. Select the Periodicity interval for this customer trading partner. This designates how often this customer
trading partner wishes to receive shipments from you. Review the previous Customer Periodicity section for
more information.

6. Select a Date Type option; this value defines the date calculation method (Ship By or Need By) used by the
Epicor application. If you select Ship By, it calculates the Ship By date based on the Need By date supplied
by the customer trading partner. If you select Need By, it calculates the Need By date based on the Ship By
date supplied by the customer trading partner.  

7. Indicate the Pricing option for this customer record. Use this value to define if internal or customer pricing
(as received on purchase orders received from this customer) is used for pricing of sales orders generated
from demand transactions. This value is the default for this customer within Demand Contract Entry.

8. Optionally, select the Unit Price Difference check box to indicate the Epicor application will evaluate the
difference between the Internal price calculated by the Epicor application (using price lists and the master
part), and the Customer price received on the customer purchase order. Use the Unit Price Difference
check box, the Tolerance field, and the Action drop-down list to define how this validation runs.
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9. Now select the Action that occurs when the Unit Price validation fails:

• If you select Stop, the demand line is designated as System Rejected within Demand Entry, and the
demand is not processed. You can override this value within Demand Entry if needed.

• If you select Warning, the demand line is automatically accepted and processed. Warning messages
appear on various logs and reports explaining the incoming demand transaction failed the data validation.

10. Use the Part section to specify if the Epicor application should validate whether corresponding part records
or revisions exist in your database for demand received from this customer trading partner. If you select
either the Check For Part or Check For Revision Level check boxes, you then use the Action drop-down
list to select the appropriate Stop or Warning action.

11. Activate the Sales Order Releases section to designate how demand entries are processed when matched
to a sales order release with partial shipments. Select the appropriate Action to apply.

12. Use the Cumulative section to indicate if cumulative quantity checking should occur. When you process
the demand and ship releases to the customer trading partner, the cumulative information is sent through
an Advanced Shipping Notice (ASN) document. The customer then uses this EDI document to indicate the
actual amounts they have received, and returns this information back as the actual received quantity. You
can then analyze differences between the cumulative quantities stored in your database and the cumulative
quantities in the inbound demand EDI transactions. This functionality is commonly used in EDI environments
to track what your customer has acknowledged as shipped, and what your records show as shipped. Select
the appropriate Action.

13. Use the Capable to Promise section to enable Capable to Promise (CTP) calculation logic for the customer
trading partner. This calculation determines the date by which a sales order quantity can be delivered
(promised) to the customer. When you select Check Dates, you then specify if the Ship By, Need By, or both
dates are included when processing CTP dates.

14. Use the Lead Time section to specify the minimum number of days ahead of the planned Ship By or Need
By date by which the Epicor application should accept requests on incoming EDI transactions and manually
enter demand transactions. You typically use these settings to avoid situations in which your company cannot
respond properly (based on your available Site/stock/time/resources) to requests received from your customer
trading partner within an inadequate time frame.

You can specify this for the addition of new demand schedules (Add), changing of existing demand schedules
(Change), cancellation of existing demand schedules (Cancel), additions of new demand lines to existing
demand orders (New Line), quantity changes for existing demand schedules (Quantity Change), and date
changes for existing demand schedules (Date Change). For each action request, specify whether to apply
a Stop or Warning action.

For example, if the Add field is set to five days, and the customer trading partner requests you add a new
demand schedule to ship four days from now, your Epicor application considers this an exception. This
occurs because the demand schedule change request was received within the Add time frame, giving you
too little time to respond to the change. The functionality then performs a Stop or Warning action, depending
on the setting of the Action (Add) field.

15. When you finish, click Save on the Standard toolbar.

Define Customer EDI Documents

Use the Customer > Documents sheet to define the processing parameters for inbound EDI documents you accept
from the customer trading partner, and the outbound EDI documents you generate and send back. The Demand
Management module uses these definitions when generating EDI documents that create and track unfirm order
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releases, firm order releases, forecasts, purchase order acknowledgments, Advanced Shipping Notices (ASN), and
invoices.

The Ship To > Documents sheet operates in the same way as
the Customer > Demand sheet, but you can also define
inbound and outbound document parameters for specific
customer ship to locations.

To define customer EDI documents:

1. Click the Down Arrow next to the New button; select New Customer Document.

2. Click the Documents > Detail sheet to enter trading partner document parameters.

3. Enter the identification number or name for this Document. This value is the number the Import EDI Demand
Process references when it retrieves this inbound EDI document or sends this outbound EDI document.

4. Select the Type of inbound/outbound document you need. For inbound documents, this value indicates
the type of demand suggestion generated for the document.

5. Select the Direction of the document by indicating whether it is an inbound document you receive, or an
outbound document you send.

6. In the Options Available field, select the part options the Epicor application should use to retrieve the
corresponding internal part numbers when processing inbound EDI transactions in Import EDI Demand. For
example, select Use Part UPC if the Epicor application should search for and use Universal Product Codes
(UPC) defined in the Part Maintenance > Part > UOMs sheet to retrieve internal part numbers.
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7. The Accept Type field indicates whether demand on this inbound EDI document is processed automatically
or manually. Select Always accept or Accept if no errors to automatically process inbound demand. Select
Manually accept to manually process inbound demand.

8. If this is an Outbound EDI Document, specify what processing should take place in the Epicor application
for outbound transactions for this trading partner. If you select Automatic, this indicates the Epicor application
automatically generates a supporting document when the associated transaction is confirmed. If you select
Manual, you must perform additional setup tasks required to define the outbound EDI documents themselves.
Refer to the EDI / Demand Management Technical Reference Guide for more details.

9. After you select the Automatic check box, enter a value into the Alt Trading Partner field. If an alternate
trading partner is not associated with your customer trading partner, enter the trading partner identifier for
your customer in this field.

10. When you finish, click Save on the Standard toolbar.

Operations

This section details the operations available within the Demand Management module. Each operation is described
as a workflow to help guide you through the process from start to finish. These programs are primarily found
within the General Operations folder for this module. If a unique setup record is required to run the operation,
this record is also described in this section.

Demand Contracts

A demand contract represents the agreement for proposed sales to your customer over a specified period of
time. The Epicor application then receives and processes demand schedules you either manually enter in Demand
Entry, or generate from inbound EDI files received from your customer trading partners. This in turn generates
order releases or forecasts for MRP processing.

Using Demand Contract Entry, you specify the dates during which each demand contract is active. Optionally,
you can also specify the parts covered under the contract. Each contract can be set up for multiple parts, so one
contract can be used to generate multiple shipping schedules for each part. You can also set up several default
values for the sales orders and/or forecasts generated through the contract.

You use Demand Contract Entry to review the contract quantities against actual incoming demand quantities on
inbound EDI transactions, or manually entered demand transactions. It also contains matching logic you use to
receive and efficiently process changes your customer trading partner requests to existing demand schedules and
order releases.

Menu Path: Sales Management > Demand Management > General Operations > Demand Contract Entry

Primary Details

Use the Header sheet to enter or edit primary details for the demand contract. This includes specifying the length
of the contract, and other default settings.

To enter demand contract primary details:
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1. Click New on the Standard toolbar.

2. Enter the identification number for the demand Contract. The demand contract number you enter must
match the identifier your customer uses for this demand contract.

3. Enter the identifier for the sold to Customer for whom you are entering this demand contract.

4. If you use EDI, identify the Trading Partner. The default value comes from the trading partner identifier
defined for the customer in Customer Maintenance.

5. In the Order section, enter the default Ship Via, FOB, Terms, Priority, Currency, Lock, and
Project identifier settings for sales orders generated from this contract.

6. Select the Apply Order Based Discounts Automatically check box to automatically apply discounts based
on the quantity on each order line, the total value of the order, or both. For more information on the discount
pricing system, review the Sales Order Processing chapter.

7. Select the Ship Order Complete check box to indicate all order lines on a specific sales order must be
shipped at the same time. If this check box is clear, various releases on this order can ship at different times.

8. Use the Hold Orders for Review check box to specify if sales orders created from this demand contract
should be reviewed before released for shipping.

9. If payments are made through another customer, select the alternate Bill To Customer identifier number.

10. Select the Cumulative Setting used to reconcile cumulative shipping part quantities (CUMM) for this
demand contract. Depending on the option you select, you can turn off cumulative tracking, reconcile
cumulative quantities in the Demand Reconciliation program using the part number, or reconcile them based
on the part number and the customer purchase order.

• If you select the Part option, cumulative quantities display in Demand Reconciliation for a particular part
number across an entire demand contract.
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• If you select the Part/PO option, cumulative quantities display in Demand Reconciliation for each part
number/purchase order combination; each of these combinations represent a single record per each
part/purchase order occurrence in a demand order.

11. The Totals Ordered Amount field displays the total amount your company will receive from orders generated
through this contract. This value only displays for your information.

12. The Totals Invoiced Amount field displays the total invoice amount of orders invoiced for this contract so
far. This value only displays for your information.

13. When you finish, click Save on the Standard toolbar.

Matching

Use the Header > Matching sheet to specify the parameters the Demand Schedule Matching process uses to
match sales orders/forecasts with demand requests. The Epicor application matches update requests received on
inbound EDI transactions against existing demand schedule releases generated through this demand contract.
You specify which matching criteria should be used and the priority sequence in which they should be applied.
When the functionality finds the matching demand schedule release, it automatically processes the request.

These order values are default settings for the generated sales
order. You can override these values on specific sales orders.

Performing matching activities, particularly in an EDI environment, is required because you typically receive
purchase orders on a daily basis from your customer trading partners. Rather than deleting previous sales order
transactions and creating new ones, the matching functionality allows the Epicor application to match incoming
action demands (such as quantity increases, date changes, adding lines, and cancelling releases) received from
your customer trading partner to existing sales orders, modifying the data accordingly.

1. To enter matching criteria for the demand contract, select the Header > Matching sheet.

2. Select the Allow Non Perfect Match check box to specify if perfect or non-perfect matches should be
performed for the demand contract. A perfect match is defined as one in which all criteria you specify in
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the Options Selected field match between demand schedules update requests and existing demand schedule
releases. A non-perfect match is defined as one in which at least one of the criteria (for example, shipping
quantities or shipping dates) match between the transactions.

3. Select the Cancel Non-Matched check box to automatically cancel all sales releases for this demand contract
that are not matched by the Demand Schedule Matching process. If you select this check box, you can also
use the Exclude From and Exclude Until check boxes and accompanying From (days) and Until (days) field
as needed to specify an cancellation exclusion grace period for non-matched schedule updates. The Epicor
application will skip cancellation of non-matched sales releases with ship dates within this date range.

4. The Options Available field displays the available criteria (for example Ship By Date, Quantity, Reference,
Open/Closed status) that can be used in the matching process. Using the buttons, select the matching criteria
being used for the demand contract, and the priority in which they should be matched. Once selected, they
appear in the Options Selected field.

5. When you finish, click Save on the Standard toolbar.

Line Details

Use the Line > Detail sheet to specify the parameters for ordering a specific part through the demand contract.
Through this sheet, you can select the part number, define its price options, and indicate how this contract line
handles the ordered quantities.

1. Click the Down Arrow next to the New button; select New Contract Detail.

2. Navigate to the Line > Detail sheet.

3. Enter or select the internal Part ordered on this demand contract line.
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4. Customers often have unique part numbers and revisions they use to identify specific parts. If you need,
enter the Customer Part number ordered on this demand contract line; or, click the Customer Part button
to find and select the customer part you need.

5. Optionally, specify the Revision number (if any) required for the customer part.

6. Enter the Total Contract Quantity you expect this customer to order through this contract. Select the
UOM code that represents the unit of measure (for example, Each, Case, Cubic Centimeters) in which the
quantity will be ordered.

7. From the Pricing drop-down list, define whether the Internal Price or Customer Price is used in sales orders
generated from demand entries.

8. Enter the allowable price Tolerance percentage; this value is the percentage difference between the customer
price and your internal price. It indicates that demand is generated for prices that fall within this percentage
value.

9. Specify the Unit Price for the selected part. By default, the internal price defined on the part record displays.

10. Select the Use Pricing Logic check box if the internal price is calculated using price lists defined for this
customer. If the Use Price List check box is selected, the Order Quantity may trigger a change due to a price
break. This takes precedence over any values you manually enter into the Pricing and Price Per fields.

11. The Totals section displays the total ordered quantity, ordered amount, shipped quantity, invoiced quantity,
and invoiced amounts for this line.

12. When you finish, click Save on the Standard toolbar.

Actions Menu

The Actions menu in Demand Contract Entry contains options you use to perform demand contract processing
tasks.

Available options:

1. Open Contract - Use this command to re-open a closed demand contract. When a contract is open, you
can add new demand entries for that contract.

2. Close Contract - Use this command to close a demand contract. When a contract is closed, you cannot
add new demand entries for that contract.

Inbound EDI Transactions

eVision™ is a third-party XML/EDI solution provided by TIE KINETIX and certified for use with the Epicor application.
eVision receives inbound EDI 830/DELFOR, 850/ORDERS, 860/ORDCHG, and 862/DELJT files from your customer
trading partners, converts them into pre-defined Epicor-compatible EDI transaction files, and then deposits these
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text-based tilde-delimited files into a designated inbound folder for processing using the Import EDI Demand
Process.

Use the Company Configuration > Modules > Sales > Demand sheet to set up the default location for
the Import process folder.

The Epicor application supports processing of the following inbound EDI documents:

• 830/DELFOR (Inbound Planning Schedule) – Used for transfer of forecasting/material release information
from your customer trading partner. The document can be used to generate order releases.

• 850/ORDERS (Inbound Purchase Order) – Used for transferring purchase orders you receive from a customer
trading partner to communicate the specific items, unit prices, and quantities they wish to have delivered.

• 860/ORDCHG (Inbound Purchase Order Change) - Used by your customer trading partner to request a
change to a submitted purchase order, or confirm a purchase order change. The document communicates
the specific items, unit prices, and quantities they wish to change.

• 862/DELJIT (Inbound Shipping Schedule) - Used by your customer trading partner to communicate shipping
schedule requirements.

Figure 1: Inbound EDI 850/ORDERS Transaction Record

eVision conversely collects outbound Order Acknowledgment, Advanced Shipping Notice, and AR Invoice document
record files produced by the Epicor application, and then converts them to corresponding EDI 810/INVOIC,
855/ORDRSP, and 865/ORDRSP messages sent to your customer trading partners.

Import EDI Demand Process

The Import EDI Demand Process runs on a server code and significantly improves EDI performance. File importation
occurs based on a processing schedule that you designate in the Import EDI Demand Process.

First, search for any potential errors that occurred during the direct EDI import. Use the Errors sheets found on
the Header, Line and Schedule level to identify a reason for the error.

After you correct invalid data on inbound EDI transactions, from the Actions menu, select Ready To Process. Once
you select this option, a document that first failed to be loaded into Demand Management is ready for re-processing
next time the Import EDI Demand Process is scheduled to run. In order to process the corrected demand entries
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immediately, from the Actions menu, select Process IM Demand. The Import EDI Demand Process window displays,
allowing you to submit the process.

For a detailed explanation regarding Inbound EDI Transactions,
refer to the EDI/Demand Management Technical Reference
Guide. This guide is found within application help.

To import EDI transactions :

1. Click Import Folder to find and select the folder in which the files deposited by TIE KINETIX eVision are
stored.

2. In the Backup Process File field, specify if the inbound EDI transaction files should be backed before being
imported.

3. Select the Continuous Processing check box if you want the Import EDI Demand Process to run continuously
in the background, and enter the Continuous Processing Delay.

4. Enter the remaining processing parameters. Click Log Filename to select the log file location. Click the
Schedule drop-down list to select a Schedule and select the Recurring check box if you need.

5. To run this process now, click the Process button.

6. If erroneous data is identified during direct EDI import processing, you can correct it as required using the
Demand Workbench located on the General Operations folder of the Demand Management module. It
displays a visual representation of how current data found in the inbound EDI transaction would appear if
converted to a demand record. This workshop is valuable when an incoming record is less than complete,
or something is wrong with the data. It indicates the type of errors detected, and allows you to correct them
before importing the inbound EDI data into demand records that can be maintained using Demand Entry.
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Demand Entry

If you are not using EDI, Demand Entry is used to manually create and process demand entries. It contains tools
you leverage to accept, revise, or reject demand entries, lines, and schedules. You can also manually override
System Rejected demand entries which have not passed validations based on user-defined rules you specified for
the customer trading partner on their customer record.

If designated in the customer’s demand settings, the Epicor application can automatically perform the same tasks
as Demand Entry or Demand Mass Review when processing demand on inbound EDI transactions. Use Demand
Entry as necessary to review the demand lines and shipping schedule, in order to evaluate their impact. When
you are satisfied with a demand schedule, use the Process action to manually process the demand. Depending
on the demand type, the Demand Entry process either creates unfirm order releases, firm order releases, or MRP
forecasts. You can do this if the Epicor application is not configured to do so automatically through workflow
processing for the customer trading partner. You can then use either Sales Order Entry or Forecast Entry to further
refine the resulting data.

Menu Path: Sales Management > Demand Management > General Operations > Demand Entry

Primary Details

Manually enter the primary values needed to generate shipping schedules for a demand contract. After you
specify the demand contract, the default values associated with the contract appear, but you can override these
values. If you need, you also specify the purchase order number associated with the demand record. The Epicor
application uses this purchase order to track all releases created for the demand record. It also links the sales
order (if any) generated at a later time for the demand record to the designated purchase order.

If you are using EDI, the Epicor application automatically generates this demand record from the inbound EDI
transaction received from your trading partner; use the Header > Detail sheet as needed to edit this information.

To enter demand header information:
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1. Click New on the Standard toolbar.

2. Enter or select the demand Contract identifier you need.

3. Enter or select the PO (purchase order) used by the demand record.

4. Select the Ready To Process check box to indicate the demand is ready to turn into sales orders or forecast
releases. You use the Process command from the Actions menu to generate these records. If the demand
record was originally created from an EDI transaction, this check box is automatically selected.

5. Optionally, select the ERS Order check box to indicate that Evaluated Receipt Settlement and Self Billing
invoices generate for demand schedules and sales orders when you ship part quantities to the customer.
The ERS invoicing allows your bill to customer to pay invoices based on the received packing slip information.
You can override this setting as needed by clicking the Override button.

6. When you generate a sales order for the demand record at a later time, the Order field displays the identifier
number assigned to the sales order. If the Hold Orders indicator is highlighted, it indicates that sales orders
created for this demand contract are placed on hold for review and error correction and not released for
shipping.

7. Select the Ship Order Complete check box to indicate if the associated sales order can only ship if all
quantities are available.

8. Use the Apply Order Based Discounts Automatically check box to apply discounts based on the quantity
on each order line, the total value of the order, or both. For more information on the discount pricing system,
review the Sales Order Processing chapter.

9. The Demand Lines grid at the bottom of the Header > Detail sheet displays a summary of all demand lines
linked to the current contract.
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10. When the User Rejected icon displays in the Contract section and is highlighted, it indicates you have
selected the Rejected check box and have manually rejected this demand line. No demand processing takes
place for rejected lines.

11. When System Rejected displays in the Contract section and is highlighted, it indicates the Epicor application
rejected this demand line due to problems such as price, lead time, or cumulative quantity validation issues.
A shipping schedule is not processed from this line. This situation occurs if this demand line or a schedule
on this demand was created/changed within a specified customer lead time range, and the Stop action was
used against it. You can manually change this option by selecting the Override System Reject check box
on the Line > Detail sheet. Use this check box to override the system validation rules and manually accept
the line.

12. When Reset Cum Info displays in the Contract section and is highlighted, it indicates the customer has
requested the cumulative information be reset for this customer purchase order, and you have run the Reset
Cumulative Info option on the Demand Reconciliation > Actions menu for this demand record.

13. When you finish, click Save.

Line Details

Use the Line > Detail sheet to manually enter or edit demand line information. If you use EDI, the Epicor application
automatically generates demand line records from inbound EDI transaction. However, you can edit these automatic
details as you need.

To enter a demand line:

1. Click the Down Arrow next to the New button; select New Demand Line.

2. The Line > Detail sheet displays.
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3. In the Contract Line field, enter or select the demand contract line associated with the demand line.

4. Enter or select the internal Part number and part revision number associated with the demand line.

5. If you select a part revision designated as Configurable in the Configurator Designer, click Configure as
needed to invoke a Configurator session. You can then enter or select configuration inputs and options
specified for the part in the Configurator Designer. Depending on how you design the configuration, the
Configurator Q&A session prompts users to enter a Smart String or select specific product parameters. These
selections create a part configured based on the customer requirements.

6. In the Sales Order section, enter the default parameters used for the sales order line generated from the
demand line. This includes specifying the unit of measure price per, internal price, customer price, price
group, and so on. If a sales order is already generated, the order identifier number displays in the Sales
Order field.

7. When you finish, click Save on the Standard toolbar.

Schedules

Use the Schedule > Detail sheet to manually create, review, and edit a demand schedule. You can enter as many
schedules as you need for the associated demand line. You can also generate a shipping schedule by using the
Create Demand Schedule option on the Actions menu. If you use EDI, the Epicor application automatically
generates demand line records from inbound EDI transactions. You can, however, fine-tune these schedules as
you need.

To enter a demand schedule:

1. Click the Down Arrow next to the New button; select New Demand Schedule.

2. The Schedule > Detail sheet displays.
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3. Enter the Order Quantity for the demand schedule.

4. Select the Demand Type associated with the demand schedule. This defines the record generated when
this schedule is processed. Available options:

• Select Firm Releases if this demand schedule is converted into a firm release for the sales order.

• Select Unfirm Releases if this demand schedule is converted into an unfirm sales order release.

• Select Forecasts if this demand schedule is converted into a forecast record.

5. Enter the Need By date; this value is the date on which this customer needs to receive the quantity.

6. Specify the number of Delivery Days required to ship a part from your manufacturing center to this
customer. The Epicor application uses this to calculate the Ship By date. This value defaults from the Customer
> Demand sheet within Customer Maintenance.

For existing demand schedules, the CTP Need By and
CTP Ship By fields display the Need By and Ship By dates
calculated by the Capable to Promise functionality.
Beyond Need By or Beyond Ship By appear as
highlighted if calculated CTP Need By or CTP ship By dates
are later than the actual Need By or Ship By dates on the
demand schedule.

7. Now specify the Ship By date; this value is the date on which you need to ship the schedule quantity so
that the parts reach the customer by their requested Need By date.

8. In the Ship To section, select the Ship To customer number and the Ship Via method. Specify any associated
sub-ship to, ship routing, and One Time ship information for the demand schedule.

9. When you finish, click Save on the Standard toolbar.

Actions Menu

The Actions menu in Demand Entry contains several commands you use to perform demand processing tasks.
These functions are grouped on sub-menus, and are processed against the specific header, line, or schedule you
define.

Common Sub-Menu Options

The Actions sub-menus contain the following common commands:
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1. Open - Use this option to re-activate a schedule, demand line, or demand record. When an item is open,
you can add, update, or process these items.

2. Close - Use this option to end activity on this schedule, demand line, or demand record. You cannot add,
update, or process closed items.

3. Reject - Use this option to prevent the demand record, demand line, or schedule from being used. Rejected
items are not removed, but they appear as Rejected in Demand Entry.

4. Unreject - Use this option to reverse the status of a Rejected demand record. You can then create releases
and forecasts from this demand record.

5. Unlock - Use this option to unlock a locked demand header or demand line record.

6. Delete By Schedule Number – Use this option to delete demand lines or schedules from the current
demand record.

7. Log - Displays a log of errors related to processing the associated demand header, line, or schedule.

Demand Header Sub-Menu

This sub-menu contains the following options unique to the demand header:

1. Process – Use this option to generate sales order releases and forecasts from the current demand record.

2. Close and Process All Schedules – Use this option as needed to close all remaining open demand schedules
linked with the demand record, and indicate these schedules are Processed.

3. Create New Sales Order – Use this option as needed to create a new sales order for the selected demand
schedule.
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Demand Line Sub-Menu

This sub-menu contains the following option unique to the demand line:

1. Get Demand Lines from Contract - Use this option to retrieve demand line information from the specified
demand contract. Once you have retrieved this information, you can view and edit it on the Line > Detail
sheet.

Demand Schedule Sub-Menu

This sub-menu contains the following options unique to the demand schedule:

1. Create Demand Schedule - Use this option to automatically generate a shipping schedule for the current
demand line. It converts the part quantities into a shipping schedule.

2. Review – Use this option to review how the proposed shipping schedule interacts with the current inventory
and production quantities. If there are discrepancies, click the Reconciliation button within this program to
launch the Demand Reconciliation program to make schedule adjustments.

3. Match – Use this option to combine a new release with previous releases generated through this demand
record.

Demand Mass Review

Use the Demand Mass Review program to quickly review, reject, and process multiple demand records at the
same time. It contains many of the same tools as does Demand Entry, but you can evaluate and process the
current demand for a specific part or all of the current demand records in your database. If you work with a large
volume of data, use this program to evaluate your incoming demand.

Menu Path: Sales Management > Demand Management > General Operations > Demand Mass Review
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To review and process multiple demand records at the same time:

1. Click New on the Standard toolbar.

2. You first create groups of demand records for mass processing. To do this, enter the name of the group
being created, or click Group to select an existing group to which you are adding demand records.

3. Select the Demand Mass Review sheet.

4. You can Review By either Part records or Demand records. Depending on the option you select, either part
or demand fields display on this sheet. In this example, you are reviewing demand using part records.

5. To review demand records requiring processing, click the Part button to find and select specific part numbers.

6. Use the check boxes in the Demand Types section to select the type of demand records (firm, unfirm, or
forecast) you want to review.

7. To add the selected demand records to the Group sheet, use the options located on the Select for Group
sub-menu in the Actions menu. For example, to add all of the demand orders displayed in the Parts sheet
to the group, click Select All for Part.

173Epicor ERP | 10.0.700

Demand Management | Chapter 4Epicor ERP Application User Guide - Part One



8. Once you have selected the demand records, click the Groups sheet to review and process them. You can
select the Locked Group check box as needed to lock the selected demand records and prevent them from
being reassigned to another group.

9. You use the remaining selections on the Actions menu to process the group, match releases, re-activate
demand records, reverse the status of previously rejected demand records, or close them from future
processing. Review the Demand Entry section for details on these options.

10. If you need, click Demand Entry to launch this program and edit a specific demand record.

11. When you finish, click Save.

Demand Reconciliation

You can use Demand Reconciliation to update demand entries to reflect changes that occurred during shipping.
It displays cumulative quantity amounts according to your company’s records, and your customer trading partner’s
records. If items on a release did not reach a customer because they were returned, lost, still in transit, or any
other reason, you can enter a manual adjustment quantity in this program. Depending on if the adjustment
quantity is entered as a positive or negative, an invoice charge or a chargeback credit memo are created.

The way in which cumulative quantity changes for a demand contract are tracked depends on the option selected
in the Cumulative Setting field in Demand Contract Entry. Changes are based on shipments you make to the
customer, and by using the EDI documents received from your customer trading partner.

Menu Path: Sales Management > Demand Management > General Operations > Demand Reconciliation

To manually adjust demand entries:
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1. Click the Demand Reconciliation button to find and select the contract you need to adjust.

2. If a Purchase Order number does not appear in the demand reconciliation record, it indicates the cumulative
quantities display for the part number across an entire demand contract. If a purchase order number appears,
it indicates the cumulative quantities are for this specific part and purchase order demand record combination
only.

3. The Trading Partner Information section displays cumulative quantity and last shipment information,
according to your trading partner. This information automatically updates each time incoming EDI transactions
that contain cumulative quantity information reported by your customer trading partner are processed. This
information includes the cumulative quantity to-date, the starting date for the cumulative quantity, the last
ship quantity, last ship date, last pack identifier, last master pack number, and schedule number (EDI
transmission ID) on which the trading partner last reported cumulative quantity information.

4. The Company Information section displays cumulative quantity and last shipment information, according
to your company’s record. This information automatically updates each time a shipment record in Customer
Shipment Entry or Master Pack Shipment Entry generates. The same cumulative information displays here
as in the Trading Partner section, but is based on your company’s records, not those provided by the customer
trading partner.

5. The Variance field reports the cumulative variance quantity; this value is the difference between your
company’s reported cumulative quantity and that reported by your customer trading partner.

6. The Reconciled field reports the reconciled cumulative shipment quantity acknowledged by your customer
trading partner.

7. Click the Shipments tab to view shipments that have been made to this customer for the specified purchase
order and part number.
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8. The specific shipment transactions associated with the demand reconciliation record appear in the
Shipments grid.

9. Enter the Adjustment quantity (if any) for this demand reconciliation record. For example, if your company
reports that a quantity of two shipped, but your customer trading partner reports only one was received,
you enter an adjustment quantity (in this case, -1). A chargeback credit memo for the customer is generated.

10. Click the Adjustments sheet to view all adjustment records created for the demand reconciliation record.

11. When you finish, click Save on the Standard toolbar.

Outbound EDI Documents

This section explores the EDI documents you send out to your customers. Each document contains information
that helps customers follow the progress of their sales orders.

Purchase Order Acknowledgements (EDI 855)

An EDI 855 document informs a customer about the progress of a purchase. It indicates you have accepted the
demand, and you are filling the order and shipping the goods by the requested date. You usually send EDI 855
transactions in response to EDI 850 inbound purchase order documents. This outbound EDI document is the text
or XML-based document record that is automatically or manually generated within Sales Order Entry. You can
also print these documents as a group using the Mass Print Sales Orders program.

If the Automatic check box is selected for the Sales Order Acknowledgement document type in the Outbound
Document section on the customer record (defined on the Documents sheet in Customer Maintenance), this
document is automatically produced when sales order releases generate for inbound EDI demand requests. You
must perform additional setup tasks required to define the outbound EDI documents themselves. Refer to the
EDI/Demand Management Technical Reference Guide within application help for more details.

Menu Path: Sales Management > Demand Management > Reports > Mass Print Sales Orders

To mass print order acknowledgements:

1. Use the Filter sheet to print acknowledgements for specific sales orders or demand contracts.

2. Click the Print button on the Standard toolbar.
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Advanced Shipment Notifications (EDI 856)

An EDI 856 document is an electronic version of a packing slip; it informs your customer how you have packed
and shipped their purchased items. The Advance Ship Notice, or ASN, also informs the buyer the goods are
shipped. This type of outbound EDI transaction, along with a UCC-128 bar code label, notifies your customer’s
receiving dock what is packed in the shipping cartons, eliminating the need for receiving personnel to open these
cartons.

This outbound EDI document is the text or XML-based document record that is automatically or manually generated
in Customer Shipment Entry or Master Pack Shipment Entry.

You can also print these documents as a group using the Mass Print Packing Slip/Labels program. If the Automatic
check box is selected for the Invoice document type in the Outbound Document section on the customer record
(defined on the Documents sheet in Customer Maintenance), this document is automatically produced when
you save a customer shipment record.

Menu Path: Sales Management > Demand Management > Reports > Mass Print Packing slips

To mass print packing slips:

1. Specify to print Packing Slip, Shipping Labels, or Both types of documents.

2. Use the Filter sheet to print packing slips or shipping labels for specific packing slips and demand contracts.

3. Click the Print button on the Standard toolbar.

Invoice Notifications (EDI 810)

An EDI 810 document is an electronic version of an invoice you normally send to your customer. You use 810
Invoices to communicate the payment terms, specific items, price, and quantities you delivered and for which
you now must be paid.

This outbound EDI document is the text or XML-based document record automatically or manually generated in
AR Invoice Entry. You can also print these documents as a group using the Mass Print AR Invoices program. If
the Automatic check box is selected for the Invoice document type in the Outbound Document section on the
customer record (defined on the Documents sheet in Customer Maintenance), this document is automatically
produced when the AR invoice successfully posts to the General Ledger.

Menu Path: Sales Management > Demand Management > Reports > Mass Print AR Invoices
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To mass print invoices:

1. Select the types of Transactions to print. In this example, you select All transactions.

2. Next, indicate the Document Types you want to mass print. In this example, you select All document types.

3. Use the Filter sheet to print invoices for specific customers and demand contracts.

4. Click the Print button on the Standard toolbar.

Reports

This section describes some key reports you use to review demand entries. You can run these reports whenever
you need. You can also set up each report to generate and print through a recurring, automatic schedule. Review
the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for information on how you link
a report to a recurring schedule.

Demand Review Report

Use the Demand Review Report to analyze your demand records. This report displays demand processed in
Demand Entry or Demand Mass Review, updated orders, rejected orders, and unprocessed orders.

The report includes price discrepancies, internal price, customer price, and price tolerance percentages. You can
run the report for specified customers, parts, and customer purchase orders for a specified date range.

Menu Path: Sales Management > Demand Management > Reports > Demand Review

To use this report:
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1. In the From Date and To Date fields, specify the date range for the demand entries.

2. Use the check boxes in the Exclude section to specify which types of demand transactions (rejected, those
with no changes, demand transactions that have been processed, posted, or closed) should not appear on
the report.

3. Use the Demand with Price Discrepancies Only check box to specify only demand entries with price
discrepancies should display on the report.

4. Select the Display All Log Entries check box to include all demand log entries on the report; this includes
entries for current and previous schedules.

5. Use the Filter sheet to print demand detail for specific customers, parts, customer purchase orders, or sales
orders.

6. When you finish, click the Print button on the Standard toolbar.

Demand Net Change Report

Use the Demand to Sales Order Net Change Report to review demand records that have been turned into sales
orders. You can limit the information by specifying the sales orders, customers, parts, and trading partners
associated with the demand.

Menu Path: Sales Management > Demand Management > Reports > Demand Net Change Report

To use this report:
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1. Indicate the Transaction Date From and To date range.

2. If you wish, enter a Sales Order number to only display demand entries converted for this specific sales
order.

3. Optionally, enter a Trading Partner Name to only display demand entries converted for this specific trading
partner.

4. Use the Filter sheet to print demand entries linked to specific part and customer records.

5. Click the Print button on the Standard toolbar.

Cumulative Quantities Variance Report

Use the Cumulative Quantities Variance Report to review cumulative quantities and variances calculated for
demand entries. It reports differences between shipment quantity records maintained by your company and those
maintained by your customer trading partner. If you need, you can exclude some information from this report.

Menu Path: Sales Management > Demand Management > Reports > Cumulative Variances

To use this report:

1. Select the Include Variance Zero check box to include zero cumulative quantity variances on the report.

2. Use the Include Variance Equal to Last Shipment check box to set the cumulative quantity variance for
demand purchase orders to the last pack shipped by your company to (but not necessarily received by) your
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customer trading partner. Selecting this check box helps you identify when a reported variance is actually
due to in-transit shipment quantities. For example, if you have already shipped three units to your customer
trading partner and two more are in-transit on the last shipped pack, the quantity is set to two.

3. Click the Print button on the Standard toolbar.
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Chapter 5: Sales Order Processing

The sales order process is a flexible system you can use to create everything from single release sales orders to complex,
configured, kitted, multi-line, multi-release orders. The sales order entry process is also directly integrated with quoting,
purchasing, and job management. You can create a new sales order from an existing quote, make the changes you
need, allocate the inventory from stock, mark some items to buy direct, and drop ship, or even automatically generate
jobs from the order’s detail lines.

The module also contains advanced functions. Use the pricing and discounting functionality to define a regular system
for discounts and price point levels. You can then apply uniform price breaks across your products or individual price
breaks that you assign to specific customers. Use the Sales Kitting functionality to create a sales kit for a part that
contains a series of related parts. These child parts can either be stock or non-stock. If you use the Configurator module,
you can also create multi-level configured parts that can be included as detail lines on a sales kit order.

By using the available functionality within the sales order process, you can efficiently create, process, and complete
your company’s sales orders.

Operations

This section details the operations you can run through the Order Management module. Each operation is
described as a workflow to help guide you through the process from start to finish. These programs are primarily
found within the General Operations folder for this module. If a unique setup record is required to run the
operation, this is also described in this section.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review the application help for this
program; the Configuration topic details the options you define within Company Configuration. You can also
review the Company Configuration chapter in the Epicor ERP Implementation Guide.

Sales Order Entry

Use Sales Order Entry to both create and edit sales orders. Each order can have multiple detail lines, and each
detail line can also have multiple releases. Each sales order can have different Sold To, Bill To, Ship To, and Mark
For locations.

Menu Path: Sales Management > Order Management > General Operations > Order Entry
The CRM menu path is: Customer Relationship Management > Order Management > General Operations >
Order Entry

To create a new sales order:
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1. Click the New button on the Standard toolbar. The fields on the Summary sheet become active.

2. To enter the Sold To customer, click the Customer button to search for and select a customer record. The
Sold To is the customer location purchasing the goods and services. This location is the main address that
you enter on the Customer > Detail sheet within Customer Maintenance.

After the customer is selected, default information from the customer record displays.

3. The Bill To location defaults to the address defined on the Billing > Detail sheet within Customer
Maintenance. The Bill To customer is the customer location that pays for the purchased goods and services.
To select an alternate Bill To, select a customer from the drop-down list, or select Same as Sold To if the
Bill To customer is the same as the Sold To customer.

4. The Ship To customer defaults from the Sold To customer. You can click the Customer button to search
for and select a different Ship To customer. The Ship To customer is the customer who receives the goods.

5. The Ship To location defaults to the address defined on the Ship To > Detail sheet within Customer
Maintenance. The Ship To code is the ship to customer location that receives the goods and services.
Optionally, click the Ship To button to search for and select a different Ship To customer address related
to the Ship To customer.

6. If the order needs to be shipped to a location other than those that appear in the Ship To field selection
list, select the One Time check box. This check box is available only if the Allow One Time Ship To check
box has been selected for the specified Sold To or Ship To customer on the Customer > Detail sheet within
Customer Maintenance.
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7. If you selected the One Time check box, click the One Time Ship To sheet and define the one time shipping
address for the order.

8. The contact Name and Address information displays for both the Sold To and Ship To customers.

9. On the Summary sheet, enter a Need By date. This defines the date the customer wants to receive the
order.

10. Enter a Ship By date. This defines the date you must ship out the order so that the customer can receive
the parts by the Need By Date.

Epicor ERP | 10.0.700184

Epicor ERP Application User Guide - Part OneChapter 5 | Sales Order Processing



11. Optionally, select the check boxes set by default through the Company Configuration program.

• The Apply Order Based Discounts Automatically check box activates the automatic pricing system.
You can then apply discounts based on the quantity for each order line, the total value of the order, or
both.

• The Auto-Print Ready check box starts the automatic printing functionality with a Crystal Report or
Bartender Labels. This functionality is available if a corresponding Business Activity Manager (BAM) record
has been set up. For information on creating BAM records, review application help or the Business Activity
Manager chapter in the Epicor ICE Tools User Guide.

12. Select the Ready To Process check box to indicate sales tax is calculated against this sales order. When the
current sales order is saved, the sales tax amounts are calculated using rates set up for the specific locality
defined on the order. Note this check box can be automatically selected by default through the Company
Configuration program. If you use the Tax Connect functionality (Avalara® AvaTax®), this check box indicates
that sales taxes against this order will be automatically calculated and validated through this service.

You should only select the Ready to Process check box if
you are reasonably sure the sales order is complete. Each
time you save a sales order designated as ready to process,
all of the TaxConnect processes run and the resulting
calculated amounts are automatically sent to the Avalara®

AvaTax® website. You typically will have better order entry
performance when the Ready to Process check box is
clear, as this prevents the additional processing and
Internet data transfer from placing demands against your
network. For more specific information on what occurs
when this check box is selected, review the Ready to
Process field definition within the application help.

13. Click Save.

Sales Order Entry assigns a new sales order number to the record.

Sales Order Detail Lines

When the main information on the Sales Order header is complete, you are ready to enter detail lines on this
sales order.

To create a new order detail line:
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1. Click the Down Arrow next to the New button; select New Line.

2. Enter the detail line on the Summary sheet within the Order Lines grid.

Order Lines - Detail Sheet

Use the Lines > Detail sheet to enter complete detail line information. You both select the part and enter the
quantity that the customer has requested on this sheet.

To enter a detail line:
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1. After you have created a new detail line, select the Lines > Detail sheet.

2. Click the Part/Rev button to find and select the part the customer ordered.

3. In the Order Quantity field, enter the number of parts that the customer ordered. Select the unit of measure
for the part.

4. After the part record is selected, the Lines > Detail sheet displays default part information such as the Price
Per and Unit Price values. Optionally edit this information.

5. If your sales force generated this sales order as part of a marketing campaign, this campaign appears in the
Marketing Campaign field. Click the Campaign button to find and select the marketing campaign that
generated the sales order.

To learn more about marketing campaigns and other
marketing features, review the chapter on Customer
Relationship Management.

6. When you finish, click Save.

Your new detail lines are saved on the sales order.

Order Releases

When you save a detail line, Sales Order Entry automatically creates a single release for the line. This release has
the same quantity that was entered on the detail line.

You can also create multiple releases for each detail line. You would do this, for example, if the customer needs
to receive part quantities at different locations, or to set up a delivery schedule.

To enter a release:
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1. Click the Down Arrow next to the New button; select New Release.

2. The Releases > Detail sheet displays. The fields on this sheet become active for data entry.

3. In the Order Quantity field, enter the amount to be sent with this release.

4. If you want to add any additional information about this release, enter it in the Reference field.

5. The order header’s Need By and Ship By dates display on this release. If you ship this release on another
date, select different Need By and Ship By dates.

6. If the release will definitely be shipped, select the Firm Release check box. This status displays on various
reports.

7. Select the necessary check box to specify if this sales release is a Buy To Order, which indicates purchase
order suggestions are generated, or Make Direct, which indicates this release quantity is manufactured
instead of pulled from inventory.

Epicor ERP | 10.0.700188

Epicor ERP Application User Guide - Part OneChapter 5 | Sales Order Processing



8. If you selected the Buy To Order check box, you can also enter or find and select the Supplier identifier.
This defaults from the supplier designated for the part in the Part Maintenance > Part > Site sheet. Leaving
the Supplier field blank allows the buyer to define the supplier needed to fulfill the order.

9. For a Buy To Order sales release, select the Drop Ship check box if this order is drop shipped by your supplier
to your customer. This defaults from the Default Drop Ship value as defined for this part in the Part
Maintenance > Part > Sites >Details sheet.

10. The Ship To Address displays. This address defaults from the sales order header. If this release is sent to
an alternate location, click the Ship To button to find and select a different ship to address for this customer.

11. If your company ships to a distribution center instead of directly to a customer, you need to specify the final
destination of the order. To do this, click the Mark For sheet and define the Mark For Customer and Ship
To Address.
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12. Select a Tax Liability from the drop-down list to specify the tax liability for this sales release.

13. When you finish, click Save.

Sales Order Entry automatically assigns a number to the new release.

Build Order From History

Use the Build Order from History program to first review the most recent past orders placed by the customer,
and then generate new lines for selected items on the current sales order. The Build Order from History program
displays order information for all items ordered by a specific customer within the time frame value designated in
the Days Lookup For Order From History field. This value is defined within Company Configuration; the field
is located on the Modules > Sales > Order sheet.
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1. To build the order, from the Actions menu, select Build Order from History.

2. The Order History window displays. Enter a New Quantity for the part you need on the order.

3. Click OK.

The Epicor application generates a new order line for the part, and displays the part quantity using the unit
of measure contained in the UOM field. It also uses the price displayed in the New Price field as the price
for the newly ordered item.

Order Fulfillment/Allocation Processing

Use the Fulfillment Workbench to reserve or allocate inventory, in real-time, to specific sales orders, job orders,
and transfer orders. You can select specific demand transactions , based on comprehensive, user-specified search
criteria, and reserve or allocate inventory required to fulfill these transactions. This functionality is valuable when
you want to use jobs or inventory stock in a sequence that matches the allocation priorities assigned to your
customers in order to efficiently fulfill material quantity demand.
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A reservation refers to a quantity of inventory reserved at the warehouse, part, order, and release level; this
prevents the material quantities from being used on other order releases. An allocation refers to a quantity of
items that have been assigned to specific orders at the bin level. Once an order is allocated, that inventory is
locked to the particular order that was allocated. The allocation replaces the reservation for the order item; this
inventory quantity cannot be reserved or allocated to another order. As needed, you can release selected allocated
orders to the Material Request.

Prior to using the Fulfillment Workbench, you must set up your
parts, bins, warehouses, shop employees and warehouse teams.
For more information, review the Personnel chapter and
Warehouses and Bins chapter in the Epicor ERP Implementation
Guide.

Allocation Templates

You can define allocation templates for automation of the allocation process in the Fulfillment Workbench.
Multiple allocation templates can be defined, each with their own set of processing parameters. Using templates
saves time by automatically entering default parameters for each fulfillment allocation session. If you typically
handle allocations in the same way, create these templates.

Menu Path: Material Management > Inventory Management > Setup > Allocation Template

To add a template:

1. Click the New button on the Standard toolbar.

2. Enter the Template Code identifier. This value displays within related programs.

3. Enter a concise Description that explains the purpose of the template.

4. Select the Type from the drop-down list to specify if the allocation is by order or by wave. Waves are used
when you have similar orders shipping to the same or different customers. Instead of generating a pick
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transaction for each order individually, a wave groups the orders together and allows you to pick the inventory
from stock to shipping for all the orders at one time. By using waves, you can efficiently fulfill sales orders.

5. Select the Warehouse from the drop-down list. The warehouses entered in Warehouse Maintenance display
on this list.

6. Select the Demand Type from the drop-down list. The types include order, job, or transfer order.

7. Define the Inventory Allocation Search criteria to filter the search results. You can select the Warehouse
Zone which includes any warehouse zones that have been defined in Warehouse Zone Entry.

8. You can also specify the Bin Type for searching. Bin types include standard, managed, or both.

9. Several options exist for sorting available inventory. Search Sort options include FIFO (First In, First Out),
LIFO (Last In, First Out), Bin Ascending, Bin Descending, Quantity Ascending, Quantity Descending, and FEFO
(First Expiry Date First Out). FIFO, LIFO, and FEFO are only valid for lot-tracked items.

10. Specify the distribution Process Type for this template. At the time of allocation, you can select the
distribution process used to retrieve the inventory for the order. The options include:

• Pick/Pack – You print a pick ticket and use that ticket as a guide for picking. At the time of packing,
the Epicor application retrieves the inventory from the picking warehouse and moves it to the shipping
warehouse. A Pick/Pack type has its own transaction type that displays on the Material Queue. During
the packing process, the transaction is removed from the queue. These transactions cannot be accessed
via the handheld.

• Handheld Pick – You use the queues and either manually select a transaction to process or let the Epicor
application automatically assign transactions based on pre-configured groups. From the handheld, you
select the pick transaction for the specified order which immediately moves inventory from the picking
warehouse to the shipping warehouse. A Handheld Pick has its own transaction type that displays on
the Material Queue.
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11. Define the queue handling transactions. Select the Release To Picking check box to specify the allocated
inventory for the transactions can be released for picking and distribution.

12. Select the Enable Cross-Docking check box to create cross-dock transactions when no inventory is available
to allocate. Use the cross-docking process to allocate inventory not yet available (not on hand).

13. You can assign a team or user to any of the associated picking transactions that result from the allocation
process. Select a Warehouse Team Assignment or Warehouse User Assignment from the drop-down
lists.

14. Define the Transaction Priority based on the time-frame needed to ship the order. A higher priority
transaction is sequenced at the top of the queue. A lower priority transaction is sequenced at the lower end
of the queue.

15. Only available for wave picking, select the Allow Multiple Parts Per Bin check box to cause multiple parts
to be put into a replenishment or forward stocking bin. You can then define the destination for the allocation.

16. If you are allocating waves, select the Warehouse and Warehouse Zone from the drop-down lists to
specify the warehouse and zones available. Only zones with bins that have the Wave Replenishable check
box selected display in the list.

17. Select the Bin to specify the warehouse zone available. Select a bin if the wave pick is to a specific bin/floor
location. This option is available if a Forward Stage Group is not selected.

18. Select a Pack Station from the drop-down list to specify the shipping location. The pack station identifier
displays on the handheld or pick ticket to tell the warehouse employee (picker) where to take the inventory
to be packed.

19. Click Save.

Fulfillment Workbench

The Fulfillment Workbench is available only if your company uses the Advanced Material Management module.

Menu Path: Sales Management > Order Management > General Operations > Fulfillment Workbench
The CRM menu path is: Customer Relationship Management > Order Management > General Operations >
Fulfillment Workbench

To reserve inventory:

1. On the List sheet, enter a percentage in the Fulfillment %>= field to specify a filter for the search results.
Only orders that meet the specified percentage display in the search results.

Epicor ERP | 10.0.700194

Epicor ERP Application User Guide - Part OneChapter 5 | Sales Order Processing



For example, if you want to display orders that are 15% fillable, enter the percentage as 15, and only orders
that are able to be fulfilled 15% are included in the search results.

2. Click the Binoculars button to open the search window.

3. Specify the Fulfillment Range search criteria, which include Wave ID,Warehouse, Part, and date selections.

For more information on wave processing, refer to the
application help.

4. Enter the filter criteria by defining which types to Exclude or Include Only. These include Sales
Orders,Transfer Orders, Jobs, and order statuses (Reserved, Allocated,In Picking, and Picked). By
default, all types are included if the field is left blank.

5. Click Search. The records that match the search criteria display in the Search Results grid.

6. Select the records you want to manage; click Select All to select all the records.

7. Click OK.
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8. In this example, the selected records display on the Order Fulfillment sheet. If you need to make an
additional search, click the Search button to display the Search window described previously. The selected
lines are appended to the original search results.

9. To remove the search results from this sheet, click the Clear button

10. To mark a line for processing, click the Select check box that precedes the line.

11. You can select every line by clicking the Select All  button.

12. If you wish to only process the specific lines you have selected, click the Select button.

13. If you want to recalculate the OrderFill% and Avail to FulFill% values based on the sort defined for the
records displayed, click Refresh Fulfillment.

14. To reserve the inventory, click the Actions menu, highlight Reserve and select Primary Warehouse Only to
reserve the inventory in the warehouse specified as the primary warehouse. You can also select to reserve
in all warehouses, in the demand warehouse only, or select the inventory for release and picking.
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15. You can use the Supply sheet to view the material quantity as well as the inventory currently on hand. It
also shows you the quantities reserved, allocated, picking, picked, and fulfilled.

16. You can use the Job Fulfillment sheet to view the list of records for the Job demand type. Click the Search
button to open the Search window where you can enter filter criteria, including Wave ID and Job Number.

17. Use the Transfer Order Fulfillment sheet to view the list of records for the transfer order demand type.
Click the Search button to open the Search window where you can enter filter criteria, including Wave ID
and Transfer Order Number.

Allocate Inventory

To allocate inventory:

1. Select the records for which you want to allocate inventory. Click Actions > Allocate > Allocate By Part.
You can also select to allocate by lot/bin or serial number. Additional selections on the Actions menu provide
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you with the ability to release orders for picking, release orders for picking and unallocating/unreserving
previously fulfilled orders.

2. Select the Allocation Type from the drop-down list to specify if the allocation is by order or by wave. Select
Order to allocate orders being individually picked using Pick/Pack or Handheld Processing. Select Wave to
allocate orders being picking using wave picking techniques.

3. If you have pre-defined an Allocation Template in Allocation Template Maintenance, select it from the
drop-down list if you wish to use it for this fulfillment session.

4. If you have not defined any allocation templates, select the Ad Hoc check box for entry of on-the-fly ad-hoc
allocation parameters for the current fulfillment session only; the parameters are not saved for future use.

5. Click Continue to open the Ad Hoc Allocation Template window.
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6. Select allocation template information including warehouse and demand type (Sales Order, Transfer
Order, or Job).

7. Specify inventory allocation search criteria (including Warehouse Zone, Search Sort, and Bin Type) and
the Distribution Type (Handheld Pick or Pick/Pack).

8. Specify queue handling parameters for the allocation, including Warehouse Team Assignment, Warehouse
User Assignment, and Transaction Priority.

9. Select the Enable Cross-Docking check box to create cross-dock transactions if no inventory is available
to allocate; this creates a link between demand and expected inventory (receipts and production). The next
completed receipt (purchase, transfer, or job order production) with matching stock is then linked to the
matching cross dock record in the work queue. When the receipt transaction is entered, the cross dock
transaction automatically becomes a pick transaction, and shop floor/warehouse personnel can directly pick
the stock for the linked, allocated order.

10. Select the Release To Picking check box to release the allocated orders for picking.

11. Click Continue. Click OK to confirm.

Get Opportunity/Quote

You can automatically create a new order from an existing quote within Sales Order Entry. These quotes are
entered through Opportunity/Quote Entry. When you turn a quote into an order, all the detail lines on the quote
become identical detail lines on the new sales order.

To launch the Get Opportunity/Quote program within Sales Order Entry:

1. From the Actions menu, select Get Opportunity/Quote.
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2. The Create Order from Quote window displays. Enter or find and select the Quote you need. 

3. After you select a quote, its Terms, Ship Via, and other primary information displays.

4. Also notice the quote’s Due Date,Expiration Date, and other quote information displays.

5. In the Quote Lines grid, the detail lines created from this quote display. Verify that you want to generate
an order from these quote detail lines.

6. Click the Create Order button.
A new sales order is generated. The detail lines from the quote are now turned into detail lines within a
new order. If you need, you can edit this new order and its detail lines.

Order Job Wizard

When you complete a sales order, you are ready to turn this sales order into jobs. A key feature within Sales
Order Entry, use the Order Job Wizard to add a demand to an existing job or create new jobs from the current
order’s detail lines.

You can also use this program to pull in the manufacturing details for the part, schedule the job, and release it
to your manufacturing center.
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1. From the Actions menu, select Order Job Wizard.

The Order Job Wizard command is only available on the
Actions menu if the Make Direct check box is selected for
a detail line on the Releases > Detail sheet. This indicates
that the part quantity on the detail line is manufactured
and shipped directly to the customer, and that this
quantity is not to be pulled from inventory.

2. The Order Job Wizard program displays. The parts that are on this sales order display.

3. To create jobs for all the order lines, select the Select All check box.
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4. To pull all the part methods into the new jobs, select the Get All Methods check box.

Method of Manufacturing, or method, is the information
required to build a part. It includes the necessary
purchased and manufactured parts, as well as the steps
required to build the final product. The list of materials is
known as the bill of materials and the list of operations
is known as the routing or bill of operations. For more
information on methods, review the chapter on
Engineering.

5. You can automatically place the new jobs within the manufacturing center’s schedule by selecting the
Schedule All check box.

6. To release these jobs to manufacturing, select the Release All check box.

7. Now generate the jobs. To do this, click the Create Jobs button. If prompted for part validation, click Yes to
continue.

 You can also use the Order Job Wizard to link order
releases to existing jobs. For more information, read the
Order Job Wizard topics within application help.

Sales Order Acknowledgement

To communicate with your customer that the sales order is processed, use the Sales Order Acknowledgement.
Run this report after you have finished the sales order. You can then send the report out to your customer.

To generate this report for the current sales order:

1. From the Actions menu, select Print Sales Order Acknowledgement.
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2. The Sales Order Acknowledgement window displays.

3. Click the Filter  tab.

4. Select the sales orders for which you wish to print acknowledgements.

5. Click the Selection tab. Review the selection information.

6. To print the report, click Print on the Standard toolbar.

You can now send the Sales Order Acknowledgement to your customer.

Pricing and Discounting

The Epicor application utilizes a pricing system that gives you great flexibility for determining prices. Designed to
work with a variety of business practices, use this feature set to define a regular procedure for creating and
maintaining prices for your products.

Two kinds of discounting processes are available: quantity-based discounts and value-based discounts. You can
use a quantity-based discount system, a value-based discount system, or both. If both systems are used, the
Epicor application first calculates the quantity-based discounts. After this discount is applied, the Epicor application
next compares this new amount with the value breaks.

You can also define minimum and maximum discount limits on the customer or ship to location record. These
fields are located in the Customer Billing Detail sheet in Customer Maintenance. If the order exceeds these limits,
a different discount percent is applied to the order. You may also add an additional discount after the quantity-
and value based discounts have been calculated.
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Quantity-based discounting reviews the quantity on the order line and compares it to the quantity breaks set up
on a price list. The Epicor application then applies the discount that matches the quantity break. For quantity-based
discounting, the Epicor application uses the pricing hierarchy to search for the first available price list. Once it
finds a price list for the parts, it uses that unit price for quote or order detail line.

Value-based discounting takes the total amount on the order and compares it to the value breaks set up within
a price group. The Epicor application then applies the discount that matches the value break.

Price Groups

Use Price Group Maintenance to combine product groups for order-based pricing. After the Epicor application
has assigned a price to the products, the Epicor application then checks the discounting options defined for the
price group. Once the Epicor application has calculated the price against the selected discount option, it displays
a final price on the quote or order line.

Leverage this program to establish quantity - or value-based discounts based on the product groups identified
on each part in the Part master file.

Available discount options:

• Value of the total sale.

• Total quantity of the sale.

• Both value and quantity of the total sale.

Menu Path: Sales Management > Order Management > Setup > Price Group
The CRM menu path is: Customer Relationship Management > Order Management > Setup > Price Group

To create a price group:

1. Click the New button on the Standard toolbar.

2. Enter a unique code for the Price Group record and a Description.

3. Select the Order Based Value Discount check box.

4. Click Add All Available Product Groups to assign all product groups to the price group. Individual product
groups may also be added by clicking the New button and selecting New Product Group.
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5. Click the Down Arrow next to the New button; select New Order Value Break.

6. Enter the Order Value and associated Discount % for the price group.

7. Click Save.

Price Lists

Use Price List Maintenance to assign a specific price or discount to a part or product group. You can create price
lists in either the Quote Management module or Order Management module. However once a price list is created,
its pricing defaults are used in both the Opportunity/Quote Entry and the Sales Order Entry.

A price list must be assigned either to a specific customer (in Customer Maintenance), or to a customer group
assigned to a specific customer. The price lists then default into quotes or orders for that customer based upon
the part(s) on the line(s). Price lists require that a Start Date be defined; however, no end date is required for the
pricing, so the prices can stay in effect for as long as you need.

For any price list pricing to default into sales orders or quotes, the price list must be assigned to a customer (bill
to or ship to) or to a customer group.

Menu Path: Sales Management > Order Management > Setup > Price List
The CRM menu path is: Customer Relationship Management > Order Management > Setup > Price List

1. Click the New button on the Standard toolbar.

2. Enter a Price List code and Description.

3. Enter a Start Date and End Date.
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4. In the Type field, specify whether the price list is used to calculate Discount, Unit Price or Both. These
options provide a large degree of flexibility in terms how pricing and discounting operate with specific orders
and quotes.

• Discount – A price list that defines discounts when its values are matched with a corresponding Unit
Price List.

• Unit Price – A price list that displays gross unit prices. Discounts are not applied against these prices.

• Both – A price list that combines both gross unit prices and corresponding discount percentages.

You can link separate Discount and Unit Price lists to each
customer. When you do this, gross unit prices, discounts,
and net unit prices display in Sales Order Entry, Quote/
Opportunity Entry, and related programs. However if you
link a price list that uses the Both type, only the net unit
prices display in these programs.

5. Select the Currency used on transactions for this price list.

6. Click the Down Arrow next to the New button; select New Product Group.

7. Click the Group button to search for and select the appropriate product group for the price list.

You can also assign specific parts to a price list. Use this
feature to define pricing and discounting for specific or
multiple parts.
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8. Select the record you want from the search results and click OK.

After you have created price or discount lists, you must
assign them to customers in Customer Maintenance. To
see how to assign a price list to a customer, refer to the
Customer Maintenance - Price Lists section within the
chapter on Customers and Accounts Receivable.

9. In the UOM field, select a default unit of measure for the product group.
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10. Click the Warehouse tab to assign the warehouses to the price list.

11. To assign all the warehouses to the Price List, click the Double Arrow button. All the warehouses move
into the Selected Warehouses list.

12. Next, assign the quantity break discounts to the product group assigned to the price list. Click the Down
Arrow next to the New button; select New Product Group Quantity Break.

13. Enter the first Quantity Break to define the order break at which this discount takes effect.

14. Select the Discount Type from the drop-down list. The options include Discount % (Percent) or Unit
Price.

15. When Discount % is selected as the discount type, you enter the percentage in the Discount Pct column.
When unit price is selected, you enter a dollar amount in the Unit Price column.

16. Continue entering remaining quantity breaks, as required for the price list.
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Sales Kitting

Use the Sales Kitting functionality to sell a part type that contains a series of related parts called a sales kit. These
part records define the individual component parts needed to complete the kit. If you have the Configurator
module, you can create sales kits with multi-level configured parts that include non-stock components. When a
sales order is created for a sales kit, the component parts are pulled from your stock in the quantities required
to complete the final sales kit quantity.

You can set up these part records so that kits either can or cannot be modified. For example, your company sells
computer systems. You have a standard computer kit that always uses the same processor, monitor, keyboard,
and mouse. You also sell a custom computer kit where the customer can choose different components, such as
multiple monitors, hard disk sizes, and colors. Both kit types are supported by the sales kitting functionality.

A sales kit is sold through a single detail line on the sales order. Pricing can be determined at either the parent
part or component part level. Price lists can also be used for the parent part and its component parts. Although
kits are sold as a single sales order line item, each part component can also be displayed as separate lines on the
Sale Order Acknowledgment, quote, packing slip, and invoice.

Component Parts

You create a sales kit by first entering its component parts and then defining the parent part. You create these
records in Part Maintenance. To create configured components, you would use the Configurator module. To
learn more about creating configured part components, review Chapter 6: Configurator.

Menu Path: Sales Management > Order Management > Setup > Part
The CRM menu path is: Customer Relationship Management > Order Management > Setup > Part

To set up a sales kit component part:
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1. Click the New button on the Standard toolbar.

2. Within the Part ID and Description fields, enter an identifier and a concise explanation for the part
component.

3. From the Type drop-down list, define whether this component part is Purchased or Manufactured.

4. Select a unit of measure class from the UOM Class drop-down list to specify the class type.

5. Optionally enter a Sales Unit Price for the part. This defines the specific price for the component part. If
you leave this field blank, however, you can use price lists to determine the final price for the component
part.

Epicor ERP | 10.0.700210

Epicor ERP Application User Guide - Part OneChapter 5 | Sales Order Processing



6. Click the Down Arrow next to the New button; select New Site.

7. On the Sites > Detail sheet, define the Primary Warehouse that stocks this component part.

8. From the Costing Method drop-down list, select the costing type.

9. If this part is a non-stock component, select the Non-Stock Item check box.

10. From the Type drop-down list, indicate whether this part component is purchased or manufactured.

11. Within the Inventory section, define the Maximum On-Hand and Minimum On-Hand quantities that
should be maintained for this component part.

12. On the Standard toolbar, click Save.

To learn about the other fields and features available
through this program, review the Part Maintenance
sections within the chapter concerning Engineering.

Continue to create all the component parts you need for the final sales kit.

Parent Parts

After you enter the component part records, you are ready to define the parent part. This record defines the
main options on the sales kit. You also select this part record on quote and sales order detail lines. You create
parent part records within Part Maintenance.

To complete the kit, you next open the part within the Engineering Workbench and create a bill of material, or
BOM, for the part record. This bill of material lists the component parts required to complete the kit.

First, you define the parent part within Part Maintenance. Here’s how:
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1. Click the New button on the Standard toolbar.

2. Within the Part ID and Description fields, enter an identifier and a concise explanation for the parent part.

3. From the Type drop-down list, select the Sales Kit option.

4. Select a unit of measure class from the UOM Class drop-down list to specify the class type.

5. Optionally enter a Sales Unit Price for the part. This defines the overall price for the kit. If you leave this
field blank, however, two other methods are available for generating prices. You can total the prices of all
the component parts to generate the final kit price; you can also use price lists to determine the final price.
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6. Click the Down Arrow next to the New button; select New Site.

7. On the Sites > Detail sheet, define the Primary Warehouse that stocks this parent part.

8. From the Type drop-down list, select the Sales Kit option. This activates the fields on the Sales Kit sheet;
this sheet defines the main options for the sales kit. The next section, Parent Parts – Sales Parameters, explains
these options.

9. Within the Inventory section, define the Maximum On-Hand and Minimum On-Hand quantities that
should be maintained for this parent part.

10. On the Standard toolbar, click Save.

Parent Parts – Sales Parameters

Use this sheet to define the main aspects of the sales kit. The options you select here affect how this sales kit is
assembled, purchased, and displayed throughout the sales kitting process. To activate the fields on this sheet,
you need to select the Sales Kit option from the Type drop-down list on the Sites > Detail sheet.
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1. To display this sheet, click the Sales Kits tab. The options are displayed within the Sales Kit
Parameters section.

2. If you select the Allow Component Update check box, users can change the component parts that make
up the kit. Select this option for sales kits that can be modified for different kit combinations, such as
customer selections, during the sales order entry process.

3. The Allow Parameter Changes check box indicates that users can change the sales kit parameters directly
on quotes and sales orders. This causes the Sales Kit Params button to activate on the Line > Detail sheet
within both Opportunity/Quote Entry and Sales Order Entry; users can click this button to display and
change the sales parameters.

4. When the Backflush Kit Components check box is selected, it causes the component parts to be
automatically pulled from stock. If this check box is clear, each component part quantity must instead be
pulled individually from stock.

5. The Must Ship Kit Complete check box indicates all the component part quantities must be packaged
with the sales kit before it can be shipped to the customer. This sales order detail line cannot be closed
unless all the parts are shipped at once.

6. When you select the Print Components On Pack Slip check box, the application displays each component
part on a separate line on the packing slip. When this check box is clear, only the sales kit part’s information
displays.

7. Use the Print Components On Customer Documents check box to display each component part on a
separate line on the quote, Order Acknowledgement, and invoice. When this check box is clear, only the
sales kit part’s information displays.

8. Use the Price Type drop-down list to define how the system calculates the price for the sales kit. If you
select Parent Pricing, the total price is pulled from the Sales Unit Price field on the parent record. If you
select Component, the individual Sales Unit Price values on each part component are added together to
generate the final price.

If you leave the Sales Unit Price fields blank on the
component parts and parent part records, price lists can
instead be used to determine the sales kit’s final price. To
learn more, read the previous Pricing and Discounting
section in this chapter.
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Finish the Sales Kit Record

After you enter the parent part and the component parts, you are ready to complete the sales kit. You do this
within the Engineering Workbench by adding the component parts to the parent part’s bill of material (BOM).

The Engineering Workbench is a program found within the
Engineering module. This section briefly describes how to use
the Engineering Workbench for sales kitting. To learn more
about this program, review the chapter on Engineering.

To finish creating the sales kit part:

1. Click the Down Arrow next to the New button; select New Part Revision.

2. The Revisions > Detail sheet displays. In the Rev field, enter the new revision’s level.

3. In the Effective field, enter the date on which the revision can begin to be used.

4. In the Description field, enter a concise explanation for the revision.

5. Next, click the Actions menu, highlight the Revision sub-menu, and select Check Out Revision.
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6. The Part Revision Checkout window displays. Select the revision that you want to update, or engineer,
from the Revisions grid.

7. Revisions need to be checked out into an Engineering Change Order (ECO) group. Enter this Group ID
directly, or click the ECO button to find and select the group you need.

8. Click OK.

9. You can now launch the part revision within the Engineering Workbench. Click Actions > Revision >
Engineering Workbench.

10. The Engineering Workbench displays. To create the bill of material (BOM), click the Method of
Manufacturing > Engineering > Parts tab.

11. Click the Part button to find and select the component part records you need.

12. After you exit the Part Search program, the parts you selected display within the Parts grid. Select a
component part.

13. Click and drag this part under the Materials branch on the Tree View. The part is now a material required
for assembling this part. Continue adding all the component parts to the Tree View.

14. When you finish, click Save.
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15. Now click the Revision > Detail tab.

16. Select the Not Approved check box. This check box changes to Approved.

Check In Sales Kit Part

You now must check the part back in.

1. Click the Actions > Revision > Check In.
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2. Enter a description of the change, and click OK. A message displays that states the check in is complete.
Click OK.

You have finished creating the sales kit. You can now create quotes and orders for this sales kit.

Sales Order Entry – Sales Kits

A sales kit is entered as a single detail line within Sales Order Entry. You enter the main quantity for the sales kit
on the Lines > Detail sheet.

You follow a similar process to add a sales kit detail line to a
quote within Opportunity/Quote Entry.

As the sales order is processed, the component part quantities needed to satisfy each kit are manufactured and
pulled from stock.

To create a detail line for a sales kit:

1. Click the Down Arrow next to the New button; select New Line.
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2. Enter the sales kit part identifier directly, or click the Part/Rev button to find and select it.

3. In the Order Quantity field, enter how many sales kits the customer is ordering.

4. If the sales kit is set up so that users can change its parameters, the Sales Kit Params button is active. Click
this button.

5. The Sales Kit Parameters window displays. Make any changes that you need to the sales kit.

6. When the Allow Component Update check box is selected, you can change the sales kit components
during the sales order entry process.

7. When you finish, click OK.

8. To add a new component to a sales kit, click the Down Arrow next to the New button; select New Sales
Kit Component.

9. Enter the Part number for the component part that you are adding to the sales kit.

10. Now enter the Quantity Per Kit value and unit of measure; this value defines the number of component
parts required to complete the kit.
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11. If you need to remove a component part from the sales kit, highlight the component part on the Kits Detail
> List and click the Delete button on the Standard toolbar.

12. You can also view the sales kit components on the Summary sheet in the Order Lines grid.

13. Within the Order Lines grid, select the Kit Details check box.
The parent part and the component parts now display within the Order Lines grid.

Sales Order Entry – Sales Order Acknowledgement

After you have finished the sales kit, you can view the sales kit’s part components printed on the Sales Order
Acknowledgement.

To generate this report for the current sales kit:
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1. From the Actions menu, select Print Sales Order Acknowledgement.

2. The Sales Order Acknowledgement window displays.

3. Use the Filter sheet to limit the report by specific sales orders and demand contracts.

4. Use the Selection sheet to define the report style.

5. To print the report, click Print on the Standard toolbar.

The Sales Order Acknowledgement report displays. The sales kit part components print on separate lines.
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Chapter 6: Time Management

Use the Time Management module to enter and manage employee labor hours. You use Time Management programs
to enter, approve, and correct time transactions, and to set defaults used in the time approval process.

Employees, managers, and department supervisors typically use Time Management to enter and manage their own
time entries and the time entries of other employees. When configured, an optional approval process can require the
approval of time entries before time is posted in the Epicor application.

Typically, employees enter their labor hours on a daily or weekly basis and then submit their hours for approval.
Authorized approvers then review, correct, approve, or reject the time transactions. Reports are available to generate
employee timesheets and to help manage employee work hours and percentage utilization.

Employee Maintenance and Site Configuration Control are programs you use to define the approval process. Depending
on the particular needs of your company, you may also use additional programs, such as Project Entry.

Setup

This section describes the primary records you need to create for the Time Management module. Only the primary
records are described here. Some areas within the next Operations section may also document setup records if
these items are required for a specific workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for this module;
the Configuration topic details the options you define within Company Configuration. You can also review the
Company Configuration chapter in the Epicor ERP Implementation Guide.

Site Configuration

Use the Site Configuration Control program to determine if time transactions require approval or to bypass the
approval process entirely. You also define the approval logic, or method, used to approve indirect time and
production time. You can set the approval method to approve transactions automatically, or to approve transactions
according to a setting in Employee Maintenance.

Menu Path: System Setup > Company/Site Maintenance > Site Configuration

This program is not available in the Epicor Web Access.

1. Click the Site button to find and select the Site you need. The Name of the selected Site displays. 
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You define the project time approvals on each project as
appropriate.

2. Navigate to the Modules > Time and Expense > Time sheet.

3. Select the Restrict Entry check box to restrict all employees from entering time for other employees. When
selected, you designate users who can enter time for a specific employee in Employee Maintenance. Clear
the check box to allow any user to enter time for any employee.

4. If you selected the Restrict Entry check box, you can select the Supervisor Allowed Entry check box to
allow designated supervisors to enter, modify, and delete time transactions on behalf of the employees they
supervise. Employee supervisors are designated in Employee Maintenance.

5. Select the Submit on Save check box to automatically submit new Time entries when you click Save. If you
select or clear this check box in Time and Expense Entry, you override this default Site setting.

6. If you want approvers (supervisors) to validate all time entries submitted by employees, select the Approval
Required check box.

7. If you want approvers (supervisors) to validate all time entries submitted by employees in the Manufacturing
Execution System, select the MES Labor Approval Required check box.

8. Use the Rights section to define whether approvers can delete or change time transactions submitted for
approval by employees.

9. Use the Logic section to define the approval method for indirect time transactions and production time
transactions submitted by employees. If the method is Automatic, time is approved automatically upon
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submission. If the method is Employee, then the transactions are approved as defined in Employee
Maintenance.

You define the project time approvals on each project as
appropriate.

10. Use the Time Defaults section to define a default Time Workflow Group used to approve time if a time
workflow group is not defined in Employee Maintenance.

11. When you finish, click Save on the Standard toolbar.

Time Type

Use Time Type Maintenance to define different charge rates for labor hours. For example, you may want to define
time types for higher rates charged for overtime hours or labor performed on weekends. You use time types in
Time Entry when entering time for project labor; a different charge rate is applied to the hours worked instead
of the charge rate associated with the employee’s project role code.

Menu Path: Service Management > Time Management > Setup > Time Type

To enter a new time type:

1. Click New on the Standard toolbar.

2. Enter the Time Type identifier for the new time type.

3. In the Description field, enter a description of the time type.

4. Leave the Inactive check box clear to indicate the time type is available in the application.

5. When you finish, click Save.

Employees

If you set options in the Site Configuration Control program to define approvals according to settings in Employee
Maintenance, additional setup is required. You use Employee Maintenance to define whether time for a specific
employee is approved automatically or by a specific workflow group. You also assign a mandatory supervisor
which may be used during the approval process. You can restrict who can enter time for another employee in
this program.
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For details about other setup requirements in Employee
Maintenance, review the Personnel chapter in the Epicor ERP
Implementation Guide.

Menu Path: Service Management > Time Management > Setup > Employee

To set up an approval workflow for a specific employee:

1. On the Detail sheet, click the ID button to find and select the employee record you need. The selected
employee record displays in the sheet.

2. You can also click the   Person / Contact button to find and select the individual you want to define as an
employee.

If you have an individual who needs to be defined on
multiple records like a shop employee who is also a buyer,
you can define this person in Person / Contact
Maintenance first and then link this person record to other
records throughout the application. To learn about this
functionality, review the Personnel chapter in the Epicor
ERP Implementation Guide.

3. Click the Supervisor button to find and select a supervisor for this employee. If the Approval Required
check box is selected in the Site Configuration Control program, then each employee must have a designated
supervisor. The supervisor is the approver when the approval process is not automatic and you have not
designated a workflow group in Employee Maintenance or Site Configuration Control.
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4. Navigate to the Time and Expense > Time > Detail sheet.

5. Select the Auto Approve Time check box to automatically approve time transactions.

6. Alternately, select a workflow group from the Workflow Group drop-down list to designate a workflow
group to approve time transactions.

7. You can view the workflow group you selected. To do this, click the Approval Tasks tab.

8. Expand the workflow group tree to review the different tasks defined for the workflow group.

9. When you finish, click Save on the Standard toolbar.

Restrict Entry

If you selected the Restrict Entry check box in Site Configuration Control, you must also define who can enter
time for specific employees in Employee Maintenance. Designated users can enter time for employees in Time
Entry.
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1. Navigate to the Production Info sheet.

2. In the User Name field, select the user who can enter time for the employee.

3. When finished, click Save on the Standard toolbar.

As a result, the designated user can enter the employee’s ID in Time Entry, and enter time for the employee.

You can restrict an employee from entering their own
time by selecting the Disallow Time Entry for user
assigned to employee check box on the Time and
Expense > Time > Detail sheet in Employee
Maintenance.  You can also identify an employee (for
example, a payroll manager) in User Account Maintenance
with the ability to update time or expense records for
employees.

Indirect Labor

Use Indirect Labor Maintenance to create labor codes you leverage to track labor performed during the work
day that is not associated with a specific project or job. Indirect labor codes are available in Time Entry when
employees are entering time for indirect labor.

Menu Path: Service Management > Time Management > Setup > Indirect Labor

To create a new indirect labor code:

1. Click New on the Standard toolbar.
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2. In the Code field, enter an identifier for the new indirect code.

3. In the Description field, enter a description of the indirect code.

4. In the Expense Code field, select the code you need. The labor expense code displays as the default during
time entry when you enter the indirect code, and it defines the type of labor recorded within the general
ledger.

5. When you finish, click Save.

Role Codes

Role codes define a position an employee carries out on a job or project. Employees can have approval roles on
time entries, expense entries, and projects. Roles also define supervisor and labor positions. You create roles
within Role Code Maintenance and you later select these codes on quick entries and workflow groups.

Menu Path: Service Management > Time Management > Setup > Role Code

To create a new role code:

1. Click New on the Standard toolbar.

2. Enter the identifier for the new record in the Role field.

3. Enter a Description for the new role. This value displays on Role drop-down lists throughout the application.

4. If employees will receive commission through this role, select the Commissionable check box. Commission
rates are defined on quotes and sales orders.

5. Optionally, select the Resource Group Billing Rates check box to indicate you wish to define expense
rates for this role. You can then enter the expense rates you need for this role on the Rates > Detail sheet.
You use this functionality with project billing.

6. Selecting the Resource Group Billing Rates check box activates the Primary Resource Group button. Use
this button to find and select the resource group you wish to use for billing expenses on the project. After
you select a resource group, its Description displays automatically.

7. Select the Time and Expense Approval Role check box to indicate employees assigned to this role can
approve both time and expense transactions other employees enter.
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8. Select the Project Manager Approval Role check box to indicate employees assigned to this role manage
work within a project. When you select this role within Workflow Group Maintenance, the time and expense
approval process creates an approval task for the project manager.

9. Use the Supervisor Approval Role check box to indicate employees assigned to this role work as supervisors
over tasks carried out on jobs and projects. Selecting this check box activates the Level field. Use this field
to define how many levels of supervisors are above the current employee assigned to this role. For example,
0 indicates no further approval is required for the employee, while a 1 indicates the employee’s supervisor
must also approve the task.

If you select more than one approver role option, tasks
will be created for all individuals matching those role
criteria.

10. Select the Employee Submit Role check box to indicate employees assigned this role perform labor on
the job or project. This information is then used when creating tasks for time and expense approvals.

11. Because you determined that this role requires resource group billing rates, you next must add these rates.
To do this, click the Down Arrow next to the New button; select New Role Rate.

12. Define how long this rate will be active within the Effective Date and End Date fields.

13. Click the Currency drop-down list to define the currency used with this rate.

14. Enter the rate you need within the Charge Rate field. This rate is calculated using the currency you selected.

15. Now select the Time Type you want linked to this rate. This value determines what kind of labor will be
performed through this rate, like week day labor or overtime pay.

16. Continue to add the rates you need. When you finish, click Save.

Quick Entry Codes

Use Quick Entry Maintenance to define frequently used time entries and to associate them with a quick entry
code. You use quick entry codes when entering time in Time Entry. You can enter a quick entry code to populate
the entry with the time defaults; thus time transaction entry is faster and more efficient. For example, a quick
entry code is useful when you are working on a project and entering time for the same task every day. Your
employees define the quick entry codes they need.
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Menu Path: Service Management > Time Management > General Operations > Quick Entry Code

To enter a new quick entry code:

1. On the Detail sheet, click the Employee ID button to find and select the employee record. The selected
employee record displays on the sheet.

2. Click the Down Arrow next to the New button; select New Time Quick Entry.

3. The Time > Detail sheet displays. In the Quick Entry field, enter a unique identifier for the quick entry
code.

4. Click the Labor Type drop-down list  to select a labor type for the time quick entry code. The labor type
determines which fields are available for definition. You can select Indirect, Production, Project, Service, or
Setup. Depending on what you select, different fields become active on this sheet.

5. If you select the Project labor type, the Project button activates. Projects define complex initiatives your
company is working on. Click this button to find and select the project you need. You can also enter the
Project identifier directly. You create projects within Project Entry; review Chapter 8: Project Management
for more information.

6. Selecting a Project labor type activates the WBS Phase button. Click this button or use the drop-down list
to select the Work Breakdown Structure (WBS) phase you wish to link to this time quick code entry.

7. If you select the Production, Service, or Setup labor types, the Job button activates. Use this button to find
and select the specific job you wish to associate with this time quick code entry.
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8. After you select a job, the Assembly and Operation buttons and fields activate. If you need, use these
controls to define a specific assembly or operation you wish to include.

A job can also be linked to a WBS Phase. If this is the case,
the Job number displays by default, and you can then
select the Assembly and/or Operation you need.

9. Roles define a position the employee carries out on a job or project. If you need to associate a role with this
time quick code entry, select it from the Role drop-down list. You create roles within Role Code Maintenance.

10. Time types define different charge rates you use for labor hours. For example, you might create a time type
for overtime hours. Select the Time Type you need from the drop-down list.

11. If you select the Indirect labor type, the Indirect drop-down list activates. Select the indirect code you need
to associate with this time quick code entry.

12. Click the Expense Code drop-down list to define what expense type – like Inspection, Grinding, and so on
– to link to this time quick code entry.

13. If active, select the Resource Group and/or Resource you need to associate with this time quick code entry.
Resources define machines and employees involved in the production process.

14. Enter the Labor Hours you need for this entry.

15. When you finish, click Save on the Standard toolbar.

16. The time quick entry code displays in the Tree View. Notice all of the time quick entry codes and expense
quick entry codes for the selected employee display on this Tree View.
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Operations

This section details the operations available in the Time Management module. Each operation is described as a
workflow (sequence) to help guide you through the process from start to finish. These programs are primarily
found within the General Operations folder for this module. If a unique setup record is required to run the
operation, this record is also described in this section.

Time Entry

Use Time Entry to enter employee hours for indirect labor, production labor, or project labor and submit those
hours for approval. You can enter time on a daily or weekly basis. After time transactions are entered, you can
view, modify, recall, and copy them. You can also monitor the status of entered transactions and enter comments
for approvers.

The sheets in Time Entry provide different ways for entering time. The sections that follow demonstrate some of
the ways you can enter time.

Menu Path: Service Management > Time Management > General Operations > Time and Expense Entry

Daily Time Entry

Use the Daily Time > Detail sheet to enter labor hours for a single item and submit them for approval. The labor
type you select when entering time determines the fields available on the sheet.

To enter a new time transaction in the Daily view:

1. On the Employee sheet, enter the Employee identifier or click the Employee ID button to find and select
the employee for whom you are entering time.

2. The current date displays in the Calendar by default. Click another date to change it.
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3. Navigate to the Time > Daily Time > Detail > Detail sheet. 

4. Click the Down Arrow next to the New button; select New Time Detail.

5. From the Labor Type drop-down list, select the type of labor performed. The labor type determines which
fields are available for entry in the sheet, and default values populate some of the fields. This example uses
the Indirect labor type.

6. In the Labor section, use the Clock In and Clock Out values or enter the time in the Labor Hrs field to
define the time the employee performed the labor.

7. Select an Indirect Code for the labor performed.

8. Select an Expense Code for the labor performed.

9. Select the Submit on Save check box to automatically submit new Time entries when you click Save. If you
select or clear this check box in Time and Expense Entry, you override this default Site setting.

10. The Location section defines the default resource group, department information, and resource for this
transaction. You can change these options if you need.

11. When you finish, click Save on the Standard toolbar.

Weekly Time Entry

Use the Time > Weekly Time sheet to enter and submit time for a week. Fields in this sheet display in a grid
format for easy entry. Press the <Tab> key to quickly move through the fields and enter values.
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1. In the Calendar, select a date during the week for which you want to enter time. 

2. Click the Down Arrow next to the New button; select New Weekly Time.

3. The Time > Weekly Time sheet displays.

4. Tab to the Labor Type drop-down list and select the type of labor.

5. Select the  Job, Assembly, and Operation for the labor performed.

6. Tab to the fields for the days of the week; enter the number of labor hours performed for each day.

7. When you finish, click Save on the Standard toolbar.

8. Click the Submit button to submit the time entered for the week for approval.

Calendar View Time Entry

The Calendar sheets display your time entries for review by day, week, or month. You can also use the Calendar
to enter time.
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1. Navigate to the Calendar > Day sheet.

2. Select a date in the Calendar section.

3. You can view the Day, Week, or Month for the selected date. Click the Month tab.

4. The Month of the selected date displays with the date highlighted. Right-click and select New Time Detail.
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5. The Daily Time > Detail sheet displays. From the Labor Type list, select the type of labor.

6. In the Project section, select the Project, WBS Phase, and Operation.

7. Enter the time in the Labor Hrs field.

8. Depending on the configuration of your application, default values may populate the remaining fields in
the Labor and Location sections. You can change these values as needed.

9. When you finish, click Save on the Standard toolbar.

MES Time Entry

If your company uses the Manufacturing Execution System (MES) interface to record labor performed against
jobs, you can view time records created through the MES interface in Time Entry. The MES interface is designed
for users within a manufacturing environment. You can enter labor against specific operations on selected jobs
in the MES.

When you first launch the MES, you need to log in and select the activity you are working on.
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1. Enter your Employee ID, and press the Tab key on your keyboard. You are now logged into the MES.

2. To begin tasks on an operation, click the Start button for the type of activity you are performing. You can
select Start Production Activity, Start Indirect Activity, Start Setup Activity, or Start Rework Activity.

3. The appropriate Start Activity window displays. This example is for a production activity. Enter or search
for the Job you need to work on.

4. Select the Assembly and Operation.

5. When you finish, click OK. You are now working on this operation. The clock is active, so the MES is
calculating labor time against this operation.
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6. To stop working on this activity, click the End Activity button on the MES Menu.

7. The End Labor Activity window displays. Click OK.
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8. To end your MES session, click the Log Out button on the MES Menu.

9. To close the interface, click the Close button.

10. Now to review your time entries, log into the Epicor application and navigate to Time and Expense Entry.
Menu Path: Production Management > Job Management > General Operations > Time and Expense
Entry

11. To display the labor entries, navigate to the Time > Daily Time > Summary > Detail sheet.

12. In the Calendar pane, click the date you performed the work. The labor entries display on the sheet.
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Selection Calendar

You can use the time entry selection Calendar to review and manage your time entries and the time entries of
your employees. The selection Calendar determines the time transactions that display in the time entry tree,
indicates the status of the transactions, and loads transactions into the time entry grids for review.

Menu Path: Service Management > Time Management > General Operations > Time and Expense Entry

1. In the Employee field, enter your Employee ID.

2. By default, the current date is selected in the Calendar.

3. Review the selection Calendar. Color indicates a time transaction has been entered on the date. Green
indicates a time transaction and red indicates a rejected time transaction.

4. Select a date in the selection Calendar to review time transaction details. You can use the Shift key or click
and drag to select and view multiple dates.
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5. Expand the date within the Tree View to see the transactions entered. Icons indicate the status of a
transaction.

6. Select a date in the tree to display transaction details on the Time > Daily Time > Detail > Detail sheet.

7. Click the List tab to view a list of each time entry. Each time entry displays in a separate row. Use the scroll
bars to review the details.
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8. Click the Approvals tab to see who is assigned to approve the transaction.

Approval Workflow

Configure the application to define an approval workflow for time transactions entered by employees and
submitted for approval in Time Entry. An approval workflow is the process a time transaction must complete to
be approved.

When approvals are required, you define an approval workflow for indirect time, production time, and project
time. Approval workflows for indirect time and production time follow the same process flow.

An approval workflow for project time transactions is similar
to a workflow for indirect time transactions, except that you
have the additional option to use a workflow defined on a
project or a project Work Breakdown Structure (WBS) phase.
Also, the approval logic, or method, used for project time is
set on the project instead of in the Site Configuration Control
program.

Supervisor approval is the default approval workflow for the application when approvals are required. To use
this approval workflow, you select the Approval Required check box in Site Configuration Control. For more
information, see the Site Configuration Control section earlier in this chapter.

If you require a more complex approval process using multiple approvers or multiple levels of approvals, you can
define one or more approval workflow groups using tasks, task sets, and workflow groups. The sections that
follow discuss the approval workflow configuration for indirect and production time.

You can define an approval workflow that applies to all employees or specific employees. An approval workflow
can be as simple as requiring approvals by employee supervisors or as complex as requiring multi-level approvals
by different workflow groups for specific employees.

You define approval workflows mainly through the Site Configuration Control program. If you define an approval
workflow using Employee as the approval logic method, additional setup is required in a variety of programs,
including Employee Maintenance.

When a workflow uses Employee as the approval logic method and you want to designate a group of employees
as approvers, you must also set up a time workflow group for approving time transactions. A workflow group
is made up of tasks, task sets, and group members assigned to an approver role. Once you create a time workflow
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group, you can use it in Employee Maintenance to associate it with a specific employee, or you can set it as the
default time workflow group in Site Configuration Control to apply it to all employees.

You can define time approval workflows either using a
pre-defined workflow group template or manually using your
own workflow. This chapter describes how to manually define
your own workflow. The process for defining approval
workflows using a pre-defined template is discussed in the
chapter called Expense Management.  

Tasks

An approval task is the approval of a time transaction performed by a user belonging to a defined role. You use
Task Maintenance to define one or more approval tasks. A task is a combination of approving time plus an
approver role. For example, you define a task named Time Approval Task, which consists of an approve time task
assigned to an approver role named Time Approver. You can assign one or more users to an approver role.

Tasks are used throughout the application. In the following
sections, the tasks described are for use within Time
Management.

You can also define a hierarchical approval process which requires two or more levels of approvers to approve
a time transaction. To define a hierarchy of approvers, define an approval task for each level of approval, such
as a task named First Approval with an assigned First Approver role, and a task named Second Approval with an
assigned Second Approver role.

Roles

Tasks require roles. Before you create approval tasks, you must first create approver role codes. Create an approver
role code for each approval task.

Menu Path: Service Management > Time Management > Setup > Role Code

To create time approver roles:

1. Click the Down Arrow next to the New button; select New Role Code. 

2. Enter a Role code ID.

3. Enter a Description for the First Approver role. 
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4. Select the Time and Expense Approval Role check box.

5. Click Save on the Standard toolbar.

Repeat these steps to create additional roles if you are defining an approval hierarchy needing more levels.

Tasks

After you have created approver roles, you are ready to create approver tasks. You must create a Submit Task.

Menu Path: Service Management > Time Management > Setup > Task

To create time approval tasks:

1. Click New on the Standard toolbar.

2. Enter a Task ID for the First Approval Task.

3. Enter a Description for the First Approval Task.

4. In the Task Type list, select Time & Expense Approval.

5. From the Role Code drop-down list, select First Approver. This option associates the approval role with the
task.

6. To require users to complete this task, select the Mandatory check box.

7. Select the Any Approver check box if you want to assign multiple approvers to the role, and you only want
to require any one of them to approve a transaction. Clear the check box if you want to require all users in
the role to approve a transaction.

8. Click Save.

Repeat these steps if you are defining an approval hierarchy with more than one level.
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Task Sets

A task set is a group of organized tasks and milestones. A time approval task set must include all the approval
tasks required to approve a time transaction. For example, a simple task set might include a single approval task.
If you use an approval hierarchy, you must include all other tasks.

Menu Path: Service Management > Time Management > Setup > Task Set

To create a time approval task set:

1. Click the Down Arrow next to the New button; select New Task Set. 

2. Enter a task Set ID and a Description for the task set.

3. Click the Workflow Type drop-down list and select Time & Expense.

4. Click Save on the Standard toolbar.

5. Add milestones for each approval task included in the task set. To do this, add a new milestone for each
task in sequential order, such as First Approval and Second Approval.

6. Select the First Milestone check box for the milestone that begins the series.

7. Click Save after adding each new milestone.
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8. Clear the First Milestone check box on the second milestone.

9. Associate each milestone with the next milestone. To do this, select the First Approval Task milestone.

10. Click the Down Arrow next to the New button; select New Next Milestone.

11. The Milestones > Next Milestones > Detail sheet displays.

12. Click the Next Milestone drop-down list and select the Second Approval Task.

13. Click Save.
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14. When you finish, the task set structure is defined in the Task Sets tree.

Workflow Group

A time approval workflow group consists of a time approval task set and the group members assigned to the
approver roles. You set up a time approval workflow group and assign group members in Workflow Group
Maintenance. You can set up one or more workflow groups as needed, and apply them to specific employees
or use one as the default for all employees.

Menu Path: Service Management > Time Management > Setup > Workflow Group

To create a time approval workflow group:

1. In the Workflow Type list, select Time & Expense.

2. Click the Down Arrow next to the New button; select New Workflow Group.

3. Enter a Workflow Group identifier.

4. Enter a Description for the group.

5. Click the Default Task Set drop-down list to select the time approval task set for the workflow group.

6. Click Save on the Standard toolbar.
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7. Click the Down Arrow next to the New button; select New Group Member.

8. The Group Member > Detail sheet displays.

9. Click the Member drop-down list and select the employee you want to add to the workflow group.

10. Click the  Role drop-down list and select the approval role you want to assign to the group member from
the approval task set.

11. When you finish, click Save on the Standard toolbar.

Workflow Setup Example – Indirect Time

The example here defines an approval workflow for indirect time. This workflow uses Employee as the approval
method for time transactions, and it applies a specific time workflow group to the employee.

Site Configuration Control

Menu Path: System Setup > Company/Site Maintenance > Site Configuration

This program is not available in the Epicor Web Access.

1. Click the Site button to find and select the Site.

2. The Name of the selected Site displays. 
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3. Navigate to the  Modules > Time and Expense > Time sheet.

4. Select the Approval Required check box to require approval of all time entries submitted by employees.

5. Click the Indirect Approval Logic drop-down list to select the method for approving time transactions.
Select Employee to approve time transactions as defined in Employee Maintenance.

6. If you need, select an optional default Time Workflow Group.

7. When you finish, click Save on the Standard toolbar.

Employee Maintenance

Menu Path: Service Management > Time Management > Setup > Employee
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1. On the Detail sheet, click the ID button to find and select the employee record you need.

2. Navigate to the Time and Expense > Time > Detail sheet.

3. Clear the Auto Approve Time check box.

4. Click the Workflow Group drop-down list to select the time approval workflow group.

5. When you finish, click Save on the Standard toolbar.

Time Approval

Use the Time Approval program to review, approve, or reject time transactions submitted by employees. Depending
on the configuration of your company, authorized approvers can modify submitted transactions or delete existing
transactions during the approval process. Approvers can enter optional comments for review by the submitters
of the transactions.

Epicor ERP | 10.0.700250

Epicor ERP Application User Guide - Part OneChapter 6 | Time Management



Menu Path: Service Management > Time Management > General Operations > Time and Expense Approval

To approve time transactions:

1. On the Approver sheet, enter your Approver ID or click the Approver ID button to find and select your
ID. Your approver ID is the Workforce ID assigned to you in Work Force Maintenance.

2. All time transactions submitted by employees for your approval display on the Time > List sheet; each time
transaction displays on a separate row.

3. Use the Time > Comments sheets to review any comments entered by the submitter.
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4. Select the row you want to approve; or, to select all rows for approval, click the Select All button.

5. To approve a transaction(s) without entering any comments, click the Approve button.

6. To enter comments for the submitter, click the Approve With Comment button.

Once the transaction is approved, it no longer displays in the grid.

Reject Time Transactions

To reject time transactions:

1. On the Approver sheet, enter your Approver ID or click the Approver ID button to find and select your
ID. Your approver ID is the Workforce ID assigned to you in Work Force Maintenance.

2. All time transactions submitted by employees for your approval display on the Time > List sheet; each time
transaction displays on a separate row.

3. Select the row you want to reject.

4. To reject a transaction without entering any comment, click the Reject button.

5. To enter comments for the submitter, click the Reject With Comment button.
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6. The Approve/Reject Comment window displays.

7. Enter your comment and click Ok.

The transaction is rejected and no longer displays in the Time and Expense Approval program.

Reports

This section describes some key reports you use to monitor your employee’s time entries. You can run these
reports whenever you need. You can also set up each report to generate and print through a recurring, automatic
schedule. Review the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for information
on how you link a report to a recurring schedule.

The Time Management module includes two reports to help you manage your time and the time of your employees.
These reports are the Time Report and the Time Booking Exception Report.

Time Report

Use the Time Report to generate and print a simple employee time sheet. This report displays time entered by
specific employees for a specific time sheet period. A time period typically begins on a Sunday and ends on a
Saturday.

Menu Path: Service Management > Time Management > Reports > Time

To set up and run this report:

1. Navigate to the Filter sheet.

2. Click the Employee button to find and select the ID of the employee whose time you want to review. You
can select one or more employees.

3. In the Employee List, select the employee(s) to include in the report. 
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4. Click the Selection tab.

5. Use the From Date and To Date fields to define the week to include in the report. 

6. Click the Print button on the Standard toolbar to print the time sheet.

Time Booking Exception

Use the Time Booking Exception report to determine the employees with missing hours and to analyze employee
utilization. Missing hours are determined by calculating the difference between employee available work hours
and total booked hours. The report displays the number of booked hours that are chargeable, non-chargeable,
and indirect. You can also select the indirect codes to include or exclude from the calculation of employee
percentage utilization.

Menu Path: Service Management > Time Management > Reports > Time Booking Exception

To set up and run this report:
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1. Use the From Date and To Date fields to define the week to include in the report.

2. Use the Report Options section to define the report criteria. To include Missing Hours, select = (equal
to), < (less than) , or > (greater than), and enter a numeric value in the adjacent field. For example, you can
define criteria to include employees missing more than 10 hours.

3. To include a utilization percentage, select = (equal to), < (less than), or > (greater than), and enter a numeric
value in the adjacent field. The Indirect Codes for % Utilization list contains the indirect codes included
in the percentage utilization calculation.

4. To exclude an indirect code from the calculation, select the code in the Indirect Codes for % Utilization
field and click the Right Arrow to move the code to the Excluded Indirect Codes list.

5. Use the Filter sheet to limit the report to specific employees.  

6. Click Print on the Standard toolbar to print time booking exceptions.
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Chapter 7: Project Management

Use the Project Management functionality to organize the manufacturing of large capital projects. Through this advanced
feature set, you can create, monitor, and finish complex projects that require significant organization and planning.

The program you primarily use is Project Entry. You use this flexible program to organize your project through Work
Breakdown Structure (WBS) Phases or project Milestones. If you use WBS Phases, you can define multiple parent and
child WBS Phases within each project. These phases can in turn have multiple jobs and tasks assigned to them. If you
use Milestones, you define specific completion points within the project. You also indicate which quotes, sales orders,
and purchase orders are required to finish the project. As work progresses, you then leverage this program to track
the costs of each phase and the total cost for the project.

You can also create projects for non-manufacturing functions like claim invoicing and progress invoicing, and these
projects are billable through various methods. When you use progress claim invoicing, each progress claim is created
and managed against projects. When you use cost plus invoicing, the normal rates for labor and burden are used as
the base value for the costs. You add a set of mark up percentages to the labor, burden, and material costs to calculate
a total invoice amount. When you use time and materials invoicing, the contract defines the rates charged for the roles
required to satisfy the contract. These roles are defined through physical resources, and the material and burden costs
are calculated using a percentage factor.

With this functionality, you also have the ability to export a project to Microsoft® Office Project 2007®. Within this
Microsoft application, the project can be changed as you need. You can then import the project back into the Epicor
application where the revised project is incorporated into your database.

Leverage this complete set of features to track and bill your capital project from start to finish.

Setup

This section describes the primary records you need to create for the Project Management module. These programs
are contained within the Setup folder for this module. Only the primary records are described here. Some areas
within the next Operations section may also document setup records if required for a specific workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review the Company Configuration
chapter in the Epicor ERP Implementation Guide.

Time Types

Use Time Type Maintenance to create and maintain Time Type codes. These codes establish different charge
rates for different times recorded against a project. These types help classify the labor placed against a project.
They display on various reports and trackers.

Menu Path: Service Management > Time Management > Setup > Time Type

To create a time type code:
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1. Click New on the Standard toolbar.

2. Enter a unique identifier for the Time Type. This value displays on several programs and reports.

3. Enter a Description for the time type.

4. If this time type is no longer in use, select the Inactive check box. This time type will then not be available
as an option from Time Type drop-down lists.

5. Click Save.

Burden Codes

You create and maintain burden codes to help you track burden costs within your resources and resource groups.
Use these codes to define the unique expenses your company needs to define as burden. The expenses defined
as burden are unique from company to company, but as a costing rule, burden expenses do not include direct
labor or direct material costs on a job.

The codes you create here are grouped within Burden Set Maintenance.

Menu Path: Service Management > Project Management > Setup > Burden Code

To create a burden code:

1. Click New on the Standard toolbar.

2. Enter a unique identifier for the Burden Code. This value displays on several programs and reports.

3. Enter a Description for the burden code.
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4. Select the Project Roles sheet to indicate what roles within the project are included with this burden code.

5. Select the Use All Project Role Codes check box to add all roles to the current burden code.

6. If you only want to use some roles, use the Arrow buttons to select and remove specific roles from the
current burden code.

7. Click Save.

Burden Sets

Access Burden Set Maintenance to define a group, or set, of burden codes you want to apply against a project.
The burden set controls the provisional percentages used during the invoice preparation process. You also use
burden sets to update actual burden percentages you then use at the end of a project to see where the actual
burdens vary from the original burden estimates. You can also place, or nest, one burden set inside another
burden set; you can then override burden rates as you need to reflect the makeup of the capital project.

Menu Path: Service Management > Project Management > Setup > Burden Set

To create a burden set:

1. Click New on the Standard toolbar.

2. Enter a unique identifier for the Burden Set. This value displays on several programs and reports.
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3. Enter a Description for the burden set.

4. Click the Down Arrow next to the New button; select New Burden Code.

5. The Burden Codes sheet displays. Use the Processing Sequence field to define the sequence through
which the burden set calculates the burden codes.

6. Select the Burden Code you want to add to this burden set.

7. Use the check boxes in the Apply Burden On section to specify what is calculated by the invoice process
(labor, contract labor, and so on) using the selected burden code.

8. Click the Down Arrow next to the New button; select New Effective Date.

9. The Burden Codes > Effective Dates sheet displays. Enter the Effective Date you need for the burden
code.

10. Enter the Provisional Percent you need for the burden code.

11. Continue to add the effective dates you need. When you finish, click Save.
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Burden Code Actual Percentage

This maintenance program updates the actual burden percentages for the burden codes used in a burden set.
You leverage the actual burden rates to create a revenue recognition journal that records actual burden costs
every month.

Menu Path: Service Management > Project Management > Setup > Burden Actual Percentage

To update the actual burden percentage:

1. Click New on the Standard toolbar.

2. Click the Burden Code button to find and select the burden code.

3. In the Actual Rate field, enter the current actual burden percentage.

4. Enter the Effective Date when this rate becomes active.

5. Continue to enter actual rates for all the burden codes you need. When you finish, click Save.

Role Codes

Use Role Code Maintenance to create and maintain the role codes you need for projects. These codes define
various functions required to complete a project. They provide the Project Billing process with rates for each role
in order to invoice them. It is possible to assign a role code to an operation, which forces the hours to be booked
against employees authorized to carry out that role in the project.

You also use roles within the Customer Relationship
Management, Case Management, and Engineering modules.

Menu Path: Service Management > Project Management > Setup > Role Code

To create a role code:
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1. Click New on the Standard toolbar.

2. Enter a unique identifier for the Role Code. This value displays on several programs and reports.

3. Enter a Description for the role code.

4. Select the Resource Group Billing Rates check box to indicate the billing rates defined for the selected
resource group are used in project billing.

5. You can click the Primary Resource Group button to find and select the resource group you need.

6. Use the check boxes in the Time and Expense Options section to specify approval permissions for the
role.

If you select more than one approval role option, tasks
will be created for all individuals matching those role
criteria.

7. Click the Down Arrow next to the New button; select New Role Rate.

8. Enter the Effective Date when the rate becomes active.

9. Enter the base Currency and the Charge Rate.
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10. Select the Time Type for the rate. Time Type codes establish different charge rates for different times
recorded on a project. You create time types within Time Type Maintenance; this program is described in a
previous section.

11. Click Save.

Employees

You set up employees to help define the work they will do on a project. You can link an employee to a resource
group. Employees can also report time against jobs directly. You can also select and review role codes on each
employee record; use these role codes when you want to track the role criteria of an employee.

Menu Path: Service Management > Project Management > Setup > Employee

To associate an employee to a resource group and role code:

1. Click the Down Arrow next to the New button on the Standard toolbar; select the New ID  option.

2. Enter a unique identifier for the Employee. This value displays on several programs and reports.

3. Optionally, select the Person / Contact identifier for this employee record, if one exists. If one does not
exist, the application uses the values in the employee information fields to automatically create a
person/contact record.

If you have an individual who needs to be defined on
multiple records, like a shop employee who is also a buyer,
you can define this person in Person/Contact Maintenance
first and then link this person record to other records
throughout the application. To learn about this
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functionality, review the Personnel chapter in the Epicor
ERP Implementation Guide.

4. Select the Contract Employee check box to indicate this employee is paid on contract rather than through
payroll. This value is used when the application determines costs through an advanced billing invoice.

5. Select the Production Info sheet.

6. Select the Resource Group and Resource you want to associate with this employee.

7. Click the Down Arrow next to the New button; select New Role Code.

8. The Role Codes > Detail sheet displays. Click the Role Code button to find and select a role code. Role
codes contain role code rates which define the effective date and end date, the currency associated with
the charge rate, and time type codes.

9. Continue to make the changes you need. When you finish, click Save.
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Add Role Rates

You can associate charge rates to a specific role code. If the role code has a defined role rate, this rate is used
to determine the charge rate on a Time and Material project. You can define role rates for a role code in both
Role Code Maintenance and Employee Maintenance.

To add a role rate to a role code:

1. Click the Down Arrow next to the New button; select New Role Rate.

2. Navigate to the Role Codes > Role Rates > Detail sheet.

3. Select the Effective Date and the End Date for this project role code rate.

4. Enter the Charge Rate and its associated Currency.

5. Select the Time Type associated with this charge rate.

6. Click Save on the Standard toolbar.

Markup Codes

Use Markup Maintenance to enter markup percentages for specific part classes or against specific project role
codes. These percentages are linked to a markup record. You must create the markup record before you can
define markup percentages.

Menu Path: Service Management > Project Management > Setup > Markup Code

When Cost Plus Invoicing is selected on a project, the invoice process calculates the cost of labor, material, and
subcontract expenses, and then applies the markup percentages.

You also use markup codes within the Customer Relationship
Management and Quote Management modules.

To enter and edit the primary information for a markup record:
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1. Click the Down Arrow next to the New button; select New Quote Markup.

2. Enter a unique identifier for the Markup. This value displays on several programs and reports.

3. Enter a Description for the markup code identifier.

4. Select the appropriate Percent Type option, Markup or Profit. These options change how the markup
percentages are calculated. If you select Markup, the cost is increased directly by the markup percentages.
If you select Profit, the percentage is subtracted from 100%; the cost is then divided by this percentage.

5. Enter the markup rates as needed for this markup identifier.

6. Click Save.

Enter Material Markup Percentages for Part Classes

To enter material markup percentages for specific part classes:

1. Click the Down Arrow next to the New button; select New Material Markup.

2. Click the Class drop-down to select a class identifier from the list of the codes assigned to uniquely identify
the Part Class codes.
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3. Enter the Mtl Markup% for materials within the selected part class. All materials assigned to this part class
receive this markup rate.

4. Select the appropriate Percent Type option, Markup or Profit. These options change how the markup
percentages are calculated. If you select Markup, the cost is increased directly by the markup percentages.
If you select Profit, the percentage is subtracted from 100%; the cost is then divided by this percentage.

5. Click Save.

Enter Material Markup Percentages for Role Codes

To enter markup percentages for specific project role codes:

1. Click the Down Arrow next to the New button; select New Role Code Markup.

2. Click the Role Code drop-down to select a role code identifier from the list of previously assigned role
codes.

3. Enter the Role Code Markup% for the selected role code. This information is used when project roles
require a different markup percentage from the percentage defined on the Markup > Detail sheet.

4. Click Save on the Standard toolbar.

Operations

This section details the operations available in the Project Management module. Each operation is described as
a workflow to help guide you through the process from start to finish. These programs are primarily found within
the General Operations folder for this module. If a unique setup record is required to run the operation, this
record is also described in this section.

Project Entry

You create, update, and complete your projects within Project Entry. Almost every aspect of each project is
controlled through this entry program; use it to add the Work Breakdown Structure (WBS) phases, milestones,
checklist tasks, and the contract billing records you need. You also add quotes, orders, and other records required
to complete the project.

You start by defining a project’s main settings on the Project > Detail sheet. Once the overall project is defined,
you can then add Work Breakdown Structure (WBS) phases to it.
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Menu Path: Service Management > Project Management > General Operations > Project Entry

To create a new project:

1. Click New on the Standard toolbar.

2. In the Project ID and Description fields, enter a unique identifier and a description for the project.

3. The Revision field indicates the revision level of a project. For a new project, this value is always set to 1.
When the Build Project Analysis process is run, you can increase the revision level using the next available
number. You can then keep the project data from the previous version for use on the next project.

4. The Start Date defines when the project will be launched.

5. The End Date defines when you expect to finish the project.

6. Optionally, use the Warehouse and Bin fields to indicate where the parts are staged during the project.

7. By default, the Active check box is selected. This indicates you can add or update records to the project.
However, if this check box is clear, the project becomes inactive and no changes can be made to it.

8. Click the Create Project Job button to generate a new job using the next available job number. This number
is assigned to the primary job.

9. The Job field defines the project’s primary, or parent, job record. Any jobs created for a WBS phase are
linked to this parent job.

10. The Assembly and Material fields define the specific assembly and material sequence that is linked to all
jobs within the WBS phases.

11. When you finish, click Save.

267Epicor ERP | 10.0.700

Project Management | Chapter 7Epicor ERP Application User Guide - Part One



Define Project Approvals

You can define the approvals for all time and expense transactions against the project. You can select a different
approval method for the time workflow and the expenses workflow.

1. Navigate to the Project > Approvals > Time > Detail sheet.

2. Select the Approvals Method. Available options:

• Employee - Project time is approved for specific employees as defined in Employee Maintenance.

• Project - Project time is approved by the approval workflow group designated for the project on this
sheet.

• Automatic - Project time is automatically approved when these records are submitted.

3. Select the approval Workflow Group.

4. Click Save on the Standard toolbar.

You follow the same process to assign an expenses approvals method to a project. For more information on
creating time and expense workflows, review the Time Management and Expense Management chapters.

WBS Phases

You organize each project through a series of optional Work Breakdown Structure (WBS) phases. These WBS
phases can contain a series of checklist tasks and a phase job. Each phase can either be the parent or a child of
another WBS phase. Use these phases to structure the entire project. You can set up as simple or as complex a
series of WBS phases as you need to complete the project.

Once the project begins, you can then use the WBS phases to track your progress. You can also use the WBS
functionality to record the costs that accumulate for each phase.

If you want, you can organize work on your project through
a series of milestones. Once a project milestone is complete,
your users can then move on to the next milestone. For more
information, review the Milestones section later in this chapter.

To create a WBS phase:
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1. Click the Down Arrow next to the New button; select New WBS Phase.

2. The WBS Phases > Detail sheet displays. In the WBS Phase ID and Description fields, enter a unique
identifier and a description for the specific phase.

3. If this phase is a child of another phase, select a Parent WBS Phase from the drop-down list. In this example,
the phase is a parent phase, so this field is blank.

4. Indicate how this phase is placed in relation with the other parent or child phases through the Display Sort
Sequence field. If you enter 1, for example, the phase is the first phase within its level (parent or child) of
phases.

5. Click the Status drop-down list to define whether the phase has Not Started, is In Process, or is Completed.

6. The Start Date defines when this phase is planned to start.

7. The Due Date defines when this phase is planned to end.

8. Click the Date Complete field to define when this phase was actually finished.

9. Use the Duration drop-down list to define how long the phase takes to complete. This value is used as the
time value for its corresponding project task and can be passed along to Microsoft Office Project 2007. You
can enter this value in hours or days.

10. When you finish, click Save on the Standard toolbar.

After you save the WBS phase, you can no longer edit the fields within the WBS Phase Job Details section. These
fields are only active when you initially create a WBS phase.
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Define Invoicing Method for WBS Phases

Use the Invoicing and Recognition sheet to select a specific Invoicing Method and Revenue Recognition Method.
The application supports multiple invoicing methods, each tied to a revenue recognition method that captures
financial data.

1. In the Tree View, select the WBS phase for which you want to define revenue recognition methods.

2. Navigate to the WBS Phases > Invoicing and Recognition sheet.

3. Select an Invoicing Method. Available options:

• Customer Shipment – Use this method to bill this project based on the shipments sent to the customer.

• Milestone Billing – Defines costs that occur during each milestone level within the project. Use this
method when you need to divide up the costs by each milestone.

• Fixed Fee – Defines costs required throughout all phases of a project. Use this method when you have
a number of overall costs you want to define for the life of the project.

• Time and Materials – Use this method when you use the rates for each role assigned to the project to
calculate the total cost on the project.

• Cost Plus – This method uses the defined rates for labor and burden as the base value for all of the
costs. You can add a series of markup percentages to the labor, burden, and material costs to calculate
a total invoice amount.

• Progress Payments – Use this method to invoice a customer for a percentage of the labor, material,
and burden costs during a specific period of time. You typically use this method when product quantities
are shipped before a contract is formally negotiated. You first send out the shipments, and then the final
price is agreed upon within the contract. You can then invoice the difference between the amounts on
the progress payments and the final negotiated contract amount. The costs created for each invoice
depends on a percentage defined on the Invoicing - Progress Payments sheets

You do not need to select an Invoicing Method or a
Revenue Recognition Method on child WBS phases. If you
leave either the Invoicing Method or the Revenue
Recognition Method blank, the methods selected on the
Parent WBS Phase are used by default. You select this
parent WBS phase on the WBS Phases > Detail sheet.

4. Click Save.
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Define Approvals for Project WBS Phases

You can define the approvals for all time and expense transactions against the project WBS phase.

1. Navigate to the WBS Phases > Approvals > Time > Detail sheet.

2. Select the Approvals Method. Available options:

• Project - Project time is approved by the approval workflow group designated for the project on this
sheet.

• Employee - Project time is approved for specific employees as defined in Employee Maintenance.

• Automatic - Project time is automatically approved when these records are submitted.

3. Select the approval Workflow Group.

4. Click Save.

You follow the same process to assign an expenses approvals method to a WBS phase. For more information on
creating time and expense workflows, review the Time Management and Expense Management chapters

WBS Phase Costs

You use the WBS Phase Costs sheet to review and update the costs for the current WBS phase. This sheet displays
the costs in time through its Labor Hours and Burden Hours values. It also breaks out the monetary costs for
Labor, Burden, Subcontract, Material, Mtl Burden (Material Burden), and Other Direct Costs (ODC). You can use
this sheet to manually enter the planned budget and final cost to complete (CTC) values. If this phase is a parent
WBS phase, you can also pull in these costs from any child phases linked to this parent phase.

To use this sheet:
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1. If you need to enter the planned budget for this phase, enter these costs within the fields under the Budget
column.

2. The Estimated column displays the predicted costs for this phase. To generate these values, from the
Actions menu, select Build Project Analysis.

3. As time and costs are reported against this phase from your manufacturing center, they display under the
Actual column. To generate these values, from the Actions menu, select Build Project Analysis.

4. Use the Manual CTC column to directly enter how much this phase cost to complete. You can manually
enter the labor and burden hours that were accumulated, as well as the labor, burden, subcontract, material,
and material burden costs.

5. The Calculated CTC column displays how much the application calculated that phase cost to finish. To
generate these values, from the Actions menu, select Build Project Analysis.

You must use the Build Project Analysis function to
populate the Estimated, Actual, Calculated CTC, and
Quoted columns on this sheet. To learn how to run this
process, review the Build Process Analysis section later in
this chapter.

6. The Quoted column indicates the costs quoted to the customer. If a quote or quotes were added to this
project or phase, the quoted costs that apply to this phase display in these fields. To generate these values,
from the Actions menu, select Build Project Analysis.

7. If you select the Roll Child Budgets to this Level check box, the budget values from any child WBS phases
are pulled into this phase’s Budget column. You can no longer edit these costs.

8. If you select the Roll Child Manual Cost to Complete to this Level check box, the manually entered CTC
values from any child WBS phases are pulled into this phase’s Manual CTC column. You can no longer edit
these costs.
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Checklist Tasks

In addition to jobs, each WBS phase can have multiple tasks. These tasks define the steps to complete during
each WBS phase.

Besides defining the task, you can assign start and due dates. You may also define the person responsible for
completing the task.

To add a task to a project:

1. Click the Down Arrow next to the New button; select New Task.

2. In the Checklist Task ID and Description fields, enter a unique identifier and a description for the new
task.

3. Click the Checklist Task Type drop-down list to select the type that best applies to this task.

4. Click the Status drop-down list to define whether the task has Not Started, is In Process, or is Complete.

5. The Start Date and Due Date define when this checklist task is planned to both begin and end.

6. Click the Date Complete drop-down list to select the date when this task was actually finished. In this
example, the task has not started yet, so the field remains blank.

7. Click the Person drop-down list to indicate who is responsible for this task.

8. Click the Project WBS Phase drop-down list to define the phase inside which you are placing this task. This
phase is not complete until all tasks assigned to it are complete.

9. Use the People section to define who is responsible for work on the task. The people who you assign to
this task display within the Available list.
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10. Use the Right Arrow button to move these people to the Selected list.

11. When you finish, click Save on the Standard toolbar.

General Ledger Controls

You can associate one or more GL controls within a project. Each control associated with a project must belong
to a different control type. You can then use control values when the project applies to a posted transaction.
The selected general ledger control(s) determine the accounts and journal codes used to post transactions against
the project.

1. Click the Down Arrow next to the New button; select New GL Control.

2. Navigate to the GL Control > Detail sheet.

3. Click the Type button to find and select the appropriate GL Control type.

Each control on a project must belong to a different
control type. Transactions then post to the different
controls available on a control type. For example, project
jobs require the Project Billing GL control type.

4. Click the Control button to find and select the GL Control code associated with the GL Control type.

5. Click Save.
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Add a Quote

You can add quotes to either the entire project or to a specific WBS phase within the project.

1. From the Actions menu, select Add Quote To Project.

If you want to add a quote to a specific phase, first
highlight the phase on the Tree View. Then, from the
Actions menu, select Add Quote to Phase
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2. The Quote Line Search window displays. Use this window to find and select the quote you want to add.

3. To begin, click the Search button.

4. Highlight the quote you want from the Search Results list.

5. Click OK.

6. The quote detail is added to the project. It displays on the Quotes sheet.
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Add a Sales Order, Job, and Purchase Order

You follow the same steps to add a sales order, job, or purchase order to the project.

1. Click the Actions menu.

2. To add a job, select Add Job To Project.

3. To add a sales order, select Add Order To Project.

4. To add a purchase order, select Add PO To Project.

5. Selecting these options launches the appropriate search program - in this example, the Purchase Order
Release Search program. Select the record you want.

6. Click OK.
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7. The new record displays on the Orders, Jobs, or POs sheets.

Milestones

Milestones are specific points within the project that help you quickly measure the progress on a project. In some
cases, you can also use milestones to indicate a payment is due for some aspect of the project. Use this optional
functionality to help you track how work is progressing during the life of the project.

If you want, you can instead organize the work on your project
through a series of Work Breakdown Structure (WBS) Phases.
Once a WBS phase is complete, your users can then move to
the next WBS phase. For more information, review the WBS
Phases section earlier in this chapter.

To add a milestone:

1. Click the Down Arrow next to the New button; select New Milestone.

2. The Milestones > Detail > Milestone sheet displays. In the Milestone ID and Description fields, enter
a unique identifier and a description for the new milestone.

3. To add this milestone, click Save on the Standard toolbar.

4. If this milestone is complete, select the Complete check box. This check box is also selected if its Selection
Criteria have been satisfied.

Epicor ERP | 10.0.700278

Epicor ERP Application User Guide - Part OneChapter 7 | Project Management



5. If a customer is required to pay for the engineering during this milestone, an invoice is generated and sent
to the customer. If the invoice is posted within AR Invoice Entry, the Invoice Posted check box is selected.

Selection Criteria

Use the Selection Criteria sheet to define what project items must be finished before the current milestone is
complete. You first define the type of selection criteria you use for the milestone. You then define the specific
values that indicate when the milestone is complete. You can have multiple criteria for each milestone.

To define new selection criteria:

1. Click the Down Arrow next to the New button; select New Selection Criteria.

2. The Milestones > Detail > Selection Criteria > Detail sheet displays. Click the Type drop-down list to
define the main criteria you use. Available options: Cost to Date, Fixed Date, Job Operation Complete,
or Phase.

3. If you selected the Cost to Date type, the Material, Subcontract, Labor, Burden, and Material Burden
fields become active. Enter values in one or more of these fields to indicate the milestone is complete when
the costs equal one or more of these values.

4. If you selected the Fixed Date type, enter a date within the Fixed Date field. On this date, the milestone is
considered complete.

5. If you selected the Job Operation Complete type, enter the job that must be complete within the Job field.
You can also indicate the specific Assembly and Operation that must be complete in order to satisfy this
criterion.

6. If you selected the Phase type, enter the WBS Phase that must be complete to satisfy this milestone.

7. The Selection Criteria Description field displays the selected criterion.

8. Continue to add the criteria you need. When you finish, click Save on the Standard toolbar.
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Contracts

You define the contract for the project using the Contract sheets. This series of sheets define the contract selected
on the project, the variations that may occur as work on the project proceeds, billing methods for the contract,
and the taxes calculated against the life of the contract.

Contract Details

To define the contract details:

1. Navigate to the Contract > Detail sheet.

2. If this contract is with a customer, click the Customer button to find and select the record you need.

3. If this customer has a different billing location, click the Bill To button to find and select the customer
location that will send you payments on this contract.

4. Click the Invoicing Method drop-down list to select the method of payment you will use. The option you
select defines how the contract is billed throughout the life of the project. Available options include Customer
Shipment, Milestone Billing, Fixed Fee, Time and Materials, Cost Plus, and Progress Payments. For
more information on each method, review the previous Define Revenue Recognition for WBS Phases section.

5. Optionally, enter a value in the Contract Reference field. Use this field to enter the reference number you
use with the current contract.

6. Enter the Total Contract Value for the current contract. This value defines how much the complete contract
is worth.

7. Use the Contract Start Date and Contract End Date fields to define the overall length of the contract.
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8. If you estimated a different end date for the contract, select this date in the Projected Contract End
Date field.

9. Select how you are recording the revenues received from this project in the Revenue Recognition Method
drop-down list. Available options include On Invoice, Manual, Labor Booking, and Actual Burden. For
more information on each method, review the previous Define Revenue Recognition for WBS Phases section.

10. Optionally, select a Price List you want to associate with this contract. The price breaks for the part quantities
created through this contract can then be reviewed and used for the invoice billing.

11. Click the Project Manager button to find and select the individual responsible for administrating the
contract. After you select a project manager, the Name of the person also displays.

12. Select the Allow Invoicing Over Ceilings check box to indicate the application can generate invoices when
the costs rise above the estimates set up for the project.

13. Click the Hours To Be Used For Invoicing drop-down list to indicate whether Labor or Burden hours are
used to calculate amounts on the project billing.

14. Click the Derive Project Rates From drop-down list to define from where the rates used for costs on the
project are calculated. Available options:

• Hierarchical – Uses a rate located through the rate hierarchy. When the functionality locates a rate on
the hierarchy, this rate is used for the contract. The hierarchy order is project, employee, and role. Rates
found on a project are selected first, followed by the rates found on an employee record, followed by
the rates found on a role record.

• Project – Only uses the rates defined on the current project.

• Employee – Only uses the rates defined for the employees assigned to the project.

• Role – Only uses the rates from the roles assigned to the current project.
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15. Select the Validate Employee Role to Operation Role check box to indicate a project role must be one
of the role codes assigned to an operation. If this check box is clear, an employee can enter any project role
code defined on their employee record.

16. Click the Revenue Recognition Journal Reversal  drop-down list to select the method used to reverse
the posted transaction. Available options:

• Reverse in Following Period

• Reverse on Project Close

• Reverse on Invoice/Shipping

• Reverse on Billing/Shipments

The Reverse in Following Period option is only available
when the Manual Revenue Recognition Method is selected
on the WBS Phase or the Contract

17. To define the currency rates used to calculate the billing amounts, select the options you need on the Rate
Type and Currency drop-down lists. The rate type defines how currency pairs convert using their various
exchange rates, while the currency option defines the specific currency used on transactions for this contract.

18. If a contract does not exactly proceed as planned, enter this variant issue on the Variations sheet. Use this
sheet to keep track of any issues that occur over the life of the contract.

19. When you finish, click Save on the Standard toolbar.

Contract Billing - Fixed Fee

Fixed fees define a cost set used throughout the duration of a project. These fees are different from Milestone
fees, as milestone fees are used to define the billing costs that occur during one phase of the project. Use fixed
fees to cost items needed across all the phases of a project.

To enter a new fixed fee:

1. Click the Down Arrow next to the New button; select New Billing Schedule.
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2. The Billing Schedule > Detail sheet displays. Enter the Schedule ID you want to use for this Billing Schedule.

3. To exclude the Billing Schedule from the invoice generation process, select the Schedule Inactive check
box.

4. Click the Schedule Frequency drop-down list to select a frequency option that defines how often to
generate invoices.

5. In the Start Date field, enter the date when you want the first invoice to generate.

6. In the Total Value of Schedule field, enter the total contractual value for this Billing Schedule.

7. If you need to associate a sales order with this billing schedule, click the Order Number button to find and
select a specific order, and the Line button to find and select a specific sales order line.

8. If you need, enter the Retention Percentage for the invoice.

9. When you finish, click Save on the Standard toolbar.

You can create as many Fixed Fee Billing Schedules as you need against a project. You can link one or multiple
measured work elements to each fixed Fee Billing Schedule. For more information, review the Measured Works
section later in this chapter.

Schedule of Works

You can define the Schedule of Works agreed upon with the customer for each project. These schedule of works
define a specific set of related tasks required to complete the project. You have no limit to the number of schedules
defined within the project.

To define a schedule of works:

1. Click the Down Arrow next to the New button; select New Schedule of Work.

2. The Schedule of Works > Detail sheet displays. Enter the Schedule of Work ID you need. This value
displays on several programs and reports.
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3. Enter a Description for the schedule of works.

4. If you need, select the Planned Complete Date and Estimated Complete Date. These dates are used for
your reference, and they help you verify the progress that is made against each schedule of works.

5. When you finish, click Save on the Standard toolbar.

Each Schedule of Works can have any number of Measured Work records associated with them; for more
information, review the next Measured Works section.

Measured Works

You use measured work activity records to help track the cost of a specific work activity required to complete a
phase of the project. Each measured work must be associated with either a Fixed Fee Schedule or a Schedule of
Works, and it can contain as many measured work activity details as you need.

To define a measured work activity:

1. Click the Down Arrow next to the New button; select New Measured Work.

2. The Measured Works > Detail sheet displays. Define the Measured ID for the measured work activity
and its short Description.

3. Click the Activity Unit drop-down list to select a measure work activity detail.

4. Click the Quantity Surveyor button to find and select a shop employee to assign as Quantity Surveyor.
This individual controls the part quantity used within this Measured Work activity.

5. Enter the Price Per Unit using the activity unit charged to the customer.

6. In the Total Amount field, enter the contractual amount in the activity unit.

7. If required, select the Parent Billing Schedule and Parent Schedule of Works from the drop-down lists.
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8. Use the Percentage of Contract field to indicate how much of the project contract the current measured
work item satisfies.

9. When you finish, click Save on the Standard toolbar.

Contract Billing – Project Billing Invoicing

Use the sheets under the Project Billing Invoicing > Time & Material and Cost Plus tab to define the settings to
use when a project is invoiced through either a Time and Material or Cost Plus basis. You use the sheets under
this tab to control any overrides used for project roles, employee ceilings, supplier ceilings, and markup percentages.
When a project does not use ceilings, fees, or burden sets, you can leave them at a zero or blank value to prevent
using them within the project billing.

To activate these sheets, you must select either the Time and Materials or Cost Plus invoicing method on the
Contract > Details sheet.

To set up a project billing:

1. Navigate to the Contract > Project Billing Invoicing > Time & Material and Cost Plus > Details sheet.

2. If you need to associate a sales order with this project, click the Order Number button to find and select
a specific order, and the Line button to find and select a specific sales order line.

3. To use a specific markup code to apply against this project activity billing, click the Cost Markup button to
find and select this record. The Material Markup, Labor Markup, Subcontract Markup, and Other Cost
Markup fields now display a value and cannot be changed. The values defined for these fields on the markup
code are used instead to calculate the billing amounts. You need markup percentages for Cost Plus billing.
You create markup codes within Mark Up Code Maintenance. For more information on this program, review
application help.

285Epicor ERP | 10.0.700

Project Management | Chapter 7Epicor ERP Application User Guide - Part One



4. The Retention Percentage defines what percentage of the billing to retain. Enter a percentage value in
this field.

5. Click the Retention Processing drop-down list to select an option that defines how the application will
use the retention percentage to calculate amounts. Available options:

• Maximum of Contract Value – This percentage is calculated against the highest value on the contract.

• Percent of Invoice Value – This percentage is calculated against the value of invoices sent to the
customer.

6. To define a maximum cost for any fees placed against the project, enter a value in the Fees field. If you
leave this field blank, there is no limit to the cost of the fees.

7. Likewise, define a maximum cost for the entire project within the Project Total field. If you do not enter a
value in this field, there is no limit to the total cost of the project.

8. You can activate cost ceilings on suppliers, employees, and project roles by selecting the respective check
box. You can then enter the cost limits for each category on the respective sheet. If you select the Individual
Ceilings on Suppliers check box, use the Supplier Ceilings sheet to enter the ceiling you need on each
supplier involved with the project. (To add a supplier ceiling, click the Down Arrow next to the New button
and select New Supplier Ceiling; then enter the values you need on this sheet.)

9. If you select the Individual Ceilings on Employees check box, use the Employee Ceilings sheet to enter
the ceiling you need on each employee involved with the project. (To add an employee ceiling, click the
Down Arrow next to the New button and select New Employee Ceiling; then enter the values you need on
this sheet.)

10. If you select the Individual Ceilings on Project Roles check box, use the Role Codes sheet to enter the
ceiling you need. (To add a project role ceiling, click the Down Arrow next to the New button and select
New Project Rate; then enter the values you need on this sheet.)

11. Add any fees you need to include with the project on the Fees sheet.

12. If you need to include burden sets with the project activity billing, click the Down Arrow next to the New
button; select New Activity Billing Burden Set.

13. A new row displays on the Burden Sets grid. Enter the identifier for the set within the Burden Set field.

14. When you finish defining your Time and Materials or Cost Plus billing, click Save on the Standard toolbar.

Contract Billing – Progress Payments

When you bill a customer using the Progress Payment method, you invoice the customer periodically based on
a percentage of the costs of labor, materials, and burden generated so far against the project. Use this method
when product quantities are shipped before a contract is formally negotiated. You first send out the shipments,
and then the final price is agreed upon within the contract. You then invoice the customer on the difference
between the amounts on the progress payments and the final negotiated contract amount. The costs created
for each invoice depends on a percentage defined on the Progress Payments sheets.

You must select the Progress Payments invoicing method on the Contract > Details sheet to activate the Progress
Payments sheet.

To set up progress payment billing:
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1. Navigate to the Contract > Project Billing Invoicing > Progress Payments sheet.

2. Click the Order Number button to find and select a specific order, and the Line button to find and select
a specific sales order line from the order.

3. Enter the Progress Payment Allowable Percentage. This value defines the markup percentage you use
on the costs of material, labor, and burden used on the project.

4. Select the Hold Product Invoices check box to indicate customer shipments will not be invoiced immediately.
During customer shipment entry, any packing slips for the current sales order detail line are placed on hold
to prevent them from being selected for invoicing. When you are ready to generate invoices, clear this check
box.

5. The Total Progress Payments to Date field displays the total value of the invoice amounts received so far
against this project. You cannot modify this value.

6. The Total Amount Liquidated to Date field displays the total value of any liquidations taken place so far
as part of the customer shipment process. You cannot edit this value.

7. The Outstanding Balance field displays the remaining amount owed on the current project. This value is
calculated by subtracting the Total Amount Liquidated to Date from the Total Progress Payments to Date.
You cannot change this value.

8. You can define a maximum cost for the entire project within the Project Total field. If you do not enter a
value in this field, there is no limit to the total cost of the project.

9. To add the burden sets you need to the progress payments, click the Down Arrow next to the New button;
select New Progress Payment Burden Set.

10. A new row displays within the Burden Sets grid.

11. Enter the identifier you need within the Burden Set field.

12. Continue to add the burden sets you need. When you finish, click Save on the Standard toolbar.
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Contract Billing – Taxes

You use the Taxes sheet to define the tax categories associated with a transaction type on the current project.
During the invoicing process, the application uses these categories to calculate the amount of taxes owed against
the various financial transactions generated through the project.

To define the project tax categories:

1. Select the Contract > Taxes sheet.

2. You select a tax category for each project transaction type. Click the Material drop-down list to select a
tax category for material transactions.

3. Click the Labor drop-down list to select a tax category for labor transactions.

4. Click the Other Direct Cost drop-down list to select a tax category for miscellaneous direct cost transactions.

5. Click the Burden drop-down list to select a tax category for burden transactions.

6. Click the Subcontract drop-down list to select a tax category for subcontract work on the project.

7. Click the Fee drop-down list to select a tax category used to asses taxes on fees.

8. Click the Billing Schedule drop-down list to select the billing schedule tax category used for tax calculations.

9. When you finish, click Save on the Standard toolbar.

Copy Projects

You can duplicate an existing project and then modify the copied project to fit the requirements for the new
project.

To duplicate a current project:
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1. From the Actions menu, select Duplicate Project.

2. The Duplicate Project window displays.

3. In the New Project ID, enter the identifier for the project.

4. Enter a Description for the new project.

5. If you want to automatically create WBS job records for the duplicated project, select the Create WBS
Phase Job check box.

6. Lastly, select the Start Date you need for the new project. All copied items within the project use this date
value to calculate their start dates.

7. Click OK.

The new project displays within Project Entry, and you can modify it as you need.

Project Entry - Tree View

Project Entry uses Tree View icons unique to this program. Available icons and what they represent:

1. This graph icon indicates a WBS Phase for the project.
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2. This wrench icon represents a Job contained within the project.

3. This binoculars icon indicates a Milestone.

4. Sales Orders are indicated with this green shopping cart icon.

5. This orange shopping cart icon represents a Purchase Order (PO).

6. Quotes are represented with this document icon. The document icon is also used to identify a Schedules
Of Work, Billing Schedule, and Measured Works A Task is indicated with this check mark icon.

When an item is complete, a red check displays on top
of the icon. For an example, refer to step five.

Project Costs

You use the Project Costs sheet to review and update the costs for the entire project. This sheet displays the costs
in time through its Labor Hours and Burden Hours values. It also breaks out the monetary costs for Labor, Burden,
Subcontract, Material, Material Burden, and Other Direct Costs

Use the Project Costs sheet to manually enter the planned budget and final cost to complete (CTC) values. You
can also pull in the costs from all the WBS phases within the Budget and the Manual CTC columns.

To use this sheet:

1. If you need to enter the planned budget for this project, enter these costs within the fields under the Budget
column.

If the Roll Project Phase Budgets to Project check box is
selected, the project budget amounts are disabled and
calculated as the sum of the WBS Phase costs (production
and setup combined). If this check box is cleared, you can
manually enter the amounts.
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2. The Estimated column displays the predicted costs for the project. To generate these values, from the
Actions menu, select Build Project Analysis.

The cost for the Labor (Estimated), Labor Hours (Estimated), Burden (Estimated), and Burden Hours (Estimated)
fields are calculated as the sum of the production and setup costs.

 You must use the Build Project Analysis function to
populate the Estimated, Actual, Calculated CTC, and
Quotes columns on this sheet. To learn how to run this
process, review the Build Process Analysis section later in
this chapter.

3. As time and costs are reported against this project from your manufacturing center, they display under the
Actual column. To generate these values, from the Actions menu, select Build Project Analysis.

The cost for the Labor (Actual), Labor Hours (Actual), Burden (Actual), and Burden Hours (Actual) fields are
calculated as the sum of the production and setup costs.

4. If the Roll Child Phase Manual Cost to Complete to this Level check box is cleared, you can manually
enter the cost to complete (CTC) amounts for the project. You can enter the labor and burden hours that
were accumulated – as well as the labor, burden, subcontract, material, and material burden costs. However,
if this check box is selected, these fields are disabled and calculated from the WBS phases (The production
and setup values are combined).

5. The Calculated CTC column displays how much the system calculated the project to cost to completion.
To generate these value, from the Actions menu, select Build Project Analysis.

Labor Hours, Burden Hours, and Costs are calculated as an estimate of the remaining required quantity on
the job. The CTC Costs and Hours display zero when the job operation or the job are complete. Labor and
Burden costs are calculated as the sum of Setup and Production costs. CTC production hours are calculated
according to the qualifier of the job operation and the Company parameter (Load Relieved By).

6. The Quoted column indicates the costs that were quoted to the customer. To generate these values, from
the Actions menu, select Build Project Analysis.

 To learn how to add quotes to a project or phase, read
the Add a Quote section found earlier in this chapter.

7. The cost for the Labor (Quoted), Labor Hours (Quoted), Burden (Quoted) and Burden Hours (Quoted) fields
are calculated as the sum of the production and setup costs.

8. If you select the Roll Project Phase Budgets Costs to Project check box, the budget values from the WBS
phases are pulled into the project’s Budget column. You can no longer edit these values.

9. If you select the Roll Project Phase Manual Estimate to Complete Values to Project check box, the
manually entered CTC values from the WBS phases are pulled into this project’s Manual CTC column. You
can no longer edit these costs.
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Project Schedule

When you finish setting up the project, you can then incorporate this project’s jobs into your manufacturing
center’s schedule.

1. Click the Actions menu; select Project Schedule.

2. The Job Scheduling Board displays. Make any schedule changes you need.

To learn how to use the JobScheduling Board, review the
Scheduling chapter later in this guide.

Build Project Analysis

You can generate and review the overall costs of the project through the Build Project Analysis function. Use this
function to total Estimated, Actual, Calculated Cost to Complete (CTC), and Quoted costs. These costs are further
broken down into labor, burden, subcontract, material, material burden, and other direct costs.
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Within Project Entry, this data is then populated within the Project Costs and WBS Phase Costs sheets for your
review. To learn more about these cost sheets, read the WBS Phase Costs and Project Costs sections earlier in
this chapter.

When the Build Project Analysis process is run, you can increase the revision level using the next available number.
You can then keep the project data from the previous version for use on the next project.

To generate the analysis for the current project:

1. From the Actions menu, select Build Project Analysis.

2. The Build Project Analysis window displays.

3. If you want to regenerate records in the project analysis process table, select the Re-Generate Project
Analysis  check box.

4. If you want to save a copy of the project costs and analysis within your history, select the Save Copy check
box. The saved project data is then available for the production of comparison reports as required.

5. If you want to schedule a time when this process should run, select an option from the Schedule drop-down
list.
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6. When you finish, click the Submit button on the Standard toolbar.

After the process runs, the costs display on Project Costs and WBS Phase Costs sheets.

Revenue Recognition

You can produce general ledger journals that recognize the revenue for an ongoing project using the Revenue
Recognition function. The entries are based on the costs calculated from the Project Analysis function and the
parameters you select. You can also close the project, which causes the application to automatically reverse these
journals for the revenue recognized to date.

You use Revenue Recognition to recognize costs and revenue on long-term projects where invoicing does not
occur frequently. Revenue Recognition provides a way to recognize costs and revenue independent of invoicing.

All journal transactions are reversed eventually based on the project setting. You can reverse journals on the Next
Period or Billing depending on the Contract > Detail setting defined in the Revenue Recognition Journal Reversal
drop-down list. You can also close the project, which causes the application to automatically reverse these journals
for the revenue recognized to date.

1. From the Actions menu, select Revenue Recognition.
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2. The Revenue Recognition window displays with the cost and revenue produced to date for the project.
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3. Select a Sales Category to determine general ledger account numbers.

4. In the Calculation of To Be Recognized Revenue is Based On field, select an option (Quoted, Budget,
Estimated, Project Total, Revenue Balance, or Manually Entered) to calculate the revenue in the
Revenue Recognition section. If you select Manually Entered, specify the percentage to use for the calculation.

5. Click the Calculate button.

6. A suggested revenue recognition amount displays in the To Be Recognized field.

7. The sum of the values in the Recognized To Date and To Be Recognized fields displays in the Total
Recognized field.

8. The total projected revenue amount for the project displays in the Projected Revenue field.

9. The total value of all posted invoices made against this billing schedule displays in the Invoiced to Date field.

10. The sum of all revenue recognized for the project with an Apply Date on or before the selected Recognition
Date with the account context of Sales - Measured Work, Sales - Material, Sales - Subcontract, Sales - Project
ODC, Sales - Project Fees, and Sales - Provisional Burden displays in the Recognized (Invoiced) field.

11. The cost of sales captured by the Capture COS process after a sales order release is shipped or invoiced
displays in the Invoiced/Shipped column.

12. The cost of sales against project jobs which exist on WBS phases with the Customer Shipment invoicing
method displays in the Purged WIP to COS column. Any costs that are in work in process (WIP) will be
purged from WIP to COS when the project job is closed. If a project job is on a WBS phase which is not

Epicor ERP | 10.0.700296

Epicor ERP Application User Guide - Part OneChapter 7 | Project Management



invoiced by shipment, costs move from WIP to COS after Invoicing and execution of the Capture COS/WIP
process.

13. The labor and burden costs recognized to date via the Labor Booking Recognition method display in the
Booked column.

14. The cost of sales that have been manually recognized to date display in the Manual Entered column.

15. The cost of sales amount recorded for the project with an Apply Date on or before the selected Recognition
Date with the account context of Sales Recognized displays in the Recognized To Date column.

16. The amounts that should be recorded for the project and posted to cost of sales displays in the To Be
Recognized column. The default can be overridden and negative amounts can be entered.

17. The sum of the values in the Recognized to Date and To Be Recognized columns displays in the Total
Recognized column.

18. Click Save on the Standard toolbar after completing the entries.

The Capture Revenue Recognition window displays.

19. Click Generate Only on the Standard toolbar and then close the window.

The application creates sales and cost of sales journals based on the amounts displayed in the To Be Recognized
field in the Revenue Recognition pane and the To be Recognized column in the Cost of Sales Recognition pane.

When the project is being closed and the accrual amounts are to be reversed, select the Close Project Accrual
check box. This updates the To Be Recognized field and displays negative amounts in the fields of the To Be
Recognized column to reflect the accruals. When saved, the Epicor application then posts the reversals for the
journals that were previously created for the project by Revenue Recognition.

Close Billing Schedule Process

You can close a project so the application creates invoices that contain retention values you need. You can then
reverse these retention values from the General Ledger. If the project is for Fixed Fee invoicing, then the application
checks whether all measured work activities are processed up to the posted stage.

When the Billing Schedules are closed, the process creates an invoice line for each Billing Schedule retention
transaction, then posts the Invoice group, reverses the retentions, and marks the Billing Schedule as inactive.

To close the project:
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1. From the Actions menu, select Close Project.

2. The Close Project window displays.

3. To the message, click Yes.

4. To the Project is Closed message, click OK.

Export to Microsoft Project 2007

A key Project Entry feature is its ability to export a project into the Microsoft Office Project 2007 application. If
your company uses Microsoft Office Project 2007, you can export the project out of the Epicor application and
open it within Microsoft Office Project 2007 where you can edit the project.

To do this, you run an option from the Actions menu. After you define the aspects of the project you want to
export, you generate a .csv file that you can then open within Microsoft Office Project 2007. After you finish
working on the project within Microsoft Office Project 2007, you can then import the project back into your
application.

To export a project:
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1. From the Actions menu, select Export to MS Project.

2. The Export To MS Project window displays.

3. In the Calculate % Complete section, define the method that you want Microsoft Office Project 2007 to
use for calculating how near the project is to completion. You can calculate this value by using either the
time placed against the project or the quantities manufactured to date. You can also ignore this calculation.

The Send Phase as Task check box is disabled until you
select the Jobs check box. When you send a phase as a
task, the WBS phase is sent twice to Microsoft Office
Project 2007. It is first sent as a summary and then also
sent as a task for a job.
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4. In the Download Items section, select which project items you want to include within the exported .csv
file. You can download Predecessors, Checklist Tasks, WBS Phases, Jobs, Phases, Job Assemblies,
and Job Operations.

5. Next, define the Operation Duration value. You can choose either Days or Hours.

6. When you finish, click the Export button.

7. The Export File window displays. Use this window to place the .csv file into a folder you use for
Microsoftproject files.

8. In the File Name field, enter a file name.

9. Click Save.

10. The application now exports the file to the location you selected. A dialog box displays, indicating the export
was successful. Click OK.

Epicor ERP | 10.0.700300

Epicor ERP Application User Guide - Part OneChapter 7 | Project Management



Launch the Import Wizard

1. Launch the file within Microsoft Office Project 2007. When the Import Wizard window displays, click Next. 

2. On the Import Wizard – Map window, keep the New map option selected to create your data settings
from scratch.

3. Click Next.
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4. On the Import Wizard – Import Mode window, keep the As a new_project option selected for how you
want to import the file. Optionally, you can select to append or merge the data to an active project.

5. Click Next.

6. Select the types of data you want to import. The default is Tasks. Other types include Resources and
Assignments.

7. Select the text file options. The Import includes headers check box is selected by default.

8. Click Next.

9. On the Import Wizard – Task Mapping window, review the fields from within the central grid that map
the fields from the .csv file to the corresponding Microsoft Office Project 2007 field.

When a project is exported to Microsoft Office Project
2007, the data must be in a format the application uses.
To do this, create a map within Microsoft Office Project
using the data elements in the From: and To: fields that
display on the Import Wizard - Task Mapping sheet. If
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additional data fields are added to an existing project, the
new fields must be added to the end of the map.

10. Click Next.

11. On the Import Wizard – End of Map Definition window, click Save Map if you want to save the wizard
settings as a map to use again later.

12. In the Save Map window, select an existing map from the displayed list or enter a new map name.

13. Click Save.
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14. Click Finish in the Import Wizard to complete the import of data into Microsoft Office Project 2007.The
project displays within the Microsoft Office Project 2007 application.

To learn about the features within this application, review
your Microsoft Office Project 2007 documentation.

Import from Microsoft Project 2007

After you finish making changes within Microsoft Office Project 2007, you can then import the updated project
data back into your Epicor application. The Microsoft Office Project 2007 changes are then incorporated into the
project.

To import a project:

1. From the Actions menu, select Import from MS Project.
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2. The Import From MS Project window displays. Click the File Name button to find and select the .csv file
you want to import back into the application.

3. Several import options exist. If you want to generate new phases based on the changes you made in Microsoft
Office Project 2007, select the Create WBS Phases check box.

4. If you want to generate new tasks based on the changes you made in Microsoft Office Project 2007, select
the Create Checklist Tasks check box.

5. If you want to update the Microsoft Office Project 2007 links you made within the application, select the
Update Project/Job Links, Update WBS Phase/Checklist Task Links, or Update WBS Phase/Job
Links check boxes.

6. To generate job records for each WBS phase, select the Create WBS Phase Jobs check box.

If the Create WBS Phase Jobs check box is selected on the
Import from MS Project window, the Operation used to
create the job must also be in the Resource Group field
within the import map.

7. Use these date check boxes to update the specific dates you need from the Microsoft Office Project 2007
file.

8. When you finish, click the Import button.

The .csv file is pulled into your application. You can now open this file within Project Entry.

Link Sales Order Line to WBS Phase

You can link a sales order line to a specific WBS phase from within Sales Order Entry.

Menu Path: Sales Management > Order Management > General Operations > Order Entry
The CRM menu path is: Customer Relationship Management > Order Management > General Operations >
Order Entry
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1. In the Summary sheet, click the Sales Order button to find and select the sales order.

2. In the Tree View, select the specific sales order line you want to link to the WBS phase.

3. Navigate to the Releases > Project sheet.

4. Click the Project button to find and select the project identifier.

5. Click the WBS Phase button to find and select the specific WBS phase to be linked to the sales order line.

6. Review the Invoicing Method and Revenue Recognition Method fields pulled in from Project Entry. For
an explanation of each method, review the previous Define Revenue Recognition for WBS Phases section.

7. Click Save.

Project Role – Jobs

Use the Project Billing functionality to assign a role code to an operation while you enter a job. You do this to
prevent an employee who is not assigned to the role code from entering time against a job operation.

Menu Path: Service Management > Project Management > General Operations > Job Entry

To assign a role code to an operation:
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1. On the Job sheet, click the Job button to find and select the job you want to assign a role code.

2. Select the Job Details > Operations > Role Codes sheet.

3. Highlight the roles from the Available Roles column.

4. Click the Right Arrow button to add them to the Selected Roles column.

5. Click Save on the Standard toolbar.

Project Role – Quotes

Use the Project Billing functionality to assign a role code to an operation while you enter a quote. You do this to
prevent an employee who is not assigned to the role code from entering time against a job operation.

Menu Path: Sales Management > Quote Management > General Operations > Opportunity/Quote

To assign a role code to an operation:
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1. On the Summary sheet, click the Opportunity/Quote button to find and select the quote you want to
assign a role code.

2. Select the Line > Mfg Details > Quote Details > Operations > Roles sheet.

3. Highlight the roles from the Available Roles column.

4. Click the Right Arrow button to add them to the Selected Roles column.

5. Click Save on the Standard toolbar.

Project Invoice Preparation

You can prepare the project invoices for a specified fiscal period. Use this function to create and store detailed
audit data of all the elements to include in the invoice, such as Labor, Materials, Subcontract, Other Direct Costs,
Detailed Burden Analysis, and Material Burden. These detailed audit records are then summarized in the invoicing
data required for the actual invoice document and kept for historical reference.

You can launch this program from either the Main Menu or from within Project Entry using the Project Invoice
Preparation option on the Actions menu.

Epicor ERP | 10.0.700308

Epicor ERP Application User Guide - Part OneChapter 7 | Project Management



Menu Path: Service Management > Project Management > General Operations > Project Invoice Preparation

To prepare the project invoices:

1. Enter the Period End Date for the range used to prepare the invoices.

2. Enter the Invoice Date used when the invoices post to the general ledger.

3. If you want to schedule a time when this process should run, select an option from the Schedule drop-down
list. For more information about assigning processes to a regular schedule, review the Automatic Schedules
section within the Automatic Data Processing chapter of the Epicor ERP Implementation Guide.

4. In the Invoice Types pane, select the type of invoice you want to process. Available types include Cost
Plus, Time and Materials, Fixed Fee, and All Types.

5. Use the Filter sheet to limit the invoices to a specific project or projects. If you launch the program from
the Main Menu, all projects are selected by default. If you launch the program from Project Entry, the current
project is selected by default. You can add or remove as many projects as you need.

6. When you finish, click the Submit button on the Standard toolbar.

Cost Plus Invoice Review

Use this process to review and update the Cost Plus invoices generated during the Project Invoice Preparation.
You can also review the source data for invoices posted through this process.

Menu Path: Service Management > Project Management > General Operations > Cost Plus Invoice Review

To review the Cost Plus invoices:
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1. Click the Project button to find and select the project. The invoice data displays.

2. The proposed Invoice Date displays. Invoice Totals display.

3. The Invoice Totals display in the column on the right.

4. Review the data. Click the Lines tab to update the rates and other items on the Cost Plus invoice. You can
also delete lines you do not need.

5. Click the Burden Amounts tab to make changes to the burden amounts.

6. Click the Ceilings tab to modify any ceiling values you require for roles, employees, and/or suppliers.

7. After you finish making your changes, from the Actions menu select Recalculate Invoice. All your new
and updated values are included in the Cost Plus invoice.

8. You are now ready to complete the invoice. Select Approve Invoice. To the confirmation message, click
Yes. The temporary invoice records are approved and you can no longer edit them.

9. To print a report of the Cost Plus Invoice Review, select Print Detail.
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Fixed Fee Invoice Review

Use this process to review and update the Fixed Fee invoices generated during the Project Invoice Preparation.
You can also review the source data for invoices posted to the general ledger.

Menu Path: Service Management > Project Management > General Operations > Fixed Fee Invoice Review

To review the Fixed Fee invoices:

1. Click the Project button to find and select the project. The invoice data displays.

2. The proposed Invoice Date displays.

3. The Invoice Totals display in the column to the right.

4. Review the data. Click the Line tab to update the rates and other items on the Fixed Fee invoice.

5. From the Actions menu, select Approve Invoice and to the confirmation message, click Yes.

The temporary invoice records are approved.

6. To print the Fixed Fee invoice, select Print Detail.

Time and Material Invoice Review

Use the Time and Material Invoice Review process to review and update the Time and Material invoices generated
during Project Invoice Preparation. You can also review the source data for invoices posted to the general ledger.

Menu Path: Service Management > Project Management > General Operations > Time and Material Invoice
Review

To review the Time and Material invoices:
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1. Click the Project button to find and select the project. The invoice data displays.

2. The proposed Invoice Date displays. and Invoice Totals display.

3. The Invoice Totals display in the right column.

4. Review the data. Click the Lines tab to update the rates and other items on the Time and Materials invoice.
You can also delete lines you do not need.

5. Click the Burden Amounts tab to make changes to the burden amounts.

6. Click the Ceilings tab to modify any ceiling values you require for roles, employees, and/or suppliers.

7. After you finish making your changes, from the Actions menu select Invoice Recalculation. All your new
and updated values are included in the Time and Material invoice.

8. You are now ready to complete the invoice. Select Approve Invoice and to the confirmation message,
click Yes. The temporary invoice record is approved and you can no longer edit it.

9. To print the Time and Material invoice, select Print Detail.
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AR Invoices – Get Project Billing Invoices

AR Invoice Entry contains functionality you can leverage to pull in any AR invoices you created for a project. Use
this feature to pull in Cost Plus, Fixed Fee, Time and Material, and Progress Payment invoices.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry

To pull in project billing invoices:

1. Click the Group button to find and select an invoice group for which you want to pull in the project billing
invoices.

2. From the Actions menu, select Get > Project Billing.

313Epicor ERP | 10.0.700

Project Management | Chapter 7Epicor ERP Application User Guide - Part One



3. The Get Project Billing Invoices window displays.

4. You can limit the invoices you pull in by project. Click the Project button to find and select the project or
projects you want to include.

5. To pull in all of the projects displayed, click the Select All button.

6. To only pull in specific invoices from the selected projects, click the Manual Selection button.

7. When you finish selecting the project billing invoices you want for the current AR invoice group, click the
Close button on the window.

Project Tracker

You can use the Project Tracker to review current information about a selected project. The Project Tracker is a
display-only version of Project Entry. You cannot add or edit records in this tracker. However, this tracker does
provide supplemental sheets in addition to the Project Entry sheets. On these supplemental sheets, you can
retrieve the information for the current project.

Menu Path: Service Management > Project Management > General Operations > Project Tracker

To retrieve a summary of project costs and hours in Project Tracker:

1. On the Project > Detail sheet, click the Project ID button to find and select the project you want to review.
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2. Navigate to the More > Summary > Project sheet.

3. Click the Retrieve button to view the current project costs and hours for the selected project.

4. The Total Hours and Total Costs panes display the total hours and total costs for the current project.
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Chapter 8: Maintenance Management

You use the Maintenance Management module to enter maintenance requests, track maintenance jobs, and plan
preventative maintenance tasks performed on equipment in a manufacturing or distribution facility. This includes
internal capital equipment, tools, gauges, and fixtures such as air conditioning units, forklifts, and shop floor tools.
You perform preventative maintenance according to predefined schedules, based on elapsed use time or on equipment
meter readings. You can also use functions within the module to manage manual requests for maintenance on specific
pieces of capital equipment.

Several methods are available for entering maintenance jobs. A tradesman or manager can directly enter them, jobs
can be planned in advance and scheduled based on calendar schedules or meter reading intervals, or they can be
generated from maintenance requests you enter for specific tools or pieces of equipment.

The Maintenance Management module is not intended, however, for managing maintenance services performed on
equipment sold to customers. You must use the Field Service module to manage services performed on customer-owned
items. For more details, review the Field Service chapter.

Setup

This section describes the primary records you need for the Maintenance Management module. These programs
are contained within the Setup folder; only the primary records are described here. Some areas within the next
Operations section may also document setup records if they are required for a specific workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review the application help for this
module; the Configuration topic details the options you define within Company Configuration. You can also
review the Company Configuration chapter in the Epicor ERP Implementation Guide.

Equipment Type

Use Equipment Type Maintenance to define and organize (group) multiple pieces of equipment by kind, or type.
Equipment types can be high level categories or very specific categories. Examples of equipment types include
Transportation Device, Motor, Pump, and so on. Each piece of equipment you define in Equipment Maintenance
can only have one attached equipment type. The defined codes are used in various Maintenance Management
search programs and reports to filter the results.

Menu Path: Service Management > Maintenance Management > Setup > Equipment Type

To define equipment type codes:

1. Click the Down Arrow next to the New button; select New Equipment Type.

The Equipment Type Detail sheet displays.

Epicor ERP | 10.0.700316

Epicor ERP Application User Guide - Part OneChapter 8 | Maintenance Management



2. Enter the Type code identifier.

3. Enter a Description of the equipment type code.

4. Click the Down Arrow next to the New button; select New GL Control.

The Gl Control - Detail tab displays.

5. In the GL Control tab, you can specify the accounts and journal code used to post transactions to which
the record applies. You can associate one or more GL controls with an equipment type record.

6. When you finish, click Save on the Standard toolbar.

Equipment Status

Use Equipment Status Maintenance to define custom codes that denote the status of a piece of equipment; for
example, In Service, Requires Maintenance, and Out of Service. Each piece of equipment you define in Equipment
Maintenance can only have one equipment status code attached to it.

Menu Path: Service Management > Maintenance Management > Setup > Equipment Status

To define equipment status codes:

1. Click the New button on the Standard toolbar.

2. The Equipment Status Detail sheet displays. Enter the Status code identifier.

3. Use the Default check box to specify if this is the default status code used on all new pieces of equipment
entered in Equipment Maintenance. You can override the default code for specific pieces of equipment to
accommodate the needs of your operations.

4. Enter a Description of the equipment status code.

5. When you finish, click Save.
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Equipment Location

Use Equipment Location Maintenance to define the physical location of each piece of equipment. The physical
location of equipment can be defined at a high level (Building A) or at a detailed level (Building A Pole 45). Each
piece of equipment you define in Equipment Maintenance can only have one attached equipment location code

Menu Path: Service Management > Maintenance Management > Setup > Equipment Location

1. Click the New button on the Standard toolbar.

2. The Equipment Location Detail sheet displays. Enter the Location code identifier.

3. Enter a Description of the equipment location code.

4. When you finish, click Save.

Resources/Resource Groups

Use Resource Group Maintenance to define the resource groups and resources you will assign to operations used
during maintenance job entry. These resources and resource groups define what capacity for work is available
during the scheduling process. A resource is a subset of a resource group, and is defined in the Resources > Detail
sheet within Resource Group Maintenance. Each resource is an asset within your manufacturing center that
performs a specific function. A resource can be a physical piece of equipment like a tool or a gauge required to
measure various parts, or, a resource can be an employee like a tradesperson, electrician, and so on

Resources can also be used in equipment records. Use
Equipment Maintenance to create a new equipment record
from a resource. You can then update this equipment record
as you need.

Resource groups and resources carry labor and labor burden cost estimates, and define where and how to perform
operations. This section briefly describes resources and resource groups. Refer to the Engineering chapter for
detailed information on how to create and define resource groups.

Menu Path: Service Management > Maintenance Management > Setup > Resource Group

To define resources and resource groups:
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1. Click the Resource Group button to find and select a resource group.

2. Click the Down Arrow next to the New button; select New Resource.
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3. The Resources > Detail sheet displays. Enter the unique identifier for the Resource.  

4. Enter a Description that further identifies the resource. This text displays on various reports and windows
throughout the application.

5. When you finish, click Save on the Standard toolbar.

Equipment

You use Equipment Maintenance to define equipment records for each tool or piece of capital equipment you
plan to track. For each equipment record, you specify identifying items like Brand, Model Number, Serial Number
and also maintenance plan information. Additionally, you can establish parent/child relationships between different
pieces of equipment. If you use the Enhanced Quality Assurance module, you can designate the inspection plan
and specifications to record equipment calibration information. You can also attach and store a picture of the
tool or piece of equipment.

Menu Path: Service Management > Maintenance Management > Setup > Equipment

Detail

Use the Detail sheet to enter specific information for the equipment record. For each record, you enter information
such as serial numbers, in service data, warranty expiration date, location, and specific maintenance required.

You can also optionally link the equipment record to a parent record. For example, you may have a capital piece
of equipment (such as a Conveyor  System) that contains secondary, or child pieces of equipment (such as Motors
or Controllers) you wish to separately track based on their own individual maintenance schedules. To do this,
you first create an equipment record for the parent item, then create individual equipment records for each of
the child items, and finally link them together using the Parent field.
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To define equipment records:

1. Click the Down Arrow next to the New button; select New Equipment.

2. The Detail sheet displays. Assign an identification number for the equipment record in the Equipment ID
field.

3. Select the appropriate Status for this equipment item. You define the available options in Equipment Status
Maintenance.

4. Select the Site in which the maintenance will be performed.

5. If you need, select the Fixed Asset record to which the equipment item is associated.

6. Select the appropriate Resource Group and Resource associated with the equipment record.

7. Enter a brief Description for the piece of equipment.

8. Optionally, enter additional identifying information for the equipment. This includes the OEM, Serial
Number, Brand, and Model number.

9. Select the appropriate equipment Type. You define the available options in Equipment Type Maintenance.
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10. Specify the Meter UOM Class and Meter UOM for the equipment. This specifies the unit of measure, like
minutes, hours, units, and feet, in which the equipment meter reading is expressed.

11. Record the In Service Date for the equipment.

12. Specify the Warranty Expiration for the equipment.

13. Using the Location drop-down list, select the appropriate equipment location. You define the available
options in Equipment Location Maintenance.

14. Optionally, enter or select the Parent equipment record to which this equipment record belongs. This value
indicates this piece of equipment is related to another primary, or parent, piece of equipment.

15. If you wish, select the Project ID to which you want to associate this piece of equipment.

16. If you need, select the Parts Supplier and the Service Supplier for the equipment item.

17. If you are using the Enhanced Quality Assurance module, you can record calibration information against
specific pieces of equipment. Select the Inspection Plan used for recording calibration information. It must
be defined as a Calibration type inspection.

Refer to the Quality Assurance chapter for more details
on how to set up inspection plans and specifications.

18. Select the Specification that contains the calibration inspection parameters.

19. The Last Calibration Date field automatically populates when the item is calibrated.
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20. When you finish, click Save on the Standard toolbar.

Maintenance Planning

Use the Maintenance Planning sheet as needed to create preventative maintenance plans for the equipment
record. Each plan you create represents a preventative maintenance procedure that needs to be completed on
the item; for example, oil changes, filter replacements, belt changes, and so on. You can designate the preventative
maintenance plan as time- or meter-based. Time-based maintenance plans are based on a designated calendar
frequency, while meter-based maintenance plans are triggered based on equipment meter readings you record
in Meter Reading Entry.

The background Maintenance Plan Processor scans the preventative maintenance plans you define for the
equipment record and creates maintenance job records you can update as needed in Maintenance Job Entry. For
each maintenance plan you define, you can optionally select a template job that defines the operations, resources,
and materials used in the maintenance jobs generated for each equipment maintenance plan.

To create preventative maintenance plans:

1. Click the Down Arrow next to the New button; select New Equipment Plan.

2. The Maintenance Planning > Detail sheet displays. Assign an identification number for the Plan.

3. Enter a Description that briefly describes the plan.

4. Use the Recurring check box to specify if the maintenance should recur in the future once it has been
performed.

5. If the plan is time-based, specify the Frequency and select the unit of measure that represents the frequency
at which the maintenance occurs. For example, if the maintenance occurs every three months, enter 3 in
the Frequency field, and select Months in the field to its right. Valid selections include Days, Weeks, Months,
or Years.
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6. If the plan is time-based, specify the Next Execute Date on which the Preventative Maintenance Process
will create a maintenance job order for this plan.

7. If the plan is meter-based, use the Meter field to specify the number that is added to the last executed
meter value in order to determine the next time this plan should run.

8. If the plan is meter-based, specify the Next Execute Meter value at which the Preventative Maintenance
Processor should create a maintenance job order for this plan.

9. Specify the number of Buffer Days for the maintenance plan. This value is the number of days ahead of
the actual due date the process should generate the maintenance job for the plan.

10. Optionally, select the Template Job you want to associate with the maintenance plan.

11. Use the Topics section to associate topics with the maintenance plan. Refer to the next Topics section for
more information.

12. Click the Specifications tab as needed to add free-form specification text for the equipment record.
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13. Click the Comment tab as needed to add free-form comment text for the equipment record.

14. Click the Children tab as needed to view the secondary, or child, equipment items associated with this
equipment record.

15. When you finish, click Save on the Standard toolbar.
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Topics

Use Topic Maintenance to define maintenance issue and resolution topic codes. You assign maintenance issue
topic codes in Maintenance Request Entry or Maintenance Job Entry to identify the maintenance issues that need
to be resolved on a piece of equipment. Likewise, you assign topic resolution codes in these programs after the
maintenance is performed to analyze equipment failures and required maintenance tasks.

Topic Maintenance supports ten levels of sub-topics for each topic. As a result, you can further subdivide the
scope of maintenance issues. For example, Engine could have the sub-topics Dirty Filter and Fouled Spark Plugs,
and each of these topics can have subtopics.

Menu Path: Service Management > Maintenance Management > Setup > Topic

To add a maintenance issue or maintenance resolution topic:

1. Click the Down Arrow next to the New button; select New Case Topic.

2. Enter a Topic ID.

3. Enter a Description of the maintenance issue, or maintenance resolution.

4. Select the Top Level check box if this is a top level issue or resolution topic that will contain subordinate
issue or resolution topics. Clear this check box if this is an issue or resolution that is subordinate to a parent
topic.

5. Select the Maintenance Issue check box if this topic is used to describe a maintenance issue that needs to
be resolved.

6. Select the Maintenance Resolution check box if this topic is used to indicate how a maintenance issue
will be solved.

7. If you are defining a subordinate maintenance issue or resolution topic, click the Down Arrow next to the
New button; select New Case Topic Parent.

Epicor ERP | 10.0.700326

Epicor ERP Application User Guide - Part OneChapter 8 | Maintenance Management



8. The Parent Topics > Detail sheet displays. Select the Parent Topic.

9. Specify the Parent Sequence number.

10. When you finish, click Save on the Standard toolbar.

Maintenance Operations

Use Maintenance Operation Maintenance to define specific operations required to complete a maintenance job.
You add the operations you define in this program to a maintenance job or a maintenance job template in
Maintenance Job Entry. Examples of maintenance operations include: Remove Panel A, Switch off Electrical
Power, or Open Valve C. Maintenance operations can also be much more complex, and can include paragraphs
of detailed instructions and guidance.

You define maintenance operations as internal or subcontract operations. Internal operations track the hours
and costs for all planned and actual labor performed. Subcontract operations track the movement of parts and
costs associated with outside services

Menu Path: Service Management > Maintenance Management > Setup > Maintenance Operation

Create Maintenance Operations

You define maintenance operations as internal or subcontract operations. Internal operations track the hours
and costs for all planned and actual labor performed. Subcontract operations track the movement of parts and
costs associated with outside services.

To create maintenance operations:

1. Click the Down Arrow next to the New button; select New Operation.

2. In the Operation field, enter a concise identifier for the maintenance operation.

3. Now in the Description field, enter a brief explanation for the operation.

4. The Text field displays standard comments you want to print on the Maintenance Request and Maintenance
Job Reports.

5. If this is a subcontract operation performed by an external resource, select the Subcontract Operation check
box. Clear the check box if it is an internal operation.
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6. For internal operations, select the Primary Operation Detail number.

7. For subcontract operations, select the Primary Supplier performing the subcontract operation. You can
also select the Buyer code for the subcontract operation.

Select the Resource Groups or the Resources

To select the resource groups or the resources used to run this operation.

1. Click the Down Arrow next to the New button; select either New Resource Group Requirement or
New Resource Requirement.

2. For this example, you are linking this maintenance operation to a resource group. The Scheduling
Requirements > Resource Groups sheet displays.
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3. In the Resource Group ID field, find and select the resource group you wish to add to the maintenance
operation. To do this, right-click this field. From the context menu, select Open With > Resource Group
Search.

4. Use the Resource Group Search program to find the resource group that you need to run this operation.

5. Click OK
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6. The resource group you selected displays within the grid. Continue adding resources and resource groups
that run this operation.

Optionally, you can use the Resources sheet to add resources for the maintenance operation, or use the
Capabilities sheet to add capabilities for the maintenance operation.

Operation Text

Use Operation Text Maintenance to set up standard operation text that displays on maintenance job travelers
printed on the Maintenance Job Report. Operation text records are standard comments you associate with an
operation in Operation Maintenance. For example, you can set up standard instructions or warnings as Operation
text records and then associate them with specific operations. If you associate a specific operation text record
with an operation, that text automatically prints on the job traveler below job operation comments.

Menu Path: Service Management > Maintenance Management > Setup > Operation Text

To add operation text:

1. Assign a unique Code identifier for the operation text.

2. Enter a Description for the operation text.

3. Enter the additional Operation Text that you want to print on the maintenance job traveler.

4. When you finish, click Save on the Standard toolbar.

Operations

This section details the operations you can use within the Maintenance Management module. Each operation is
described as a workflow to help guide you through the process from start to finish. These programs are primarily
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found within the General Operations folder for this module. If a unique setup record is required to run the
operation, this record is also described in this section.

Request Entry

Use Maintenance Request Entry to request that maintenance be performed on a piece of equipment. Employees
with the appropriate permissions can search for a particular piece of equipment based on some of the fields
defined in Equipment Maintenance. When the equipment is identified, you use predefined codes and enter free
form description to identify the issues or maintenance that is requested.

Menu Path: Service Management > Maintenance Management > General Operations > Request Entry

To enter a pending maintenance request:

1. Click the New button on the Standard toolbar.

2. A system-assigned identifier displays in the Request field. This value only displays for your information; you
cannot change it.

3. Select the Equipment ID for the piece of equipment that requires maintenance.

4. Enter the Required Date. This value defines the due date for when the maintenance work must be finished.

5. Select the Priority for the required maintenance.

6. Enter a Description of the maintenance issues, and then select the Topics that categorize the nature of
the required maintenance.

7. When you finish, click Save.

331Epicor ERP | 10.0.700

Maintenance Management | Chapter 8Epicor ERP Application User Guide - Part One



Your request is now waiting for disposition in the Maintenance Request Queue.

Request Queue

After you enter a request for maintenance into Maintenance Request Entry and submit it for approval, it displays
in the Maintenance Request Queue. A tradesperson or manager can then disposition the result. After the request
is approved, a maintenance job is created and is linked to the submitted request. No further updates are made
to the maintenance request until the maintenance job order is complete. Once the maintenance job order is
finished, the status of the request automatically updates to Complete.

Menu Path: Service Management > Maintenance Management > General Operations > Request Queue

To disposition the pending maintenance request:

1. Click the Request button to find and select the maintenance request identifier.

2. To approve the maintenance request and create a maintenance job order, click the Approve Job button.

3. To approve the maintenance request and create a maintenance job order that is immediately placed on
hold, click the Approve Job on Hold button.

4. To reject the maintenance request, click the Reject JobRequest button. You must enter text that indicates
the reason for the rejection.

5. Click Save on the Standard toolbar.

Maintenance Job Entry

Use Maintenance Job Entry for direct entry of maintenance jobs for a particular piece of equipment. When entered
by a tradesman or manager, the maintenance job record is used to initiate and track the progress of maintenance.

Menu Path: Service Management > Maintenance Management > General Operations > Maintenance Job Entry
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To use Maintenance Job Entry:

1. Click the New button on the Standard toolbar.

2. The New Job Number window displays.

3. Enter the job number or click Next Job to assign the next sequential identifier.

4. Click OK.
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5. Select the Equipment ID for the piece of equipment being maintained.

6. Optionally, select the Mass Print check box to include the maintenance job on the Maintenance Job Report.

7. Optionally, select the Project ID to define which project the maintenance job is assigned.

8. Click Save.

Add a Job Operation

Use this sheet to manually enter or edit operation information for the current maintenance job. You can retrieve
operation information using the Get Details command found under the Actions menu, or drag and drop the
operation from the Operation Master sheet onto the Job Tree View.

To add a maintenance job operation:
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1. From the Tree View, right-click Operations and select Add Operation.

2. Select the Operation that needs to be performed on this maintenance job. In this example, you add the
Check Brakes operation.

3. Enter the estimated number of Hours it will take to perform this operation. In this example, you enter 2.00.

4. When you finish, click Save on the Standard toolbar.
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Engineer and Release the Maintenance Job

After entering all required operation and material detail, return to the Detail sheet to engineer and release the
job.

1. Click the Job tab.

2. In the Status section, select the Engineered and Released check boxes.

3. When you finish, click Save on the Standard toolbar.
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Schedule the Maintenance Job

Once you have engineered and released the job, use the Job Scheduling command on the Actions menu to
schedule the maintenance job

1. Click the Actions menu, highlight the Schedule sub-menu, and then select Job Scheduling.

2. Enter the Due Date for the maintenance.

3. When you finish, click OK.

4. Click Save on the Standard toolbar.

Issue Material from Inventory

Use the Issue Material from Inventory program as needed to issue replacement parts to the maintenance job.

Menu Path: Service Management > Maintenance Management > General Operations > Issue Material

To issue replacement material to the maintenance job:
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1. Enter the maintenance job number in the Job field.

2. Select the correct assembly level in the Assembly field.

3. Select the correct material in the Mtl field.

4. Enter the Quantity to issue.

5. If the item to issue is lot controlled, enter a lot number in the Lot field.

6. If the part is serial tracked, you can click the Serial Numbers button to define the serial numbers used with
the issued quantity.

7. Click OK to complete the transaction.

Time Entry

Use Time and Expense Entry to enter employee hours for indirect labor, production labor, or project labor and
submit those hours for approval. You can enter time on a daily or weekly basis. After you enter time transactions,
you can view, modify, recall, and copy them at a later time. You can also monitor the status of transactions and
enter comments for approvers. Refer to the Time Management chapter for more information.

Menu Path: Service Management > Maintenance Management > General Operations > Time and Expense Entry

To enter labor hours for a maintenance job:
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1. Click the Employee ID button to find and select the identification number for the employee who performed
the maintenance work.

2. Click the Down Arrow next to the New button; select New Time.

3. The Time > Daily Time > Summary > Detail sheet displays. Accept all defaults.  

4. Click the Down Arrow next to the New button; select New Time Detail.
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5. Select the maintenance Job for which you are entering labor hours.

6. Select the maintenance job Operation for which you are entering labor hours.

7. Enter the Clock In time at which labor started on this operation.

8. Enter the Clock Out time at which labor ended on this operation.

9. Select the Complete check box to indicate the maintenance operation is finished.

10. Enter any additional Labor Notes you need.

11. When you finish, click Save on the Standard toolbar.

Maintenance Job Completion

Once you have recorded labor time against the maintenance job, you must close it within Maintenance Job Entry.
You can then add text that describes the specific resolution for the maintenance issue

Menu Path: Service Management > Maintenance Management > General Operations > Maintenance Job Entry

To close the maintenance job and add resolution text:
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1. Select the maintenance Job to close.

2. Click the Resolution tab.

3. Enter the Description text that indicates the maintenance problem is resolved.

4. Select the Topics that define how the maintenance problem was resolved.

5. To close the maintenance job, select the Job Closed check box.

6. The status indicator for the maintenance job now displays as Closed.

7. When you finish, click Save on the Standard toolbar.

Meter Reading

Use Meter Reading Entry to record the meter data for a specific piece of equipment. You can enter meter data
for a piece of equipment regardless of whether it is attached to a preventative maintenance plan with configured
meter data. You can view meter reading information as needed in the Equipment Tracker. The Maintenance Plan
Processor uses the meter data to create and schedule required maintenance jobs.

Menu Path: Service Management > Maintenance Management > General Operations > Meter Reading

To use Meter Reading Entry:
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1. Click the Equipment ID button to find and select the piece of equipment whose meter you are reading.

2. The previously recorded meter reading displays in the Current Reading field.

3. Enter the New Reading quantity that displays in the usage meter for this piece of equipment.

4. Optionally, enter any Comment text you need for the new meter recording.

5. When you finish, click Save on the Standard toolbar.

Maintenance Plan Processor

The Maintenance Plan Processor is a background process that scans maintenance plans defined for equipment
records on the Equipment Maintenance > Maintenance Plan sheet. Once scanned, it analyzes the data to create
maintenance jobs based both on the maintenance plan and on meter readings recorded for equipment in
Equipment Meter Reading. You can then edit the resulting maintenance jobs in Maintenance Job Entry.

Menu Path: Service Management > Maintenance Management > General Operations > Maintenance Plan
Processor

To use the Maintenance Plan Processor:

1. Use the Continuous Processing check box to designate if this process should constantly run in the
background, or if you should call it manually from the menu.

2. Specify the Continuous Processing Delay, stated in minutes.

3. Designate how to Schedule the process and if it should run as a Recurring process. If you indicate this
process is recurring, it will then run through a regular, automatic schedule you define. For more information
about assigning processes to recurring schedules, review the Automatic Data Processing chapter in the
Epicor ERP Implementation Guide.
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4. When you finish, click Submit on the Standard toolbar.

Reports

This section describes some key maintenance management reports you use to review maintenance entries. You
can run these reports whenever you need. You can also set up each report to generate and print through a
recurring, automatic schedule. Review the Automatic Data Processing chapter in the Epicor ERP Implementation
Guide for information on how you link a report to a recurring schedule.

Equipment List Report

Use the Equipment List Report to print a full or selected list of equipment records. You create these records within
Equipment Maintenance Entry.

Menu Path: Service Management > Maintenance Management > Reports > Equipment List

To print this report:

1. Use the Status drop-down list to select the status level of the equipment to include on the report. You
define status levels on equipment records.

2. Use the Equipment Type drop-down list to select the kind of equipment you want to display on the report.
You create these types on equipment records as well.

3. Select the Print Details check box to print all the information for the listed equipment records.

4. Select the Print Maintenance Plan check box to print the maintenance plan linked to each selected
equipment record.

5. Use the New Page per Equipment check box to designate each piece of equipment will print on an
individual page.
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6. Use the Include Child Equipment check box to print secondary, or child, equipment records linked to the
equipment records listed on the report.

7. Select the Print Maintenance Log check box to print associated maintenance logs for the equipment listed
on the report.

8. Using the Jobs Closed After field, specify the job closure date. Maintenance log information prints for all
maintenance jobs closed on or after this date.

9. Use the Filter sheet to specify the equipment IDs, locations, and sites for which the equipment records
should print.

10. When you finish, click Print on the Standard toolbar.

Maintenance Request Report

Use the Maintenance Request Report to print a hard copy of maintenance requests you enter in Maintenance
Request Entry.

Menu Path: Service Management > Maintenance Management > Reports > Maintenance Request Report

To print this report:
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1. Use the Priority drop-down list to select the maintenance priority status for which the report will print.

2. Use the Request Status drop-down list to select the request status for which The report will print.

3. Specify the Site for which the report will print.

4. Use the Requested On or After field to specify the beginning request date. Maintenance request information
entered on or after this date prints on the report.

5. Use the Required On or Before field to specify the ending request date. Maintenance request information
entered on or before this date prints on the report.

6. Select the Bar Codes check box to print bar codes on the report.

7. Use the Filter sheet to further limit what equipment records display on this report.

8. When you finish, click Print on the Standard toolbar.
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Maintenance Job Report

Use the Maintenance Job Report to print a hard copy of maintenance job information. You can call this report
from the Main Menu as well as from Maintenance Job Entry.

Main Menu Path: Service Management > Maintenance Management > Reports > Maintenance Job Report

To print this report:

1. Use the Print all jobs flagged for mass print check box to indicate maintenance jobs selected for mass
printing in Maintenance Job Entry should print on the report.

2. Select the Print Scheduled Resources check box to print information on each resource selected for each
maintenance job.

3. Select the Print Scheduled Resource Descriptions check box to print descriptions of the resources used
on each maintenance job.

4. Use the Operation Dates check box to specify if operation dates should print for each maintenance job
operation.

5. Use the Operation Standards check box to specify if time standards information should print for each
maintenance job operation.

6. Select the Bar Codes check box to print bar codes on the report.

7. Use the Filter sheet to specify the maintenance jobs that should print on the report.

8. When you finish, click Print on the Standard toolbar.
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Chapter 9: Field Service

Field Service is designed to manage the installation, repair, and on-going service of equipment for your customers at
their facilities or out in the field. You can use Field Service to schedule service calls on a timetable you define. For those
customer calls that require immediate repair, you can quickly determine if the problem is still covered under a warranty,
or if it requires a billable service call.

The Service Call Center centralizes all processes related to dispatching technicians and cost reporting of service calls in
the field. This workbench pulls information from existing service contracts and warranties, and then a dispatcher
schedules service orders, assigns technicians, and creates service jobs.

As a service job’s operations are worked on by technicians, labor is recorded against these operations, so you can
precisely track labor costs. Depending on the setup of the service call, those charges may be absorbed into the service
contract or automatically invoiced to the customer.

Field service also includes valuable reports that provide detailed information on individual contracts and warranties to
know whether you are making or losing money.

Epicor Mobile Field Service provides your mobile workforce access to the relevant functions and data from the application.
Technicians away from the office have instant access to data, including pricing and inventory levels. Use Epicor Mobile
Field Service to process service call jobs, to track labor, inventory, materials, and equipment in a configurable workflow,
and to update work orders in real-time. For more information on Epicor Mobile Field Service, contact your Epicor
Account Manager.

Setup

This section describes the primary records you need to create for the Field Service module. These programs are
contained within the Setup folder for this module. Only the primary records are described here. Some areas within
the next Operations section may also document setup records if they are required for a specific workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review the application help for this
module; the Configuration topic details the options you define within Company Configuration. You can also
review the Company Configuration chapter in the Epicor ERP Implementation Guide.

Service Contract Code

You use Service Contract Code Maintenance to define the various service contracts your company offers. Service
contract codes are used in Service Contract Entry, and also display in Service Call Center.

Menu Path: Service Management > Field Service > Setup > Service Contract Code

To add a service contract code:
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1. Click the Down Arrow next to the New button; select New Contract Code.

2. In the Contract Code field, enter the identifier for this code.

3. Now enter a brief explanation for the service contract code in the Description field. This description is used
during entry of a service contract for a customer.

4. Select the Ship Contract check box to indicate the contract needs to be shipped to a customer. The contract
created using this contract code needs to be invoiced by creating and shipping a sales order. If this check
box is clear, you can use AR Invoice Entry to invoice the contract directly.

5. Select the charges - Material, Labor, or Misc. – this service contract code covers. Miscellaneous charges
include items such as travel, meals, and parking. A service contract code must have at least one coverage
charge.

6. The Duration field displays the length of time the service contract lasts. This value, along with the Modifier
setting, determines how long the service contract is active.

7. Enter the Unit Price for service contracts that have this code assigned to them. This value, and the Price Per
setting, determines the amount the customer is charged for the service contract.

 To learn about generating recurring invoices, review
application help.

8. Select the Recurring Inv check box to indicate this contract is invoiced on a recurring basis. The values in
the Unit Price and Price Per fields determine the recurring invoice amount.

9. Select the Deferred Revenue check box to indicate whether the contract is configured to defer revenue.
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10. Select the Quoted check box to indicate whether a quote must be created and approved by the customer
before the contract can be invoiced.

11. If this service contract code covers on-site service calls, select the On Site check box.

12. Select the Renewable check box to indicate whether the contract that uses this contract code is valid for
renewal.

13. In the Renewal Code field, select the renewal code to use for the service contract renewal. This code defines
the contract price increase.

14. Use the Modifier field to select the unit of time the service contract lasts. This value, along with the Duration
setting, determines how long the contract is active. Valid selections include Days, Months, or Years.

15. In the Price Per field, select the unit by which the Unit Price value is applied. The default is Contract; however,
you can set the unit identifier to per day or per month.

16. The Frequency Period field is only available if you select the Recurring Invoice check box. Use this field to
indicate how often you want to generate an invoice for this contract.

17. The RA Code field is only available if you select the Deferred Revenue check box. Use this field to indicate
the revenue amortization schedule for the contract.  

18. The Task Set field is only available if you select the Quoted check box. Use this field to indicate the task set
to use when creating a quote for a contract renewal.

19. When you finish, click Save on the Standard toolbar.
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Renewal Code

Use Renewal Code Maintenance to create an entry that controls the price increase when renewing a service
contract. The renewal codes are associated to the service contract codes in order to use the renewal entry settings
when renewing a service contract.

Menu Path: Service Management > Field Service > Setup > Renewal Code

To add a renewal code:

1. Click the New button on the Standard toolbar.

2. In the Renewal Code field, enter a unique code identifier.

3. Enter a description of the renewal code in the Description field.

4. Use the Quoted check box to indicate whether a quote must be created and sent to the customer for
approval before renewal can be invoiced. If selected, a task set must be selected.  

5. Use the Increase Method field to classify the increase cost of the renewal contract; select an option from
the increase method list. Available options:

• Amount – A flat renewal amount is added to the original amount of the contract. The Amount field is
required and enabled when the Amount option is selected in the Increase Method field.

• Percentage – The percentage of each contract line is increased by the value entered in the Percentage
field. The Percentage field is required and enabled when the Percentage option is selected in the Increase
Method field.

• Price List – This value recalculates the renewal contract price based on the price list defined on the Price
List field. The Price List field is required and enabled when the Price List option is selected in the Increase
Method field.

6. After selecting the increase method, enter the value by which the renewal contract price will increase. The
field will be enabled, according to the selection in the Increase Method field.

7. When you finish, click Save on the Standard toolbar.
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Service Call Type

Use Service Call Type Maintenance to define the types of service calls placed by your customers such as billable
from non-billable calls, warranty from service contract calls, preventative maintenance from standard, or corrective,
maintenance calls, and so on. You can then associate a tax category and general ledger (GL) controls.

Menu Path: Service Management > Field Service > Setup > Service Call Type

To add a service call type:

1. Click the Down Arrow next to the New button; select New Call Type.

2. In the Call Type field, enter the identifier for this call.

3. Now enter a concise explanation for the service call type in the Call Description field. This description is
used during entry of a customer service call.

4. If you use tax categories to classify your service calls for sales tax reporting, select an option from the Tax
Category list.

5. When you finish, click Save on the Standard toolbar.

Employee

You use Employee Maintenance to indicate the specific employees that can be dispatched for field service calls.
Then during service call entry, you can display only those employees you designate as service technicians. This
section discusses the Employee Maintenance functionality that applies to the field service functionality. To learn
about adding an employee, refer to Epicor ERP Implementation Guide.

Menu Path: Service Management > Field Service > Setup > Employee

To add a service technician employee:
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1. Click the Down Arrow next to the New button; select New ID.

2. In the ID field, enter the identifier for this employee.

3. Optionally, select the Person/Contact identifier for this employee record if one exists. If one does not exist,
the application uses the values in the employee information fields to automatically create a person/contact
record.

4. Enter employee information such as Name, Address, Phone, and Email.

5. Specify the current employment status in the Status field. The available options are Active, Inactive, or
Terminated.

6. Select the Service Technician check box to specify this employee can be dispatched for field service calls.

If you have an individual who needs to be defined on
multiple records, like a shop employee who is also a buyer,
you can define this person in Person/Contact Maintenance
first and then link this person record to other records
throughout the application. To learn about this
functionality, review the Personnel chapter within Epicor
ERP Implementation Guide.

7. If you want name, address, phone, and email changes made to this employee record to automatically update
the linked person record within Person/Contact Maintenance, select the Sync Name, Sync Address, Sync
Phone, and/or Sync Email check boxes.
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8. On the Production Info sheet, select the labor shift this employee ordinarily works from the Shift drop-down
list.

9. Optionally, enter a Resource Group and Resource to which this employee belongs. A resource can be a
piece of equipment like a calibration tool or a drilling machine, or an employee like a service technician. A
resource group pulls similar equipment and employee skills together, defining a specific aspect of your field
service organization. To learn more about resources and resource groups, review the Engineering chapter.

10. When you finish, click Save on the Standard toolbar.

11. Navigate to the Mobile > Labor Rate > Detail sheet.

Use this sheet to define Service labor rates. Each level above the Labor Expense Code in the Labor Rates
hierarchy can have its own Labor Rate defined, by selecting the Fixed Rate option in the Rate Type field
and then defining the Fixed Rate, or you can specify a Multiplier value used on the rate from the level
below it, by selecting the Based on Base Rate option in the Rate Type field. The base labor rate is defined
in Indirect Labor Account Maintenance. Each level can override or adjust the rate from the level below.

The Labor Rates are calculated according to the following hierarchy:

• Service Contract

• Customer > Ship To (this relates to the Address chosen for the Job)

• Customer

• Employee
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• Labor Expense Code

You can only enter data in this sheet if the Advanced
Labor Rate check box is selected in the Company
Configuration > Modules > Production > Job sheet.

12. From the New menu, select New Employee Labor Rate.

13. Select an expense code as defined in Indirect Labor Account Maintenance. Each expense code can include
a labor rate, depending whether you select the Advanced Labor Rate check box in Company Configuration.
The rate value entered in Indirect Labor Account Maintenance is used once you select a particular expense
code record in this field.

14. Select a rate type for a labor rate. The options include Fixed and Based on Base Rate. Depending on which
option you select in this field, the Rate Multiplier and Fixed Rate fields activate. If you select the Fixed
option, the Fixed Rate field activates. If you select the Based on Base Rate option, the Rate Multiplier field
activates.

15. Enter a rate multiplier value used on the rate from the level below in the Labor Rate hierarchy. This field
activates only if you select the Based on Base Rate option in the Rate Type field.

16. Enter a fixed rate value. This field activates only if you select the Fixed option in the Rate Type field.

Fixed rate allows overriding of rates defined lower in the Labor Rates hierarchy. This is to allow for more
specific rates rather than using the base rate.

17. Navigate to the Mobile > Field Service sheet.
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18. Specify a resource. You cannot assign an employee to a service job when you schedule it, but you can assign
a resource. Use this field to link the employee in focus to a resource for cases where an employee technician
is scheduled to work on a service job.

19. When you finish, click Save on the Standard toolbar.

Operations

This section describes the operations available in the Field Service module. Each operation is described as a
workflow to help guide you through the process from start to finish. These programs are primarily found within
the General Operations folder for this module. If a unique setup record is required to run the operation, this
record is also described in this section.

Service Contract Entry

A service contract is an order for services that a technician performs while on a customer service call. Use Service
Contract Entry to set up service contracts for customers. The service contract contains information such as the
type of coverage and the parts the contract covers. Material, labor, and miscellaneous charges are defined as
either covered or not covered on the contract. As technicians are dispatched, the costs are tracked against the
service contract.

Once a service contract is established for a customer, it is then
entered as a line on a sales order and later invoiced. This
process is described in the next section, Invoice a Service
Contract.

After a service contract is invoiced, you can add and remove lines on the contract. Each line must have its own
billing dates. If a line is added to the contract, you must invoice the particular line using the Get > Contract Billing
command in AR Invoice Entry.

Use a renewal to extend the contract duration beyond the original expiration date. You can use Service Contract
Entry to individually renew a contract about to expire or use the Renew Contracts process to select and renew
several contracts at once.

The renewal duration an be different than the original contract.

Menu Path: Service Management > Field Service > General Operations > Service Contract Entry

To enter a service contract:
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1. Click the Down Arrow next to the New button; select New Contract.

2. On the Header sheet, click the ID button in the Sold To section to find and select the customer you are
selling the service contract.

3. From the Attn drop-down list, select the person at the customer sold-to site who is considered the contact
for this service contract.

4. If the service contract covers parts located at a different address than the sold to customer, click the ID
button in the Ship To section to find and select the customer where the parts are located.

5. If the customer billed for the service contract is different from the customer to whom you are selling the
service contract, select that customer from the Bill To Customer drop-down list.

6. Select the service contract code to assign to the contract from the Type drop-down list. This code determines
the type of coverage for the contract – such as contract duration, services covered, billing frequency, and
 renewal setting, and if the contract is configured to defer revenue. For information on how to add a service
contract code, review the Service Contract Code section earlier in this chapter.

7. The Contract Total field displays the total amount of the service contract. This field updates once you add
line detail information to the service contract.

8. When a contract is renewed, the Renewals Total field displays the total contract amount including the
renewal price increase.

9. Use the Quoted Contract pane to create and approve a quote before the original or renewal contract can
be invoiced. The Quoted check box displays as selected and the task set used for the quote displays in the
Task Set field.
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10. In the Quote field, when saved, the Epicor quoting system automatically generates a quote number for the
original or renewal contract, allowing a copy of the quote to be sent to the customer for approval. Once
the quote in Opportunity/Quote Entry is marked as won, approved, and accepted by the customer, the
Accepted check box is enabled.

11. The Order/Line fields display the sales order and sales order line on which this service contract was sold.
These fields are for display only. For more information on invoicing a service contract, see the Invoice a
Service Contract section later in this chapter.

12. The Duration field specifies the length of time the service contract lasts. This value, along with the
Modifier setting, determines how long the service contract is active. The value defaults from the Type code
you specify, but if you need, you can change this option.

13. The Expire Date field specifies the date on which the service contract expires. This date is calculated as the
Effective Date plus the Duration. Once a contract has expired, an Expired status indicator displays at the top
of this sheet.

14. Once the service contract is invoiced, the Invoiced check box displays as selected, and an Invoiced status
indicator displays at the top of this sheet.

15. The Effective Date field specifies the date on which the contract goes into effect. The default is today’s
date; if you need, change this date.

16. The Renewed Until field displays the expire date of the last effective renewed contract. This field is
automatically calculated based on the renewal effective date plus the duration of the renewal.

17. In the Coverage section, select the Material, Labor, Misc, and Onsite check boxes to indicate the service
contract covers material, labor, miscellaneous, or onsite service call charges. The default setting for this
check box comes from the Type code you selected for the contract, but you can change these options.
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18. Use both the Recurring check box and the Frequency field to indicate the contract is invoiced on a recurring
basis and how often to generate the invoice. The amount on the invoice is determined by the Frequency
Period in addition to the contract price and the extended price on the Line > Detail sheet.

19. The Price Per field specifies the unit by which the Contract Price value on the Line > Detail sheet is applied.
The default setting for this check box comes from the Type code you chose for the contract, but it can be
changed. Valid selections include Contract, Daily, and Monthly.

Complete Contract Header Information

To complete contract header information:

1. Select the Renewable check box to indicate whether the contract is available for renewal.

2. Once the original or renewal contract is ready to be quoted, select the Ready to Quote check box.

3. Select the Suspended check box to indicate the contract has been suspended and all open deferred revenue
amortization (DRA) periods are put on hold.

A suspended contract cannot have service calls linked to
it.  

4. Select the Ready to Invoice check box to indicate the contract is to be invoiced directly in AR Invoice Entry
and a sales order and shipment are not necessary. If the Ship Contract check box is selected in Service
Contract Code Maintenance, the Ready to Invoice check box is disabled.

Once a contract is suspended, you must define the hold reason code and enter a comment on the action.

Line - Detail

To enter line information:
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1. Click the Down Arrow next to the New button; select New Line.

2. On the Line > Detail sheet, click the Part/Rev button to find and select the part that is covered by this
service contract.

3. Select the appropriate revision for the part from the Revision drop-down list.

4. If you need, enter the Customer Part number and the Customer Revision level by which the customer
refers to the part.

5. The Serial Numbers button becomes active if the part is assigned a serial number.

6. Optionally, enter the sales order and line numbers on which the part was originally sold, or click the Ref.
Order/Line button to find and select it. When you enter this information, the part number, revision, and
quantity are pulled into the contract line.

7. Enter the part quantity this service contract covers in the Contract Qty field.

8. The Contract Price value defaults from the Type code you chose for the contract on the Header sheet; if
you need, enter a different amount.

9. The Ext Price displays the contract quantity multiplied by the contract price.

10. Verify the Billing Dates for each line are accurate. The dates in the Start Date and End Date fields populate
automatically based on the duration specified in the service contract code. These dates can be overridden
if necessary.

11. When you finish, click Save on the Standard toolbar.

Mobile - Detail

Use the Mobile sheet to define Service labor rates for a selected service contract record. You can only enter data
for service jobs if the Advanced Labor Rate check box is selected in the Company Configuration > Modules
> Production > Job sheet.

The Labor Rates in the Epicor application are calculated according to the following hierarchy:

• Service Contract
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• Customer > Ship To (this relates to the Address chosen for the Job)

• Customer

• Employee

• Labor Expense Code

Each level above the Labor Expense Code can either define its
own Labor Rate (by selecting the Fixed Rate option) or specify
a multiplier to be used on the rate from the level below it (by
selecting the Based on Base Rate option). The base labor rate
can be defined in the Labor Expense Code.

Example  A Service Contract could specify a multiplier of 2
upon the rate from Customer Ship To, which itself defines a
fixed rate of 10, resulting in the total rate being 20. If the
Customer Ship To defined a multiplier of 3 instead, then a
multiplier of 2x3 = 6 would be applied on the rate from the
customer. If an entry exists for a particular level for that Labor
Expense Code, then the logic skips to the next level down.

To define labor rates:

1. From the New menu, select New Labor Rate.

2. Select an expense code as defined in Indirect Labor Account Maintenance. Each expense code can include
a labor rate, depending whether you select the Advanced Labor Rate check box in Company Configuration.
The rate value entered in Indirect Labor Account Maintenance is used once you select a particular expense
code record in this field.

3. Select a rate type for a labor rate. The options include Fixed and Based on Base Rate. Depending on which
option you select in this field, the Rate Multiplier and Fixed Rate fields activate. If you select the Fixed
option, the Fixed Rate field activates. If you select the Based on Base Rate option, the Rate Multiplier field
activates.

4. Enter a rate multiplier value used on the rate from the level below in the Labor Rate hierarchy. This field
activates only if you select the Based on Base Rate option in the Rate Type field.

5. Enter a fixed rate value. This field activates only if you select the Fixed option in the Rate Type field.

Fixed rate allows overriding of rates defined lower in the Labor Rates hierarchy. This is to allow for more
specific rates rather than using the base rate.
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6. When you finish, click Save on the Standard toolbar.

Renew Contracts

Use the Renew Contracts process to renew several contracts at once. Select the Get Contracts/Renewals option
from the Actions menu to retrieve all contracts that expire prior to the Expire Date.

You can use Service Contract Entry to view and modify renewal details after contracts are renewed.

The Renewable check box must be selected in Service Contract
Entry in order for a contract record to display in the Contract
Renewals pane.

Menu Path: Service Management > Field Service > General Operations > Renew Contracts

To renew several contracts at once:

1. In the Expire Date field, select the expire date to use as a filter to display the service contract records.

2. From the Actions menu, select the Get Contracts/Renewals option to bring up all contract records that
expire prior to the expire date.

3. In the Contracts/Renewals pane, select the Selected check box for each service contract to renew.

4. Once all the contracts to renew are selected, click the Submit icon on the Standard toolbar.  

Invoice a Service Contract

Once a service contract is set up for a customer, there are two ways to process the financial transaction. One
way is to create a sales order that has the service contract line attached. Then, after you ship the sales order, use
AR Invoice Entry to create an invoice.

Another way to process the financial transaction is to invoice a service contract directly in AR Invoice Entry without
creating a sales order or shipment. Define whether a contract needs to be shipped in Service Contract Code
Maintenance.
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Sales Order Entry

You use the New Contract Line option within Sales Order Entry to add a service contract as a line item to a sales
order. You specify the parts, quantity, and price for each service contract line item. You follow the same procedure
that you use to create a sales order. However, on the Line > Detail sheet, you enter information specific to a
service contract.

Once you attach a service contract to an order, you cannot add any more lines to the service contract within
Service Contract Entry. You can, however, continue to add as many order lines and service contract lines as you
need to the sales order.

Menu Path: Sales Management > Order Management > General Operations > Order Entry
The CRM menu path is: Customer Relationship Management > Order Management > General Operations >
Order Entry

To enter a sales order for a service contract line item:

1. Click the New button on the Standard toolbar.

2. On the Summary sheet, click the Customer button to find and select the customer you are selling the
service contract.
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3. Click the Down Arrow next to the New button; select New Contract Line.

4. The Lines > Detail sheet displays. Notice many fields are not open for data entry. For example, you cannot
enter parts that are covered by the service contract in Sales Order Entry. Parts covered by a service contract
are added to the service contract record within Service Contract Entry. For more information, refer to the
previous Service Contract Entry section.

5. Enter the service contract number in the Contract field, or, click the Contract button to find and select the
service contract you created for this customer.

6. If you are creating a sales order for a renewed contract, enter the renewal number in the Renewal field,
or, click the Renewal button to search for and select the renewal record.

If the renewal number is zero, the sales order is processing the original contract which has not yet been
renewed. If the renewal number is greater than zero, the number indicates the renewal contract record
being processed.

The Renewal button is enabled once the contract has
renewals to invoice. Once you select a renewal contract,
the amounts that relate to the renewal display in the Unit
Price field. If it is a quoted renewal, it must be accepted
in order for the renewal values to display.

7. The Description of the service contract displays.

8. The Order Quantity defaults from the service contract and cannot be changed.

9. If you need, change the Unit Price amount. The value in this field defaults from the service contract.
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10. Continue to add other line items to this sales order. When you finish, click Save on the Standard toolbar.

 For more information on how to enter a sales order,
review the Sales Order Processing chapter.

AR Invoice Entry

To invoice a customer for a service contract, you can use two commands in AR Invoice Entry – Get Shipments
and Get Contract Billing. Use the Get Shipments command to generate an invoice when the service contract has
a packing slip with a Shipped status. Use the Get Contract Billing command to create an invoice for a contract
with recurring billings, if the contract is to be invoiced directly, or to invoice a particular line added to a contract.

For more information on how to generate invoices, review the
Customers and Accounts Receivable chapter.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry

To generate an invoice for a service contract:

1. Click the New button on the Standard toolbar.

2. In the Group field, enter the identifier for the entry group.

3. Define the Invoice Date and the Apply Date for the group.
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4. You are now ready to add the packing slip on which the service contract is found. Click the Actions menu.

5. If the service contract is set up for recurring invoices or invoiced directly, select Get > Contract Billing.

6. In this example, the service contract is not set up for recurring invoices, so you select Get > Shipments.

7. The Get Shipments window displays.

8. Click the Customers button to find and select the customer you are selling the service contract.

9. To review only those packing slips not invoiced, click the View Not Invoiced Packing Slips button.

10. The Packing Slip Browse window displays. Select the packing slip on which the service contract is found.
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11. Click OK. Select Yes to the confirmation message that displays.

You can now print the invoice for this service contract.

Service Call Center

You use Service Call Center to enter and track field service calls for a customer. A service call details the parts
that need service, why they need service, and the service contract coverage for the parts. You also use Service
Call Center to assign and schedule technicians to service calls.

Menu Path: Service Management > Field Service > General Operations > Service Call Center

To enter a service call record:

1. Click the New button on the Standard toolbar.

2. A unique call number is automatically assigned to the service call and displays in the Call Number field.

3. Click the Customers button to find and select the customer you are entering a field service call.

4. In the Attn field, select someone at the customer site who is considered the contact for this service call.

5. Enter the Request Date and Request Time the customer is asking for service. The current date and time
default, but you can change these values.

6. Use the Scheduled Date and Scheduled Time fields to define the date and time the technician will be on
the service call.
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7. The Duration field indicates the estimated duration of the service call in days.

For more information on Time Entry, review the Time
Management chapter.

8. The date and time the technician logs against this service call within Time Entry displays in the Actual field.

9. In the Priority field, enter the priority status for the service call. Options include High, Normal, and Low.

10. Specify the type of call assigned to this service call from the Call Type drop-down list. Call types identify
tax and G/L account information. For more information on service call types, review the Service Call Type
section earlier in this chapter.

11. The Case Number field indicates the case identifier, if any, which created this service call.

Line - Detail

To enter line information:

1. Click the Down Arrow next to the New button and select New Line.

2. On the Line > Detail sheet, click the Part/Rev button to find and select the part that requires service.

3. Select the Reason for the requested service for the parts.

Reason codes are defined in Reason Code Maintenance.
Codes that display in Service Call Center are grouped
under the reason type Service Call. For more information
on service call reason codes, review application help.

4. Enter the Quantity and the unit of measure of the part that will be serviced.
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5. If you sold a service contract to this customer for this part, click the Contract button to find and select the
service contract you need.

6. If a part is still under warranty, click the Packing Slip/Line button to access a modified version of the
Customer Shipment Search window; browse for the correct packing slip and line on which the part originally
shipped.

 You cannot reference both a contract and a warranty on
the same service call line.

7. If a part is still under warranty, click the Drop Shipment/Line button to access a modified version of Drop
Shipment Search window; browse for the correct drop shipment and line on which the part originally shipped.

8. Use the Coverage section to see if the contract or warranty covers material, labor, or miscellaneous charges.

9. The Job that is created from the service call displays. You can right-click in this field to access the Job Entry,
Job Scheduling Board, Job Tracker, or Job Search programs.

10. Use the Line Pricing sheet to review the pricing for the selected service call line. The pricing you can review
includes:

• Estimate - The estimated amounts for the pricing elements Service (labor), Material, Subcontract, and
Miscellaneous charges entered at the job level on either operation sequences or material sequences.

• Actual - The actual amounts for the pricing elements Service (labor), Material, Subcontract, and
Miscellaneous charges captured typically during time entry, material issues, and purchase receipts.

• Billable - The amounts billable to the customer for this service call line. These amounts depend on the
settings for Labor, Material, and Miscellaneous found on the Line > Detail sheet.

Technicians

Use the Technicians sheet to assign a shop employee to the field service call.

1. Select the Technicians > List sheet.
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2. Select the Technicians Only check box to only view employees with the Service Technician check box
selected in the Employees program. To view all employees, clear the Technicians Only check box.

3. Select a technician in the Technicians list to review their schedule in the Open Service Calls list.

4. Select a service call record in the Open Service Calls grid to review a call – requested date and estimated
duration in days. This information also displays in the Call section of this sheet.

5. To assign a technician to the service call that is open in the Service Call Center, select a technician in the
Technicians list, and then click the Assign button.

6. The technician is added to the Technicians > Assigned Tech List sheet.

Actions – Create Service Call Job

Use the Create Service Call Job command on the Actions menu to automatically create a service job in Job Entry
with the information entered in Service Call Center.

1. Click the Actions menu.

2. Select Print Service Call Ticket to produce a ticket for the service call open in the Service Call Center. The
service call ticket is printed after you add the new line.

3. A service call automatically closes when the Service Call Labor Complete check box is set from Time Entry,
and the Issued Complete check box is set in Issue Material. You can also manually close the service call. To
do this, select Close Service Call. When you select Close Service Call from the Actions menu, a yellow
Closed status indicator displays in the header of the service call.

4. Select Reopen Service Call to access the call again. Note however, that once a call has been invoiced, you
cannot reopen it.

5. Use the Void Service Call and Activate Service Call commands to cancel and launch a service call
respectively. When you select Void Service Call from the Actions menu, a yellow Voided status indicator
displays in the header of the service call. You cannot void an invoiced service call.

6. To create a service job, select Create Service Call Job. The Job Entry program launches with all pertinent
information populated. In addition, the service job number populates on the Line > Detail sheet in Service
Call Center for the line.
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Service Job Entry

Service Job Entry is the Job Entry program; you can, however, customize Job Entry specifically to match your field
service needs. Then you launch the customized version of Job Entry from the Field Service – General Operations
folder or from Service Call Center – Actions menu. For information on customization, review the Basic
Customization and the Advanced Customization chapters in the Epicor ICE User Experience and Customization
Guide.

You add components such as assemblies, operations, material,
and resources to a service job in the same way you add these
components to a production job. For information on how to
create resource groups, resources, operations, and parts, review
the Engineering chapter. For more information on how to add
components to a job, review the Job Management chapter.

Menu Path: Service Management > Field Service > General Operations > Service Job Entry

Add a Service Operation

In this example, you will add a Repair service operation to this service job.

1. Click the Job button to find and select the service job created from Service Call Center.

2. The Job Search window displays. From the Job Type drop-down list, select Service.

3. Click Search.

4. Notice only service job type’s display in the search results. Select the service job you want and click OK.
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5. The service job number displays in the Job field. The service job number begins with the prefix SRV, and
then contains the service call number along with a sequential number, starting at 1. This sequential number
refers to the number of jobs created for this service call.

6. The Part field displays the part defined in the service call.

7. Notice the Required Date is the same date defined in Service Call Center; if you need, you can change this
date.

8. You can add operations to a job in different ways within Service Job Entry. In this example, you will add an
operation using the Engineering > Operation Master sheet. Click the Operation button to find and
select an operation to add to this service job; you want to add a Repair operation to this service job.

9. Your selected operation displays within the Operations grid.
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10. Click and drag the operation onto the Operations node in the tree view. Notice the Repair operation now
displays underneath the Operations node.

You may want to set up standard operations for those
service call operations you use frequently. Within
Operation Maintenance, you can define the labor rate
and the estimated number of hours to complete a Service
Call operation. For more information on Service Call
operations, review the Engineering chapter.

11. Now you want to enter the estimated number of hours the service technician needs to complete this
operation. You do this on the Job Details > Operations > Service sheet.

12. Because the service contract associated with the service call from which this service job was created covers
labor, the Billable check box is clear; however, you can change this option.

13. The Service Rate is the hourly rate charged for this service. If the operation is maintained within Operation
Maintenance, this field displays for your information and you cannot change this value.

14. Enter the estimated number of hours this service call operation requires in the Estimated Hours field.

15. The total estimated cost of the service call operation displays in the Amount field.

16. If this operation is a subcontract operation, you can use the Subcontract section to enter the estimated
cost per unit for a material quantity worked on during this service.
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17. Select the Job Details > Operations > Detail sheet.

18. To set the operation as mobile, select the Mobile Operation check box.

Select this check box to mark the operation in focus as a Mobile Operation. Once you select this check box,
the operation will be moved to Epicor Mobile as a job.

A mobile operation must satisfy one of the following criteria:

• At least one resource marked as Epicor Mobile Resource must be linked to a mobile operation in Job
Entry and an Employee record in Employee Maintenance. The resource must be set as Location in the
Resource Group Maintenance > Resources > Detail sheet.

• At least one resource group that includes a resource marked as Epicor Mobile Resource must be linked
to a mobile operation in Job Entry. The resource group must be set as Location in the Resource Group
Maintenance > Detail sheet.

When you assign a Resource Group record, which contains
a mobile resource, to a Mobile operation in Job Entry, the
Resource field located in the Job Entry > Job Details >
Operations > Scheduling Resources > Detail sheet must
be void.

19. When finished, click Save on the Standard toolbar. The estimated service cost for this line is now updated
within Service Call Center – Line - Line Pricing.
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Add Material

You also add material to this service job.

1. You can add material in different ways within Service Job Entry. In this example, you add material using the
Engineering > Parts sheet. On the Engineering > Parts sheet, click the Part button to find and select the
material needed for this service job. In this example, you want to add material DSS-1020.

2. Your selected part displays within the Parts grid.

3. Click and drag the part onto the Materials node in the tree view. Notice the DSS-1020 material now displays
underneath the Materials node.

4. Now you need to define the reason this new part is needed and make any adjustments to the unit price of
the material. You do this on the Job Details > Materials > Material Service sheet.

5. Select the reason this material is needed on this service job from the Reason drop-down list.

6. If this added material is for a miscellaneous charge, such as travel expenses, select the service call billing
charge code from the Misc Charge drop-down list.
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7. Because the service contract associated with the call on the service job covers material, the Billable check
box is clear; however, you can change this value. In this example, you bill the customer for this material.

8. The Unit Price is the sales price defined for this material within Part Maintenance; if you need, you can
change the unit price. If this material is for a miscellaneous charge, you enter the charge here.

9. The Ext Price displays the gross extended line total for this material. It is calculated by multiplying the
Qty/Parent value, defined on the Job Details > Materials > Detail sheet, by the Unit Price.

10. When you finish, click Save on the Standard toolbar. The estimated material cost for this line is now updated
within Service Call Center > Line > Line Pricing.

Engineer and Release the Service Job

You are ready to schedule and release this service job.

1. On the Job sheet, select the Engineered and Released check boxes.

In this example, the service technician will repair the part on-site. However, if needed, you could have the
part returned to your facility for repairs. In this case, you may need to schedule the service job in a similar
way as scheduling manufactured jobs.

2. When finished, click Save on the Standard toolbar.

Once a job is released, you can report labor against the job within Time Entry. For more information on how to
add time entries, review the Time Management chapter.
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Time Entry

Time and Expense Entry is the tool you use to enter time records against specific operations on selected service
jobs.

Menu Path: Service Management > Field Service > General Operations > Time and Expense Entry

To enter a new time record:

1. Click the Employee ID button and search for and select an Employee ID.

2. Click the Down Arrow next to the New button and select New Time.

3. The fields on the Time > Daily Time > Summary > Detail sheet open for data entry. In the Payroll
Date field, enter the date on which the labor occurred.

4. From the Shift drop-down list, select the shift during which you performed the labor.

5. Default time values populate the Clock In, Clock Out, and Lunch panes. If you need, you can edit these
times.

6. The total hours display in the Pay Hours field.
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7. When you finish, click Save on the Standard toolbar.

You are now ready to enter the labor details.

Time and Expense Entry - Details

You use the Time > Daily Time > Detail > Detail sheet to define on which job and operation the labor occurred.
You can enter as many details as you need to account for the total labor time that displays on the Time > Daily
Time > Summary > Detail sheet.

To enter a time detail:

1. Click the Down Arrow next to the New button; select New Time Detail.

2. The Time > Daily Time > Detail > Detail sheet displays. From the Labor Type list, select the labor that
was performed. The available options are Indirect, Project, Production, Service, and Setup.

3. Enter the Job, Assembly, and Operation for the labor transaction.

4. If the labor for this service call is complete, select the Service Call Labor Complete check box.

5. In the Labor Qty field, enter the quantity that resulted from this labor detail.

6. In the Labor section, use the Clock In and Clock Out values to define how long you worked on the operation.

7. If this labor transaction completes the operation, select the Opr Complete check box.

8. The Location section defines the default resource group, department information, and resource for this
transaction. You can change these options as needed.
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9. Enter a labor rate associated with an employee selected in the Employee ID field.

The value that defaults in this field comes from the labor rate defined on the Expense Code assigned to
an employee. The Expense Code is assigned in the Expense field located on the Employee Maintenance >
Production Info sheet.

10. Click Save on the Standard toolbar.

11. To complete your time record, click Submit to send through the appropriate approval process.

You have now completed a time detail record. Each record posts actual hours, labor costs, and burden costs
against jobs.

Invoice a Service Contract Call

In this example, the technician reported labor against the service job within Time Entry, indicating the service call
labor is complete. The technician also reported the material as consumed within Mass Issues to Manufacturing.
As labor is reported, material consumed, and miscellaneous charges added, the actual and billable costs update
within Service Call Center – Line - Line Pricing.

When you issue all material to the service job and report all labor against the service job, the status of the service
job changes to Complete within Service Job Entry, and the status of the service call within Service Call Center
changes to Closed. Once the status of the service call is closed, you can invoice the service call.

AR Invoice Entry

Use AR Invoice Entry to generate an invoice for a service call. For more information on how to generate invoices,
review the Customers and Accounts Receivable chapter.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry

To generate an invoice for a service call:

1. Click the New button on the Standard toolbar.

2. In the Group field, enter the identifier for the entry group.

3. Define the Invoice Date and the Apply Date for the group.

Epicor ERP | 10.0.700378

Epicor ERP Application User Guide - Part OneChapter 9 | Field Service



4. You are now ready to add the field service call. Click the Actions menu.

5. Highlight the Get sub-menu and select Field Service Calls.

6. The Generate Field Service Invoices window displays.

7. Click the Sold To Customers button to find and select the customer that you are invoicing for the service
call.

8. Click OK. Select Yes on the message window that displays.

For more information on how to generate invoices, review the Customers and Accounts Receivable chapter.

Reports

This section describes some key field service reports you use to monitor service contracts and service calls. You
can run these reports whenever you need. You can also set up each report to generate and print through a
recurring, automatic schedule. Review the Automatic Data Processing chapter in Epicor ERP Implementation
Guide for information on how you link a report to a recurring schedule. 
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Service Contract Status

The Service Contract Status Report summarizes your existing service contracts by customer, parts, and contract
codes for the specified time period.

Menu Path: Service Management > Field Service > Reports > Service Contract Status

To generate this report:

1. Use the From and To fields to specify the date range of service contracts on the report.

2. Select the Contract Status of the service contracts you would like to see on the report. Valid selections
include All, Active, Expired, or Both.

3. Use the Filter sheet to filter the report by Contracts, Customers, and Parts.

4. Select the report output format.

5. To review the report before printing, click Print Preview on the Standard toolbar.

Service Contract Analysis

The Service Contract Analysis Report summarizes your current service contracts by customers, parts, and contract
codes for a time period you specify. This report compares the invoiced price of contracts with non-billable costs
incurred on service calls issued against the contract.

Menu Path: Service Management > Field Service > Reports > Service Contract Analysis

To generate this report:
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1. Use the From and To fields to specify the date range of service contracts currently in effect to analyze on
the report.

2. Select the Contract Status of the service contracts you would like to see on the report. Valid selections
include All, Active, Expired, or Both.

3. Use the Filter sheet to filter the report by Customers, Parts, and Contract Codes.

4. Select the report output format.

5. To review the report before printing, click Print Preview on the Standard toolbar.

Service Call Status Report

The Service Call Status Report summarizes service call status by customers, parts, and call types for a time period
you specify. You can also include the technicians, services, materials, and miscellaneous service charges assigned
to the service call.

Menu Path: Service Management > Field Service > Reports > Service Call Status

To generate this report:

381Epicor ERP | 10.0.700

Field Service | Chapter 9Epicor ERP Application User Guide - Part One



1. Use the From and To fields to specify the date range of service calls entered on the report.

2. Select the Call Status of the service calls you would like to see on the report. Valid selections include Open,
Closed, or Both.

3. Use the Details section to choose the information assigned to the service call such as the technicians,
services, materials, and miscellaneous service charges.

4. Use the Filter sheet to filter the report by Customers, Parts, and Call Types.

5. Select the report output format.

6. To review the report before printing, click Print Preview on the Standard toolbar.

Service Technician Dispatch

The Service Technician Dispatch report summarizes your technician dispatches for the specified time period.

Main Menu Path: Service Management > Field Service > Reports > Service Technician Dispatch

To generate this report:
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1. Use the Begin and End fields to specify the date range of scheduled service calls you want to review.

2. Optionally, select the Page Break per Technician check box to indicate a new page should start each time
the report encounters a new technician (employee).

3. Use the Filter sheet to limit the report data to only display dispatches for specific Employees.

4. Select the report output format.

5. To review the report before printing, click Print Preview on the Standard toolbar.
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Chapter 10: Engineering

Use the Engineering module to accurately define the components, subassemblies, and operations your company uses
to manufacture parts. The components and subassemblies define the bill of material for a part; the operations define
the routing for a part. Together, the bill of material and the routing are the method of manufacturing. As your
manufacturing practices evolve, the application will continuously update the method of manufacturing to reflect these
changes. By effectively leveraging these engineering features, your company can precisely follow the manufacturing
steps required for your product line.

The part revision drives the engineering functionality. Before you can enter any bill of materials or routing information
on the part, you must create at least one revision for it. After the revision is created on the part record, you check out
this initial revision to an Engineering Change Order (ECO) Group; this record tracks the description, reason, and approvals
for the revision. You can then create the bill of materials and routing information for this revision.

You can also engineer alternate methods for each part revision. Use this feature when the revision must be manufactured
differently – for example, when it is assembled through a slightly different method at another Site. These alternate
methods then reflect the specific process used at each Site within your company.

Before you begin engineering your parts, you need to set up some key records using the Resource Group Maintenance,
Operation Maintenance, and Part Maintenance programs. After you finish defining these records, you engineer your
parts through the Engineering Workbench. Run this program to design and update the processes used for each part
manufactured by your company.

Setup

This section describes the primary records you need to create for the Engineering module. These programs are
contained within the Setup folder for this module. Only the primary records are described here. Some areas within
the next Operations section may also document setup records if they are required for a specific workflow.

You also need to set up some parameters within Company Configuration. The Engineering module has global
settings you need to define through this administration program. For more information, review the application
help for the Engineering module; the Configuration topic details the options you define in Company Configuration.
You can also review the Company Configuration chapter in the Epicor ERP Implementation Guide.

Resource Groups

You manufacture a part through the combined effort of equipment, tools, and people. You can define each of
these items within your manufacturing process using Resource Group Maintenance

A resource is a specific manufacturing asset. A resource can be a piece of equipment like a punch press or a laser
wire marking machine, a tool required to produce components, or an employee like a setter, or operator. A
resource group pulls similar equipment and employee skills together, defining a specific aspect of your
manufacturing center. Resource groups can also define equipment and skills that are placed together within a
physical location.

Menu Path: Production Management > Engineering > Setup > Resource Group
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1. Click New on the Standard toolbar.

2. In the Resource Group field, enter an identifier for the new group.

3. Enter a Description for the resource group.

4. Click the Department drop-down list to select the department that will collect information on multiple
resource groups for various reports.

5. Click the Calendar button to find and select the calendar for this group. You can also enter the calendar
ID directly. This value is the default calendar used for resources created within the group. For more information
about Production Calendars, review the Sites chapter in the Epicor ERP Implementation Guide.

6. If this resource group is a physical place within the manufacturing center, select the Location check box.
Selecting this check box causes the resource group to be defined as the destination on the shop floor where
both raw materials and partially completed product quantities are delivered. It also indicates where completed
product quantities are picked up from this resource group to be sent to the next operation, shipped to the
customer, or received to inventory.

Location resource groups also define the primary amount of manufacturing burden (overhead) placed against
a labor transaction. Because of this functionality, a resource group defined as a location controls the amount
of actual burden placed against an operation. The burden rate defined on a location resource group overrides
any burden rates used on the primary resource group selected for the job operation. When a shop employee
enters labor against a location resource group, the burden rate from this resource group is used on the labor
transaction, instead of the burden rate from the planned resource group on the job operation. You use this
feature to allocate burden costs for tooling, product fixtures, and so on in order to include them in actual
burden amounts.

7. Define the burden rates for both Production and Setup. Burden is the overhead cost, like machine operation
costs, that occur while this resource group runs.
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8. Indicate how this rate calculates by using either the Flat or Percent method. The Flat method uses the
Costing Burden Rate as a flat hourly rate; this value is multiplied by the hours posted against a job to
determine the total burden cost. When you select the Percent method, the Costing Burden Rate is a
percentage of the shop employee’s Labor Rate and is multiplied by the hours posted against a job to determine
the total burden cost.

The Setup value defines the cost that occurs while the
resource group is readied for production. The Production
value defines the cost that occurs while the resource group
is manufacturing materials.

9. Define the labor rates for both Production and Setup. Labor is the cost of the time employees spend
working within the resource group.

10. In the Crew Sizes fields, enter how many shop employees work within this group. You can have different
crew sizes for setup and production.

11. In the Scheduling Blocks field, enter how many resources one operation needs in order to be complete.
The scheduling program divides the production time by the number of scheduling blocks you enter here.

12. The Queue Hours field defines how long materials wait before work begins on them. During scheduling,
this time is added to the estimated production hours.

13. The Move Hours field indicates how long materials wait after the last operation is complete before they
move on to the next resource group. During scheduling, this time is added to the estimated operation hours.

14. Click Save on the Standard toolbar.

Now that you have entered the main information for the resource group, you are ready to enter the group’s
resources

Resource

You also use the Resource Group Maintenance program to create the resources that make up the resource group.
A resource is a specific manufacturing asset. A resource is a piece of equipment like a punch press or a laser wire
marking machine, a tool required to produce components, or an employee like a setter, or operator.

To define resources on the Resources > Detail sheet:
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1. Click the Down Arrow next to the New button; select New Resource.

2. The Resources > Detail sheet displays. In the Resource field, enter the unique identifier for the resource.

3. Enter a Description to identify the resource. This text displays on various reports and windows throughout
the application.

4. Optionally, select the Finite Capacity check box to indicate the resource works only during a specific number
of hours each day. Any operation linked to this resource is not scheduled over this capacity limit.

5. The default Production Calendar selected for the resource group displays in this field. Either enter or search
for and select the production calendar you need.

If you clear this check box, the global scheduling
functionality calculates this resource for infinite capacity.
This means that multiple operations can be scheduled on
this resource at the same time. For more information,
review the chapter on Scheduling.

6. If this resource is a physical place within the manufacturing center, select the Location check box. Selecting
this check box causes the resource to be defined as the physical location on the shop floor where both raw
materials and partially completed product quantities are delivered. It also indicates that complete product
quantities are picked up from this resource to be sent to the next operation, shipped to the customer, or
received to inventory.

Location resources also define the primary amount of manufacturing burden (overhead) placed against a
labor transaction. Because of this functionality, a resource defined as a location controls the amount of
actual burden placed against an operation. The burden rate defined on a location resource overrides any
burden rates used on the primary resource selected for the job operation. When a shop employee enters
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labor against a location resource, the burden rate from this resource is used on the labor transaction, instead
of the burden rate from the planned resource on the job operation. You use this feature to allocate burden
costs for tooling, product fixtures, and so on in order to include them in actual burden amounts.

7. Click the Input Warehouse and In Bin drop-down lists to define the warehouse and bin from which this
resource pulls its material.

8. Click the Output Warehouse and Out Bin drop-down lists to define the warehouse and bin that receives
material from this resource.

9. Click the Backflush Warehouse and Backflush Bin drop-down lists to define which warehouse and bin
backflushes materials to this resource. If the In Bin does not have enough on-hand quantity, materials are
issued from this location instead.

10. The Costing Burden Rates area defines the setup and production burden rates this resource uses. To pull
in the rates from the resource group as a default, select the Use Resource Group Values check box.

11. The Costing Labor Rates area defines the setup and production labor rates this resource uses. To pull in
the rates from the resource group as a default, select the Use Resource Group Values check box.

12. Use the Scheduling section to define how operations at this resource are scheduled. If the resource uses
the same options as the resource group, select the Use Resource Group Values check box.

 For details about the scheduling functionality, review the
chapter on Scheduling.

13. When you finish, click Save on the Standard toolbar.

You next must indicate the days on which work will not be performed within this resource group.

Calendar Exceptions

Use the Calendar Exceptions sheet to define specific days and hours when work does not occur within the current
group. This prevents the scheduling functionality from assigning production hours during these inactive times.

To define calendar exceptions:
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1. Click the Calendar Exceptions tab.

2. Select the date on which the hours normally worked on that date will be different. In this example, you
select April 9th.

3. Click the Calendar Exceptions button.

4. The Calendar Exception window displays. Note both the resource group and the date display on the title
bar.

5. Select or clear the check boxes to indicate the hours during which work will or will not occur on this date.

6. Click OK.
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7. A Calendar Exception icon displays on the date you modified.

Operations

Operations define actions your shop employees perform during the manufacturing process. Operations interact
with resource groups and resources so you can precisely calculate the costs in time, burden, and labor each
operation takes to complete.

Menu Path: Production Management > Engineering > Setup > Operation

To create operations in Operations Maintenance:
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1. Click New on the Standard toolbar.

2. In the Operation field, enter an identifier for the operation.

3. Enter a Description of the operation.

4. You can select two types of operations. A Manufacturing operation is an action used during production.
A Service Call operation is an action used during field service repairs. Select the type that applies to this
operation.

5. The Text field displays standard comments that print on various reports. These comments are used when
the operation is used on a quote, job, or part method.

6. To select the resource groups or the resources used to run this operation, click the Down Arrow next to
the New button; select either New Resource Group Requirement or New Resource Requirement.
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7. For this example, you are linking this operation to a resource group. To do this, navigate to the Scheduling
Requirements > Resource Groups sheet.

8. In the Resource Group ID field, find and select the resource group you want to add to the operation. To
do this, right-click this field. From the context menu, select Open With and then Resource Group Search.

9. Use the Resource Group Search program to find the resource group that you need to run this operation.

10. The resource group you selected displays within the Resource Group List grid. Repeat these steps to add
the resources and resource groups that run this operation.

11. Optionally, you can add a restriction on the use of certain hazardous substances that may be added by this
operation during the production process. To do this, click the Down Arrow next to the New button; select
New Restriction.
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12. The RoHS > Restrictions > Detail sheet displays.

13. Click the Restriction Type drop-down list to select the appropriate restriction type. The default description
from the selected restriction type displays.

14. Click Save.

15. Click the RoHS > Substances > Detail tab.

16. Review the substances included in the selected Restriction Type. For each substance, enter a Substance
Weight, which defines the default weight of the substance per primary part of the Unit of Measure.

17. When you finish, click Save.

When your operations are defined, you are ready to enter your part record.

Base Part Records

The base record used during the engineering process is the part. Each part record can contain multiple revisions,
so the part record can evolve as changes and innovations occur within your company. Part records define all
aspects of the part – including its unit of measures, sites, and lots.

Menu Path: Production Management > Engineering > Setup > Part

To create a new part:
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1. Click New on the Standard toolbar.

2. In the Part field, enter a number for the part. This value is the identifier for the part throughout the
application.

3. Enter a Description for the part.  This description prints on sales orders and AR invoices.

4. Click the Type drop-down list and select Manufactured. This indicates the part is assembled by your
company.

5. Define the UOM Class for the part. The UOM Class represents a combination of unit of measures valid for
the part and the factors used to perform conversions to the base UOM.

6. Select the Primary UOMs for Inventory, Sales, and Purchasing. These represent the units of measure in
which this item is normally sold, quoted, stocked, or purchased.

7. Now define the Sales Unit Price of the part. This price is the default price used for this part when entering
a sales order. This value is just the base price; it can be modified later by any price breaks you enter.

8. Use the drop-down list next to the Sales Unit Price field to indicate the Price Per quantity associated with
this price. You can sell at this price for every one part, every hundred parts, or every thousand parts.

9. In the Internal Price field, enter how much this part costs when this part is transferred from stock in one
plant to a job in another plant. Once again, define the Price Per value from the accompanying drop-down
list.

10. The next fields are all optional items you can define for various project reporting and analysis functions. For
example, if your company classifies parts by product group, select a Group from this drop-down list. Do
the same for the Class, Warranty, Head/Asm Analysis, and Material Analysis drop-down lists. These
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values group together materials operations, assemblies, and headers. You then can run a project analysis
using a specific value you define here, comparing costs contained within each analysis group.

For example, you have a project with multiple jobs that
use material from multiple part classes. If you want to see
how much of the total amount came from these different
part classes, run a project analysis against these class
values to view the segregated costs.

11. If you use Reference categories to group materials for assignment of reference designators, click the
Reference Category drop-down list and select the category, for example, Resistor, LED.

12. If you use tax categories to classify your items for sales tax reporting, click the Tax Category drop-down
list and select an option.

13. When you finish, click Save on the Standard toolbar.

The part record is added to the database. You are now ready to add more details to the part record.

Define the Site

Each part is manufactured at one or more sites within your company. After you define the part’s main information,
indicate which site handles the manufacturing for this part.

Each company automatically has at least one default site. If
your Epicor application has a Multi-Site license, you can define
multiple sites for each company and then select these sites on
your part records.

1. Within Part Maintenance, click the Down Arrow next to the New button; select New Site.
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2. The Part > Sites > Detail sheet displays. Click the Site drop-down list to select the site that manufactures
the part.

3. Click the Primary Warehouse drop-down list to select the main warehouse that stores this part’s finished
quantities.

4. Click the Type drop-down list to select the Manufactured  option.

You create site records in Site Maintenance and
warehouse records in Warehouse Maintenance. You
launch these setup programs from the Inventory
Management module.

5. You can also define the site’s planning parameters. To do this, click the Planning tab.

6. On the Part > Sites > Planning sheet, define the MRP and scheduling parameters for this part at this site.
For example, if you want the Get Details process to create a pull quantity that utilizes existing stock to reduce
the production quantity, select the Auto Consume Stock check box. This causes overrun quantities to be
automatically consumed that have been put into stock.

7. Manufacturing Lead Time is the elapsed time from when production begins on a quantity to when the
quantity is considered complete on the costing lot. This time includes how long it takes to acquire any
constrained materials for the current assembly and how long it takes to manufacture subassemblies needed
to create the current part. You can use the Manufacturing Lead Time Calculation process to automatically
calculate lead time values; this process considers all the variables for manufacturing the complete part from
beginning to end. However, you can override these calculated values and enter the number of days as an
exception value. For more information on this process, review the Manufacturing Lead Time Calculation
section later in this chapter.
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8. Enter a Cumulative Time value. This value is the sum of the manufacturing lead time plus the material lead
time. It incorporates the lead time of the longest constrained material requirement found on any of the
sub-assemblies.

9. Enter a This Level Time value. This value is the time required to build the job cost quantity of the part; it
assumes the required materials are available.

10. When you finish, click Save on the Standard toolbar.

Many other fields and sheets within the Part Maintenance
program are available for use by other functions within
the application. These fields are beyond the scope of this
chapter. To learn about all the available functions, review
the Part Maintenance topics within application help.

The part’s main site information is now defined.

Part Revision

When you finish entering the basic information on the part, you need to create at least one revision for it. You
can then open the part within the Engineering Workbench – where you define the revision’s method of
manufacturing.

To create a part revision:

1. Click the Down Arrow next to the New button; select New Part Revision.

2. The Part > Revisions > Detail sheet displays. In the Rev field, enter the revision identifier. This value
identifies the part revision throughout the application, and it is typically labeled by a letter. For example, A
is the first revision and B is the second revision.  

3. In the Effective field, enter or click the drop-down list to select the date on which this part revision becomes
the main revision for this part. The application uses this date to determine the default revision whenever a
part with revisions is selected on a job record.

4. Enter a Description for the revision.
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5. If you have an engineering drawing for this revision, enter this file’s identifier within the Draw field.

6. If you use reference designators, select the Validate Ref Designators check box to perform validations for
this part revision. Validations include determining the number of reference designators for each material
record, and verifying that each identifier is unique.

7. The Configurable check box indicates the revision has either a configuration linked to it or the revision's
bill of materials (BOM), created through the Engineering Workbench, contains a material or subassembly
revision linked to a configuration.

For example, if a Revision is approved, the application launches a Configuration Sequence process (visible
through the System Monitor) that goes through all subassemblies/materials in the current part's BOM and
searches for configurations linked to the part's BOM. If a configuration is found, the part revision is marked
Configurable. The process continues to branch through any part BOM used as a subassembly. If the logic
finds a configuration linked to a subassembly BOM, this subassembly part is also marked as Configurable.

8. The ECO and ECO Group fields are blank. These fields populate after the part revision is checked out within
the Engineering Workbench. This program is explored later in this chapter.

9. Click the Site field drop-down list to select the site that manufactures this part revision. If you only have
one site within your company, this default site displays.

10. If the Co-Parts check box is selected, the selected part has at least one co-part associated with it.

11. Click the Concurrency field drop-down list to select either Concurrent or Sequential.  The selected value
determines quantity reporting and costing.

• If sequential, the quantity requirements of the co-parts are factored in the total cost of the revision and
then split according to the labor/material cost split set up in the co-part.

• If concurrent, only the quantity requirement of the main part is considered and then divided by yield
to determine the total cost of the revision. Labor and material cost factors are used to split the costs.

12. The Rough Cut Parameter section includes the Rough Cut Code field. This functionality is described in the
chapter concerning Scheduling.

13. When you finish, click Save on the Standard toolbar.
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Alternate Methods

You may have slightly different methods you use to manufacture each part, depending upon various conditions.
If your company manufactures this part in different sites, the method of manufacturing may also vary between
these facilities. To account for these different methods, you can define alternate methods for each part revision.

1. In the Tree View, select the revision level. Click the Down Arrow next to the New button; select New
Alt Method.

2. The Alternate Methods > Detail sheet displays. Notice the Base Revision Number (in this example, B)
displays within a read-only field.

3. In the Alternate Method ID field, enter a value that identifies the alternate method. Typically, you enter
a number in this field. For this example, a 2 displays, which indicates this method is the second alternate
method for part revision B. The method identifier for this alternate method is now B2.

4. The default plant from the Revisions > Detail sheet displays in the Plant field. If this alternate method is
used in a different plant, select this option from the drop-down list.

5. In the Effective Date field, enter or click the drop-down list to select the date on which this alternate
method becomes the alternate method for this part within the current plant. The application uses this date
to determine the default alternate method whenever a part with revisions is entered.

6. If an engineering drawing was entered for the part revision, this default drawing number is displayed within
the Drawing field. If you need, you can enter a different number.

7. If you use reference designators, select the Validate Ref Designators check box to perform validations for
this alternate method.

8. When you finish, click Save on the Standard toolbar.

The part record, its revisions, and its alternate methods are now defined. You are ready to engineer and ultimately
approve this part using the Engineering Workbench.
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Alternate Parts

Use the Alternates sheet to set up substitute and complement parts for the current part record. A list of part
substitutions is then available when you enter sales orders and purchase orders for this part.

When you select a complement part, the Epicor application adds a new detail line to the sales order or purchase
order. This detail line contains the complement part. When you use a substitute part, however, the Epicor
application substitutes the original part on the detail line with the substitute part.

To define a substitute or complement part:

1. Click the Down Arrow next to the New button; select New Part Alternative.

2. Click the Alternate Part button to find and select the part you want to use to either substitute or
complement.

3. The Description of the alternate part defaults from the selected part record.

4. Select the Alternate Type you want from this drop-down list. Available types:

• Substitute – This alternate part replaces the original part selected on the sales order or purchase order
detail line.

• Complement – This alternate part is a cross-sell part you can sell to a customer considering a purchase.
For example, if a customer purchases a keyboard, a mouse is considered a complement item. A new
detail line is added to the sales order or purchase order for this complement part.

5. If you select the Substitute option, you must select a type from the Substitute Type drop-down list. Available
options:

• Comparable – This part is similar in fit, form, and function to the original part. Use comparable parts
when not enough inventory

• Downgrade – This part is a lower price (down-sell) you can offer to a customer. Use this part for a
bargain-minded buyer looking for a cheaper alternative to the original item.

• Upgrade – This part is a higher price (up-sell) you can offer to a customer. Use this part to provide a
better version of the same product or service the customer is considering to purchase.

6. In the Suggested Qty field, enter the quantity of the alternate required to match each base unit of measure
for the original part. Enter a numeric value in this field and then select the unit of measure from the
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accompanying drop-down list. The number of decimals you can enter depends on the Allow Decimals and
Decimals values defined for the selected UOM code.

For example, the base unit of measure for the original part is Case and the selling unit of measure for the
alternate part is Each. If you enter a quantity of 12 in this field and select the default of Each, a 12 quantity
of Each of the alternate part is required to equal one Case of the original part.

7. If you need, enter any additional Comments you want for the alternate part.

8. Select the Default check box to indicate this part is the first alternate option available on the current part
record. You can only select one alternate part as the default option.

9. Continue to add the alternate parts you need. When you finish, click Save on the Standard toolbar.

Restricted Substances

Use the RoHS (Restrictions on the use of certain Hazardous Substances) sheets to indicate the current part complies
with the weight limits defined for hazardous substances used in electrical equipment, electronic equipment, and
other materials. Different legislative bodies, such as the European Union or the state of California, have defined
these weight limits to reduce accumulation in landfills. Use these sheets to indicate the current material meets
these restrictions for the various localities that may receive the part.

Restrictions

To begin using this functionality, you first specify a substance restriction type for a part. Each restriction contains
some overall parameters you define first before you select the substances included with this restriction.

To add a restriction to the current part:

1. Click the Down Arrow next to the New button; select New Restriction.  

2. The Reporting > RoHS > Restrictions > Detail sheet displays.  
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3. Select the Restriction Type from the drop-down list. The current restriction types display as options on this
list; select the one you need.

To learn how to create restriction types for use throughout
your Epicor application, review the Part Parameters chapter
within the Epicor ERP Implementation Guide.

4. The Description for the restriction type displays.

5. Select the Override check box to indicate a weight roll-up will not be calculated for this restriction. You
then enter the restriction amount manually within the Substances sheet. Selecting this check box also causes
the Compliance Date to automatically display the current date.

6. The Compliance Date displays the date on which the roll-up process was last run. This field populates when
the Override check box is selected or when the RoHS Compliance process successfully runs.

7. The Last Roll-Up field displays the date on which the last roll-up process was run against this restriction.

8. If the current restriction can no longer be used against this part, select the Inactive check box. The roll-up
process then ignores this restriction.

9. The compliance status icon indicates the results of the RoHS Compliance process. Available options:

• Not Applicable (yellow) – No substances are selected.

• Non-Compliant (red) – One or more substances are selected, but the roll-up has either not run or has
failed.

• Compliant (green) – One or more substances are selected and the roll-up was successful.

• Exempt (yellow) – All substances are not subject to RoHS compliance

10. When you finish, click Save on the Standard toolbar.

Substances

After you define the restriction for the part, you can then specify the substances, by weight percentage, included
for the current restriction.

You must enter an exempt date for substances exempt for a specific part. After this date, the substance can be
declared as exempt or restricted again. You can also enter an exempt certificate for the substance.

To add a restricted substance to the part record:
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1. Click the Down Arrow next to the New button; select New Restriction Substance.

2. The Reporting > RoHS > Substances > Detail sheet displays.  

3. Select a Substance from the drop-down list. All the substances available within your application display;
select the option you need.

To learn how to create restricted substance records for
use throughout your Epicor application, review the Part
Parameters chapter in the Epicor ERP Implementation
Guide.

4. The Description for the selected substance automatically displays.

5. Enter the Substance Weight restriction and select the Unit of Measure value you need for the current
substance. This value defines the limit for which the restricted substance can be used within the current
part.

6. Select the Exempt check box to indicate the current substance is not subject to RoHS restrictions.

7. Enter the Exempt End Date on which the current substance will no longer be subject to RoHS restrictions.
If this date is equal to or before the current system date, the substance can be exempt.

8. If you need, select the Exempt Certificate to help verify this exemption. This value is the identifier of the
document that validates the exemption.

9. To cause this substance to be ignored during the weight roll-up process, select the Override check box.

10. Continue to update or add the substances you need to this restriction type. When you finish, click Save on
the Standard toolbar.

Operations

This section describes the operations available in the Engineering module. Each operation is described as a
workflow to help guide you through the process from start to finish. These programs are primarily found within
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the General Operations folder for this module. If a unique setup record is required to run the operation, this
record is also described in this section.

RoHS Part Compliance

If you have defined restrictions on the use of certain hazardous substances, you can use the RoHS Part Compliance
Process to run the job compliance roll-up process for the engineered parts. The process generates a log file with
the compliance status of each assembly, material, operation, and substance.

Menu Path: Production Management > Engineering > General Operations > RoHS Part Compliance Process

The RoHS Part Compliance Process window displays. You can now run the compliance for a specific restriction
type or part.

To run the job compliance:

1. Select the Processing Options method you need. The Net Change process is the default method.

You can run a Net Change, which only updates records either updated or added since the last time you
ran this process. You can also select Regenerative, which completely verifies all the current restricted
substances within your application.

2. You can also click the Filters tab to limit the information that displays.

3. Enter filters for the Restriction Type and Parts you want to use for the compliance process.

4. Click Submit on the Standard toolbar to run the compliance process.

Engineering Workbench

The Engineering Workbench is the main program you use to build and maintain a method of manufacturing for
a part. A method consists of two key components – a bill of materials (BOM) and its routing. The BOM is a list
of all the component and subassembly parts needed to produce the final part. The routing defines all the operations
and shop resources needed to produce the final part quantity.

The Engineering Workbench contains all the functionality required to engineer your parts. The next sections of
this chapter give you an overview of this program’s many functions.

Menu Path: Production Management > Engineering > General Operations > Engineering Workbench
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Create a New ECO Group

The Engineering Workbench organizes its data through Engineering Change Order (ECO) Groups. Before you
can create or edit a part revision, you must create an ECO group that maintains and tracks the part revision
changes.

To create an ECO group:

1. Click New on the Standard toolbar.  

2. In the Group field, enter the new group's identifier.

3. Now, in the Description field, enter a reason for the ECO group. Use this field to indicate which part or
parts are engineered through this ECO group.

4. In the Due Date field, enter or click the drop-down to select the date by which this group’s part revisions
need to be complete.

5. Now indicate when these part revisions are available for manufacturing within the Effective Date field.
The application uses this date to determine the default revision whenever a part with revisions is entered
on a job or quote.

6. By default, the Single User check box is selected. This indicates that only one user can have this ECO group
active at a time. If this check box is clear, multiple users can access this group simultaneously.

Although multiple users can be in the same ECO group,
only one user can access a part revision at a time.

7. When you finish, click Save on the Standard toolbar.
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The ECO group is added to your database. You are now ready to check out part revisions to this group and
develop part methods for each revision.

Check Out Parts

Before you can engineer a part revision, it must be checked out to the ECO group. To do this, you launch a
command from the Actions menu.

1. From the Actions menu, click Check Out Part.

2. The Part Revision Checkout program displays. Either directly enter the part number you want to engineer,
or click the Part button to find and select it.

3. All the part record’s revisions and alternate methods display within this program’s grid. Select the revisions
and alternate methods you want to check out to this group. For this example, part revision C and its alternate
method, C2, are selected.

4. Click OK.

A warning message displays indicating this revision and its alternate methods are checked out to this ECO
group. Click OK again.
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5. The part revision you previously created in the Part Maintenance program displays within the Engineering
Workbench. You may begin modifying this part’s method of manufacturing.  

Copy Existing Methods

When you first check out a new revision, it does not have any operations and materials. A quick way to begin a
new part revision is to pull in an existing method of manufacturing from a previous revision. You can then use
this method as a base for your changes to this new revision.

To pull in an existing method of manufacturing from a previous revision:

1. From the Actions menu, select Revision > Get Details > Get from Methods/Jobs/Quotes.
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2. The Get Details window displays. Notice the revisions for the current part display in the grid.

3. Select the revision that has the method you want to use. For this example, select revision A.

4. Click OK.

5. The method from revision A is now pulled into revision B. Its operations and materials display within the
Tree View. You are ready to make the changes you need to the existing method.
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Modify a Routing

When the operations from the previous revision are loaded into the Engineering Workbench, you can modify
them as you need.

1. In the Tree View, select the operation you need to change. The Method of Manufacturing > Operations
> Detail sheet displays, and the selected operation automatically populates the fields on this sheet.  

2. The key field is the Operation drop-down list. Use this list to select the operation that runs at this point in
the routing.

3. The Opr field displays the sequence number that uniquely identifies each operation on an assembly. This
number is assigned in increments of 10. You can insert new operations (for example, 15) between other
operations.

4. The Description field displays the default description for the selected operation. You can edit this field.

5. The Labor Reporting Resource area contains the scheduling resources used for this operation’s setup and
production. The default values are the Production and Setup selected on the operation record. If you need,
you can change these values.

All the operations you define through the Operation
Maintenance program display on the Operation list. Before
you use the Engineering Workbench, you must first create
the operations you want to use through this maintenance
program.
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6. The Setup Per Scheduling Block area contains fields that define this operation’s setup. Enter the amount
of Hours to prepare this operation. If an additional part quantity and setup time is needed, enter these values
in the other fields.

7. In the Scheduling Factors area, you indicate what relationship this operation has with the preceding
operation. The three options are Start-To-Start, Finish-To-Start,and Finish-To-Finish. They indicate
whether this operation starts at the same time as the preceding operation, begins when the previous
operation ends, or finishes at the same time as the previous operation.

8. If you can advance a complete part quantity on the current operation to the next operation before the
operation is complete, select a Send Ahead Type from the drop-down list. You can use this functionality
when the current and previous operations have a Start-To-Start relationship. Available options:

• Hours – Any quantity manufactured after an elapsed time can be moved to the next operation.

• Pieces – A specific complete quantity can be moved ahead to the next operation.

• Percentage – When a percentage of the total quantity is complete, this quantity percentage can be
moved ahead to the next operation.

9. You then indicate the quantity that can be moved to the next operation through the Send Ahead
Offset field. Enter a number that reflects the Send Ahead Type – hours, pieces (a quantity value), or a
percentage.

You define within Site Maintenance whether the Send
Ahead modifier is based on either the Setup Start Time
or the Production Start Time. Depending on what you
select, the Send Ahead calculation estimates what
production quantity can be advanced by including or
ignoring the setup time.

10. Click the Labor Entry drop-down list to define how labor is entered for this operation. The valid options
areBackflush, Quantity Only, and Time and Quantity.

11. The Qty/Parent field indicates how many times this operation must be run on one part. This value is
multiplied against the operation quantity to figure out how many times this operation runs at this point in
the routing.

12. The Prod Std (Production Standard) field defines the rate of production for this operation. The default value
from the operation record displays in this field, but you can change it if you need.

13. The Production Standard value you enter depends upon the Standard Format. You can define the Production
Standard by number of pieces, hours, minutes, or operations. These two values calculate the total estimated
production hours for this operation.

14. When you finish, click Save on the Standard toolbar.

Continue to make any changes you need to each operation within this method. This part revision’s routing is
then correctly engineered.
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New Operations

You can also use the Engineering Workbench to add new operations to the part revision’s method.

1. From the Actions menu, select Operation. Valid selections for the Operations submenu display.

2. You can add an operation step run internally by your manufacturing center, a subcontract operation step
completed by a supplier, and a scheduling resource.

You can only add multiple scheduling resources to an
operation if the Advanced Planning and Scheduling (APS)
module is installed.
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Modify Bill of Materials (BOM)

You can change the materials required to manufacture the part revision in the same way you modify a routing

1. Select the material you need to change on the Tree View. The Method of Manufacturing > Materials >
Detail sheet displays, and the selected material automatically populates the fields on this sheet.  

2. The main field on this sheet is the Part field. This value is the identifier for the material required in this part
of the BOM. If you need to change this part, you can enter it directly or click the Part button to find and
select it.

3. The Description field displays the default explanation for the selected part. If you need, click the
Description button to review the Extended Description for this part.

4. The Mtl Seq (Material Sequence) field indicates at which point in the method this material is needed. You
can change this value.

5. If this material is required at a specific point within the routing, enter the specific Operation in this field.
You can enter this operation directly or click the Operation button to find and select it.

The operation you select here is used to calculate a
Material Required Date when you use this method on a
job. For more information, review the chapter on
Scheduling.

6. Specify the Assembly Options for this part material. Available options:

• Pull as Assembly – Select this check box to indicate this material requirement should be manufactured
as it is needed. Clear the check box to indicate this material requirement should be pulled from stock.
If the check box is clear, the material is pulled into the job or quote as a material with no related

Epicor ERP | 10.0.700412

Epicor ERP Application User Guide - Part OneChapter 10 | Engineering



manufacturing details. If the check box is selected, the material creates an assembly record on the job
or quote, and all material and operation manufacturing details are pulled over.

• Plan as Assembly – Select this check box to indicate this material requirement is fulfilled from stock,
but if not enough stock is available during the manufacturing lead time, it will be planned as a subassembly
by the MRP process.

• View as Assembly – This setting indicates whether all the material required to make a subcomponent
part should display in the bill of materials. If you select this check box, the material required to make this
component displays in the parent part’s bill of materials. If you clear this check box, the item’s material
will not display in this bill of materials.

• Reassign Serial Number to Assembly - Select this check box to designate if serial numbers from the
associated job material/subassembly can be reassigned as the serial number of the parent assembly (top
assembly) itself when reworked using a job. You can report time against this type of operation, if required,
and receive the same serial part back to stock, to another job, or ship directly from a job.

7. The Qty/Parent field defines the quantity of material needed to produce one part. This value is used to
calculate the quantity of material that is needed to manufacture the final part quantity on the job.

8. If you use reference designators, for example to match a schematic to a board layout, click the Reference
Designators tab.

9. To create and link reference designators to the specific material, first you enter the number of identifiers
needed in the Required Ref Designators field.

10. You can create the reference designators individually, or you can create a range of reference designators
for the number of identifiers required. To create a range, enter a Prefix and Suffix, if desired, and click
Add Range.

11. A series of individual reference designators are automatically created for that range. For each line, enter the
XYZ coordinate and Rotation information, and the Description.

In order to use reference designators, you need to create
reference designator categories. For more information,
review the Part Parameters chapter in the Epicor ERP
Implementation Guide
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12. If you use restrictions on certain hazardous substances, you can assign or change the specific compliance
weight of each material. To assign or change a weight, click the RoHS tab.

13. Enter the Material Weight. This value defaults from the Part master for the specific material. Any material
within the weight limit is considered in compliance with your RoHS restriction policy.

14. You can also change the restriction type and substance information associated with this material. To do
this, use the fields on the Restrictions and Substances sheets.

15. When you finish, click Save on the Standard toolbar.

Continue to make any changes you need to each material within this bill of materials.

New Materials

You can also use the Engineering Workbench to add materials to the part revision’s method.

1. From the Actions menu, select Material > Add Material.

Co-Parts

Use the co-parts functionality to define a method of manufacturing that can produce multiple parts (co-parts)
on a single job.

During some part manufacturing processes, you can produce additional parts as by-products from a primary part.
You can also produce two nearly identical parts at the same time using similar routing. An example of this is a
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left and right bracket (with different part numbers) where the only functional difference in the two parts is the
bend operation or the placement of the drilled holes. Four examples are shown below.

To use the Co-Parts functionality, you must have an Advanced
Production license.

Example 1

Part A has co-parts B and C. B and C are only built when part A is built.

CBAPart

NoneNoneB, CCo-Part

NoNoYes - ABCMethod

NothingNothingABCResult

Example 2

Part A has co-parts B and C, but B and C could have independent demand.

CBAPart

NoneNoneB, CCo-Part

Yes - CYes- BYes - ABCMethod

CBABCResult

Example 3

Parts A, B and C are always produced together and could have independent demand.

CBAPart

A, BA, CB, CCo-Part

Yes - CYes - ABCYes - ABCMethod

CBABCResult

Example 4

Part A has B and C as co-parts but B and C have co-parts D and E, respectively.

EDCBAPart

CBEDB, CCo-Part

Yes - ECYes - DBYes - ECYes - BDYes - ABCMethod

ECEDECBCABCResult
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Co-Part Methods

In Engineering Workbench, you can establish the yield per quantity of the co-parts, their costing ratios, and
whether this revision will be used to cost the co-part. Once this data is entered in the Engineering Workbench
(on the Revision > Co-Parts sheet), it is automatically pulled into the job or quote when you select Get Details.

1. To select a new co-part for the identified primary part, click the Down Arrow next to the New button;
select New > New Co Part.

2. Click the Part/Rev button to find and select the part number and revision for the co-part.

3. Use the Yield Per field, enter how many of the specified co-part will be made when one quantity of the
primary part is manufactured.

4. If you need, you can further define the costs by entering values in the Material Cost Factor and Labor
Cost Factor fields. For example, increase a part’s Material Cost Factor if the part uses more material than
the primary part.

5. You can select the Prevent Suggestions check box to prevent Material Requirements Planning (MRP) from
creating job suggestions for the co-part. Refer to the Material Requirements Planning (MRP) Technical
Reference Guide for more information on the Primary Suggestions modifier.

6. Select the Primary Costing check box to indicate this revision is used to cost the co-part. The roll-up
calculation then uses the co-part method and applies the costing factors to the total cost of the method
and divides by the Yield Per value. If this check box is clear, the part method is used to determine the job
costs.

Display Other Revisions/Alternate Methods

To modify other part revisions and alternate methods within this ECO group, you must navigate to them using
the Revision > List sheet. As described previously in the Base Part Records section, alternate parts are substitute
and complement parts for the current part record.

To display this sheet:
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1. Select the Revision > List sheet.

2. Double-click the revision or the alternate method you want to edit.

The Engineering Workbench now displays this revision or alternate method within all of its sheets. Edit the method
of manufacturing as you need.

Create New Revisions/Alternate Methods

Just like Part Maintenance, you can also create new revisions and/or alternate methods through the Engineering
Workbench.

1. From the Actions menu, select Revision. Select either New Revision or New Alternate Method.

Approval

When you have completed creating or editing a part revision’s method of manufacturing, you need to approve
it. Only revisions approved for use are available on jobs and quotes.

A revision cannot be approved if any of its operations are not
assigned to a scheduling resource.

To approve a part revision:
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1. Click the Revision > Detail sheet.

2. Select the Not Approved check box.

3. The Approved icon displays.

The part revision is now approved. After the system clock passes this revision’s Effective Date, this revision becomes
the default version used to manufacture this part.
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Part Revision Check In

To complete the engineering process, you must check in the revision. After the revision is checked in, it is available
for use on jobs and quotes. You can only check in approved part revisions. Before continuing, verify the approved
part displays on the Revision > Detail sheet.

1. From the Actions menu, select Revision > Check In.

2. The Description of Change window displays. Make sure this description explains the reason for the change.

3. Click OK.

Check In Part Revisions and Alternative Methods

You can also check in all the part revisions and their alternate methods at the same time. To do this:

1. From the Actions menu, select Group > Check In All. Click Yes at the verification prompt.
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2. The Description of Change window displays; make sure this description explains the reason for the change
and click OK. Another window displays with a list of part revisions checked in through this group; click OK.

The ECO group is cleared from the Engineering Workbench. All approved part revisions within this group activate
throughout the application.

Express Check Out

You can streamline the engineering process by using the Express Part Checkout program. When you run this
program, you can simultaneously check out a part revision, create a new ECO Group, and launch the Engineering
Workbench.

Menu Path: Production Management > Engineering > General Operations > Express Part Checkout

To check out a specific part revision:

1. Click the Part/Revision button to find and select the part revision you want to check out. You can also
enter the Part/Revision directly.

2. Click the Revision drop-down list to select the revision you want to work on.

3. If you want, you can also check out a specific alternate method. To do this, click the Alternate
Method drop-down list. All the alternate methods created for this part revision display. Select the method
you want.

4. Notice several display only fields – Part Description, Effective Date, ECO Group, and Drawing – populate
with information about this part revision. Review this information to make sure you have selected the correct
revision or alternate method.

5. To immediately display the Engineering Workbench after checkout, select the Launch Engineering
Workbench check box.
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6. Click the Checkout button.

7. If you selected the Launch Engineering Workbench check box, this program displays.

8. Notice a new ECO Group is created. By default, the Group ID displays your User ID as the identifier.

9. The Description field displays Express Checkout as a prefix, followed by your User ID.

10. The Tree View displays the part revision or alternate method you checked out.

You are now ready to engineer the selected part revision or alternate method.

ECO Workflow

A workflow is a series of tasks automatically assigned and routed to ensure processes, like engineering changes
and designing new products, are acted on and completed on time. Tasks are tightly embedded into the application,
so that transactions are updated only if the task is at the right status. For example, when you assign a workflow
to an ECO group, you can track if tasks are complete before an updated part revision is available for production.

This section starts with the setup needed to create the workflow. Then you assign the workflow to an ECO group
and act on the tasks.

Workflow Stage

Workflow stages define the status of an ECO at any time within its workflow; the current stage displays on the
Detail sheet in the Engineering Workbench. You establish these stages in Workflow Stage Maintenance for a
particular workflow type. When you create the ECO task set for your workflow, you assign each milestone task
a workflow stage.

Menu Path: Production Management > Engineering > Setup > Workflow Stage

To create a workflow stage:
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1. Click the Workflow Type drop-down list and select ECO.

2. Click New on the Standard toolbar.

3. In the Stage field, enter a unique code that identifies the workflow stage.

4. Enter a Description that further describes this stage.

5. Click Save.

Now you can define tasks and tasks sets for your ECO workflow. The next section discusses this feature.

Tasks

Tasks are the action items, or milestones, created and assigned to each step in the ECO process, from documenting
a proposed change to approving the ECO design. Tasks are also used to track other activities, such as credit or
time and expense approvals.

Menu Path: Production Management > Engineering > Setup > Task

To create tasks:

1. Click New on the Standard toolbar.

2. In the Task ID field, enter the task identifier.

Epicor ERP | 10.0.700422

Epicor ERP Application User Guide - Part OneChapter 10 | Engineering



3. The Description displays in the Engineering Workbench as well as in Task Set Maintenance. This program
is described in the next section.

4. The Priority code is not required but can be used to weight the importance of a task. The default is 50;
you can enter a range of 1-99. Priority number 99 is considered least important and will be done later;
priority number 1 is considered most important and will be done earlier.

5. Select the Task Type that corresponds to this specific task.

6. Select the Role Code associated with this task. Only members assigned this role have access to this task.

7. If users are required to complete this task, select the Mandatory check box.

8. You can assign multiple persons within a role to a task. If you want the application to indicate this task (or
milestone) is complete when any person assigned to the task marks it complete, select the Any Approver
check box.

9. The application can automatically send a message, or alert, to specific users when this task is created or
finished. To active this feature, select the Send Alert Complete and the Send Alert Create check boxes.

10. When you finish, click Save.

Continue to add all tasks you need.

Task Sets

Defining the ECO process workflow you want your team to follow is a key part in making sure new or updated
part revisions are not available to your manufacturing center until complete. You can set up multiple workflow
task sets to either guide or control the process within your engineering environment. They can be as simple as
a “to do” list of guidelines or as complex as a rigid series of mandatory tasks that require electronic signatures
at key milestones. You decide how to best leverage this powerful workflow tool.

Once individual tasks are identified, they are organized into a task set. Within the task set, you organize the
milestones (tasks) into the sequence you want as viewed in the Engineering Workbench, assign responsibility,
define the number of days to complete the milestone, and add any related tasks. You can create complex,
branching workflows that can handle the requirements you need.

Menu Path: Production Management > Engineering > Setup > Task Set

To create a task set:

1. Click New on the Standard toolbar.

2. Enter a Set ID.
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3. Enter a Description of the Set ID.

4. Click the Workflow Type drop-down list and select ECO. Other types include CRM (Customer Relationship
Management), Case Management, and Time & Expense.

Add Milestones

Now you are ready to add milestones to this task set. A Milestone is a task completed in a specific order (determined
by the task set) and is typically assigned to a specific person. A Related Task is used to describe details about
tasks within tasks. These can be used if one task has several distinct steps within it, each of which merits its own
details

To add milestones:

1. Click the Down Arrow next to the New button; select New Milestone.

2. The Milestones > Detail sheet displays. Accept the default of 10 in the Seq field. Sequence numbers
establish the order in which tasks are done.

3. Click the Task drop-down list to select the first task in this task set.

4. The role assigned to this task displays as read-only in the Required Role field.

5. Click the Current Stage drop-down list to select the stage in which this task is found within the ECI process.
Stages are defined in the Workflow Stage program. Review the previous Workflow Stage section in this
chapter for more information.

6. Optionally, enter the number of days to complete this task in the Days to Complete field.

7. Select the First Milestone check box to indicate this milestone is the first one in this task set.

8. Select the Check Out Allowed and the Check In Allowed check boxes to define if revisions to this ECO
group, at this milestone, can be checked out or in.

9. Select the Workflow Complete Allowed check box if you want the workflow to be marked complete
when this milestone is finished.

10. Continue adding milestones, and related tasks, to the task set until all the tasks are identified. Click Save
on the Standard toolbar.
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Define Next Milestones

Once all milestones are identified, you are ready to establish the order in which these milestones are completed.

1. In the Tree View, select a milestone.

2. Click the Down Arrow next to the New button; select New Next Milestone.

3. The Milestones > Next Milestones > Detail sheet displays.

4. Select the next milestone that makes up this task set from the Next Milestone list. When a user completes
the current task, this next task starts. You can select another milestone available in this task set.

5. Click Save on the Standard toolbar. Continue connecting the remaining milestones to each next milestone.

Workflow Group

You use workflow groups and assign them in the Engineering Workbench to establish a series of tasks to perform
on a specific ECO group, and if you want, by specific team members. You set up workflow groups, and assign
team members to them, in Workflow Group Maintenance.

Menu Path: Production Management > Engineering > Setup > Workflow Group

To create a new workflow group:
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1. Click the Workflow Type drop-down list and select ECO.

2. Click New on the Standard toolbar.

3. In the Workflow Group field, enter a code identifier for the workflow group.

4. Enter a Description that further describes this workflow group.

5. Select the Default Task Set from the drop-down menu.

6. Click Save on the Standard toolbar.

Add Members

Use the Group Member sheet to add the team members you need to the workflow group.

1. Click the Down Arrow next to the New button; select New Group Member.

2. Click the Member drop-down list to select the work force member to add to the group. For information
on how to add a work force member, review the Work Force (Sales Team) section in the chapter on Customer
Relationship Management.

3. The Role assigned to the work force member defaults; if you need, change the role.

4. If this work force member is the primary person in this group, select the Primary check box.

5. To reassign a workflow from one workflow group member to another, click the Reassign button. You are
asked to select the member to reassign.
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6. When you finish, click Save on the Standard toolbar. Continue to add members to this group.

Assign and Update ECO Workflow

You assign ECO workflows to ECO groups in the Engineering Workbench. Once defined, the task set milestones
and related tasks are automatically pulled into the ECO group.

Menu Path: Production Management > Engineering > General Operations > Engineering Workbench

To assign ECO workflows to ECO groups:

1. Click the Group ID button to find and select the ECO group you want to assign a workflow.

2. Click the Workflow Group drop-down list to select the workflow group assigned to this ECO group.

3. The Task Set assigned to this workflow group displays; if you need, change the task set.

4. Click Save on the Standard toolbar.

Update and Complete Tasks

The workflow group and task set are now assigned to the current ECO group. The task set, including the milestones
and related tasks, display on the Tasks > Tree sheet. The members of the workflow group can now update and
complete tasks.

To update and complete tasks:

1. Navigate to the Tasks > Tree sheet.
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Tasks that have a light gray icon are available for update. Tasks with a dark gray icon are not available
because these tasks require another task to be either in process or complete before available. This depends
on how the task is defined.

2. In the Tree View, select a task that is available for update.

3. On the Tasks > Maintenance sheet, select the Complete check box.

4. Optionally, update additional details regarding this task. For example, the reason the task is now marked
as complete, the person to whom the task was assigned, the status of the task, and the percent complete.

Only ECO reason type codes are available in the Reason
list. You set up reason codes in Reason Code
Maintenance. Review application help for more
information on reason codes and reason types.
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5. Click the Update button.

6. Notice the task icon on the Tasks > Tree sheet now displays a green check mark; this indicates the task is
complete.

Continue to update tasks until all tasks in this task set are complete.

Costing Workbench

Use the Costing Workbench to pull in current costs from parts, operations, and resource groups into a unique
cost group you can review and modify. These values become the standard cost values for the parts included in
the cost group. If you modify labor and burden rates through this workbench, these modified rates are also saved
to the resource groups defined on the part methods. Leverage this functionality when you want to generate the
costs of a part at a specific point in time. You can then use these values as a reference point for future transactions
for the part.

You run this program by first creating a cost group. You then define the manufactured and purchased parts you
want included in the group. You also define other global options for the cost group. When you finish defining
the parts you want to include and the overall cost group options, you can then total, or roll up, the costs to
generate the standard values for the parts. However if you do not use the standard costing method, you can still
run the cost rollup process to generate a mass update of burden and labor rates.

Menu Path: Production Management > Engineering > General Operations > Costing Workbench
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New Cost Group

To create a new cost group:

1. Click New on the Standard toolbar.

2. In the Group field, enter the name of the new costing group.

3. Click the Plant drop-down list to select the plant from which the initial costs are loaded into the new cost
group.

4. Either enter or click the drop-down list to select the Proposed Posting Date for the cost group. This value
defines the date on which you expect to post the updated standard costs and labor/burden rates. Use this
field to plan when you will update these costs.

5. The Proposed Posting Date value is only an estimated date. After you post this cost group, the actual date
will display in the Posted Date field.

6. Select the Load Alternate Methods check box to indicate that alternate methods defined for manufactured
parts must be included in the cost group.

7. Select the Load Costing Lot Sizes check box to indicate all costing lot sizes defined on each part plant
combination are included in the costing group. You define the plant modifications for each part within Part
Maintenance.

8. Plant cost IDs, or cost sets, define unit cost calculations across multiple sites. For example, if three sites share
the same cost set, they then use the same costing method for the parts they manufacture. If you wish to
use a cost set, select an option from the Copy from Plant Cost ID drop-down list. You create cost sets in
Plant Cost ID Maintenance.

9. If you want to copy cost values from an existing cost group, select an option from the Copy from Cost
Group drop-down list. These values become the starting point for values in your new cost group.
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10. Use the Costing Method radio button options to define the method used to calculate costs for all the parts
within the group. Available options:

• Average – Calculates a weighted average of all receipt costs for all parts in the cost group.

• FIFO – The First In First Out method assumes the next quantity to be issued or shipped from stock is the
oldest quantity stored in the warehouse. The application uses this cost value until the entire quantity
from the original receipt is used up.

• Last – Calculates the most recent receipt cost for parts within this group.

• Standard – Calculates a cost baseline for the parts within this cost group.

• Costing Method – The default method, selecting this radio button option indicates the costing method
defined on each part record will be used to calculate cost values. Besides the methods available within
the Costing Workbench, this option can also pull in values calculated using the Lot Average and Lot FIFO
costing methods.

11. Use the Burden Rates radio button options to determine which burden rates are used to calculate burden
costs for resource groups included in this cost group. You can select either the Costing or Quoting burden
rates.

12. Use the Labor Rates radio button options to determine which labor rates are used to calculate labor costs
for selected resource groups. You can select either the Costing or Quoting labor rates.

13. When you finish defining the primary values for the new cost group, click Save on the Standard toolbar.

Load Cost Details

When you finish setting up the default values for a cost group, you next select the manufactured and purchased
parts you want to include within the group. You do this by running the Load Cost Details process.

To select parts for the cost group:

1. From the Actions menu, select Load Cost Details.
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2. The Load Cost Details window displays.

3. Select the Effectivity Date for the cost details. This date determines what active part revisions will be used
when costs are loaded into the Costing Workbench.

4. Select what part types you want to include in the cost group by selecting or clearing the Manufactured
Parts, Purchased Parts, and Kit Parts check boxes.

5. You can also indicate the Costing Method you will use with the part you are pulling into the cost group.
Notice these options are the same ones available on the Detail sheet.

6. Select the Burden Rates check box to select you want to pull burden costs from resource groups into the
cost group. You can pull in either Costing or Quoting burden rates.

7. Select the Labor Rates check box to indicate you want to pull labor costs from resource groups into the
cost group. You can pull in either Costing or Quoting labor rates.

8. Optionally, select the Retrieve unlinked Purchase Parts check box to indicate any purchase parts defined
for the current Site but not linked to any of the selected manufactured parts will be included in the cost
details.

9. Likewise, select the Retrieve unlinked Labor/Burden Rates check box to include any labor or burden
rates defined for the current Site not linked to any of the selected manufactured part methods.

10. Use the Log Filename field to indicate the directory path and file name for the log generated through this
process. If an issue occurs, you can use this log to troubleshoot the cause of the problem.

11. Use the Filter sheets to limit the cost details to specific parts, product groups, and/or part classes.

12. The filter options you select display within the Manufactured Part Selection Filter Summary fields.

13. When you are ready to pull in the cost details, click the Process button.
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Modify Costs and Rates

Once the cost details are pulled into the cost group, you can then display these details and modify them as you
need. These details display in a grid so you can move through them and make the modifications.

To modify part costs and labor rates:

1. Navigate to the sheet that contains the costs you want to modify. In this example, you want to modify costs
for manufactured parts, so you navigate to the Cost > Manufactured Parts sheet.

2. Click the Search button to find and select the manufactured parts you want.

3. The selected parts display within the Manufactured Parts grid.

4. Modify the cost values you need. For example, you could modify the Costing Lot Size values for all of the
selected manufactured parts.

5. You can repeat this process on the Purchased Parts, Burden Rates, and Labor Rates sheets.

6. When you finish modifying the costs and rates, click Save on the Standard toolbar.

Rollup Cost and Rate Values

When you are ready to calculate these revised values as the standard cost for the selected parts, you next generate,
or roll up, these values. The new values display on the Costing Workbench report for your review.

The Cost Rollup calculation is a complex routine that uses each
level of assembly in the part method to generate the final cost
of each part. For more information about how the Cost Rollup
calculation generates its values, review the Job Costing
Technical Reference Guide. This guide is available within the
application help.
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To run the cost rollup:

1. From the Actions menu, select Rollup.

2. The Cost Rollup window displays.

Figure 2: Modify Costs and Rates > Steps 2-9

3. Select the Effectivity Date from which this rollup process will be active. The part costs you generate are
then used to determine cost estimates forward from this selected date.

4. Select the Consider Pull As Assembly Settings check box if you want the subassembly costs to be included
as material costs on the higher assemblies on the part methods.

5. Select the Consider Transfer Part as Material check box if Transfer type parts should be considered as
purchased material parts when their costs are rolled up in associated bill of material records. In essence, it
treats it like a purchased material part, not a manufactured part.

6. Select the Consider Only Approved Revisions check box if the Rollup process should only consider
approved revisions when rolling up a part into a higher level assembly

7. Use the Filter sheets to limit the cost rollup to specific parts, product groups, and part classes.

8. Use the Log Filename field to indicate the directory path and file name for the log generated through this
process. If an issue occurs, you can use this log to troubleshoot the cause of the problem.

9. When you are ready, click the Process button to generate the new part costs.
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Costing Workbench Report

You can view the results from the cost rollup process on the Costing Workbench report. Run this report to review
the proposed cost changes you want to make before you save, or post, these changes to the part and resource
group records included in the current cost group.

To run the Costing Workbench report:

1. From the Actions menu, select Print Cost Set Group.

2. The Costing WorkBench Report window displays.

3. Use the Report Type radio button options to indicate whether this report will display costs for parts, resource
groups, or operations.

4. Select a Part Type radio button option to define whether the report displays manufactured parts, purchased
parts, or both manufactured and purchased parts.

5. To limit the report to only display records modified since the last time the part costs were generated, select
the Changed Items Only check box.

6. Use the Filter sheets to limit the report to display selected parts, product groups, and part classes.

7. Click the Print Preview button to display the generated report in a separate window.
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8. Click the Print button to print out a hard copy of the report.

Post New Costs to Records

When you are satisfied with the changes you have made to the part cost values, burden rates, and labor rates,
you then record, or post, these changes to part and resource group records. The revised costs become the standard
cost values for the selected manufactured and purchased parts, while the labor and burden rates update on the
selected resource groups.

To post the new costs to the selected records:

1. From the Actions menu, select Post.

2. The Cost Post Set window displays.

3. Click the Post to Plant Cost ID drop-down list to define the plant cost ID, or cost set, to which you want
to post the results of the cost group. The posting process then updates all sites that share the selected plant
cost ID with your new cost values.

4. Use the Filter sheet to only update records for specific sites, product groups, and/or part classes.

5. If you want to update the labor rates for resource groups included in the part methods, select the Labor
Rates check box.

6. If you want to update the burden rates for resource groups included in the part methods, select the Burden
Rates check box.
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7. Click the Reason drop-down list to select the reason why you are updating the cost values. A required field,
this value displays on various reports and dashboards.

8. Use the Log Filename field to indicate the directory path and file name for the log generated through this
process. If an issue occurs, you can use this log to troubleshoot the cause of the problem.

9. When you are ready to post the cost values to the selected parts and resource groups, click the Process
button.

Manufacturing Lead Time Calculation

You can use the Manufacturing Lead Time Calculation process to calculate the manufacturing lead time for a
single part, all parts, product group, or plant. Manufacturing lead time is the elapsed time from when production
begins on a quantity to when the quantity is considered complete on the costing lot. This time includes

Menu Path: Production Management > Engineering > General Operations > Mfg Lead Time Calculation

To set up this process:

1. Review the processing options. The As of Date defaults to today’s date. It defines the effective date of the
revision.  

2. Click the Product Code drop-down list to select a product group.

3. Click the Filter tab to specify parts and sites for processing. Individual parts can be selected. The plant
defaults to the current plant but can also be changed to include multiple sites.

4. To run the calculation, click Process on the Standard toolbar.

When the process starts, rough cut scheduling is used to calculate the lead time (in days) for the Costing
Lot Size specified by the part planning parameters. Rough cut scheduling uses the Need By Dates and Lead
Time Values on each material and operation to calculate how much time is required for each job to finish
its operations and gather its materials. You can view the calculation values within Part Maintenance on the
Parts > Sites > Planning sheet. For more information on rough cut scheduling, review the chapter on
Scheduling.

437Epicor ERP | 10.0.700

Engineering | Chapter 10Epicor ERP Application User Guide - Part One



Chapter 11: Job Management

The Job Management module contains the central application functions for manufacturing processes. Job Entry pulls
information from sales orders, purchase orders, inventory, and other sources into its core component – the job record.
You then assign each job record a method of manufacturing. This method in turn defines the job’s schedule for its
production within your company’s manufacturing center.

To help you create jobs, two key tools are available – the Job Manager and the Planning Workbench. Use the Job
Manager to review the demand for a part and then answer this demand by creating jobs. Use the Planning Workbench
to evaluate suggestions made to the manufacturing center through sales orders, other jobs, and inventory requests.
You can then create the jobs you need.

As a job’s operations are worked on by shop employees, labor is recorded against these operations, so you can precisely
track labor costs. Use the Job Tracker to accurately review the current real time status of any job. At any point in the
process, you can review a job through three key reports – the Job Traveler, the Production Detail Report, and the Time
Phased Material Requirements Report. Each report helps your supervisors manage job production from operation to
operation.

You then finish the production cycle by indicating when production is complete and when the job is finally finished,
or closed. The part quantity can then be shipped to your customers, completing the job management process.

Setup

Most of the records required for the Job Management module are set up in other modules. However, you have
additional parameters you can define within Company Configuration. For more information on these parameters,
review application help for this module; the Configuration topic details the options you define within Company
Configuration. You can also review the Company Configuration chapter in the Epicor ERP Implementation Guide.

Operations

This section details the operations available in the Job Management module. Each operation is described as a
workflow to help guide you through the process from start to finish. These programs are primarily found within
the General Operations folder for this module. If a unique setup record is required to run the operation, this
record is also described in this section.

Job Types

To help you organize jobs, four categories or types of jobs are available. Each category automatically defines the
specific need or purpose for the job, and indicates how the job is expensed. The type is assigned immediately
when you create a new job, and depends on the module from which you launched Job Entry. For example, a
Maintenance job is created when you launch Maintenance Job Entry within the Maintenance Management
module.

You can use job types as a filter for searches to pull in the specific job you want to review. Available job types
include:

• Service – Use this job type for jobs created for field service orders.

• Maintenance – Use this job type for jobs created to record maintenance tasks on equipment.

Epicor ERP | 10.0.700438

Epicor ERP Application User Guide - Part OneChapter 11 | Job Management



• Project - Use this job type for jobs created to complete Work Breakdown Structure (WBS) phases within a
project.

• Manufacturing – Use this job type for jobs created to assemble a part quantity required to satisfy one or
more demand links.

You can review all job types in Job Entry; however, you cannot create all job types through this program. For
example, maintenance jobs must be created through Maintenance Job Entry. For more information regarding a
particular job type, refer to Project Management, Maintenance Management, and Field Service chapters.

Job Entry

Job Entry is the base production program that you use to create job records. A job can manufacture one or more
quantities for a specific part. You define these quantities by creating demand links within the job record.

Menu Path: Production Management > Job Management > General Operations > Job Entry

To create a new job:

1. Click the Down Arrow next to the New button; select New Job.

2. The New Job Number window displays. Click the Next Job button.

3. The next available job number within the database is assigned. Click OK.
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Primary Job Details

Now that the Job sheet is active, you use this sheet to define the part to be manufactured and other aspects of
the job.

1. Click the Part button to find and select the part number to be manufactured. You can also enter the part
number directly.

2. When you enter an existing part, default values from the part record displays. The Rev list displays the most
current part revision. Optionally select a different revision from the list. You can also enter part numbers
that do not exist in your part master file to create on-the-fly part records.

You create part revisions in the Engineering Workbench.
To learn more about part revisions, review to the
Engineering chapter.

3. If an engineering drawing exists for the part, its identifier displays in the Draw field. When a drawing is
defined on a part revision, it displays automatically.

4. The Desc (Description) field displays the default explanation entered within the part record. If you need to
edit this text, click the Desc button.

5. The Group field displays the Product Group used to track this part. Product groups classify the different
types of parts you sell within your General Ledger. You can also review part transactions for sales analysis
purposes.

6. The Exp Code (Expense Code) field defines the GL expense account numbers used for payroll transactions
from labor entries. This field is required for labor entry.
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7. The Prod Team (Production Team) field is used to assign a specific Production Team. Production Teams are
not resources scheduled for the job, but are simply personnel teams who automatically receive email alerts
when a change occurs on a job.

8. The Planner field displays the person mainly responsible for manufacturing this job. This field is optional.
If a planner was selected on the part record, this person displays in this field automatically.

9. In the Mode field, select either Concurrent or Sequential. The selected value determines quantity reporting
and costing.

• If sequential, the quantity requirements of the co-parts are factored in the total cost of the revision and
then split according to the labor/material cost split set up in the co-part. Co-parts is a method of
manufacturing that can produce multiple parts (co-parts) on a single job. Co-parts are reviewed in more
detail later in this chapter.

If you are not using the co-parts functionality, you
should select this option.

• If concurrent, only the quantity requirement of the main part is considered and then divided by the yield
to determine the total cost of the revision. Then, labor and material cost factors are used to split the
costs. This option only applies to the co-parts functionality.

10. In the Req By (Required By) field, indicate the date by which this job needs to be complete.

11. The Scheduling Priority section indicates if this job has precedence over other jobs. If a job has a High
priority, the Global Scheduling functionality schedules this job ahead of other jobs. If selected, the
Locked check box indicates that the job cannot be rescheduled through Material Requirements Planning
(MRP) or through scheduling boards.

12. The Status section indicates the state of the job. In this example, the job is currently Open, which indicates
that work on this job’s quantities is not complete.

The Status options are reviewed in more detail at the end
of this chapter.

13. When you finish, click Save on the Standard toolbar.

Demand Links

A demand link is a specific part quantity manufactured on the current job. You can create demand links for a
specific order, a stock quantity, or another job. Each job can have multiple demand links. You create demand
links on a job as follows:

1. Click the Down Arrow next to the New button, and then highlight the New Demand Link sub-menu.
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2. Select one of the demand options. Available options:

• Make to Stock

• Make to Job

• Make to Order

Depending on the demand option you select, the corresponding Make tab on the Job sheet becomes active. The
next sections describe the information you must enter to create each demand link type.

Make to Stock

When you select the Make to Stock option, the Make to Stock tab becomes active. This link is a demand for a
part quantity placed within inventory. Enter the following information:

1. The Part field displays the part to manufacture.

2. The Warehouse list displays the warehouse that receives this stock quantity. If you need, select a different
warehouse from the drop-down list.

3. In the Quantity field, enter the part quantity to manufacture.

4. The WIP Quantity displays the part quantity that remains to be manufactured to satisfy this stock demand
link. As parts are manufactured, this quantity decreases.

5. The Received Quantity indicates the quantity placed so far in the selected warehouse.
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Make to Order

When you select the Make to Order option, the Make to Order tab becomes active. This demand link satisfies a
release on a sales order. Use this sheet to find and select the order release filled by this demand link. Enter the
following information:

1. Click the Order/Line/Rel button to find and select the Sales Order, the Detail Line, and the
Release completed through this demand link. You can also enter the order, the line, and the release numbers
directly.

2. The details from this release populate the remaining fields on this sheet. Notice the Customer ID and Ship
By date from the release displays.

3. The Ship By date from the release displays.

4. Notice the Production Quantity from the order release also displays. If you need, you can change this
value.

5. The Shipped field displays the quantity sent to the customer so far. Because this is a new job, no quantities
are currently released to the customer.

6. The WIP Quantity displays the quantity of this part that needs to be manufactured.

7. If a quantity for this demand link can be satisfied through your inventory, use the Pull From Stock fields.
First, select the Warehouse that contains the part quantity.
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8. Enter the Our Pull Quantity you want from this warehouse. This indicates the quantity you are using from
the selected warehouse to satisfy the Make to Order demand link.

If you enter an Our Pull Quantity but do not reduce the
release Production Quantity and click Save, a message
displays explaining you are producing more quantity than
needed to satisfy the link. To prevent this message,
subtract the Our Pull Quantity from the Production
Quantity.

Make to Job

When you select the Make to Job option, the Make to Job tab becomes active. This demand link satisfies a part
quantity needed on another job. Use this sheet to find and select the job and the material filled by this demand
link.

1. Click the Job Number button to find and select the job number. You can also enter the job number directly.

2. Click the Assembly button to find and select the assembly that requires this part as materials. You can also
enter the assembly number directly.  If there is only one assembly on the selected job, a zero displays in this
field.

3. Click the Material button to find and select the material sequence number from the selected job's bill of
materials. You can also enter the sequence number directly.

4. The Quantity field displays the part quantity manufactures with this demand link. If you need, you can edit
this value.
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5. Notice that part information also displays. Review this information to verify the Make to Job demand link is
correct.

Demand Summary

All the demand links on a job can be reviewed on the Demand Summary sheet. In this example, three demand
links display. Following are details on this information:

1. The Source column displays the reasons for the demand links. Notice, in this example, a warehouse, sales
order release, and job material display in this column.

2. The Order column displays any sales orders used for Make to Order demand links.

3. The Warehouse column displays any warehouses used to satisfy a demand link.

4. The Job column displays any jobs used for Make to Job demand links.

5. The Transfer Order column displays any transfer orders (internal requests) used for Make to Order demand
links.

6. The Ship By column indicates when the demand link quantity needs to be shipped to a customer or other
location.

Co-Parts

Use co-parts to define a method of manufacturing that can produce multiple parts (co-parts) on a single job.

Often when you produce one part, another part is produced as a by-product, or two parts are produced similarly
except for one minor operation. An example of this is when you produce a left and right bracket with different
part numbers where the only functional difference in the two parts is the bend operation or the placement of
the drilled holes.

Co-parts is available only if you have the Advanced Production
module installed. Refer to Engineering for more examples of
co-parts.

To add co-parts manufactured with the primary part on the current job:
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1. Click the Down Arrow next to the New button; select New Co-Part.

2. Click the Part/Rev button to find and select the part number and the revision number for the co-part you
want to add.

3. In the Yield Per field, enter how many of the specified co-part will be made when one quantity of the
primary part is manufactured.

4. If you need, you can further define the costs by entering values in the Material Cost Factor and the Labor
Cost Factor fields. For example, increase a part’s Material Cost Factor if the part uses more material than
the primary part.

5. You can select the Prevent Suggestions check box to prevent Material Requirements Planning (MRP) from
creating job suggestions for the co-part. Refer to the Material Requirements Planning Technical Reference
Guide within application help for more information on the Primary Suggestions modifier.
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6. Navigate to the Co-Parts > List sheet to review the co-parts manufactured with the primary part on this
job.

7. The UOM column displays the unit of measure used for the part quantity on the Make Part List. You define
the unit of measure values used for each part withinPart Maintenance.
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Job Production Quantity Total

When you finish creating the demand links for the job, all the quantities on each link are totaled and displayed
in the Prod field in the Quantities section. This field is found near the top of the Job sheet.

Engineer the Job

You are now ready to define the engineering process used to manufacture this job. To do this, you can pull in
the part’s existing method of manufacturing. This includes the part’s routing (bill, or sequence, of operations)
and bill of materials (materials required to manufacture the part).

To pull in the part’s method of manufacturing:

1. Click the Actions menu and highlight the Job sub-menu.

2. Select Get Details.
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3. The Get Details window displays. The Part manufactured by the job automatically displays within this
window.

4. All part revisions available on this part record display on the Revisions grid. Select the revision you want.

5. Click OK.

For complete information on engineering a part, review
Engineering. This chapter describes how you create and
approve part revisions. These revisions are then pulled
into job and quote records.

This part’s method of manufacturing now populates the Job Tree View. Use this view to navigate within this
method as you need.
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Job Tree View

The Job Tree View visually displays the job’s method of manufacturing through a tree structure. Use the interface
to quickly view the job’s method, tracking the job’s progress as its quantities are manufactured.

To view the indented structure for a job:

1. Click the job order icon at the top of the Job Tree View to display the indented job structure. Each method
item is displayed with an icon and some descriptive text.
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Each Job Tree View icon identifies the manufacturing item and in some cases, indicates the item’s current
status.

DescriptionIcon

Indicates that this item is a project.

Indicates that this item is a standard job.

Indicates that this is an assembly linked to the job.

Indicates that the assembly is on the critical path. Any delay to an item on the critical path will
delay the job's completion.

Indicates that this assembly has a problem with the availability of its material needs.

Indicates an operation that has not been run yet. This icon may also be coupled with the "tag
with a red dot" icon to indicate that there are material constraints for the operation.

Indicates that this operation is complete.

Indicates that this operation has a problem with its capacity. This icon may also be coupled with
the "tag with a red dot" icon to indicate that there are material constraints as well as capacity
constraints.

Indicates that this is a subcontract operation. This icon may also display with a red dot to indicate
that the subcontract operation has a capacity constraint.

Indicates that this subcontract operation is complete.

Indicates that this item is a material. This is the default icon for material.

This icon can appear for one of several reasons:

• This icon can appear for one of several reasons:

These materials have been issued to the job.

• The job material does not have a required date. This is either because the job was not
scheduled, or the material was added after the job was scheduled.

• The job material is from stock, and it is Make Direct.

• The job material is from stock, and is coming from a different site, from which the material
has already been shipped.
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DescriptionIcon

• The job material PO release (if purchased) has a received quantity, or will be here before the
Material Required Date.

Indicates that the backflush location does not have enough on-hand quantity to satisfy the
requirement, but the job material record's warehouse - plus the backflush warehouse - does
have enough on-hand quantity.

This icon can appear for one of several reasons:

• Not enough stock is available to satisfy this material’s requirement.

• The Job Material is now overdue.

• The job material is from stock, and is coming from a different site, from which the material
cannot arrive by the Job Material Required Date

• The job materials PO release (if purchased) does not have a received quantity, or will not be
here before the Material Required Date.

• The job material is backflushed, but the backflush location did not have enough on-hand
quantity to cover the requirement, and neither does the job material's warehouse plus the
backflush warehouse.

• The job Start Date is in the past. In this case, there may be enough material quantity available,
but because the Start Date is in the past, the material is considered late.

Indicates that the part revision has changed.

Edit the Part Method

Use Job Entry to change all aspects of the part’s method of manufacturing. You can then fine-tune how the part
quantity is manufactured for this specific job. You can also make this revised method available on other quotes,
jobs, and part records.

To edit specific material:
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1. In the Job Tree View, select the material.

2. The Job Details > Materials > Detail sheet displays. Edit the primary information on this material as you
need.

To learn about the fields on the Material Details sheet,
review the Modify Bill of Materials section in the
Engineering chapter.

3. To review all the materials used on this method of manufacturing, click the List sheet.

4. Use the Material Salvage sheet to enter scrap quantity information on the current material. The value you
enter here credits material costs back to the job, as it defines how much quantity of the material can be
recovered as scrap and reused on a different job.

5. Use the Material RFQ sheet to review the current status about a request for quote linked to the current
material. A request for quote is a document you send to a potential supplier to receive a quote for raw
materials. You cannot edit this information.

6. Click the Comments sheet to review, edit, or add additional text about the current material. Use this sheet
to further refine how the material is used during the manufacturing process.

7. The Material Service sheet is active if the current record is for a service job. Use this sheet to add and edit
the estimated materials needed to complete a service call. After the actual material costs are posted against
the job, you can then compare these costs against the estimated material costs you entered on this sheet.

8. Use the RoHS (Restrictions on the use of certain Hazardous Substances) sheets to indicate the current
material complies with the weight limits defined for hazardous substances used in electronic equipment.
Different legislative bodies, such as the European Union or the state of California, have defined these weight
limits to reduce accumulation in landfills. Use these sheets to indicate the current material meets these
restrictions for the various localities that may receive the part.
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9. Use the Reference Designators sheet to define the reference designators related to the current material.
Typically these designators are used by the electronics industry to match a schematic to a board layout. Each
reference designator can be added as a series using the Add Range button or entered manually. You can
also add XYZ board coordinates, rotation, and comment text for each reference designator.

 To learn more about creating and updating hazardous
material restrictions and reference designators, review
these topics within Epicor ERP Implementation Guide.

10. Use the Inspection sheet to review, edit, or add an inspection plan. An inspection plan ensures the quality
of the material used during the job process. For more information on inspection plans, review the Quality
Assurance chapter.

11. When you finish editing the material, click Save on the Standard toolbar.

Edit the Specific Operation

To edit a specific operation:

1. In the Job Tree View, select the operation.

2. The Job Details > Operations > Detail sheet displays. Edit the primary information on this operation as
you need.

To learn about the fields on the Operation Details sheet,
review the Modify a Routing section in the Engineering
chapter.

3. To review all the operations used on this method of manufacturing, click the List sheet.
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4. Use the sheets under the Scheduling Resources tab to enter and update the resources required to
manufacture the part quantity on the current job. For more information on this functionality, review the
following Scheduling Resources section in this chapter.

5. The Service sheet is active if the current record is for a service job. Use this sheet to add and edit the
estimated labor needed to complete a service call. After the actual labor costs are posted against the job,
you can then compare these costs against the estimated labor costs you entered on this sheet.

6. Click the Comments tab to review, edit, or add additional text about the current operation. Use this sheet
to further refine how the operation is run during the manufacturing process.

7. A subcontract operation is a job step completed outside your company by another supplier. By entering
subcontract requirements as operations, you can include the time that the parts are off-site within the job’s
schedule. When you enter these operations, you can exactly track where the parts are throughout the
manufacturing process. Use the Subcontract sheet to manually enter or edit subcontract operation
information on the current job.

8. Use the RoHS (Restrictions on the use of certain Hazardous Substances) sheets to indicate the current
materials used on the operation comply with the weight limits defined for hazardous substances for electronic
equipment. Different legislative bodies, such as the European Union or the state of California, have defined
these weight limits to reduce accumulation in landfills. Use these sheets to indicate the current operation
meets these restrictions for the various localities that may receive the part.

9. Use the Role Codes sheet to define specific employee roles that can perform or participate in the selected
job operation. Only roles selected on this sheet can post time against this job operation. If the role codes
are not defined, any employee can post time to the job operation.

10. Use the Inspection sheet to review, edit, or add an inspection plan. An inspection plan ensures the quality
of the items that result from the operation. For more information on inspection plans, review the Quality
Assurance chapter.

11. When you finish editing the operation, click Save on the Standard toolbar.

Scheduling Resources

While a job is manufactured, it uses resources. A resource is a specific manufacturing asset. A resource can be
a piece of equipment like a punch press or a drilling machine, a tool required to produce components, or an
employee like a setter, operator, and so on. The resource selections you make are used by the Scheduling module
to calculate how long it takes each operation to run.

You create resources through Resource Group Maintenance.
This maintenance program is explored in the Engineering
chapter.

To review and edit an operation’s resources:
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1. Expand the operation’s node on the Job Tree View to display its assigned resources and select the resource
you want to review.

2. The Scheduling Resources > Detail sheet displays.

3. The Opr Dtl Seq field is the point within the operation this resource is used. In this example, the Drill Press
resource displays. This resource is required to carry out Operation 20, the DRILL operation.

4. The Description of this resource displays.

5. Click the Resource drop-down list to select a different resource. You can also enter the resource directly.

The scheduling process can automatically change a
resource based on its availability; this availability is defined
within a Capability or a Resource Group. If you select a
specific resource on this window, however, the scheduling
process only uses this resource to schedule the operation.

6. The Required For field defines if this resource is used for Setup, Production, or Both.

7. The Setup Rates indicate the estimated labor and burden this resource may use while the operation is set
up.

8. The Production Rates indicate the labor and burden this resource may use while the operation is producing
its part quantity.

9. The Crew Size fields indicate how many workers are required for both setup and production.

10. When you finish, click Save on the Standard toolbar.
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Job Assemblies

Assemblies determine the correct operation hierarchy needed for scheduling a job. Each part has one or multiple
assemblies. A parent assembly is any assembly made up of child subassemblies. If a part has no subassemblies,
only one parent assembly is needed for the produced end part quantity. In contrast, a part with a complex method
can have several parent assemblies.

By default, each method has one parent assembly. To review this assembly:

1. Double-click this assembly on the Job Tree View. The Assembly sheet displays.

2. The Parent field displays the level, or tier, of the assembly. In this example, this assembly is the main parent
assembly, so a 0 displays.

3. The Description of the assembly displays.

4. The Part Information section displays the main details of the part revision.

5. The Qty/Parent field indicates how many parts from this assembly are required to make one part quantity
within the parent assembly. In this example, one assembly quantity makes one finished part quantity. Notice
the unit of measure used for this quantity displays next to this field.

6. The Overrun Qty specifies any excess assembly quantity you want to make on this job. This quantity will
be saved within your inventory. Notice the unit of measure used for this quantity displays next to this field.

7. The Required Quantity field displays the total demand for the part on the current job. Notice the unit of
measure used for this quantity displays next to this field.

8. Click the Comments sheet to review, edit, or add additional text about the current assembly. Use this sheet
to further refine how the assembly is run during the manufacturing process.

9. A subassembly is a child of a parent assembly. Each subassembly defines a manufacturing component
required to make each part; you can have as many subassemblies as you need to complete all the steps
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required to manufacture a part quantity. Use the Subassemblies sheets to manually enter or edit subassembly
information on the current job.

10. Use the RoHS (Restrictions on the use of certain Hazardous Substances) sheets to indicate the current
materials used on the operation comply with the weight limits defined for hazardous substances for electronic
equipment. Different legislative bodies, such as the European Union or the state of California, have defined
these weight limits to reduce accumulation in landfills. Use these sheets to indicate the current assembly
meets these restrictions for the various localities that may receive the part.

11. Use the Inspection sheet to review, edit, or add an inspection plan. An inspection plan ensures the quality
of the items resulting from the assembly. For more information on inspection plans, review the Quality
Assurance chapter.

12. When you finish editing the assembly, click Save on the Standard toolbar.

New Job Method Component

You can further refine the process through which this part quantity is manufactured by adding components to
an existing job method. You can add Assembly, Operation, and Material components. To add a material
component:

1. Click the Actions menu.

2. Highlight the Job Details and Material sub-menus.

3. Method component options display. Select the component you want to add to the current job method.

4. The corresponding detail sheet displays. Enter the information you need for the method component. When
you finish, click Save on the Standard toolbar.
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Engineering Components

You can also pull an existing part, operation, material, resource group, and so on into the job method. Run this
feature to reuse common components you frequently use during the production process.

1. Click the Engineering sheet.

2. Notice several components are available for you to pull into the job method. You can pull in parts,
operations, capabilities, resource groups, resources, part revision methods, quote methods, and
other job methods. In this example, you pull in a resource group.

3. Select the Resource Groups sheet. Each component sheet has a search button to find and select a range
of items you want. In this example, you click the Resource Group button to find and select a range of
resource groups.

4. Your selections display within the sheet list. Click and drag the item you want onto the Job Tree View. In
this example, you add the HM3 Horizontal Mill to the Mill operation.

5. When you finish, click Save on the Standard toolbar.
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Schedule the Job

Selecting the Engineered check box activates the scheduling functions on the Actions menu. You are now ready
to schedule a job.

1. Click the Actions menu, highlight the Schedule sub-menu, and select Job Scheduling.

2. The Schedule Job window displays. First, you must decide how you Schedule the job. Available options:

• Forward – This method schedules the job forward from a Start Date.

• Backward – This method schedules the job back from a Due Date.

3. Depending on the option you select, either the Start Date/Time or the Due Date/Time fields become
active. Select the dates you need.

4. If you want this job to be scheduled through a Finite Capacity, select this check box. This means the finite
resources or resource groups on this job run for a specific number of hours each day, and the job operations
cannot be scheduled for time each work day greater than this constrained capacity.

To learn more about resource groups and other scheduling
features, review the Scheduling chapter.

5. To see what impact this job has on the schedule, select the What-If Schedule check box. Use this option
when you are planning upcoming work for your manufacturing center; it gives you a preview of where this
job may possibly fit into your schedule.

6. When you finish, click OK.

This job is now added to the schedule for your manufacturing center.
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Release the Job

When you are ready to begin production on this job, you need to update its status.

1. Click the Job sheet.

2. A number of options are within the Status area. The Open icon indicates this job can receive labor, material,
and accounting transactions against it. If the job is complete but still open, it can no longer receive labor
transactions, but it can still receive material and accounting transactions.

3. If you want this job method to be available for use on other quotes, jobs, and part records, select the
Template check box. Users can then select this job through the Get Details program.

4. If this job was generated by Material Requirements Planning (MRP), the Firm check box is available. Select
this check box if you want to produce this job. If this job was created manually, the Firm check box is
automatically selected.

For more information on the Get Details program, review
the Engineering chapter. For more information on MRP,
review the Material Requirement Planning chapter.

5. When selected, the Engineered check box indicates this job’s method of manufacturing is completely
planned. Select this option to add this job to the schedule.

6. Before work can begin, select the Released check box. This indicates labor can be placed against the job.
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RoHS Job Compliance Process

To complete adding restricted substances for the part, you run the RoHS Part Compliance Process. This process
totals the weight values for all the restricted substances and verifies the weight values match the RoHS
requirements. You can run this process to verify either engineered parts or parts on job records.

Issued materials and subcontract operations are included during this verification process. Issued materials are
verified if the part is compliant or if the supplier or supplier part is compliant (even if the part is not). Subcontract
operations are verified if the supplier, operation master, or supplier subcontract operation is compliant.

Menu Path: Production Management > Job Management > General Operations > RoHS Job Compliance Process

To run this process:

1. Indicate the Compliance Verification you want to run. You can run this process against jobs which contain
parts either engineered (Engineering option) or manufactured (Built option).

2. Select how you want this process to run from the Processing Options. You can run a Net Change, which
only updates records either updated or added since the last time you ran this process. You can also select
Regenerative, which completely verifies all the current restricted substances within your application.

3. Enter the name and directory path you need for the Log file. If you receive an error during the process run,
review this log file to help discover and resolve the error.

4. Use the Filter sheet to restrict the process to specific Restriction Types or Jobs.

5. Select the Include Released check box to add released jobs to this verification process.

6. Select the Include Completed check box to add any jobs defined as complete to this verification process.
A complete job is one that has finished production quantity and labor transactions, but material and other
costs can still be placed against it.

7. Select the Include Closed check box to add any jobs defined as closed to this verification process. A closed
job is totally finished and has received all of its costs.
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8. To run the process, click the Submit button.

The process runs, totaling the weight compliance totals for the restriction. If the RoHS compliance process fails,
a red icon displays on the Restrictions > Detail sheet within both Part Maintenance and Job Entry. If the compliance
succeeds, a green icon displays on this sheet instead.

Planning Workbench

Use the Planning Workbench to create new jobs or make changes to the supply/demand links on existing jobs.
You first find and select suggestions based on current sales orders. Then, you create jobs and define the demand
links by launching programs from the Planning Workbench.

If your company uses the Material Requirements Planning (MRP)
module, the application can also create suggestions not linked
to sales orders. For more information on this functionality,
review the Material Requirements Planning chapter.

Menu Path: Production Management > Job Management > General Operations > Planning Workbench

1. Click the Select button to find and select the sales order selections that you want.

2. Your selections display within the Suggestions grid. Highlight a selection on the grid.

3. In the Suggestion Detail section, an unlabelled field to the right of the Job Number field indicates what
action should be taken with the selected entry.

4. Click the Job Manager button to launch this suggestion within the Job Manager. You use this program to
define the supply and demand links for the suggestion. To learn more about this program, review the next
Job Manager section in this chapter.
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5. Click the Order Job Wizard button to launch Order Job Wizard. Use this program to generate a job based
on the selected order.

To review how to use the Order Job Wizard, review this
program in the Sales Order Processing chapter.

6. Instead of using the Order Job Wizard, you can click the Create Job button to generate the job. Clicking
this button displays a window that creates the job record. The next section describes how to use this window.

Planning Workbench – Create Job

Use the Create Job window to define the main parameters for a new job you are creating through the Planning
Workbench.

1. To create a new job number for the record, click the Next Job button. A unique job identifier displays in
this field.

2. If this suggestion is from a sales order, the Order Release button is active. Click this button to use the sales
order number, line number, and release number for the new job number. The order suggestion now turns
into a job which you can then modify as you need in Job Entry.

3. If this suggestion is from another job, click the Related Job button. The job number is assembled using the
job to job prefix followed by the original job number.

4. To pull the current method of manufacturing for the part, select the Get Details check box.

5. Selecting the Get Details check box activates the Schedule check box. If you want the new job placed in
the production schedule, select this check box.

6. Selecting the Schedule check box activates the Release check box. If you want to indicate that production
can begin on this job, select this check box.

7. Select the Mass Print check box to indicate this job can be included in batch printing. Some reports, like
the Job Traveler, can be set to print all the jobs that currently have this check box selected; these jobs then
all print at the same time.

8. Click the Submit Process button to generate jobs through background processing. While this job process
runs, you can continue to work in the Epicor application. You can then review these jobs in Job Entry, Job
Tracker, or other tracker and job management programs.

9. Click the Create Job button to create a new job from the selected suggestion.

The new job is created. You can now open this record within Job Entry and make any changes you need.
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Job Manager

Run the Job Manager to easily control the manufacturing of a specific part. You use this program to review a
part’s current demand. You can then create new jobs or link existing jobs to satisfy this demand. You can also
remove supply and demand links you no longer need

Menu Path: Production Management > Job Management > General Operations > Job Manager

To select and review a part:

1. In the Part field, either enter the part directly or click the Part button to find and select it.

2. The Job Manager grids now populate with supply and demand suggestions. The main information for the
part displays within the Detail panel.

3. The Description field displays the current explanation for the selected part.

4. The On Hand (Entire Company) field indicates the part quantity that is currently stocked within the entire
company.

5. The Demand (Entire Company) field indicates the part quantity needed on jobs and sales orders.

6. The Available (Entire Company) field displays the total part quantity available to satisfy demand for this
part.

You can now use this program to both review the current demand for the part and create jobs that satisfy this
demand.
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Job Manager - Inventory

You first should review the part quantity that is available within stock. This information is displayed in the Inventory
section. You cannot edit these fields.

1. The Site field displays the Site that contains the warehouse storing the part quantity.

2. The Warehouse field indicates the specific warehouse that stocks the part quantity.

3. The Quantity On Hand field displays the total part quantity currently stocked within this warehouse.

4. The Available field indicates how many parts are not currently used to satisfy demand.

5. The Total Demand Quantity field displays the quantity allocated to fill the demand on current order
releases.

Job Manager – Demand

The Demand section lists all the upcoming quantities that need to be filled for the current part. Demand entries
come from three sources – sales order releases, job materials, and job assemblies.

To process these demand suggestions, first highlight its row within the grid and then click one of the following
buttons:
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1. Link – Click this button to add the demand quantity to the current job selected on the Supply section.

2. Create Job – Click this button to generate a new job for the demand quantity. When you do this, the New
Job Number window displays. You can use the next job number in the database, the order release for the
job number, or the source job for the new number’s prefix.

3. Pull from Stock – Click this button to satisfy this demand suggestion with a stock quantity. When you click
this button, you are asked if you want to pull this entire quantity from stock.

4. Delete Suggestion – To remove a demand suggestion, click this button. You are asked if you want to
remove this suggestion. Click Yes.

Depending on the source of the demand, you can quickly
launch either the Sales Order Tracker or the Job Tracker.
If you double-click a row in the Demand grid, one of these
trackers displays, showing you the selected sales order or
job record.

5. To limit what displays on the Demand grid, select the Only Firm Releases check box. Only sales order
releases defined as Firm releases display.

6. Use the Suggestions drop-down list to filter the suggestions displayed on the Demand grid. Available
options are All, Change, New, and None.

When you have satisfied the demand suggestion in some way, these buttons become inactive. You can then use
the other sections within the Job Manager to refine how the jobs and stock quantities satisfy the demand.

Job Manager - Supply

The Supply section lists all the upcoming jobs that manufacture the current part. Use the buttons in this section
to manage these jobs.

To process each job, highlight its row within the grid and then click one of these buttons:
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1. Delete Job – Click this button to remove the selected job from the database.

2. Split – Click this button to divide the job into two separate jobs. You would use this function when you
need to finish part of the quantity on this job earlier than the rest, for example, on a rush order.

3. Job Entry – Click this button to launch Job Entry. The selected job displays within this program, so you
make the changes you need to the job. For more information about the Get Details program, review the
Engineer the Job section found earlier in this chapter.

4. Get Details – If the selected job does not have a method of manufacturing, this button is active. Click this
button to launch the Get Details program where you can pull a part, job, or quote method into the selected
job.

5. Schedule – If the selected job has a method of manufacturing, the Schedule button is active. Click this
button to launch the Schedule Job program, where you can define how this job is scheduled for work within
your manufacturing center. For more information about the Schedule Job program, review the Schedule
the Job section found earlier in this chapter.

6. Delete Suggestion – This button is active when a suggestion is generated through Material Requirements
Planning (MRP).If you do not want this suggestion, click this button to remove it from the database. The
MRP functionality is explored in the Material Requirements Planning chapter.

If you double-click a row in the Supply grid, the Job
Tracker launches, displaying the selected job record.

Job Manager - Supply Links

The Supply Links section displays all the jobs and warehouses currently linked to the order release or job highlighted
on the Demand grid.

To make a change to a supply link, highlight it, and click one of the following buttons:
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1. Job Entry – Click this button to display the selected job supply link within Job Entry. Edit this job as you
need.

2. Unlink – Click this button to remove the supply link.

3. Transfer – Click this button to move the supply link from one job to another. You first highlight the job on
the Demand grid and then click this button on the grid. The supply link is moved to the highlighted job on
the Demand grid.

Job Manager - Demand Links

The Demand Links section lists all the sources currently linked to the job highlighted on the Supply grid. These
sources are order releases, jobs, or warehouses. Use the controls in this section to add, update, or remove the
demand from the selected job.

1. Transfer – Click this button to move the demand link from one job to another job. You first highlight the
job on the Supply grid and then click this button on the grid. The demand link is moved to the highlighted
job on the Supply grid.
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2. Unlink – Click this button to remove the demand link from the selected job.

3. Add – Click this button to add a source link to the current job selected on the Supply grid.

4. Update – Click this button to update the source link on the current job selected on the Supply grid.

Job Tracker

You can review a job record at any point during its production and planning. The Job Tracker is a display-only
program that shows you real time information on a selected job. This includes information such as operations,
materials, shipments, and part locations.

Since users cannot add or edit records within this program, the entire company can use this key communication
tool.

Menu Path: Production Management > Job Management > General Operations > Job Tracker

To select a job and update the display:

1. In the Job field, enter the job number directly or click the Job button to find and select it.

2. Click the Retrieve Transactions button on the Standard toolbar to pull in all the current transactions for
the job.

3. If you need, click the Refresh button to display the job’s current information.
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Auto Job Firm Process

You run the Auto Job Firm process to automatically change unfirm jobs generated through Material Requirements
Planning (MRP) to firm jobs. These firm jobs are available for review by your production planners.

The Auto Job Firm process defines the criteria required for jobs to be automatically set to firm. This process
performs two main tasks:

• The process enables jobs to be firmed on a schedule that runs during off peak times.

• The process saves you from manually having to firm jobs and wait for the system to complete the request.

You can set up the Auto Job Firm Process to run on an automatic recurring schedule. This ensures your jobs are
firmed regularly for review by your job planners.

For more information on the Auto Job Firm process, refer to
the Material Requirements Planning chapter. For more
information on recurring schedules, review the Automatic Data
Processing chapter in the Epicor ERP Implementation Guide.

Auto Job Release Process

You run the Auto Job Release process to automatically indicate which firm jobs are within the process parameters
to be released. These jobs are then available for your manufacturing center and production can begin.

You can set up the Auto Job Release Process to run on an automatic recurring schedule. This ensures your jobs
are regularly released for work within your manufacturing center(s).

For more information on the Auto Job Release process, refer
to the Material Requirements Planning chapter. For more
information on recurring schedules, review the Automatic Data
Processing chapter in the Epicor ERP Implementation Guide.

Lean Metrics

Lean Manufacturing is a process that eliminates waste and cost through a continuous production flow measured
by customer demand. Use the Production Activity process both to establish lean performance metrics and to
automatically capture production data through shop floor transactions. The data you capture through this process
can then be analyzed as needed against any lean performance metrics you define.

In order to plan the manufacturing process, you must set up the application so it optimizes customer demand
and eliminates waste. The metrics you define in the lean metrics setup programs contain key information for
your lean manufacturing processing. Configuring lean production activity metrics assists you in generating the
Production Activity records you need and also minimizes data entry.

Production Activity Day Maintenance

Define your lean metrics by establishing the work pattern for each day. Production Activity Day Maintenance
contains the functionality you use to define time by period or by shift.

Menu Path: Production Management > Job Management > Setup > Production Activity Day

To establish the work pattern:
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1. Click the Down Arrow next to the New button; select Activity Day.

2. Enter the activity day ID for the pattern you want to define.

3. Enter the Description for the work pattern.

4. Select the pattern Type for the work day. Work days are defined as Period or Shift depending on how you
break up your work days.

5. When you finish, click Save on the Standard toolbar.

6. Use the List sheet to review all of the Production Activity Day patterns established in the application.

Define Specific Period or Shift Information

1. Click the Down Arrow next to the New button; select Day Detail to enter specific period information for
the work day you are defining.

2. Use the Day Detail sheet to define and review the period pattern for the work day you select.
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Production Activity Week Maintenance

You also must define your overall work week pattern or patterns. Each day of the week has a designated day
code. This pattern is flexible, because you have the ability to incorporate work week variables that accommodate
different production hours, such as weekends.

Menu Path: Production Management > Job Management > Setup > Production Acitvity Week

To define a work week pattern:

1. Click New on the Standard toolbar.

2. Click the Code button to find and select the code for the work week pattern you want to define.

3. Enter the Description of the code to identify the week pattern.

4. In each of the day fields (for example Sunday), click the button to find and select the appropriate day pattern
that applies to the week pattern you want to define.

5. When you finish, click Save.

6. Use the List sheet to review, edit, and select the week patterns you define.

Production Activity Plan Maintenance

You continue the lean manufacturing setup process by defining the production plan. The production plan
incorporates the manufacturing quantity, week patterns, resource groups, and other necessary work patterns
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per period. Production planning is useful to account for seasonal or production changes as they relate to your
production activity.

Menu Path: Production Management > Job Management > Setup > Production Activity Plan

To create a production activity plan:

1. Click the Down Arrow next to the New button; select Plan.

2. Identify the ID to be used for the production plan you create.

3. Enter the Description to identify the ID for the plan you create.

4. Select the Resource Group attached to the production plan you create. Resource group or resource
identification is essential and must be defined in order to generate accurate production planning.

5. Identify the Week ID to pull in the appropriate week pattern established in Production Activity Week
Maintenance.

6. In each of the Hours fields (Labor, Burden, Indirect, and Rework), identify the time for each defined metric.

7. Use the List sheet to review, edit, and select production plans.

8. When you finish, click Save on the Standard toolbar.
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Add Production Detail

1. Click the Down Arrow next to the New button; select Detail.

2. The Day field information defaults from the week pattern you selected on the Detail sheet.

3. Identify plan details for each Period of the day pattern. You select each period from the Tree View.

4. The Crew Size field estimates the level of staffing required for each time period.

5. Estimate the Production Quantity for the time period.

6. When you finish, click Save on the Standard toolbar.

Production Activity Schedule Maintenance

The final setup record for your lean manufacturing metrics is your production activity schedule. This record defines
the manufacturing schedule during the production activity plan. The planning happens at the resource or resource
group level, so you can account for a schedule change required because of production planning alterations due
to seasonal or product needs.

Each plan has an effective date. This value is used by the Production Activity Generator to generate activity records
for resource groups with active production plans.

You can also use the same production plan on several resources or resource groups. Be sure to do this when you
have several resources and/or resource groups that perform the same tasks during your manufacturing workflow.

Menu Path: Production Management > Job Management > Setup > Production Activity Schedule

To create the production activity schedule:
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1. Click New on the Standard toolbar.

2. Click the Plan ID button to select the production activity plan you want to schedule. Once the ID is selected,
the plan details populate.

3. Select the Effective Date for the production activity plan.

4. When you finish, click Save on the Standard toolbar.

Generate Production Activity

Once the production activity lean metrics are defined, you generate a production activity record for each resource
group with an effective plan. This generation process populates the current company’s production plan for a
day, week, or preferred period. This process can be run manually or attached to an automatic recurring schedule.

Menu Path: Production Management > Job Management > General Operations > Generate Production Activity
Process

To generate production activity records:

1. Select the Start Date and the End Date for which you want to generate production schedules.

2. If you only want to generate production schedules for the current site, select the Current Site check box.
Leaving this check box blank generates production schedules for all sites.

3. To run the process, click the Submit button.

If changes in the weekly production activity schedule occur, such as an employee is sick, you can regenerate this
process. However, before the regeneration can take place, you must either manually delete all of the previously
generated files or regenerate for the one day that needs the update.
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Production Activity Maintenance

After you generate the production activity plans, establish the target (transactional) metrics by period using the
effective plan defined in Production Activity Plan Maintenance. You define the metrics for each resource group,
each resource, and each day; this minimizes how much data you enter for time, resources, and materials. However,
you can manually update these default Production Activity values to handle fluctuations in your plans. Examples
of these fluctuations include the number of employees who work in the cell and the number of working hours
needed outside the plan. Through Time Entry, users enter the actual labor quantity and hours they worked on
each job operation.

Menu Path: Production Management > Job Management > General Operations > Production Activity Entry

To review the Production Activity Plan and the actual values:

1. If you need, click the Down Arrow next to the New button to create a new production activity plan. Select
Activity to enter and pull in production metrics from the plan you defined. Typically you will not create
new records within this program; instead, you instead will use this program to review and update the
generated production plans.

2. Enter the ID you want to use for the production activity.

3. Select the effective Date for the production activity.

4. Select the Plan to attach to the production activity you are reviewing, editing, or adding.

5. Identify the Resource Group you attached to the production activity. This value is the group that will perform
labor against the plan.
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6. The Production Plan information defaults into the Hours section. All hours that display when you first
establish the activity are the estimated values for the plan. Once time is entered against the plan, actual
values populate these fields.

7. Once all details are in place, select the Approved check box.

Add Production Activity Detail

1. Click the Down Arrow next to the New button; select Activity Detail to enter specific production activity
information for each period.

2. Use the Production Activity Detail > Detail sheet to enter specific plan information you estimate for each
time period.

The Lean Manufacturing Process

1. Create a new job.

2. Schedule the resource.

3. Schedule and release the job.

4. Post time against the job.

5. Review the activity details until the job is complete.

The previous Job Entry section in this chapter describes this process. Review this section for more information.

Production Activity Tracker

You can review a production activity record at any point during the production and planning stages. The Production
Activity Tracker is a display-only program that shows you real-time information regarding production activity on
the Site floor. Information provided in this tracker includes the production activity estimates versus actuals,
resource group, activity plan, approval status, period details, and labor details. This tracker completes the lean
metrics functionality; use it to compare the production plan estimates versus the actual results achieved during
the production process.
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Because users cannot add or edit records within this program, the entire company can use this key communication
tool.

Menu Path: Production Management > Job Management > General Operations > Production Activity Tracker

To use this tracker:

1. Click the Search tab to define the date ranges and resources you wish to review.

2. Next, click the Refresh button to populate data within the tracker.

3. The Production Activity section displays the actual and estimated values for each detail.

4. The Production Activity Detail tab displays the estimated and actual production quantity in a graph format.

5. The Period Detail section contains the breakdown of the production activity by each period (or shift). You
indicate the method by which you measure time in Production Activity Day Maintenance, a program described
previously.

Manufacturing Execution System (MES)

The Manufacturing Execution System (MES) is an interface your company can use to record labor and material
transactions against jobs. This special interface is designed for users within a manufacturing environment, so it
limits access to functions that only relate to tracking materials and working on jobs.

To use this functionality, your application must have the MES
license. Many major functions on this interface also require the
Advanced Material Management (AMM) license; it is suggested
that you purchase this license before you run MES.

MES Employees

Before users can access the MES, they need an employee record. This record links an employee to a User ID, so
you can define both the security access and the language that this employee uses. Several employees can be
linked to one User ID, like Shop – English or Shop – Spanish. Employees that create inventory or shipping/receiving
transactions, however, should have an individual ID for auditing purposes. This employee record also defines
which functions are available for each user on the MES interface.

You set up these records through Employee Maintenance.
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Menu Path: Production Management > Job Management > Setup > Employee

To create an employee record:

1. Click New on the Standard toolbar.

2. In the Employee ID, enter an identifier for the employee. This value uniquely identifies the record on various
reports.|

3. Optionally, select the Person / Contact identifier for this employee record if one exists. If one does not
exist, the application uses the values in the employee information fields to automatically create a
person/contact record.

4. Enter employee information such as Name, Address, Phone, and Email.

5. In the Status field, verify the employee is an Active employee.

6. You next define what areas of MES this employee can access. If this employee works with material quantities,
select the Material Handle check box. If this employee supervises the shop floor, select the Shop Supervisor
check box. If this employee ships out parts and receives materials, select the Shipping/Receiving check
box.

If you have an individual who needs to be defined on
multiple records, like a shop employee who is also a buyer,
you can define this person in Person/Contact Maintenance
first and then link this person record to other records
throughout the application. To learn about this
functionality, review the Person/Contact Maintenance
section within the Epicor ERP Implementation Guide
reference: Application Setup.
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7. If you want name, address, phone, and email changes made to this employee record to automatically update
the linked person record within Person/Contact Maintenance, select the Sync Name, Sync Address, Sync
Phone, and/or Sync Email check boxes.

Add Production Information

1. Select the Production Info sheet.

2. Select the Shift during which this employee normally works. You create shift records within Shift
Maintenance; for more information, review the Shift Maintenance topics within application help.

3. Click the Department drop-down list to select the job department.

4. Optionally, select the User Name of this employee. Only the identifiers for current users within the company
display on this drop-down list. Use this identifier to link the employee to specific security and language
settings. The feature can define a many to one relationship that includes several employees.

5. If you want, select the Resource Group for this employee. Define this option if you need to directly link
this employee to a specific resource group. If you do not select an option from this drop-down list, the
resource or resource group defaults from the work queue during Time Entry. Likewise, if you use Expense
Entry, this functionality defines the tasks the employee works on, and the resource/resource group is pulled
from the task.

6. When the employee record is complete, click Save on the Standard toolbar.

MES – Primary Functions

When users are set up as shop employees, they can enter labor and material transactions through the MES. This
tool is a special interface that each client machine can be set up to display.

Your system administrator can set up your client machines to
display the interface.

To log in and select the activity in MES:
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1. In the Employee ID field, enter your Shop Employee ID and press the Tab key on your keyboard.

2. You are now logged into the MES. A number of main options are available. To review the current activity
for a specific part, click the Part Tracker button.

3. To review a specific job, click the Job Tracker button.

4. To begin setup or production tasks on an operation, click either the Start Setup Activity button or the
Start Production Activity button.

5. The Start Setup Activity or the Start Production Activity window displays. Click the Job button to find
and select the job you need to work on. You can also enter the job number directly.

6. Select the Assembly that includes the operation you want. In this example, one assembly is on the current
job, so 0 is the only option.

7. Now select the specific Operation that you need to work on.

8. When you finish, click OK. You are now working on this operation. The clock is active, so the MES is
calculating labor costs against this operation.
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9. To stop working on this activity, click the End Activity button on the MES Menu.

10. To end your MES session, click the Log Out button on the MES menu.

11. If you want to shut down the interface, click the Close button on the MES menu. These items are the main
functions of the MES. Depending on whether you have an Advanced Material Management (AMM) license
and the permissions defines on your shop employee record, other functions may be available as well. These
functions are found under the Production, Material, Shipping/Receiving, and Supervisors tabs.

MES – Production

Use the Production sheet to control all aspects of production on the current job(s).

1. The grid at the top of the sheet displays all the activities that you are currently working on.

2. Work Queue – Use this program to review the operations scheduled within each resource group.

3. Count Entry – Use this program to enter physical inventory tag counts.

4. Kanban Receipts – Use this program to enter and update Kanban receipts. You can enter information for
each receipt’s quantities, scrap, and non-conformances.

5. Report Quantity – Use this program to both report a production quantity is complete against a specific
operation and then request that the pallet/skid be moved to the next operation. If you have the Override
Job Number check box selected on your user record within Employee Maintenance, you can do this
without having to clock out of the operation. However, if you do not have these rights, you can still do this
without having to end the activity.

6. Non-Conformance – Use this program to add or update non-conformant materials that occur during
production. Non-conformant materials are items that are defective or require inspection in some way.
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7. Get Request – Use this program to request materials for use during an operation. Use this window to put
in requests so the materials you need arrive on time.

8. Move WIP Request – Use this program to move a Work in Process (WIP) request from one physical location
to another physical location.

9. Move Mtl Request – Use this program to enter a movement request for materials. Use it to move material
requests from one physical location to another physical location.

10. Move Inventory Request – Use this program to enter a movement request for inventory. You can move
a part quantity request to another job or warehouse.

11. Return Assembly/Material Request – Use this program to return an assembly or a material request from
a WIP job to stock.

12. Return Miscellaneous Request – Use this program to return a part quantity request from one warehouse
to another warehouse.

13. Return Salvage Request – Use this program to send a salvaged part request from a job to stock.

14. UOM Split/Merge – Use this program to split an inventory quantity expressed in a specific unit of measure
into one or more alternate unit of measure quantities, or to merge inventory quantities expressed in several
alternate units of measure into a single unit of measure quantity. It can only be used for parts for which the
Track Multiple UOMs check box is selected in Part Maintenance.

15. Material Queue Manager - Use this program to manage and manipulate queued material transactions.
These transactions include pick transactions generated when order items are allocated using selections from
the Fulfillment Workbench Actions menu.

MES - Material

You use the Material sheet to handle the materials you need. You can process requests, issue materials to jobs,
adjust inventory, perform physical counts, and so on

DescriptionButton

Use this program to review the current requests for materials. You can select,
process, and clear material requests.

Material Queue

Use this program to receive manufactured parts into inventory.Mfg Receipts

The Serial Number Tracker displays information about serial-tracked part records.Serial Tracker
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DescriptionButton

Use this program to split an inventory quantity expressed in a specific unit of
measure into one or more alternate unit of measure quantities, or to merge

UOM Split/Merge

inventory quantities expressed in several alternate units of measure into a single
unit of measure quantity. It can only be used for parts for which the Track Multiple
UOMs check box is selected in Part Maintenance.

Use this program to issue material from inventory to a job.Issue Material

Use this program to issue an assembly from inventory to a specific job.Issue Assembly

Use this program to enter a miscellaneous issue of parts from inventory.Issue Misc

Use this program to issue all planned materials to a job, instead of issuing them
one by one.

Mass Issue

Use this program to record part quantities that have been returned.Return Material

Use this program to record assemblies that have been returned.Return Assembly

Use this program to record miscellaneous issues that have been returned.Return Misc

Use this log to review transaction activity for parts and quantities.Trans Log

Use this program to move a Work In Process (WIP) part from one job operation to
another. It updates the PartWIP table, and if the job contains a serial tracked part,

Move WIP

the Epicor application updates the serial number and serial tracing tables to reflect
the newly assigned operation.

Use this program to move a raw material issued to a job to another location.Move Material

Use this program to adjust the physical location or quantity of a Work In Process
(WIP) part. You only run this program when a WIP part is recorded in the application
in one physical location, but is actually in another physical location.

Adjust WIP

Use this program to adjust the physical location or quantity of a material. You can
only run this program when a material is recorded in the application in one physical
location, but is actually in another physical location.

Adjust Material

Use this program to add or update non-conforming materials that occur during
job production. Non-conforming materials are items that are defective or require
inspection in some way.

Non-Conformance

Use this program to transfer inventory quantities within the same site. These
transactions track the movement of parts from one warehouse/bin to another
warehouse/bin.

Move Inventory

Use this program to adjust each part’s quantity on hand values within your inventory.Adjust Inventory

Use this program to enter physical inventory tag counts.Count Entry

Use this program to unpick materials for a specified order, line, release and part
number, and then return them to a specified warehouse and bin.

Unpick Sales Order

Use this program to unpick materials for a specified transfer order line and part
number, and then return them to a specified warehouse and bin.

Unpick Transfer Order

Use this program to process a specified Queue ID in the Material Request Queue.Process by ID
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MES - Shipping/Receiving

The Shipping/Receiving sheet gives you control over all areas of the shipping and receiving process. Use these
controls to record the materials you have received and the parts you have shipped out.

DescriptionButton

Use this program to enter receipts from all inventory materials, non-inventory
materials, and subcontract parts.

Receipt Entry

Use this program to report receipts of salvaged materials from a job. Salvaged
materials are entered as inventory receipt transactions. They also reduce the
material cost against specific jobs.

Salvage Material Receipt

Use this program to enter the receipt of manufactured parts to another job.Job Receipt

Use this program to record an inter-site transfer shipment. This program satisfies
inter-site demand.

Transfer Order Shipment

Use this program to enter a receipt for a transfer order.Transfer Order Receipt

Run this tracker to review current information about a transfer shipment.Transfer Order Tracker

Use this program to process customer shipments. You can either relieve inventory
or ship directly from a job.

Customer Shipment

Use this program to enter and update bills of lading. These items are shipping
documents that carriers use to identify cargo. Create these from existing packing
slips, or create them manually.

Bill of Lading

Run this tracker to review current information about a customer shipment –
including the parts and quantities that were shipped.

CustShpmnt Tracker

Use this program to enter packing slips for non-billable material. You can also
use this program to enter and print packing slips to return discrepant parts to a
supplier.

Misc Shipment

Run this tracker to review current information about a miscellaneous shipment
– including what items were shipped.

MiscShpmnt Tracker

Use Return Material Authorization (RMA) to control and track customer returns.
Enter information about the return and then communicate this information to

RMA Processing

the different groups that may need to take action — such as inspection, billing,
and order processing.

Use this program to process shipments to subcontract suppliers for parts with
operations processed outside your company.

Subcontract Shipment

This tracker displays information about serial-tracked part records. You can review
each part’s serial tracker status, location, and part transactions.

Serial Tracker
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DescriptionButton

Use this program to dispose and complete RMA receipts from inspection.RMA Disposition

MES – Supervisor

The Supervisor sheet gives you access to several tracker programs you use to review job progress within your
manufacturing center

1. Project Tracker – This tracker displays current information about projects. Use this tracker to review milestone
information, related orders and jobs, tasks, and budgets.

2. Inspection Processing – Use this program to inspect the non-conformance entries made for defective
assemblies and materials. You can also use this tool to inspect purchase order receipts and customer returns.

3. Shop Tracker – Run this tracker to review current shop activity. You can see information on resources,
labor activity, and shop warnings.

4. Error Log – An alert error occurs when the application cannot send a global alert (an automatic email
notification) to a specific recipient. When such an error occurs, an entry displays in this log.

5. Tracker – Run this tracker to review the current information about a purchase order. This includes information
like purchase order status, supplier name and address, and order lines.

6. Receipt Tracker – Run this tracker to review current information about a purchase order receipt. This
includes information like the purchase order number, the received lines, and the landed costs.

7. Lot Tracker – This tracker displays information about lot-tracked part records. Use this tool to review lot
numbers, on-hand quantities, and lot transactions.

8. Serial Tracker – This tracker displays information about serial-tracked part records. You can review each
part’s serial tracker status, location, and part transactions.

9. CustShpmnt Tracker – Use this tracker to review current information about a customer shipment – including
the parts and quantities that were shipped.

10. MiscShpmnt Tracker – Use this tracker to review current information about a miscellaneous shipment –
including what specific items were shipped.

11. Order Tracker – Use this tracker to review current information about a sales order. You can review each
sales order’s lines and commissions.
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Time Entry

Time and Expense Entry is the tool you use to process time detail records. Use this program to record the time
and attendance of your employees. You can use this program to enter new time records against specific operations
on selected jobs. You can also pull in time records created through the MES interface and edit them.

These time detail records are placed against the selected operation. You can then calculate the labor costs on
each job.

Menu Path: Production Management > Job Management > General Operations > Time and Expense Entry

To enter a new time record:

1. Enter the Employee ID.

2. Click the Down Arrow next to the New button; select New Time.

3. The fields on the Time > Daily Time > Summary > Detail sheet open for data entry. In the Payroll Date
field, enter the date on which the labor occurred.

4. Click the Shift drop-down list to select the shift during which the employee performed the labor.
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5. Default time values populate the Clock In, the Clock Out, and the Lunch sections. If you need, you can
edit these times.

6. The total hours during which this employee is paid display in the Pay Hours field.

7. When you finish, click Save on the Standard toolbar.

You are now ready to enter the details about the labor that this employee performed.

Time Entry - Details

You use the Time > Daily Time > Detail > Detail sheet to define the job and operation the labor occurred. You
can enter as many details as you need to account for the total labor time that displays on the Time > Daily Time
> Summary > Detail sheet.

If your company uses the MES interface, the application pulls
the time details recorded through this interface during the
selected day. You can then review each detail on this sheet,
updating the time entry records as you need.

To enter a time detail:

1. Click the Down Arrow next to the New button; select New Time Detail.

2. The Time > Daily Time > Detail > Detail sheet displays. Click the Labor Type drop-down list to to select
the labor that was performed. The available options are Indirect, Project, Production, Service, and Setup.

3. Click the Job button to find and select the job this employee worked on. You can also enter the job number
directly.
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4. Click the Assembly button to find and select the assembly on which the labor was performed. You can
also enter the assembly number directly. If there is only one assembly on the job, a 0 displays in this field.

5. Click the Operation button to find and select the operation on which this labor was performed. You can
also enter the operation number directly.

6. In the quantity fields, enter the part quantities that resulted from this labor detail. Enter the number of
complete parts in the Labor Qty field, the number of scrapped parts in the Scrap Qty field, and the number
of non-conformance parts in the Non-Conform Qty field.

7. If this labor was rework so that a defective part can recover its value, select the Rework check box.

8. When you enter scrap and non-conformance quantities or select the Rework check box, the Reason fields
become available. Select a reason for these non-standard quantities in these fields.

9. Click the Serial Numbers button to find and select the serial numbers for the parts on which the employee
performed labor.

10. In the Labor Reporting area, use the Clock In and Clock Out values to define how long this employee
worked on the operation.

11. Select an Indirect Code for the labor performed.

12. Select an Expense Code for the labor performed.

13. If this labor transaction completes the setup or production on this operation, select the Complete check
box. If this labor transaction completes the operation, select the Opr Complete check box.
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14. The Location section defines the default resource group, department information, and resource for this
transaction. You can change these options as needed.

15. Click Save on the Standard toolbar.

16. To complete your time record, click Submit to send the time entry record through the appropriate approval
process.

You have now completed a time detail record. Each record posts actual hours, labor costs, and burden costs
against jobs.

Job Complete/Close

Use Job Completion/Closing Maintenance to assign complete and closed statuses to jobs. A complete job has
finished its production quantity and labor transactions, but material and other costs can still be placed against
it. Completing a job removes any remaining shop load and material requirements.

A closed job is totally finished and has received all of its costs. The accounting department typically closes the
job after auditing the financial transactions. This prevents the job from being used in any transactions or
adjustments.

You can use the Auto Job Closing and Auto Job Completion
processes in place of Job Completion/Closing Maintenance to
automatically close and complete jobs. Any jobs that fall within
the thresholds defined on closing and completion codes used
in the Epicor application are automatically closed. Any jobs
that fall outside these thresholds fail to close or complete. Refer
to the Application Help for more details.

Once you close and complete jobs, you use the Capture COS/WIP Activity process to execute the calculation
process for work-in-process (WIP) and/or cost of sales (COS) for standard jobs, project jobs, inventory, receipts,
and adjustment transactions. Refer to the Job Costing Technical Reference Guide for detailed information.

Menu Path: Production Management > Job Management > General Operations > Job Closing

To complete and close a job:
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1. Click the Job button to find and select the job number. You can also enter the job number directly.

2. The Complete Qty field displays the quantity of pieces reported as complete on the last operation.

3. The Operations sheet displays all the operations performed during this job. Use this grid to verify the
operations on the job are complete.

4. The Materials sheet displays all the materials used to manufacture the final part quantity. Use this sheet to
review the materials used on the job.

5. If you are ready to end labor on the job, select the Complete check box. You are now unable to edit
operation and assembly records on the job.

If inspections are not complete on the part quantity, a
warning message displays when you select the Complete
check box. You can either click Yes and continue, or click
No and wait to complete this job until the part quantity
passes inspection. You cannot close a job, however, until
the quantity passes inspection.

6. If all remaining costs have been assigned to this job, select the Closed check box. You can no longer edit
this job through Job Entry, nor can you post transactions against this job.

7. When you display a closed job within Job Entry, you can see its status has changed. It now displays the
Closed icon, and all the other status options are no longer available.

The application now considers the job finished. Transactions can no longer be placed against the job, and its
costs are moved to your financial records.

Epicor ERP | 10.0.700492

Epicor ERP Application User Guide - Part OneChapter 11 | Job Management



If you complete or close a job by mistake, you can launch the Job Complete / Close program again and clear
either the Complete or Close check boxes. You can now open this job within Job Entry and correct the errors.

For more information on the Job Completion / Closing process,
refer to the Job Costing Technical Reference Guide within
application help.

Reports

This section describes some of the key Job Management reports. You can run these reports whenever you need.
You can also set up each report to generate and print through a recurring, automatic schedule. Review the
Automatic Data Processing chapter in the Epicor ERP Implementation Guide for information on how to link a
report to a recurring schedule.

Job Traveler

The Job Traveler is a report you can use to print the details of any jobs you select. When you print this report,
you have a hard copy of the job that can move, or travel, within the manufacturing center and any other locations
within your company.

Menu Path: Production Management > Job Management > Reports > Job Traveler

Within the Report Options section, select the job details you want to print:

1. Print all jobs flagged for mass print – Select this check box to indicate all jobs which have their Mass
Print check boxes selected print on the report. Within Job Entry, this check box is found on the Job sheet
within the Print Status section.

2. Print Scheduled Resources – Select this check box to indicate any resources used on the job(s) print on
the report.
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3. Print Scheduled Resource Descriptions – Select this check box to indicate the descriptions of these
resources print on the report.

4. New Page Per Assy – Select this check box to indicate each assembly prints on a separate page.

5. Shipping Schedule – Select this check box to indicate the shipping schedule for any orders linked to the
job(s) prints on the report.

6. Bar Codes – Select this check box to indicate bar codes print on the report. Employees use these codes to
scan their labor records directly into the application.

7. Operation Dates – Select this check box to indicate the scheduled Start Date and Due Date for each
operation prints on the report.

8. Operation Standards – Select this check box to indicate the estimated setup and production standards
for each operation print on the report.

9. Filter – Use this sheet to select which jobs and assemblies to include on the report.

10. When you are ready to run this report, click Print on the Standard toolbar.

Production Detail Report

The Production Detail Report prints all the labor, material, shipping, and invoicing activity to date for jobs you
select. It can also display you profitability information by comparing job costs with AR invoicing information.

Menu Path: Production Management > Job Management > Reports > Production Detail

Within the Report Options section, select the items from the jobs you want to display:

1. Summary Only – Select this check box to indicate only the assemblies and total costs for each job print on
the report.

2. Consolidated Totals – Select this check box to indicate the total actual and estimated costs for each job
prints on the report. An added section, Report Totals, displays all these totals.
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3. Subtotal By Product Group – If you select the Consolidated Totals check box, this check box activates.
Select this check box to indicate a Product Group section prints on the report; this section divides the
estimated and actual costs by product group.

4. Exclude Miscellaneous Charges – Select this check box to remove shipment charges from the report.
Miscellaneous charges for expedite fees are included in the report by default.

5. Print Material Transactions – Select this check box to indicate details from material transactions print on
the report.

6. Print Material Cost Breakdown – Select this check box to indicate the cost details are separated by labor,
material, burden, subcontract, and material burden costs.

7. Print Operation Transactions – Select this check box to indicate operation transaction details print on the
report. These details include labor transactions and shipment/receipt transactions.

8. Print First Article Transactions – Select this check box to indicate all first article transactions print on the
report.

9. Print Profitability Information – Select this check box to indicate profitability information prints on the
report. This section compares job costs to AR invoices.

10. Print Serial Numbers – Select this check box to indicate part serial numbers print on the report.

11. Filter – Use this sheet to select which specific jobs and assemblies to include on the report.

12. When you are ready to run this report, click Print on the Standard toolbar.

Work in Process Report

The Work in Process report displays the current value of all work in process (WIP), cost to inventory, and cost of
sales (COS) items. This report first prints the total costs to-date for each job. Based on the part's current status,
these costs are moved into the Inventory, Cost of Sales, and Work in Process categories.

Menu Path: Production Management > Job Management > Reports > Work In Process

Within the Selection sheet, specify the selection criteria for the report:
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1. Cutoff Date – Select the cutoff date for the report; you use this to select job orders that have not been
closed and completed prior to this date.

2. Current Site – Select this check box to indicate that only the cost transactions for the currently selected
site will appear

3. Filter – Use this sheet to select which jobs, parts, product groups and sites to include on the report.

4. When you are ready to run this report, click Print on the Standard toolbar.

Inventory WIP Reconciliation Report

Use the Inventory WIP Reconciliation Report to reconcile the General Ledger (GL) with costs from Inventory and
work-in-process (WIP). This report can also be used to preview inventory and labor transactions that have not
yet posted to the General Ledger, prior to running the Capture COS/WIP Activity process.

As inventory transactions are generated, the costs accumulate in WIP and Inventory. You can summarize the
costs in this report and review the GL accounts used for each transaction. Most cost amounts in the Epicor
application, including Cost of Sales and WIP, are calculated using the base unit of measure (UOM) assigned to
the part for which the specific cost is being calculated. These costs can also be posted to the General Ledger if
you run the Capture COS/WIP Activity process. This program is found in the Job Management module.

Menu Path: Production Management > Job Management > Reports > Inventory/WIP Reconciliation

Within the Selection sheet, select the job details you want to print:

Epicor ERP | 10.0.700496

Epicor ERP Application User Guide - Part OneChapter 11 | Job Management



1. Book ID – Select the GL book identifier.

2. Date Range – Specify the start and end date for the report. Only transactions dated within this date range
are included in the report.

3. Specific G/L Account – Specify the G/L account for which transactions are being included in thr report.
You can enter a single G/L account to report associated transactions, skip the field to include all G/L accounts,
or click the G/L Account button to find and select the G/L account.

4. Including Offsetting Accounts – Select the check box to indicate that you want the report to include
complete transactions for the selected G/L account.

5. Specific Transaction Type – Specify the type of transaction for which the report is being run, or skip the
field to include all transaction types.

6. Specific Job Number – Specify the job number for which the report is being run, or skip the field to include
all job numbers.

7. Account Level Detail – Specify the level of detail that should print on the report.

• Full - Includes each part transaction that occurred within the date range and also displays the accounts
associated with the part transaction .

• Summarized by Date/Job-Part/Tran Type - The report combines, on one line, transactions for identical
parts on identical jobs that were run during the same day.

• Summarized by Date/Tran Type - The report combines, on one line, all transactions that have the
same transaction type on the same date. This is calculated for each account

8. G/L Posting Detail – Specify the G/L posting detail that should print on the report.

• Only Posted to the G/L - Indicates whether the report should include transactions that have already
been posted to the general ledger using the Capture COS/WIP Activity program.

• Only Unposted to the G/L - Indicates whether the report should include transactions that have not
been posted to the general ledger using the Capture COS/WIP Activity program.
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• Only Unposted to the G/L - Indicates whether the report should include both posted and unposted
transactions

9. Current Site – Select this check box to indicate that only the cost transactions for the currently selected
site will appear

10. When you are ready to run this report, click Print on the Standard toolbar.
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Chapter 12: Material Requirements Planning

Material Requirements Planning (MRP) is a set of planning tools you use to both estimate potential demand and propose
the supply that will answer this demand. It does this by generating job, purchase, and transfer order suggestions. MRP
is primarily designed for companies that manufacture make to stock quantities or mixed-mode manufacturers that run
both custom and stock products.

You set up Material Requirements Planning through two main maintenance programs – Part Class Maintenance and
Part Maintenance. These programs define the general quantities and time frames that you need to buy or build each
MRP part.

To enter your future demand, you can use both Forecast Entry and the Master Production Schedule. Use these two
programs to predict upcoming sales order demands and production needs.

When your forecasts and master production schedules are entered, you run Process MRP. This process creates unfirm
jobs you can then make ready for production within Job Entry. It also generates purchasing and manufacturing
suggestions that display within the Planning Workbench and the Buyer Workbench. Use these suggestions to create
jobs, transfer orders, and purchase orders.

Through regular use of MRP, you can anticipate the future demand for both your company’s products and purchasing
needs, ensuring that your materials are in the right place at the right time.

Before you use this functionality, you must have accurate methods of manufacturing designed for your part records,
solid Engineering Change Order (ECO) control, accurate inventory records, Lead Time values for purchased and transferred
materials, and proven capacity estimates for resources and resource groups.

The information contained within this chapter is intended as an overview of the MRP functionality. If you wish to learn
more about how the MRP engine calculates its results, review the MRP Technical Reference Guide available within
application help. This guide is located under the Working With section within the MRP module help topics.

Setup

This section describes the primary records you need to create for the Material Requirements Planning module.
Only the primary records are described here. Some areas within the next Operations section may also document
setup records if they are required for a specific workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for this module;
the Configuration topic details the options you define within Company Configuration.
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Site Maintenance

You define the MRP modifiers used for each site within Site Maintenance. After you enter these records, they
become default values for a selected site and will affect the calculated results for manufacturing suggestions
once you run the MRP process.

Menu Path: System Setup > Company/Site Maintenance > Site Maintenance

1. Click the Site button to find and select the site you need.

2. You select the Use Dynamic Days of Supply in Lead Time check box to more accurately generate material
requirements. When this calculation is active, the MRP functionality can expand the Days of Supply calendar
range to account for more supply and demand. The quantity available determines the amount to increase
or reduce on the purchase suggestion, job suggestion, or unfirm job.

3. Select the Allow Consumption of Minimum Quantity check box to cause both the MRP and PO Suggestion
processes to use another level of lead time calculations. When certain supply conditions are met within the
purchase lead time, an alternate set of Urgent Planning parameters activate. These parameters use the
Minimum Quantity available within inventory to satisfy demand while at the same time generate purchase
orders suggestions that require more immediate resolution.

4. The Finite Horizon field defines a number of days from the current system date (Today) where job operations
are scheduled finitely – any job operations scheduled on a specific day will not exceed the capacity for
work (hours, quantities) on the resources and resource groups available on that day. Any job operations
scheduled outside of the Finite Horizon data range are scheduled infinitely – which means any job operations
scheduled on a specific day can exceed the capacity for work on the available resources/resource groups.
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5. In the Overload Horizon field, enter the number of days from the current system date (Today) at which
resource capacity is calculated against the demand that falls within this date range. A tracker program, the
Overload Informer, then displays the capacity used on each resource per each day, indicating when a resource
is below capacity (such as 72%), at capacity (100%), and above capacity (such as 117%). Only resources
scheduled with infinite capacity display on this tracker. If you do not use this tool, enter a 1 value to load
only one day’s records into the Shop Load Table.

6. In the Rough Cut Horizon field, enter the number of days from the current system date (Today) where the
Rough Cut Scheduling calculation will be used to schedule jobs. Any jobs that fall outside of the Rough Cut
Horizon date range use the Rough Cut Scheduling calculation to generate the schedule. This formula
evaluates the Need By Dates and Lead Time values on each material and operation to calculate how much
time is required for each job to finish its operations and gather its materials. The rough cut scheduling
formula infinitely schedules these future jobs. This data, or load, is not recorded against your resources,
which reduces the processing time needed to generate the overall schedule. Rough cut scheduling also gives
you a general idea of the production plan you may require in the future.

When a job is scheduled finitely, it means that work on
the job is constrained to run for a specific number of hours
each day and that the operations cannot be scheduled
beyond this hour limit. Jobs that have a higher priority
are assigned first to the capacity available on each
resource. When a job is scheduled infinitely, it means no
scheduling limits exist on resources assigned to handle
the job operations. Infinite scheduling gives you the
optimal schedule for each job as if it is the highest priority
job in your site. Other job operations compete for the
same resources and so the available capacity on each
resource can be exceeded; use this method to locate
bottlenecks in the schedule. For more information, review
the Scheduling chapter.

7. In the Auto Firm Horizon field, enter the number of days the MRP Process will monitor to create firm jobs.
If demand is placed within the number of days you enter, the MRP process creates firm jobs automatically
from these demand records.

8. In the Unfirm Series Horizon field, enter the number of days from the current system date (Today) where
the unfirm jobs created by the MRP process generate with a job number that uses the Firm Job Prefix
value; these jobs are ready to engineer and schedule. Any jobs generated outside of this date range use the
Unfirm Job Prefix value for their numbers.

9. If you select the Lead Time check box, the application includes lead times for constrained purchased materials
when running the Manufacturing Lead Time Calculation process. Lead Time defines the number of days
that pass between the day purchased parts are ordered from a supplier and the day the parts arrive at the
site. This value is included in the total manufacturing lead time for this part, giving you a more accurate
view of the time needed to complete a part quantity if raw materials are not in stock. This value is used by
the MRP process to calculate the Order By Dates on purchase order suggestions.

10. When you finish, click Save on the Standard toolbar.
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Part Class

You can create default manufacturing and purchasing requirements through Part Class Maintenance. Part classes
are not required by the application. You need them, however, to classify inventory materials on reports. Use
these records to define overall standards that you want the manufacturing center to use for calculating MRP.

You can override default MRP values on part records. The next
sections, Part Maintenance -Manufacturing MRP and Part
Maintenance -Purchasing MRP, detail the MRP fields you can
change on part records.

Some examples of part classes are Bar Stock, Raw Materials, and Finished Goods.

After you set up these records, you then select part classes on specific part records. The default values defined
on the part class are automatically used during MRP processing for parts included within this class. These values
are intended as default MRP values and can be overridden on a specific part record.

Menu Path: Production Management > Material Requirements Planning > Setup > Part Class

To create a new part class:

1. Click New on the Standard toolbar.

2. In the Part Class field, enter the identifier for the part class.

3. Now enter a brief explanation for the part class in the Description field.

4. If this part class is used for purchased parts, select a Buyer from the drop-down list. This person is responsible
for approving all purchase orders for parts assigned to this part class.

5. If you want to evaluate all materials purchased through this part class for quality, select the Inspection
Required check box. Any materials purchased through this part class are automatically received into
inspection; you cannot change this value during purchase order entry or receipt entry. However, if you do
not select this check box on the part class record, you can still select it later during either purchase order
entry or receipt entry.

6. When you finish, click Save.
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MRP Information

When you finish defining the part class record, you are ready to add material requirements planning (MRP)
parameters to it. Within the part class, you can also set up different MRP defaults for different sites.

1. Click the Down Arrow next to the New button; select New Site.

2. The Site sheet displays. Select the site that uses these MRP requirements from the Owner Site drop-down
list.

3. In the Receive Time field, enter how many days are required to receive these materials. This value is used
differently, depending on whether this class is a manufactured or purchased part class:

• Manufactured Parts – The number of days required to move the material quantity either to stock or
the next job. This value is added to the Due Date on the job.

• Purchased Parts – The number of days required to receive and inspect the materials. This value is
subtracted from the Demand Date to give suppliers the correct Due Date.

4. The Planning Time Fence field defines the time limit for changes within this part class. This value is the
number of days from the scheduled start date that demands requiring supply changes are not considered
by the application. All demands outside of this time limit, however, are processed as normal.

To learn more about buyers and Buyer Maintenance,
review the Purchasing chapter.

5. The Reschedule Out Time Delta field defines the date range during which the MRP process is prevented
from rescheduling demand suggestions that occur in the future. Any demand record that is supposed to be
changed, but has an End Date less than or equal to the final date of this range, does not generate a new
suggestion. This value prevents suggestions from generating that you cannot act upon.

6. The Reschedule In Time Delta field defines the date range during which the MRP process is prevented
from rescheduling supply suggestions occurring in the future. Any supply record identified for change with
an End Date less than or equal to the final date of this range does not generate a new suggestion. This
value prevents suggestions from generating that you cannot act upon.

7. When you finish, click Save on the Standard toolbar.
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Part Maintenance

Although Part Class Maintenance sets up some general MRP parameters, more precise MRP definitions are defined
at the part level. You do this through the Site sheet in Part Maintenance. If MRP parameters are entered on a
part record, they override the default values defined on the part class. Part records contain the base information
that the MRP engine requires to generate suggestions.

The MRP engine can calculate the quantity requirements for both Manufactured and Purchased part types. If the
MRP engine discovers a part record has a method of manufacturing (MOM), it generates an unfirm or firm job
that will display in Job Entry. Part records also contain modifiers that define how the MRP engine calculates
demand for each part record. These modifiers cause the MRP engine to generate items like inventory quantities,
which revision level to use, and the planning time required to purchase or manufacture quantities for this part.

Manufacturing MRP

Menu Path: Production Management > Material Requirements Planning > Setup > Part

Depending on whether the part is manufactured or purchased, you define different parameters. To define MRP
for a manufactured part:

1. Use the Part field to either enter or find and select the part record you wish to review.

2. If you are using part classes to define some MRP default values, click the Class drop-down list to select the
option you want.

3. To indicate this material must be available for issuing to schedule an operation, select the Constrained
Material check box. If the scheduling engine discovers that the constrained material cannot be issued at a
specific time, it will locate the next available time.
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A constrained material is a scheduling modifier used to limit when the MRP engine calculates the Start Date
and End Date for suggestions. If an operation is linked to a constrained material, both the material and the
resources must be available at the same time before the scheduling engine will place the operation in the
schedule.

4. A Sub Level Code is used by MRP to determine the order through which parts are processed. If no Sub
Level Codes are defined, the parts are processed in alphabetical order.

5. Click Save on the Standard toolbar.

Part - Sites - Planning

To define site-specific MRP information for the part:

1. Navigate to the Part > Sites > Planning sheet.

2. If you need, you can add another site to the part record. To do this, click the Down Arrow next to the
New button, and select New Site.

3. Within the MRP Planning section, click the Planner drop-down list to select the person who is in charge
of manufacturing this part.

4. The Planning Time Fence, Reschedule Out Delta, and Reschedule In Delta values default from the part
class selected on the Part > Detail sheet. If necessary, you can edit these values for this specific part.

5. To indicate this part is included during MRP processing, select the Process MRP check box.
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6. If you want the scheduling engine to create a pull quantity to utilize existing stock and reduce the production
quantity, select the Auto Consume Stock check box. This causes MRP to automatically use overrun stock
quantities to satisfy demand.

7. Notice the Lot Sizing section. Use these fields to define how you want the application to regulate inventory
for the current part. The Multiple field defines the quantity incremen ts placed on each job. When generating
jobs, MRP always rounds up to the nearest multiple value. For example, if a demand quantity is 379 and
the Multiple value is set to 100, MRP creates a job that has a 400 part quantity. The extra quantity is sent
to inventory.

8. In the Minimum Lot Size field, enter the smallest quantity that can be manufactured for the part. If the
total demand quantity is less than this amount, MRP creates a single job that uses this value for the production
quantity. The extra amount is automatically sent to inventory.

9. The Maximum Lot Size field defines the largest part quantity that can be manufactured through one job.
If the total demand for this part is greater than this amount, two or more jobs are created by MRP.

10. The Days of Supply field defines how many days into the future MRP looks to calculate the final quantity
needed on a job suggestion, purchase suggestion, or un-firm job. This value is used against both stock
quantities and job quantities. It reduces the number of suggestions generated by MRP. All the demand
records for a part occurring within this range are combined to generate one suggestion. However, if this
suggestion is larger than the Maximum Lot Size value, two or more suggestions are generated.

11. Within the Start Min Lot Qty section, you can indicate at which point MRP should split a job. When MRP
encounters a part with both a Start Minimum Quantity which falls within the buffer days and a material
constraint value, the MRP engine will check for the minimum quantity of the material. If material is available
for the minimum lot quantity, the MRP process will split off a job by first updating the original job to contain
the quantity of material currently available and then by creating a second job for the balance of the demand.
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12. To further refine the part’s demand, use the fields within the Short Horizon Planning section. These fields
change the lot sizes produced when demand is close to the Scheduled Start Date. This value is the date
from which MRP begins processing demand.

• In the Horizon Days field, enter how many days you need for this time period. If the job’s Due Date is
less than or equal to the scheduled start date plus the Horizon Days value, the Min and Max Lot Size
values within this section are used instead of the corresponding fields within the MRP Planning section

• In the Days of Supply field, enter the supply value that falls within the short horizon time period.

13. The Scheduling section contains fields used to define how jobs for this part are scheduled.

• The Production Prep Buffer field indicates how many days are required by Production Planning to
prepare the job before it can be released to production.

• In the Kit Time field, enter the number of days required to gather the job’s components within the
warehouse before the job can start production. When the job’s Start Date is determined, this value is
used to calculate the Release Date for the job.

• The Receive Time value defaults from the part class selected on the Part > Detail sheet. If you need,
you can edit this value for this specific part.

14. Within the Manufacturing Lead Time section, review the lead time fields. These values are either calculated
by a process or entered manually. You directly enter these values by selecting the Manual check box.

• The Cumulative Lead Time field displays the lead time of the longest constrained material requirement(s)
on all sub assemblies below the main parent assembly.

• This Level Time displays the time required to build the job cost quantity of the part. This value assumes
all of the materials required for the assembly are available.

15. Click Save on the Standard toolbar.
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Part - Sites - Detail

To define site-specific material planning data for a manufactured part:

1. Navigate to the Sites > Detail sheet.

2. The Costing Lot Size field indicates how many parts need to be manufactured before the job justifies its
fixed setup costs. Enter the value you need in this field.

3. When you finish setting up the part for MRP, click Save on the Standard toolbar.
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Purchase Suggestions

The MRP purchasing functionality contains similar settings as a manufactured part; however, you have some
other values you need to define.

1. Within Part Maintenance, either create or find and select a purchased part. For the part’s type, the
Purchased option is selected.
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2. Select the Sites > Detail sheet.

3. Notice the part’s warehouse displays within the Primary Warehouse field. All the MRP settings are defined
for this warehouse.

4. Within the Purchasing section, click the Buyer drop-down list and select the buyer you need. This individual
is the person responsible for purchasing this part for the current site.

5. In the Minimum Order Quantity field, enter the smallest part quantity that can be placed on each purchase
order release.

6. In the Lead Time field, enter how many days are needed between the day on which the parts are ordered
and the day on which the parts arrive.

7. In the Supplier field, either enter or find and select the Supplier from whom you purchase this part.

8. If you select the Allow Consumption of Minimum Qty check box on the site record, you can define
alternate Urgent Planning options. If the projected On-Hand Quantity falls below the Safety Stock quantity
during the lead time date range, the Urgent Planning values are used to calculate the purchase suggestion
quantities instead. Through these parameters, you can define the specific quantities, lead times, and suppliers
to use for immediate supply needs.

9. When you finish, click Save on the Standard toolbar.
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Operations

This section describes the operations available in the Material Requirements Planning module. Each operation is
described as a workflow to help guide you through the process from start to finish. These programs are primarily
found within the General Operations folder for this module. If a unique setup record is required to run the
operation, this record is also described in this section.

Plan As Assembly

Use the Engineering Workbench to cause the MRP process to generate multiple jobs for each sub-assembly within
the method of manufacturing. When the primary job for the parent assembly is assigned the Firm status, the sub
assemblies break off to separate jobs and the material demand link is created.

Menu Path: Production Management > Engineering > General Operations > Engineering Workbench

1. Click the Group ID button to find and select the ECO group you need.
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2. Select the Revision > Detail sheet.

3. Click the Part Number button to find and select the part you need.

4. Click the Actions menu, highlight the Revision submenu, and select Check Out.
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5. In the Tree View, right-click the part and select the Tree > Expand Tree option.

6. In the tree view, select the required material.

7. The Method of Manufacturing > Materials > Detail sheet displays.

8. Select the Plan As Assembly check box.

9. When you finish, click Save on the Standard toolbar.

To learn more about the Engineering program and its
features, review the Engineering chapter.
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Forecast Entry

Use Forecast Entry to predict demand for part quantities needed for general manufacturing or specific customers.
Run this program to anticipate future sales for a specific part. MRP uses forecasts to generate un-firm jobs and
job suggestions.

Menu Path: Production Management > Material Requirements Planning > General Operations > Forecast Entry

To create a new forecast record:

1. Review the two display-only fields at the top of this window – Days Before and Days After. These values
indicate the range of days, before and after the Forecast Date, during which sales orders consume the
forecast. This date range is defined within Company Configuration on the MRP Configuration sheet.

2. In the Part field, either enter the Part ID directly or click the Part button to find and select the part you
need.

3. Use the Site field to define which site produces the part for this forecast. You can select all the sites (if you
have multiple sites) through either the navigation arrows or the drop-down list.

4. Click New on the Standard toolbar.

5. The fields on the Detail sheet become active. In the Forecast Date field, enter the date by which you need
the part quantity.

6. In the Forecast Quantity field, enter the forecast requirements quantity.

7. The Consumed Quantity field displays the amount of the forecast, if any, that has been consumed to-date
by demand requirements. As sales orders are created for a specific part, the MRP engine uses the quantities
on these sales orders to determine the Consumed Quantity value on forecasts. The MRP engine first consumes
this quantity against any customer specific forecasts created for the part. It then consumes this quantity
against any general forecasts created for the part.

8. Optionally in the Customer field, find and select a customer that you predict may order this part quantity.
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9. When you finish, click Save on the Standard toolbar. Repeat these steps to create multiple forecasts for
this part. You can create forecasts for the same or different customers.

Export Sales History

Use the Export Sales History program to generate and export sales history information. This function generates
a file very similar to the Sales Analysis report. The exported sales forecast file can then be used by the
SmartForecasts™ and Forecast Pro™ third-party applications to create a forecast that can later be imported into
Forecast Entry.

1. Click the Actions menu, highlight the External Forecast submenu, and select Export Sales History.

2. The Export Sales History window displays.

3. In the From field, enter the beginning date for the range of sales history you want to export.

4. In the To field, enter the ending date for the range of sales history you want to export.
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5. Use the Filters sheet to limit the information to export. You can filter by customers, customer groups, parts,
product groups, and sites.

6. In the Format field, select the file format you would like to export sales history information. Available options
include various Forecast Pro formats and the Smart Forecast format.

7. Click the Export File button to specify the full directory path to where you want to save the sales history
file.

8. Click the Export button to both export the sales history information and close the Export Sales History
window.

Import External Forecast

Use the Import External Forecast program to pull in an external forecast file into Forecast Entry. You can specify
the starting date and the name of the Smart Forecasts™ or Forecast Pro™ forecast file.

1. Click the Actions menu, highlight the External Forecast submenu, and select Import External Forecast.
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2. The Import External Forecast window displays.

3. In the Format field, select the format in which you would like to import the external forecast.

4. In the File Name field, specify the full directory path to the forecast file.

5. Within the Import Options section, select the Clear and Reload option to erase the entire forecast and
repopulate it with the imported information.

6. Select the Add and Replace option to add new lines to the end of the existing forecast and replace lines
with the same part, customer, and date.

7. Select the Add If New option to add new lines to the end of the existing forecast.

8. In the Start At field, specify the date from which you want to start importing forecast data.

9. Click the Import button to both import the external forecast and close the Import External Forecast
window.

Master Production Schedule Entry

Master Production Schedule (MPS) Entry is another MRP tool you can use to generate demand. Use this program
to schedule production quantities that you plan to produce before you receive sales orders.

You can use both Forecast Entry and MPS Entry. Forecast Entry helps you predict when you will ship a specific
part quantity, while MPS Entry predicts when you will manufacture the part quantity.

 If you have a forecast and a master production schedule for
the same part, MRP ignores the forecast. It only generates
demand from the master production schedule. You can,
however, import forecasts into a master production schedule.

Menu Path: Production Management > Material Requirements Planning > General Operations > MPS Entry

To create a sales order demand for a part:
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1. In the Part field, enter the Part ID directly, or click the Part button to find and select the part you need.

2. Use the Site field to define which site produces the part quantity. You can select all the sites (if you have
multiple sites) through either the navigation arrows or the drop-down list.

3. Click New on the Standard toolbar.

4. The fields on the Detail sheet become active. In the Due Date field, enter the date by which you want to
finish manufacturing this part quantity.

5. In the Production Quantity field, enter the minimum quantity that must be produced for this Due Date.

6. If you want to pull in a demand quantity from a forecast, from the Actions menu, select Copy From
Forecast.

7. When you finish, click Save.

The demand quantities you have entered through either (or both) Forecast Entry and MPS Entry can now be
processed.

Update Recycle Thresholds

Use Update Recycle Thresholds to run the Recycle Jobs calculation.  This calculation improves Material Requirements
Planning (MRP) processing performance by saving unfirm jobs that use active part revisions.

Instead of deleting all unfirm jobs each time the MRP process is run, the Recycle Jobs calculation determines
which unfirm jobs can be saved.  When the MRP process begins generating unfirm jobs during the current process
run, it uses these recycled jobs first to satisfy current demand.

A new job is only created when a valid recycled job cannot be found.  Likewise, if any recycled jobs could not be
linked to a new demand record, the recycled unfirm job is deleted.

Use the Update Recycle Thresholds process to calculate the date ranges currently available for each active part
revision.  Always run this process before you run MRP processing; this makes sure you only recycle unfirm jobs
with active part revisions.  Epicor recommends you add this process and the Process MRP process to the same
process set to make sure you generate accurate results.

To activate the Recycle Jobs calculation, select the Recycle MRP
Jobs check box in Process MRP.
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Menu Path: Production Management > Material Requirements Planning > General Operations > Update Recycle
Threshold

To use this process:

1. In the Last Run section, review the Date, Time, and User ID information. These values display the last time
the Epicor application ran this process.

2. In the Schedule drop-down list, identify the schedule you want to use for your Update Recycle Thresholds
process. If you select a schedule other than Now, you can indicate this process will run on an automatic
schedule you define, like daily, weekly, monthly, and so on.

3. Selecting a schedule other than Now activates the Recurring check box. Select this check box to indicate
you want this process to run automatically following the regular schedule selected on the Scheduling
drop-down list. For more information on running processes through automatic schedules, review the
Automatic Data Processing section in the Epicor ERP Implementation Guide.

Process MRP

Process MRP is the heart of the MRP functionality. This program examines the demand from forecasts, master
production schedules, and sales orders to generate both manufacturing and purchasing suggestions. The program
then compares this demand with the current supply – which is all the jobs and purchases orders that are not yet
complete that can answer this demand.

When the supply does not meet the demand, the application creates jobs, manufacturing suggestions, transfer
orders, and purchase order suggestions using the MRP parameters defined within each part record. If the part
has an approved method of manufacturing, Process MRP creates new unfirm jobs and generates manufacturing
suggestions for existing jobs. If it cannot find an approved method of manufacturing, Process MRP instead creates
a job suggestion for the part. It also creates purchase orders and transfer orders which can then be approved or
canceled.

MRP generates jobs with an Un-firm status. Jobs with this status
can be deleted and generated again through Process MRP.
Once the Un-firm check box is cleared on these job records,
however, MRP instead generates job suggestions against these
existing firm jobs.

You act on the results of the MRP process through these programs – Job Entry, Planning Workbench, Buyer
Workbench, and PO Suggestions. These programs are described later in this chapter.

Menu Path: Production Management > Material Requirements Planning > General Operations > Process MRP

To use this program:
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1. The Last Run section displays the Date and Time when MRP was most recently processed. The user who
activated the process is displayed in the User ID field.

2. The Processing Options are:

• Net Change – Select this option to ignore any previous MRP suggestions not changed by the current
demand. The MRP Process only generates new suggestions or updates previous suggestions affected
by new demand records.

• Regenerative – Select this option to process all outstanding sales orders, forecasts, and master production
schedules for every MRP part in the application. Any jobs with an un-firm status and any purchase order
suggestions are deleted and new job and purchase order suggestions are generated.

3. In the Cut Off Date field, enter the date on which the MRP Process stops looking for demand. Any records
that have dates after this Cut Off Date are not used to generate suggestions.

4. Next, in the Schedule Start Date field, enter the beginning date that you use to generate job suggestions,
unfirm jobs, and purchase suggestions. This date is the first date from which MRP runs. For example, if this
date is two days in the future but Process MRP is run now, then today and tomorrow are both considered
in the past.

A forward scheduled job is scheduled using a beginning
date. The job’s operations are added forwards through
the schedule based on this Start Date. A backwards
scheduled job, however, is scheduled using a final date.
The job’s operations are added backwards through the
schedule based on this End Date. For more information,
review the Scheduling chapter.
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5. The Log field is the filename you use for recording the MRP process information. This log file is located in
the Client Data Directory defined in System Agent Maintenance. This is the root directory for common system
files (such as log files, photos, and drawings) and is normally a directory on the same machine where the
application server (AppServer) runs, or a directory that contains a common shared folder.

6. The Logging Level field defines the type of tracking you want from the MRP process. You can generate a
Base log that only displays MRP parameters information, an MRP log that records MRP part processing
details information, or a MRP and Scheduling log that generates additional scheduling logs that document
unfirm jobs.

Typically you should select the MRP and Scheduling
option, as you will track the most information about each
MRP process run.

7. Select the Run Finite Scheduling during MRP Calculation check box to schedule jobs using the finite
scheduling functionality. This means that this job’s finite resource groups only run for a specific number of
hours each day, and that the job’s operations cannot be larger than this capacity.

8. Select the Ignore Constrained Materials option to indicate this MRP process does not observe material
constraints during its scheduling calculations. When a material is constrained, the scheduling functionality
determines when a material is available for an operation and then uses this date as the operation’s Start
Date. Select this option to prevent this calculation.

9. If you select the Allow Historical Dates check box, the MRP process schedules job operations in the past,
before the Schedule Start Date. This option overrides the default MRP calculation that uses the Scheduled
Start Date value for all operations.

10. Select the Use Production Preparation Buffer check box to indicate the Production Preparation Buffer
day value will be used during the MRP process. This value, defined on the part record, indicates how many
days are required by Production Planning to prepare the job before it can be released to production.

11. Select the Sort Level 0 MRP Jobs by Date check box to delay starting the scheduling engine until all zero
assembly level MRP jobs are created. After all the jobs generate, the scheduling engine can begin placing
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these jobs within available times on the schedule. Selecting this option does not affect parts that have low
level assemblies other than zero.

12. If you select the Recycle MRP Jobs check box, the MRP process will reuse un-firm jobs rather than deleting
and recreating the needed jobs.

13. If you wish, select the Run the Multi Level Pegging Process check box to directly link, or peg, each supply
part quantity to the specific demand record that created it. You can view this information on the Multi-Level
Pegging Display dashboard. Use this feature to both find potential shortages and prevent overstocking.

14. You can also generate purchase schedules by selecting the Include Purchase Contract Items check box.
Use this functionality to purchase inventory items on a recurring basis. You can define delivery schedules
that ensure inventory quantities are always available when you need them.

For more information about purchase contracts, review
the Purchasing chapter, or the Purchase Contracts topics
within the application help.

15. If you select the Rough Cut Schedule When Getting Details check box, the MRP process will schedule
jobs that cross the date threshold entered on the Site record in the Rough Cut Horizon field. You define
this value within Site Maintenance. This functionality is intended for jobs planned in the future that are not
relevant to the current production capacity. When Rough Cut Scheduling generates jobs, the resource time
used records are not written to the Overload Informer, so these jobs are not calculated against the capacity
available on each resource.

16. Use the Number of MRP Processes and Number of Schedulers fields to improve the performance of the
MRP process. These values determine how many MRP and Scheduling processes can be run simultaneously
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on your server. If your server has the capacity to handle multiple MRP and Scheduling processes, enter an
appropriate number in this field.

As a general rule of thumb, you should always use more
than one MRP processor and one scheduler to increase
MRP processing speed. Your Epicor consultant can help
you determine whether your server has enough capacity
to handle multiple processes.

17. Click the Filter tab to define whether this process is run for one or multiple sites. Use this filter when your
company has multiple sites, and you only want to generate suggestions for specific sites.

Because MRP is a process, you can also set up Process
MRP to run through an automatic recurring schedule. To
learn how to do this, review the Automatic Data
Processing section within the Epicor ERP Implementation
Guide.

18. When you finish, click the Submit button.

The application now processes MRP, generating both manufacturing and purchasing suggestions. When the
process is complete, you are able to review and act on these suggestions.
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MRP Recalculation Needed

The MRP Recalculation (Recalc) Needed process eliminates the need to run a full record regeneration during the
MRP process. This process recalculates the demand to find records that typically are ignored when the MRP
process runs in Net Change mode.

Menu Path: Production Management > Material Requirements Planning > General Operations > MRP Recalc
Needed

1. If you select the Check On Hand Qty check box, the process reviews the Safety and Minimum On Hand
Quantity values defined on the MRP part record. If the current On Hand Quantity is below the sum of these
two fields, then this MRP part’s demand is recalculated.

2. If you select the Check Cutoff Window check box, the process reviews the Cut Off Date from the previous
MRP run and compares it to the proposed Cut Off Date for this process. If demand exists within the Check
Cutoff Window date range, the MRP Recalculation process clears this part during this date range, and then
demand for this MRP part is recalculated.

3. In the Cut Off Date field, enter the final review date for the MRP process.

4. Select the Check Finite Horizon check box to cause the process to review resources assigned against a
job. If any of these resources are scheduled using Finite Capacity, the process next checks to see if the
operation’s Schedule Date value was previously outside the Finite Horizon date range, but now falls within
the finite horizon. If the job is within this horizon, demand for this MRP part is recalculated.

5. If you select the Check Short Horizon check box, the process evaluates the Short Horizon values defined
on each MRP part record. If the date on the demand record is past the short horizon date range used during
the previous MRP run, but now falls within the short horizon range for the current process, this MRP part’s
demand is recalculated.

6. The date you enter in the Schedule Start Date field will be the first date used to reschedule the MRP jobs
going forward through the schedule.

7. In the Log File field, enter the directory path and name of the file used to record the recalculations.

8. Click the Filter  tab to define whether this process is run for one or multiple sites. Use this filter when your
company has multiple sites, and you only wish to generate MRP results for specific sites.
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9. When you finish, click the Submit  button to launch the process.

Process Multi Level Pegging

The Process Multi Level Pegging program identifies the sources of overall (gross) demand requirements for a
specific part. Run this process after the MRP engine has calculated the raw Multi-Level Pegging data. You can
then view the results of this process within the Multi-Level Pegging Display dashboard.

Menu Path: Production Management > Material Requirements Planning > General Operations > Process Multi
Level Pegging

1.  Click the Schedule drop-down list and select the schedule you want to use for your multi level pegging
process. If you select a schedule other than Now, you can indicate this process will run on an automatic
schedule you define, like daily, weekly, monthly, and so on.

2. Selecting a schedule other than Now activates the Recurring check box. Select this check box to indicate
you want this process to run automatically following the regular schedule selected on the Scheduling
drop-down list. For more information on running processes through automatic schedules, review the
Automatic Data Processing section in the Epicor ERP Implementation Guide.

View Time Phase Inquiry

Use the Time Phase Inquiry to review time-phased purchase or manufacturing material requirements for a specific
part. Launch this tracker after the processing MRP process to review its impact on a particular part. The time
phased data is retrieved from the PartDetail table.

Menu Path: Production Management > Material Requirements Planning > General Operations > Time Phased
Inquiry

1. Click the Part button to find and select a specific part.

2. Select the Site for which you want to view time phase information.
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3. The Inventory section displays the Minimum On Hand, Maximum On Hand, Safety Stock, Minimum
Order Quantity, Lead Time and Days of Supply for the selected part .

4. The Manufacturing section displays the Minimum Lot Size, Maximum Lot Size, and Lot Multiple
quantities for the selected part .

5. The Due column displays the due date for the grid line.

• If this is a receipt (source of supply such as a job, purchase order or transfer order), this is the date by
which the supply quantity is due to arrive.

• If this is a requirement (source of demand, such as a sales order or transfer order), this is the due date
for the demand quantity for this part. For example, for a sales order, this is the date by which the customer
needs to receive the order quantity.

6. If this is an incoming receipt, the Receipts column displays the quantity for the job, purchase order or
transfer order.

7. If this is a requirement, the Required Qty column displays the quantity needed to satisfy the sales order or
transfer order.

8. The Balance column displays the project inventory balance for the part. This is the sum of the On Hand and
Receipt Quantities, less the Required Quantity.

9. The Source column displays the source of the receipt or the requirement.

10. The Exception column displays exception conditions for this grid line. Direct indicates there is demand for
a non-stock manufactured part. Below Minimum indicates that the on-hand quantity balance for the part
is below the quantity specified in the Min. On Hand field. Below Zero indicates that the on-hand quantity
balance for the part is negative.

11. The remaining Job Status, Job, Order, PO, Transfer Order and Container ID columns display identifier
and status information for the individual requirements and sources of supply.
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View MRP Manufacturing Suggestions

The new and modified manufacturing suggestions display through the Planning Workbench. You act on them
by creating jobs, modifying jobs, or ignoring the suggestions.

Menu Path: Production Management > Job Management > General Operations > Planning Workbench

1. Within the Planning Workbench, click the Select button to find and select all the new and modified MRP
suggestions.

2. You can now highlight each suggestion and then act on it by clicking on the Job Manager, Order Job
Wizard, and Create Job buttons.

527Epicor ERP | 10.0.700

Material Requirements Planning | Chapter 12Epicor ERP Application User Guide - Part One



View MRP Purchasing Suggestions

The new and modified purchasing suggestions display through the Buyer Workbench. You act on these suggestions
either by creating purchase orders or by ignoring them.

Menu Path: Material Management > Supplier Relationship Management > General Operations > Buyer Workbench

1. Within the Buyer Workbench, click the Buyer button to find and select a specific buyer.

2. The number of new and modified MRP purchasing suggestions displays in the PO section on the General
sheet.

3. Use the PO’s sheet to review and act on these purchasing suggestions.

 MRP purchasing suggestions can also display through Purchase Order Suggestions. These purchase order
suggestions are created through the Process MRP program - replacing the Purchase Management module’s
Generate Suggestions. To learn more about this program and Purchase Order Suggestions, review the Purchasing
chapter.
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Reports

This section describes a key report available in the Material Requirements Planning module. Run this report
whenever you need. As described previously with processes, you can also set up each report to generate and
print through a recurring, automatic schedule. Review the Automatic Data Processing section within the Epicor
ERP Implementation Guide for information on how you link a report to a recurring schedule.

Time Phased Material Requirements Report

The Time Phased Material Requirements report displays data from both purchasing and manufacturing suggestions
so you can review the potential future inventory balances. The report analyzes planned receipts and requirements
for each selected part class and then displays the calculated results. This report helps you see what potential jobs
and purchase orders were generated by MRP. You can then verify the correct quantities are purchased and
manufactured in the coming months.

Menu Path: Material Management > Inventory Management > Reports > Time Phased Mtl. Requirements

Run this report to display current MRP suggestions:

1. In the Part Types area, indicate whether this report displays Purchased, Manufactured, or Both part
types.

2. Next, in the Stock Types area, indicate whether this report displays Stocked, Non- Stocked, or Both stock
types. Because you are running this report for MRP suggestions, you typically select the Stocked option.

3. To limit the report to only display MRP suggestions, select the Suggestions have impact on balance check
box.

4. Define the projected balances cutoff date for the report. This date is used to determine which receipts and
requirements are printed.

529Epicor ERP | 10.0.700

Material Requirements Planning | Chapter 12Epicor ERP Application User Guide - Part One



Only parts with planned receipts or requirements on or before this date will be printed.

Any part that is below minimum or above maximum stock
levels will always be printed, even if there are no planned
receipts or requirements. Any part where the current
quantity on-hand is less than the Minimum Quantity
indicated in the part master file is considered below
minimum. Any part where the ending balance calculated
for the Project Balances Through date is higher than the
Maximum Quantity indicated in the part master file is
considered above maximum.

If no date is entered, all receipts and requirements are
printed.

5. If you need, click the Filter tab to select specific Part Classes to display. You can run this report for one or
multiple part classes.

6. When you finish, click Print on the Standard toolbar. This report displays the current material requirements.
Use this report to verify the current demand is precisely met with the potential manufactured and purchased
supply.

The Time Phased Material Requirements report is also
explored in Job Management. Review this chapter to learn
more about this report’s functionality.
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Chapter 13: Scheduling

The Scheduling functionality takes factors that affect production within your manufacturing center – quantity, setup
time, production time, resource capacity, and so on – to calculate how long it takes each job to complete. It then
displays this schedule within the Job Scheduling Board, the Resource Scheduling Board, and the Multi-Resource
Scheduling Board. Use these visual tools to both review and fine-tune when jobs start and end.

To help you make solid scheduling decisions, the module has a key tool – What If Scheduling. This calculation tool
gives you a preview of how the schedule may or may not work. If you like the what-if schedule displayed on the
scheduling boards, you can accept it. The what-if schedule is then included in your manufacturing center’s actual
schedule.

Reports in the application can also help you evaluate the manufacturing schedule. The Shop Load Report prints out
the load hours for operations scheduled within each resource group. Use the Priority Dispatch Report to review the
work scheduled at each resource group – according to the job schedule and the work that has already been finished
on the job. Use the Schedule Impact Report to analyze the effect of the what-if schedule on the actual schedule.

The Overload Informer is another important scheduling tool. Use it to discover which resources have too much work
assigned to them within both the actual and what-if schedules. By pinpointing where potential bottlenecks may occur,
you can then decide on how to best schedule the jobs to prevent overloading.

The information contained within this chapter is intended as an overview of the scheduling functionality. If you wish
to learn more about how the scheduling engine calculates its results, review the Scheduling Technical Reference Guide
available within application help. This guide is located under the Working With section within the Scheduling module
help topics.

Scheduling Concepts

The Scheduling module can help you prevent potential problems and more accurately predict when jobs complete
– ensuring that your job production runs both smoothly and efficiently.

This module evaluates the schedule based on the principle of supply and demand. It does this by calculating the
load on all resources (machines, employees) the job uses. The load is the hours needed to start and finish each
operation, so load during a specific time period equals the demand on the resource. For example, an operation
takes one hour to set up the machine and five hours to produce the production quantity. This means that this
operation requires six hours of load (demand) on the resource, and this time is placed on the schedule.

Capacity defines the supply of a resource. It measures either how much time is available on the resource or the
number of units that can be produced. A resource can either have finite (limited) or infinite (unlimited) capacity.
Regardless of how capacity is measured by the resource, however, capacity cannot be stored - if it is not used
during the schedule, this value disappears.

Scheduling Times

The scheduling functionality considers several factors when calculating how long it takes to complete a job’s
production quantity.

• Queue Time is the length of time a job waits at a resource before setup work is performed on the job.

• Setup Time defines how long it takes a resource to prepare the operation for the job.

• Production Time indicates how much time is needed to produce the part quantity.

• Move Time is the length of time it takes to transport the part quantity to the next resource.
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• Production Preparation Time is the time added to the lead time of the manufactured item to determine the
start date.

• Kit Time is the number of days required to assemble the materials for a manufactured part before the job
starts.

• Receive Time is the number of days subtracted from the PO Release Due Date to account for unpacking and
inspecting the purchased items. On job suggestions or unfirm jobs, this value can also indicate how many
days from the Required By Date it takes to move the manufactured items to the next job.

Scheduling Horizons

The Epicor application uses three distinct calculations to determine how much load to schedule against your
upcoming jobs. Each scheduling calculation is run against jobs whose Start Dates fall within a horizon calendar
range. You specify how many days are included within each horizon calendar range, so you can set up the
scheduling engine to generate results that best match your production planning needs.

The following graph illustrates these calculations and their different horizons.

Finite Scheduling

Finite Scheduling calculates the most detailed scheduling results. When the scheduling engines determines the
load to place against these jobs, it takes into account the existing resource load (capacity) for each operation on
the job method. Resources cannot be scheduled above their available capacity per day, so resources cannot be
overloaded in this section of the schedule. Any jobs with Start Dates that occur on or before the Finite Horizon
are finitely scheduled.

Example  If the Finite Horizon is 30 days and the Scheduled
Start Date for the scheduling process is March 1, all jobs with
Start Dates from March 1- March 30 are finitely scheduled.

Infinite Scheduling

Infinite Scheduling calculates less detailed results by ignoring existing resource load (capacity). Job operations are
scheduled without constraints against each resource. You use this calculation because at some point in the future
schedule, you do not care your resources are overloaded. You can then manage the overload by either shifting
load or increasing capacity. Shop load records are created to provide the overload visibility.

Example  If the MRP process calculates you need 500 parts
one week from today, it schedules them all to be built at the
same time, even though you can only do 100 at a time. If the
Finite Horizon is 30 days and the Scheduled Start Date for the
scheduling process is March 1, all jobs with Start Dates on
March 31 and later are infinitely scheduled.

Rough Cut Scheduling

Rough Cut Scheduling ignores resource and shop load records normally included in other scheduling calculations.
It does not create resource time used or shop load records normally created by other scheduling calculations.
Instead, this calculation schedules every job using the Need By Dates, Operation Production Standards, and the
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Rough Cut Parameters (by operation) to calculate the start dates. These jobs are infinitely scheduled, but the load
is not placed against these resources. This reduces the processing time needed to generate the overall schedule.
Rough Cut Scheduling also gives you a general idea of the production plan required in the future.

Example  If the Rough Cut Horizon is 90 days and the
Scheduled Start Date for the scheduling process is March 1,
all jobs with Start Dates on or after May 29 are rough cut
scheduled. .

To learn more about resource groups, review the Resource
Groups sections in the Engineering chapter.

Operations

This section describes the operations available in the Scheduling module. Each operation is described as a workflow
to help guide you through the process from start to finish. These programs are primarily found within the General
Operations folder for this module. If a unique setup record is required to run the operation, this record is also
described in this section.

Scheduling Features

A job is first scheduled within Job Entry. Besides indicating when the job starts and ends, you can define additional
parameters that affect how each job is placed on the Job Scheduling Board, the Resource Scheduling Board, and
the Multi-Resource Scheduling Board.

Menu Path: Production Management > Job Management > General Operations > Job Entry

1. To launch this command, click the Actions menu; select the Schedule submenu and then select Job
Scheduling. The Schedule Job window has some key features you can define.

This command is only available if the job is engineered.
To learn more about how to run this functionality, review
the Scheduling the Job section in the Job Management
chapter.
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2. Forward Scheduling indicates this job is scheduled using a Start Date and Start Time. Based on this date
and time, the job’s operations are evaluated by the scheduling process. The times for each operation, minus
any overlapping operations, are used to calculate the final date on when this job completes.

3. Backward Scheduling indicates this job is scheduled using a Due Date and Due Time. Based on this date
and time, the job’s part method is evaluated by the scheduling process. The times for each operation, minus
any overlapping operations, are used to calculate the date on which this job needs to begin.

4. When a material is constrained, the scheduling functionality determines when a material is available for an
operation. It then uses this date as the operation’s Start Date. In some situations, however, you may wish
to ignore these material constraints. To do this, select the Override Material Constraints check box.

5. Parts are manufactured through operations that run on a group of related resources. Scheduling is calculated
through the values defined on each specific resource, which can be either a machine or an employee. If a
resource is defined as Finite, it means that it is constrained to run for a specific number of hours each day
and that the operations cannot be scheduled beyond this hour limit – or Capacity. When you select the
Finite Capacity check box, all resources defined as finite are scheduled with this constrained capacity. Any
resources not defined as finite, however, are scheduled using Infinite Capacity.

If you do not select this option, the scheduling functionality assumes that all resources on this job have
infinite capacity which  means there is no limit to the number of operations that can be scheduled within
these resources. You have pros and cons for  both infinite and finite scheduling. Finite Scheduling does not
allow overloaded resources, but it can cause your jobs to miss their Required By Dates. Infinite scheduling
is useful for locating bottlenecks on specific resources, but more manual work is required to resolve scheduling
issues.

6. Use the What-If Schedule feature to test a schedule by first creating a temporary schedule and then
reviewing this schedule’s  impact. On the scheduling boards, these hours are displayed as what if times, and
you can view them independently from your current times. When you decide that the temporary schedule
is acceptable, you remove the job schedule’s What If status by accepting the changes on a scheduling
board. This job time is then incorporated into the current schedule.

7. Use the Recalculate Expected Yield check box as needed to recalculate expected production yield for a
job. You need to have already selected the Production Yield check box on the Job Entry > Header sheet
and at least one production yield recalculation system action on the Operation master for every operation
used on this job.

For more details on production yields, refer to the
Application Help.

Global Scheduling Process

The Global Scheduling process is divided into three components. Run these components in the following order
to globally schedule your jobs:

• Calculate Global Scheduling Order

• Adjust Global Scheduling Order (optional)
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• Global Scheduling

If you want the Calculate Global Scheduling Order and the
Global Scheduling processes to run automatically, you can
assign them both to a Process Set. Make sure the Calculate
Global Scheduling Order process is run before the Global
Scheduling process. For more information on how to do this,
review the Automatic Data Processing chapter in the Epicor
ERP Implementation Guide.

Calculate Global Scheduling Order Process

Run the Calculate Global Scheduling Order process before you run the Global Scheduling process.

This process causes the scheduling engine to find each job’s best End Date. The engine can then compare the
End Date to the Requested By Date to determine if the job is early or late. This Early Days or Late Days is multiplied
with the job’s Priority code to determine a scheduling order sequence.

Menu Path: Production Management > Scheduling > General Operations > Calculate Global Scheduling Order

Available options:

1. In the Schedule Start Date and Schedule Start Time fields, enter the  date and time the process uses to
begin the forward schedule.

2. In the Log File field, enter the name of the file you want to use for saving the log information.

3. The Log Level field defines the type of tracking you want from the process. Options include a basic log, a
log with process details, or logs for both process and scheduling details.

4. In the Number of Processors field, enter the number of processes that are started on the server to complete
scheduling. You can improve scheduling performance by splitting one large process into smaller, multiple
processes. If your server has the capacity to handle multiple processes, enter an appropriate number in this
field.
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Before you enter a value higher than one, however, you should verify with your Epicor consultant whether
your server has enough capacity to handle multiple processes. Your Epicor consultant can also help determine
the value to enter in this field.

5. When you finish, click the Submit button.

The process runs and the jobs are assigned a job priority sequence. You can change this sequence using the
Adjust Global Scheduling Order process. The sequence adjustments you make through this program are then
used by the Global Scheduling process to calculate the job schedule.

Adjust Global Scheduling Order

Use Adjust Global Scheduling Order to review and fine-tune the scheduling priorities that were generated by the
Calculate Global Scheduling Order process. The Priority value is defined on specific jobs to indicate scheduling
precedence.

You can manually change the sequence in which these jobs are scheduled or schedule a sub-set of the original
list. For example, you could choose to schedule all jobs for a specific Project ID. The Adjust Global Scheduling
Order is an optional step in the Global Scheduling process.

Menu Path: Production Management > Scheduling > General Operations > Adjust Global Scheduling Order

To adjust global scheduling order:

1. Click Search (Binoculars) on the Standard toolbar to find and select jobs currently in production. When
you return to the Adjust Global Scheduling Order window, these jobs display.

2. Change the Schedule Sequence field to adjust the priority scheduling sequence.

3. When you finish, click Save.

Global Scheduling

Use the Global Scheduling process to schedule the list of jobs generated by the Calculate Global Scheduling
Order process and optionally fine-tuned by the Adjust Global Scheduling Order. All the jobs selected are placed
within the schedule, either on the actual schedule or on a What-If schedule.

You can select to process using either finite or infinite capacity. If you use finite capacity, work cannot be scheduled
if it is greater than a resource’s available capacity. If you use infinite capacity, work can be scheduled above the
resource’s available capacity in order to overload it; this helps identify bottlenecks in the schedule.

You typically use Global Scheduling to schedule your jobs as you can set up this process to run on a recurring
schedule. Job schedules then update regularly based on current information.

Menu Path: Production Management > Scheduling > General Operations > Global Scheduling
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1. In the Schedule Start Date field, enter the first date that you use to globally schedule your jobs.

2. In the Schedule Start Time field, enter the time that you use to globally schedule your jobs.

3. In the Log File field, enter the name of the file you want to use for saving the Scheduling log information.

4. The Log Level field defines the type of tracking you want from the Scheduling process. Options include a
basic log, a log with process details, or logs for both process and scheduling details.

5. If you only want this process to reschedule what-if jobs, select the What-If Schedule Only check box. Your
actual schedule is not changed. You are able to review the What-If schedule and accept, discard, or save
the changes using the Job Scheduling Board, Resource Scheduling Board, or Multi-Resource Scheduling
Board.

6. Select the Finite Load check box to process and schedule finite resources.

7. In the Number of Schedulers field, enter the number of scheduling processes started on the server to
complete scheduling. You can improve scheduling performance by splitting one large process into smaller,
multiple processes. If your server has the capacity to handle multiple scheduling processes, enter an
appropriate number in this field.

Before you enter a value higher than one, however, you should verify with your Epicor consultant whether
your server has enough capacity to handle multiple processes. Your Epicor consultant can also help determine
the value to enter in this field.

8. When you finish, click the Submit button.

All the jobs that match your parameters are rescheduled. When the process is complete, you can view the changes
on the Job Scheduling Board, Resource Scheduling Board, or Multi-Resource Scheduling Board.
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Scheduling Parameters

You use scheduling parameters to determine the point at which the scheduling engine places load on the schedule.
This section discusses Finite Horizon, Overload Horizon, and Rough Cut Horizon. For more information about the
Auto Firm Horizon and the Unfirm Series Horizon ranges, review the Material Requirements Planning chapter.

Site Maintenance

Set the scheduling parameters in Site Maintenance.

Menu Path: Production Management > Job Management > Setup > Site Maintenance

1. Click the Site button to find and select the site you need.

2. Use the Scheduling Send Ahead For drop-down list to determine if the start-to-start job operation offset
will be used for production or setup time. If you chose setup, a secondary operation with a start-to-start
relationship will schedule setup to begin xxx minutes (defined in the operation) after the production starts
on the primary operation. If you select production, the production time of the secondary operation will be
scheduled to start xxx minutes after the production starts on the primary operation.

3. Select the Override Scheduling Constraints check box to indicate you can move jobs on scheduling boards
as you need. Typically when you try to move a job or an operation that has quantities for material constraints
or subcontract POs, you receive an error. However if you select this check box, you can move any jobs created
in this site to different areas on the scheduling boards, ignoring both material and subcontract PO quantities.
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4. In the Finite Horizon field, enter the future point of time (in days) at which the scheduling engine will stop
using finite capacity and begin using infinite capacity against resource groups. This number of days is added
to the current system date to determine the last day on which finite capacity is used. After this date, the
scheduling engine uses infinite capacity to calculate the schedule.

The Finite Horizon is useful in providing a long-term production view without committing resources to the
schedule. It also reduces processing time for the scheduling engine. As the schedule moves toward these
infinitely scheduled jobs, the scheduling engine can be run again to more accurately reflect how much actual
production time is required, as these jobs now fall within the finite horizon range.

5. In the Overload Horizon field, enter the future point of time (in days) at which resource capacity is calculated
against the demand that falls within this date range. A tracker program, the Overload Informer, then displays
the capacity used on each resource per each day, indicating when a resource is below capacity (such as
72%), at capacity (100%), and above capacity (such as 117%). Only resources scheduled with infinite
capacity display on this tracker.

You use the Overload Horizon to discover where bottlenecks may occur in the upcoming schedule. You can
then adjust your short-term scheduling needs to correct these bottlenecks. Any demands placed on resources
outside of this Overload Horizon date range are not included in this calculation.

6. In the Rough Cut Horizon field, enter the future point of time (in days) after which the Rough Cut Scheduling
formula is used to schedule jobs. Any jobs that fall within this date range are scheduled using the demand
requirements and supply capacity defined for each resource and resource group. The resulting values represent
the actual schedule planned for your manufacturing center to both start and finish the operations and gather
the materials required to complete each job.

Any jobs that fall outside of the Rough Cut Horizon date range, however, use the rough cut formula to
generate the schedule. This formula uses the Need By Dates and Lead Time values on each material and
operation to calculate how much time is required for each job to finish its operations and gather its materials.
The rough cut scheduling formula infinitely schedules these future jobs. This data, or load, is not recorded
against your resources, which reduces the processing time needed to generate the overall schedule. Rough
cut scheduling also gives you a general idea of the production plan you may require in the future.

7. When you finish, click Save on the Standard toolbar.

Save Resource Load

Use the Save Resource Load Process to add load back to jobs scheduled outside of the overload horizon. This
scheduling method can be used to infinitely or finitely schedule jobs without placing any load against your
resources.

To use this process, you first enter a Required By date range. When the process runs, it recalculates all jobs that
were scheduled outside of the overload horizon and have Required By Dates within the specified date range. It
also allocates load required to produce these jobs against resources.

This process adds the load by writing the load data from the Resource Time Used records of scheduled jobs to
the Shop Load table. The Save Resource Load Process accepts entry of date range, reviews scheduling resources
available, and restores the load from the Resource Time Used records that were created for the job resources.

Menu Path: Production Management > Scheduling > General Operations > Save Resource Load
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1. In the Start Date and End Date fields, enter the date range. Any jobs that have Required By Dates within
this range are rescheduled with their load.

2. Select the Edit list of Jobs check box if you want to view and edit the list.

3. In the Number of Processors field, enter the number of processes that are started on the server to complete
scheduling the resource load. You can improve scheduling performance by splitting one large process into
smaller, multiple processes. If your server has the capacity to handle multiple scheduling processes, enter
an appropriate number in this field.

Before you enter a value higher than one, however, you should verify with your Epicor consultant whether
your server has enough capacity to handle multiple processes. Your consultant can also help determine the
value to enter in this field.

4. When you finish, click Submit on the Standard toolbar.

These jobs are available for display on the Shop Load report and the Overload Informer.

Because Save Resource Load is a process, you can also set
up this program run through an automatic recurring
schedule. To learn how to do this, review the Automatic
Data Processing chapter in the Epicor ERP Implementation
Guide.

Job Scheduling Board

Use the Job Scheduling Board to review and change the schedules for one or multiple jobs. Through this program,
you can visually see all the jobs currently scheduled at your company. You can then make adjustments to them,
controlling when each job should both start and end.

Menu Path: Production Management > Scheduling > General Operations > Job Scheduling Board

This program is not available in the Epicor Web Access.

To select the jobs you want to display on the Selection sheet:
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1. If you want to view multiple jobs, click the Job button to find and select the jobs you wish to view.

2. To display a specific job, enter its number within the Job field, and press the Tab key on your keyboard.

3. To review multiple projects, click the Project button to find and select the projects you wish to display and
press the Enter key on your keyboard. The jobs created for the specific project display on the board.

4. You can also display all the jobs created for a specific project. To do this, enter the project’s identifier within
the Project field.

When you finish selecting the jobs, to review their schedules.

Job Scheduling Board – Schedule

The Schedule sheet is a key sheet within this program. Use this sheet to visually review how long it takes to start
and complete each job. If you need, you can adjust a specific job’s schedule so that it fits better in the overall
schedule.

Available features:

1. Job List – Use this list to review the primary information on each job. The Job Number, Part, Customer
ID, Due Date, Start Date, and Days Late values display on this grid.
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2. Schedule Display Area – This panel displays the schedules of each selected job through a visual interface.
Depending on the job’s status, a different color bar appears for the job’s scheduled duration.

These color bars can be modified using personalization
options. These options are explored in the Job Scheduling
Board - User Preferences section later in this chapter.

3. To move backwards through the calendar, click the Left Arrow button.

4. To move forwards through the calendar, click the Right Arrow button.

5. You can jump to a specific point within the calendar by using the Goto field. To do this, click the Down
Arrow, and select a different date from the calendar.

6. Use the Sort By field to change how the jobs are organized on the Schedule panel. You can sort jobs by
Start Date, Job, Part, Customer ID, Due Date, and Days Late.

Job Scheduling Board – Context Menu

The Job List grid on the Schedule sheet also contains a context menu you use to quickly launch selected job
records inside key programs; you can also use it to launch important functionality. To view the context menu,
select a job from the list, and then right-click the job to display the context menu.

Available features:

1. Job Tracker – Select this command to display the selected job within Job Tracker.

2. Job Entry – Select this command to display the selected job within Job Entry.

3. Start Time – Select this command to move the scheduling board to the start time of the job.

4. Move Time/Item – Select this command to adjust the time or position of the item.

5. Multi Resource Schedule Board – Select this command to display the selected job within the Multi Resource
Scheduling Board. This program is described later in this chapter.

6. Lock Schedule – Select this command to prevent the selected job from being rescheduled.
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7. Unlock Schedule – Select this command to allow the selected locked job to be rescheduled.

For more information about these programs, review the
Job Management chapter.

Job Scheduling Board – Toggle Buttons

The Job Scheduling Board contains additional buttons on its Standard toolbar. Use these buttons to either display
or hide various items on the scheduling board. The following table lists the available options:

DescriptionIcon

User Preferences – Click this button to launch the Scheduling Board Preferences window. Use
this window to personalize the scheduling board. The next section, Job Scheduling Board – User
Preferences, explores these options.

Toggle Queue Time – Click this button to hide or display Queue Time. When this option is off,
the button is not available and job queue times do not display.

Toggle Completion Time – Click this button to hide or display Completion Time in the schedule
board. When this option is off, the button is not available and job completion times do not display.

Toggle Original Time – If this option is active, a moved job’s original time displays on the schedule
board. It displays this time using the color for What-If changes.

Toggle Move Time – Click this button to hide or display Move Time in the schedule board. When
this option is off, the button is not available and job move times do not display.

Toggle Reschedule Screen – If this option is active, the Reschedule Confirmation dialog box
displays each time you click and drag a job’s schedule to a new location. When this option is off, this
dialog box does not display.

Toggle View Only – If this option is active, the board is in View Only Mode. You cannot make
changes to the schedule.

Increase Height – Click to increase the height of each row. Each time you click this button, the
height of each row increases.

Decrease Height – Click to shrink the height of each row. Each time you click this button, the height
of each row decreases.
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Job Scheduling Board – User Preferences

You can personalize the look of this scheduling board through the Scheduling Board Preferences window. Click
the User Preferences button on the Standard toolbar to launch this window.

Available features:

1. Type – This list displays the scheduling types shown on the board. If you need, you can change the type’s
name. To do this, double-click the type. The cursor appears within the cell, and you can edit the text as you
need.

2. Default Timeframe – You can expand or contract the timeframe display. To do this, click anywhere within
the date or day column headings and then drag your mouse to the left or right. Dragging to the left expands
the timeframe until it displays each day in minutes and even seconds. When you drag to the right, it continues
to contract the timeframe until it eventually displays a yearly scale.

Note: You can also expand or contract the timeframe on
the actual scheduling board. The timeframe you define
here, however, becomes the default setting.

3. Personalization – Use these options to modify the colors used for the different schedule types. You can
modify the font, font size, refresh interval, and other options.

4. Assembly Move Option – Select an option from this list to define what happens when you move an
assembly on the scheduling board. Depending on what you select, the scheduling board adjusts parent and
child assemblies differently in relation to their preceding, subsequent, or all operations.

5. Operation Move Option – Select an option from this list to define what happens when you move an
operation on the scheduling board. Depending on what you select, the scheduling board adjusts operations
differently in relation to their preceding, subsequent, or all operations.

6. Scheduling Bar Text – Select an option from this list to define the text that displays on scheduling bars.
These options include Job (Assembly/Seq), Part Number, and Customer ID/Job.

7. When you finish modifying the board, click the Apply button. The changes you made to the board’s display
now appear.
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Job Scheduling Board – Move Job

You use the Schedule sheet to make changes to each job. After you make these changes, they appear visually
on the sheet, so you can verify this job’s revised schedule works with all the other jobs at the manufacturing
center.

You make these changes through the Move Job window. To display this window:

1. On the display, either double-click the job’s scheduling bar or click and drag the scheduling bar to the right
or left.

2. The Move Job window displays. The main information about the job displays within the Job section.

3. Information about the current assembly displays within the Assembly section.
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4. The Current section displays details about the selected operation.

5. The Proposed Changes area contains the options you have for moving a job. To change the scheduling
method, select either the Forward or Backward option.

For information about the Forward and Backward
scheduling methods, read the Scheduling Features section
at the beginning of this chapter.

6. If you select the Forward schedule method, the Start Date and Start Time fields become active. Enter the
date and time you want the job to start within these fields.

7. If you select the Backward schedule method, the Due Date and Due Time fields become active. Enter the
date and time you want the job to end within these fields.

8. The Move Option drop-down list contains the options available for moving a job. Select one of these
options:

• Job - All Operations – This option reschedules operations on this resource group. However, if multiple
operations for a single job are scheduled at this resource group, this option leaves gaps for intervening
operations on additional resource groups.

• Branch - Preceding Operations – This option reschedules the selected operation and the preceding
operations for the assembly. It then reschedules operations contained in any preceding assemblies within
the method.

• Branch - Subsequent Operations – This option reschedules the selected operation and subsequent
operations for the assembly. It then reschedules operations contained in any subsequent assemblies
within the method.

• Assembly - All Operations – This option reschedules all the operations on the assembly around the
selected operation. If multiple operations for a single assembly are scheduled at this resource group, this
option leaves gaps for any intervening operations on additional resource groups.

9. A material can be defined as a constrained material, indicating the materials must be available for issuing
to schedule operation. However, to ignore constraints placed on this job's materials, select the Override
Material Constraints check box.

For more information about material constraints and finite
capacity, read the Scheduling Features section at the
beginning of this chapter.

10. To reschedule this job so that its calculations consider the limited daily capacities available on resource
groups, select the Finite Capacity check box.

11. When you finish, click OK.

The job is now rescheduled on the scheduling board, using your changes.

Job Scheduling Board – Detail

For your reference, the Job Scheduling Board displays complete information about each job. This information
displays on the Details sheet. To use this sheet:
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1. On the Schedule sheet, from the Job list, select the job you want to review.  

2. Click the Detail tab.

3. The job’s details display. The Job section displays the main information about the job - the Job Number,
Part, Start Date, Production Quantity, and other details.

4. The Assembly section displays information about the selected assembly. The Assembly Number, Part,
Revision, and other details display.

5. The Operation section displays details about the current operation like Start Date, Due Date, Resource
Group, and so on.

6. The Material Constraints grid displays any materials that must be available before operations are scheduled
on the current job.

7. The Resource grid displays the resources, if any, that are linked to the operation.
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Job Scheduling Board – Actions Menu

You finish or remove your scheduling changes through the commands on the Actions menu. You can also review
the status of materials, as well as the load on sites and resources groups.

Available features:

1. Undo All Changes – Select this command to return the entire schedule to the state it was in before your
changes were made.

2. Undo Current Job Changes – Select this command to return the schedule for a highlighted job to its
original state.

3. Accept All Changes – Select this command to incorporate all the changes you made into the actual schedule.

4. Accept Current Job Changes – Select this command to incorporate any changes you have made to a
selected job into the actual schedule.

5. Save Schedule – Use this command to save the board settings under the current schedule’s name. If this
schedule has not yet been saved under a name, Schedule Maintenance displays where you can enter the
name for this schedule.

6. Restore Schedule – Use this command to bring back, or restore, a specific schedule. When you select this
command, it causes Schedule Maintenance to display. Use this program to select the schedule you wish to
restore.

7. View Log – Select this command to launch the Restore Log window. Use this window to review any errors
(if any) that occurred while a specific schedule was restored.

8. Material Status – Select this command to review the material requirements for the current job. This
functionality displays all the material requirements – including any stock assemblies that have pull quantities.

9. Resource Schedule Load Graph – Select this command to display the resource graph. Information about
resource group and resource schedules display through both a Resource Group Load Graph and a Resource
Load Graph.

10. Plant Schedule Load Graph – Select this command to display the plant graph. Information about job
department, company, plant, or resource group schedules display. This includes both an Actual Capacity
and Load Graph and a What If Hours Graph.

11. Print – Run this command to send the schedule board to a Print Preview window. If you wish, you can
then print this schedule.
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Resource Scheduling Board

Use the Resource Scheduling Board to review and modify scheduled jobs at both the resource and the resource
group level. A resource can be a piece of equipment (like a lathe), or a shop employee (like a machine setter). A
resource group consists of several related resources that can be scheduled as a single unit.

You create resources and resource groups through Resource
Group Maintenance. For more information on this important
setup program, review the Engineering chapter.

This scheduling board’s interface is similar to the Job Scheduling Board. Some differences, however, exist between
them. The next sections explore these differences.

Menu Path: Production Management > Scheduling > General Operations > Resource Scheduling Board

This program is not available in the Epicor Web Access.

Use the Selection sheet to choose the resource or the resource group that you wish to view:

1. Select the Scheduling Board Type you need. Available options - Resource and Resource Group.

2. Depending on the board type you select, either the Resource or the Resource Group field is active. You
can enter the resource or group you want directly, or you can click the Search buttons to find and select
the resource or group you need.

3. In the Start Date field, enter the first date of the calendar range you wish to view.

4. In the End Date field, enter the last date of the calendar range you wish to view. The scheduling data
generated both on and between the Start Date and End Date displays on the scheduling board.

If your company purchased the Advanced Planning and
Scheduling (APS) module, you can also schedule resources
by capability. Capabilities are skills and abilities that
resources possess, like turning, painting, drilling, and so
on. These capabilities are then linked to specific resources
and resource groups. For more information about
capabilities, review the Scheduling Technical Reference
Guide available in the application help.

You are now ready to view the schedule for the selected resource or resource group.
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Resource Scheduling Board - Schedule

To view the manufacturing activity for the resource or resource group, use the Schedule tab. The interface is
similar to the Schedule sheet within the Job Scheduling Board; however, the Resource Scheduling Board displays
the schedule of all operations processed by the resource or group.

Available features:

1. Operations List – This panel displays the primary information for each operation. It first displays the Job
Number/Assembly Sequence Number/Operation Sequence Number. You can then scroll this list to
the left to display the operation’s Part Number, Customer ID, Operation Code, Setup Group, Start
Date, and Days Late.

2. Schedule Display Area – This panel visually displays the schedules of each selected operation. Depending
on the operation’s status, a different color bar appears for the operation’s scheduled duration.

3. To move backwards through the calendar, click the Left Arrow button.

4. To move forwards through the calendar, click the Right Arrow button.

5. You can jump to a specific point within the calendar by using the Goto field. To do this, click the Down
Arrow, and select a specific date from the drop-down calendar.

6. Use the Sort By field to change how the operations are organized on the Schedule panel. You can sort the
operations by Start Date, Setup Group, Part, Customer ID, and Operation Code.

Resource Scheduling Board – Move Job

The Schedule Display Area works in the same way as the Job Scheduling Board. Use this display to make changes
to a job and then view its impact on other jobs. On this scheduling board, however, the changes you make occur
at the operation level.

Make these changes in the Move Job window. To launch this window:
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1. On the display, either double-click the operation’s scheduled hours or click and drag the hours to the right
or left.

2. The Move Job window displays. This window is nearly identical to the window that displays within the Job
Scheduling Board. However, some additional options are available.

3. From the Move Option drop-down list, select the Operation Only option. This move option reschedules
the operation, but it leaves all the other operations in their original schedules.

For a complete list of the other move options, review the
Job Scheduling Board – Move Job section found earlier
in this chapter.

4. You can also select a different resource to run the changes you are making to the job. To do this, click the
Resource drop-down list and select the resource you need.
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5. If the production is finished on this operation, select the Production Complete check box.

6. If the setup is finished on this operation, select the Setup Complete check box.

7. When you finish making changes to the job operation, click OK. Your changes now display on the Resource
Scheduling Board.

You can also modify other options within the Proposed
Changes section. For details on these fields, review the
Job Scheduling Board - Move Job section found earlier in
this chapter.

Resource Scheduling Board – Load Leveling

Both the Standard toolbar and the Actions menu on this scheduling board contain the same controls that are on
the Job Scheduling Board. The Standard toolbar contains view options that you can toggle on or off. The Actions
menu also contains the same commands you use to save and undo changes.

The Load Leveling function, however, is unique to the Resource Scheduling Board. Use this function to compress
the operations on a resource group so that no time exists between them. This helps you prevent uneven loads
on resources and eliminates any idle time at resource groups that typically bottleneck.

Load Leveling takes all jobs that fall within a given date range and reschedules them so that the total load on a
specific resource becomes smoother.

The changes made by Load Leveling are What-If schedule changes only – you need to accept them before they
become part of your actual schedule.

You can launch this window in two ways:

1. Click the Load Level button on the Standard toolbar, or click the Actions menu; select Load Level.

To learn about these options, review the Job Scheduling
Board - Toggle Buttons and Job Scheduling Board -
Actions Menu sections found earlier in this chapter.

2. The Load Leveling window displays.
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3. In the Start Date field, enter the date on which the first operation included in load leveling begins. The
default is either tomorrow’s date or the highlighted operation’s Scheduled Start Date – whichever is later. 

4. Next, in the New Start Date field, enter the date that is used the next time you launch load leveling. By
default, this value is the Start Date displayed during your next load leveling session.

5. In the Cut Off Date field, enter the final date on which operations should be included during this load
leveling process. The default date is the What-If start date for the last operation on the scheduling board.
Operations that have a start date on or before this date are included in the load leveling.

6. Use the Move Option drop-down list to define how the schedule is adjusted with the potential changes.
The options are:

• Job – All Operations – This option reschedules operations on this resource group. However, if multiple
operations for a single job are scheduled at this resource group, this option leaves gaps for any intervening
operations on additional resource groups.

• Branch – Preceding Operations – This option reschedules the selected operation and the preceding
operations for the assembly. It then reschedules operations contained in any preceding assemblies within
the method.

• Branch – Subsequent Operations – This option reschedules the selected operation and subsequent
operations for the assembly. It then reschedules operations contained in any subsequent assemblies
within the method.

• Assembly – All Operations – This option reschedules all the operations on the assembly around the
selected operation. If multiple operations for a single assembly are scheduled at this resource group, this
option leaves gaps for any intervening operations on additional resource groups.

• Assembly – Preceding Operations – This option reschedules the selected operation and all operations
for this assembly that come before it.

• Assembly – Subsequent Operations – This option reschedules the selected operation and all operations
for this assembly that come after it.

• Operation Only – This option only reschedules the selected operation.

7. Now click the Load Level By drop-down list to define what value you use to level the load. Available options:

• Start Date – This value is the start date defined on this window.

• Setup Group – This option causes the Setup Group Scheduling Order window to display. These
groups are used to sort schedules on your board.

To learn more about setup groups, review the Setup
Group Maintenance topic within application help.

• Operation Code – This operation levels the load by operation.

8. If you want load leveling to evaluate scheduling priorities, select the Consider Priority check box. These
values indicate if some jobs have precedence over other jobs. Scheduling priorities are defined in Job Entry.

9. When you finish, click OK.

The functionality compresses the operations on the selected resource or resource group. When the process is
complete, click the Schedule tab, review the changes and from the Actions menu, select the Accept All Changes.

Resource Scheduling Board – Details

For your reference, the Resource Scheduling Board displays the main information about each job and operation.
This information is displayed on the Details sheet.
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To use this sheet:

1. On the Schedule sheet’s Operation List, select the operation you want to review.  

2. Click the Detail tab.

3. The selected job and operation details display. The Job section displays the main information about the
selected job - the Job Number, Part, Start Date, Production Quantity, and other details.

4. The Assembly section displays details about the selected assembly. The Assembly Number, Part, Revision,
and other details display.

5. The Operation section displays details about the current operation like Start Date, Due Date, Resource
Group, and so on.

6. The Material Constraints grid displays any materials on this operation that are constrained within the
schedule.
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Multi Resource Scheduling Board

Use the Multi Resource Scheduling Board to review and modify scheduled jobs at the resource. You can review
the schedule for one resource or for many resources.

The Multi Resource Scheduling Board is only available if you
have the license for Advanced Planning and Scheduling (APS)
installed.

Menu Path: Production Management > Scheduling > General Operations > Multi Resource Scheduling Board

This program is not available in the Epicor Web Access.

To review the schedule for a resource:

1. Click the Resource button to find and select the resources you need.

2. In the Start Date field, enter the first date of the calendar range you wish to view.

3. In the End Date field, enter the last date of the calendar range you wish to view. The scheduling data
generated on and between the Start Date and End Date displays on the scheduling board. You are now
ready to view the schedule for the selected resources.

4. The Schedule sheet displays the schedule for the selected resources. This interface is similar to the Schedule
sheet within the Resource Scheduling Board.

5. The Detail sheet displays specific information on a selected resource. This interface is similar to the Detail
sheet within the Resource Scheduling Board.

6. The List sheet displays the operations for the selected resources.
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Multi Resource Scheduling Board - Schedule

Use the Schedule sheet to review and modify the production schedules for the selected resources.

1. The Resource ID and Resource description display in the left panel for the selected resources.

2. The Schedule Display Area visually displays the schedules of each selected resource. Depending on the
resource status, a different color bar appears for the resource’s scheduled duration.

3. To modify the production schedule of a resource, click the beginning of the resource’s schedule bar and
then drag it to a new start date on the schedule display. The Move Job window displays. The window is
similar to the one that displays within the Resource Scheduling Board.

4. To move backwards through the calendar, click the Left Arrow button.

5. To move forwards through the calendar, click the Right Arrow button.

6. You can jump to a specific point within the calendar by using the Goto field. To do this, use the Down
Arrow to select a specific date.
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Reports

This section describes some key Scheduling reports. You can run these reports whenever you need or set up each
report to generate and print through a recurring, automatic schedule. Review the Automatic Data Processing in
the Epicor ERP Implementation Guide for information on how you link a report to a recurring schedule.

Shop Load Report

The Shop Load report prints the load hours for each operation scheduled within each resource group. Load hours
are the hours that remain on an operation before it is complete. To calculate the load hours, this report adds
together the Setup Load and the Production Load for each operation.

Closed jobs and complete operations do not display on this report. If the load calculation results in zero hours,
or if the operation scheduled Start Date is later than the Cut Off Date, the operation does not print.

Production Load is the total hours that remain to complete an
operation’s production. Setup Load is the total hours that
remain to complete an operation’s setup. For more information
about load, review the Scheduling Concepts section found at
the beginning of this chapter.

Menu Path: Production Management > Scheduling > Reports > Shop Load

To define the Shop Load report options:

1. In the Cut Off Date field, enter the first date that load is calculated. All operations running on or after this
date display on the report.

2. Next, select an option in the Units area. This defines the time scale that you want each column to represent.
Available options: Week and Days.

3. The Interval field defines the time span placed between each column, using the time scale you selected in
the Units area. This value, combined with the Units value, indicates how the column headings are printed
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on the report. For example, you enter a cutoff date of 04/30/2016, use the Week time unit, and enter an
Interval of 1. The column headings that print are 04/01/16 – 04/07/16, 04/08/16 – 04/14/16, and so on.

4. If needed, select the First Bucket is Infinite? check box. This indicates overdue hours display on the report.
The first column includes all load hours scheduled before the Cut Off Date – as well as the current hours.
If selected, this check box also causes the report to ignore the Interval value.

5. Select the Summary Only check box to limit the report to only display resource group, department, and
report total information.

6. Use the sheets on the Filter tab to limit the Resource Groups and the Departments that display. Select
the specific departments and resource groups that you want on the report.

7. When you finish, click Print on the Standard toolbar.

Priority Dispatch Report

The Priority Dispatch report communicates the work schedule to the shop floor employees. The report is designed
to answer the question, “What should/could we be working on today?” Typically you print this report to display
one page for each resource group; each page is then either given to the shop supervisor for that group or posted
within the work area. The report divides its information into the following sections – Current Work, Available
Work, and Expected Work.

Menu Path: Production Management > Scheduling > Reports > Priority Dispatch

To define the Priority Dispatch report options:

1. Use the Max No of Operations to List Per Resource Group field to limit how many operations display
for each selected resource group. The default value is 999, which means that all operations are listed.

2. Next, use the Operations due to start on or before field to define the last date that prints on the report.
Only operations scheduled to start on or before this date display.

3. Select the New Page Per Resource Group check box if you want this report to start on a different page
for each resource group.

4. Select the Print Labor Reporting Resource Only check box if you want this report to only print the labor
reporting resource.
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5. Select the List All Scheduled Resources check box if you want this report to include all scheduled resources.

6. Select the Material Status check box to include the material status on the report.

7. If the Material Status check box is selected, the Summary\Detail check box activates. Select this check
box to include summary and detail information.

8. To include totals on the report, select the Print Totals check box.

9. Use the sheets on the Filter tab to limit the Resource Groups and the Departments that display. Select
the specific departments and resource groups you want on the report.

10. When you finish, click Print on the Standard toolbar.

Schedule Impact Report

Use the Schedule Impact report to analyze the effect of different scheduling dates on current jobs. You use this
report to compare early, late, and on time jobs between the actual and what-if schedules. After reviewing this
report, you can then accept or reject the what-if jobs on the scheduling boards.

Menu Path: Production Management > Scheduling > Reports > Schedule Impact

To define the Schedule Impact report options:

1. In the Jobs Required Dates On or Before field, enter the primary date you use. All jobs whose Required
By date is on or before this date display on this report.

2. Use the Early Grace Period (Days) field to define how many days a job can be completed early and still
be considered on time. If you enter a zero, a job scheduled to complete one day before the What-If date is
considered early by the report.
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3. Use the Late Grace Period (Days) field to define how many days a job can be late and still be considered
on time – in relationship with its What-If date. If you enter a zero, a job scheduled to complete one day
after the What-If date is considered late by the report.

4. Use the Report Name field to identify these report options. If you wish to run this version of the report at
a later date, you can pull up this version again. The operations stay the same, but you need to change the
Jobs Required Dates On or Before date.

5. You are now ready to define what specific jobs display on the report. Select the Summary Only check box
to display the late, early, and on time job totals in relationship with each job’s What-If date.

6. If you clear the Summary Only check box, other check boxes on this window become active. Select the
Late Jobs as One Group check box to display all the late jobs together on the report. If you do not select
the Late Jobs as One Group check box, you can select one or multiple late job check box options. Available
options:

• Jobs Now Late – Select this check box to display jobs that are just late in relationship with their What-If
dates.

• Jobs More Late – Select this check box to display jobs that are even later in relationship with their
What-If dates.

• Jobs Less Late – Select this check box to display jobs that are still late, but less late than they originally
were in relationship with their What-If dates.

• Late Jobs Unaffected – Select this check box to display late jobs that are not changed by their What-If
dates.

7. Select the Ontime Jobs as One Group check box to display all the on time jobs together on the report. If
you do not select the OnTime Jobs as One Group check box, you can select one or multiple on time job
options. Available options:

• Jobs Now Ontime – Select this check box to display jobs that are on time in relationship with their
What-If dates.

• Ontime Jobs Unaffected – Select this check box to display on time jobs that are not affected by their
What-If dates.

8. Select the Early Jobs as One Group check box to display all the early jobs together on the report. If you
do not select the Early Jobs as One Group check box, you can select one or multiple early job options.
Available options:

• Jobs Now Early – Select this check box to display jobs that are early in relationship with their What-If
dates.

• Jobs More Early – Select this check box to display jobs that are even earlier in relationship with their
What-If dates.

• Jobs Less Early – Select this check box to display jobs that are still early, but less early than they originally
were in relationship with their What-If dates.

• Early Jobs Unaffected – Select this check box to display early jobs that are not affected by their What-If
dates.

9. Click the Filter tab to limit the sites that display on the report.

10. When you finish, click Print on the Standard toolbar.
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Overload Informer

The Overload Informer displays resources that have work time scheduled above their capacity to complete. This
tool displays both the actual and what-if schedules for the selected resources. Run this tool when you schedule
resources using infinite capacity. The key information this tool displays is the Hours Over Capacity and Percent
Over values. Use these values to determine which resources are currently overloaded by the actual or what-if
schedules.

You can filter the information that displays on the Overload
Informer by entering a value within the Minimum Overload
Percentage field on resources and/or groups. This field is
available in Resource Group Maintenance.

Menu Path: Production Management > Scheduling > General Operations > Overload Informer

Use the Advanced Search sheet to define what you want to display:

1. In the Cut-off Date field, enter the last date you wish the Overload Informer to review. All resources that
are overloaded on or before this date display.

2. To filter the results by Dept, select an option from the drop-down list. Job departments place similar resource
groups together so you can quickly find related information on the Overload Informer and reports.

To learn more about departments, review the Job
Department Maintenance topic within application help.

3. You can also limit the results to only display resources contained within a specific resource group. To do
this, select a Resource Group from the drop-down list.

4. You can further limit the results to only display a specific resource. To do this, enter the resource’s identifier
in the Resource ID field.

5. To limit the results by overload percentage, enter a value within the Percent Over field. If a resource has
an overload percentage that is greater than or equal to this value, it displays within the results. This value
is only for times calculated in the actual schedule.

6. To limit the results by the what-if overload percentages, enter a value within the WI Percent Over field.
All resources that have an overload percentage greater than or equal to this value now display. This value
is only for times calculated in the current what-if schedule.
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7. When you have defined the filters you want, click the Refresh All button. You can now review the overloaded
resources on the Actual and What-If sheets.

Overload Informer – Actual

Select the Actual tab to review which resources are currently overloaded. Available columns on this sheet::

1. The Date column displays the day on which this resource is overloaded.

2. The Dept column displays the job department that contains the overloaded resource group.

3. The Resource Group ID and Resource Group Desc columns display the identifier and description of the
resource group that contains the overloaded resource.

4. The Resource ID and Resource Desc columns display the identifier and description of the specific resource
that is currently overloaded within the actual schedule.

5. The Hours column displays the total hours scheduled for the resource.

6. The Hrs Over Capacity column displays how many hours have been scheduled above the resource’s capacity.

7. The Percent Over column displays the percentage by which the resource is overloaded.

8. Resources can also be limited based on volume or other factors. The Non Time Capacity column indicates
a limit to the resource other than time. For example, a rack resource has 10 available racks that can be filled
each day. This column displays the number 10 in this field.

Use the information in this sheet to help you adjust how resources are currently used on the actual schedule.

Overload Informer – What If

Use the What-If sheet to review which resources are overloaded if you accept what-if scheduling. Use this sheet
to help you decide whether or not you accept the what-if schedule. Available columns:
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1. The Date column displays the day when this resource is scheduled to be overloaded.

2. The Dept column displays the job department that contains the overloaded resource group.

3. The Resource Group ID and Resource Group Desc columns display the identifier and description of the
resource group that contains the overloaded resource.

4. The Resource ID and Resource Desc columns display the identifier and description of the specific resource
that is currently overloaded within the what-if schedule.

5. The Hours Over Capacity column displays how many hours are what-if scheduled above the resource’s
capacity.

6. The WI Percent Over column displays the percentage by which the resource is overloaded through the
what-if schedule.

7. Resources can also be limited based on volume or other factors. The WI Non Time Capacity column indicates
another limit to the resource besides time. For example, you have a rack resource that has 10 available racks
that can be filled each day. This column displays the number 10 in this field.

8. The WI Daily Prod Qty indicates how many items can be produced by this resource per day within the
what-if schedule. For example, a rack can heat treat 100 parts/day, so the daily production quantity is 100.

Use the information displayed in this sheet to help you adjust how resources are currently used on the
what-if schedule.
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Additional information is available at the Education and
Documentation areas of the EPICweb Customer Portal. To access

this site, you need a Site ID and an EPICweb account. To create an
account, go to http://support.epicor.com.

http://support.epicor.com
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